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Restricted Rights Legend
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Documentation Updates

To check for recent updates or to verify that you are using the most recent edition of a document, go to: https:/softwaresupport.softwaregrp.com.

This site requires that you register for a Software Passport and to sign in. To register for a Software Passport ID, click Register for Software Passport on the Micro Focus
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Support
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Micro Focus online support provides customer self-solve capabilities. It provides a fast and efficient way to access interactive technical support tools needed to manage your
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Search for knowledge documents of interest

Submit and track support cases and enhancement requests
Download software patches
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Look up Micro Focus support contacts

Review information about available services
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Most of the support areas require that you register as a Software Passport user and to sign in. Many also require a support contract. To register for a Software Passport ID,
click Register for Software Passport on the Micro Focus Support website at https:/softwaresupport.softwaregrp.com.

To find more information about access levels, go to: https:/softwaresupport.softwaregrp.com/web/softwaresupport/access-levels.

Integration Catalog accesses the Micro Focus Integration Catalog website. This site enables you to explore Micro Focus Product Solutions to meet your business needs,
includes a full list of Integrations between Micro Focus Products, as well as a listing of ITIL Processes. The URL for this website is
https://softwaresupport.softwaregrp.com/km/KM01702731.
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Release Highlights for CMS Ul 2018.08

Updated 2018.08

This release of the CMS Ul introduces the following new features and enhancements:

« Integration job email notification

Implemented this feature in CMS Ul with a new setting Email Notification Enabled added in the
Integration Studio module.

« Improvements to the LDAP Manager module

o Added the capability to search for an LDAP user by its user unique ID (UID)

o Added two LDAP server settings for retrieving all the LDAP search results entries successfully
when the LDAP server has a size limit configured for the search results

« Performance Improvements: The UCMDB Browser module now supports many more concurrent
users per server node; the Reports Dashboard is loaded much faster with no display results limit in
reports.

« Improvements to the CMS Ul landing page
o Added the possibility to view the Cls displayed in a report widget grouped by Cl Type, or by

attribute, according to the type of grouping you have defined for the report

o Capability of deleting out-of-the-box (OOTB) widgets using the Settings e icon on the landing
page
« Improvements to the Topology Map
o The Topology Map has a cleaner look

o Zoom In the Topology Map to view the Core Properties of a Cl; Zoom Out to view only the CI
Type of a Cl

« Scheduled Reports Improvements: The scheduled reports view enables you to sort and filter
scheduled reports. You can also run scheduled reports immediately, delete scheduled reports, and
pause pending scheduled reports.

« Improvements to the Assisted Modeling module:

o You can enable and disable the Start Assisted Modeling link in the Service Modeling module for
specific users
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o Group Cls inamodel by Cl Type

o View in amodel only Cls that are directly related to a selected Cl
« Other general improvements
Previous Versions:

« CMS UI2018.05

« Universal CMDB Browser 11.0
o Universal CMDB Browser 4.15.1
« Universal CMDB Browser 4.14

o Universal CMDB Browser 4.13

« Universal CMDB Browser 4.12

o Universal CMDB Browser 4.10

« Universal CMDB Browser 4.05

Read more

Documentation Library

The Configuration Management System (CMS) Documentation Library provides download links for all
Universal CMDB documents of 10.20 and later releases, and all UD Content Pack documents for
CP11 and later releases, available on the Software Support portal (SSO), including all CMS documents
for the most recent releases.

You can use this library to access any of the guides and release notes relevant to UCMDB version
10.20 or later, and UD Content Pack 11 or later, or to download the full documentation set as a bundle.

Read more

Video Library

See all
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Additional Resources

o ITOM Marketplace

« ITSMBlog

o Documentation Forum

o Support and News Forum
« Software Support Online

o Software Education Services
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Release notes

This document provides an overview of the CMS Ul 2018.08 release.

WAt S MW . 19

Enhancements .. 20

FIXEA SO UBS ... 21

KNOWN IS SUES . 21

DeprecatioNS il 27
What's new

CMS Ul version 2018.08 includes the following enhancements:

« Enhanced High Availability

This release added the High Availability Notification Service which keeps the notification listener
alive withina UCMDB cluster. Now, when a UCMDB instance that has a listener registered to it
goes down, the listener is passed to another instance inside the cluster, and the client continues to
receive notifications. This new notification service is available in the client SDK, and it is an
optimization of the old notification process which was bound to the topology query service.

« Improvements to the LDAP Manager module

o Added the capability to search for an LDAP user by its user unique ID (UID).

o When the LDAP server has a size limit configured for the search results, the two newly added
LDAP server settings allow you to properly configure the LDAP sever so that all the LDAP
entries can be successfully retrieved. For more information, see "Number of users requested
from the LDAP server" on page 189 in CMS Ul Help.

« Improvements to the CMS Ul landing page
o Added the possibility to view the Cls displayed in a report widget grouped by CI Type, or by

attribute, according to the type of grouping you have defined for the report.

o Capability of deleting out-of-the-box (OOTB) widgets: You can use the Settings e icon

on the landing page to delete OOTB widgets. This feature replaces the capability of hiding the
out-of-the-box widgets.
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« Improvements to the Topology Map

o The Topology Map has a cleaner look by displaying a single connecting link for multiple
relationships between the same two CI.

o Now you can view the Core Properties of a Cl simply by Zooming In the Topology Map. Also,
you can view only the CI Type of a Cl by Zooming Out the Topology Map.

« Integration job email notification

Implemented the integration job email notification feature in CMS Ul with a new setting Email
Notification Enabled in the Integration Studio module. At the same time, removed the integration
job email notification related settings from UCMDB Ul. For details about how to enable the
integration job email notification, see Working with integration jobs in the CMS Ul Help.

« Improvements to the Assisted Modeling module

o You can enable and disable the Start Assisted Modeling link in the Service Modeling module for
specific users

o Group Cls inamodel by Cl Type
o View inamodel only Cls that are directly related to a selected Cl

« Other general improvements

Related topics

"Enhancements" below
"Fixed issues" on the next page

"Known issues" on the next page

Enhancements

The following table includes all the enhancements that were implemented after the release of CMS Ul
2018.05.

ID Component Summary

QCCR1H112257 CMS Ul - Added the possibility to view in the model only the Cls directly
Assisted related to a selected ClI (as defined by the selected template).
Modeling
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ID Component Summary

QCCR1H119100 CMS Ul - Added the possibility to view the execution status, last
Reports execution time, and next execution time for a scheduled report.

QCCR1H120951 CMS Ul - Added the capability to search for an LDAP user by its user

LDAP Manager = unique ID (UID).

QCCR1H121039 CMS Ul - When the LDAP server has a size limit configured for the
LDAP Manager @ search results, the two newly added LDAP server settings
allow you to properly configure the LDAP sever so that all the
LDAP entries can be successfully retrieved. For more
information, see "Number of users requested from the
LDAP server" on page 189 in CMS Ul Help.

QCCR1H121649 CMS Ul - Added the possibility to group the Cls in a module by CI Type.
Assisted
Modeling

Fixed issues

The following table includes all the defects that were fixed after the release of CMS Ul 2018.05.

ID Component Summary

QCCR1H122034 CMS Ul Splash screen does not display correctly when multiple web
browser windows all click the OK button.

Fixed the issue by adding the splash screen to securityFilter.

QCCR1H122339 CMS Ul Columns without data are not exported in the UCMDB Browser
reports, by contrast they are exported in UCMDB Server reports.

The issue is fixed, now empty columns can be displayed in
exported reports.

QCCR1H122802 CMS Ul - After upgrading to version 2018.05, users fail to log in with LDAP
Login with a supported character $ in their password.

The issue is fixed. Also, if the submit field is a password, it will
not be printed into the error log.

Known issues

This release has the following known issues and limitations.

| Important: CMS Ul 2018.08 works only with UCMDB server 2018.08.
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N/A

N/A

N/A

QCCR1H120605

QCCR1H114723

N/A

N/A

N/A

CMS Ul (2018.08)

Issue

(Google Chrome only) Sometimes, the Get Related map exported to SVG is
empty.

Workaround: Position your topology map on the top left side of the screen,
and then click Export to SVG (E ).

(Mozilla Firefox only) When trying to export all widgets to PDF, multiple blocked
pop-up windows are created.

Workaround: To view the PDF file, check the available options for the pop-
up windows, and then select Allow pop-ups for <UCMDB_URL>.

(Mozilla Firefox only) When you log in to CMS Ul and choose to save the
password for this site, other password fields are auto-filled with your saved
password.

Workaround: To avoid this issue, when the Remember Password prompt
is displayed, click Don't Save.

After UCMDB server is restarted, scheduled report is still sent even after the
scheduler is deleted.

| Workaround: Restart CMS UI.

The notification message from the CMS Ul module Package Manager may
display date time format incorrectly on non-English Ul. This is a third-party
limitation as date time is formatted by the Notification component from Grommet.

(Internet Explorer 11 only) When using Internet Explorer 11, only one
UCMDB Browser widget can be added to the Home page. Otherwise, CMS Ul
might get stuck due to memory leaks.

Workaround: To add more than one UCMDB Browser widget to the Home
page, use a different supported web browser.

When hovering the mouse over the label of a Cl in the Topology Map, the tooltip
with the full name of the Display Label attribute is not displayed.

| Workaround: Hover the mouse over the icon of a Cl.
After grouping the Cls in the Topology Map by CI Type, the magnification level of
the Topology Map cannot be changed. Also, this applies to the dragging option

too.

Workaround: To change the magnification level of the Topology Map, or to

be able to drag the view, make sure that the Layout Settings ( )is
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QCCR1H116886

QCCR1H118145

QCCR1H118146

QCCR1H120235

QCCR1H120506

QCCR1H120514

QCCR1H120545

QCCR1H120491

QCCR1H119301

QCCR1H104135

QCCR1H113157
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Issue
closed. Otherwise the view is set to Fit to screen.

In certain non-English environments of CMS UlI, some strings on the Home page
are not translated into proper languages.

The date and time format is incorrect on the page where you edit UCMDB
integration point population jobs in non-English versions of Integration Studio in
CMS Ul

The date and time format is incorrect on the page where you edit the details of
UCMDB integration point population jobs in non-English versions of Integration
Studio in CMS UI.

The text string "Total" is displayed in English in some modules in Korean
versions of CMS UI.

In Brazilian Portuguese versions of CMS Ul, the localized name of the Smart
Software Analytics module is displayed incorrectly on the Ul.

The final warning message that is displayed when a non-root user installs a
Probe in non-English versions of CMS Ul on Linux is not translated.

The warning message that is displayed when you try to create an integration job
with a name that includes special characters in non-English versions of CMS Ul
is not translated.

CMS Ul does not work properly in a multi-customer environment.

Workaround: None for this release.

"There is no data available for this report” message is displayed for individual
default report widgets (such as Installed Software) on the Home page. It is highly
possible that the reports are querying over a large amount of data from the
UCMDB server which exceeds the maximum number of elements allowed in
view, and you may find "server view query over limit" error in log.

Workaround: To resolve the display issue, goto UCMDB Ul >
Administration > Infrastructure Settings Manager, locate the Maximum
number of elements (nodes) in TQL result for view setting (default
value: 30000) and increase its value to meet your need.

On Mozilla Firefox, the plug-in container for Firefox stops working and
sometimes, when clicking Logout, nothing happens. This is a known issue with

Mozilla Firefox ESR 38.4 (JavaScript garbage collection crash with Java applet).

Workaround: Use a different supported Firefox version.

The language of the system categories is the one used when the CMS Ul is
deployed. This is because the system categories are deployed only once, on the
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QCCR1H111354

QCCR1H112827

QCCR1H113171
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Issue

first login, using the current locale. On subsequent logins, the system categories
are not re-deployed, so the name is not updated either.

Workaround: To change the language of the system categories:
1. Stopthe Tomcat.

2. Change the locale.
3. Restart the Tomcat.

Note: If you change the language, all the users that are connected to the
same CMS Ul instance will view the system categories with the updated
language.

LW-SSO fails to work with CMS Ul.
Workaround: If you deploy CMS Ul in your own Tomcat, for Tomcat 8 the

following line should be added to the <Tomcat_installation_
folder>/conf/context.xml file:

<CookieProcessor className="org.apache.tomcat.
util.http.LegacyCookieProcessor" />

(Safari only) The export of reports/Cls/widgets in the PDF format does not work
on Safari.

Workaround: Check the address bar and if it is marked with Pop-ups
blocked, allow the pop-ups for this site.

When a UCMDB server is reconfigured to use a new schema, the new schema
has the OOTB packages deployed at the UCMDB server startup. If a standalone
CMS Ul is already connected to the UCMDB server, the CMS Ul's packages are
not present in the new schema.

Workaround: Restart the CMS Ul Tomcat in order for the CMS Ul's
packages to be redeployed on the new schema.

Sometimes, when SSL is configured and OpenJDK is used, the CMS Ul may
become unresponsive. This is because the hand shake between the CMS Ul
server and the browser client fails due to unnamed elliptic curve algorithm.

Workaround: Follow these steps to resolve the issue:
« If Tomcat is started by invoking .\ucmdbbrowser\bin\startup.bat:

a. Create the setenv.bat file (if one has not already been created).

b. Type the following line in the setenv.bat file:
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set CATALINA_OPTS=-Dcom.sun.net.ssl.enableECC=false

Caution: Do not use a copy-and-paste operation to add the
above line to the file. Type every character one by one.

Note: If the variable CATALINA_OPTS already exists, just
append the -Dcom.sun.net.ssl.enableECC=false value to the
variable.

c. Restart the Tomcat server.
o If Tomcat is started as a service:
a. Runthe CMS-Browserw.exe file (or the tomcat7w.exe file).

b. Inthe dialog box that opens, go to the Java tab, and add —
Dcom.sun.net.ssl.enableECC=false in the Java Options
container.

c. Restart the Tomcat server.

Currently it is not possible to load the federated CITs' icons from the remote
server.

On Internet Explorer 11, sometimes the loading animations get stuck.

Workaround: Restart Internet Explorer.

The port number of CMS Ul URL changes to 8143 when Configuration Manager
10.22 is connected to UCMDB Server 10.30, resulting that the CMS Ul is no
longer available.

After Configuration Manager is installed, CMS Ul URL becomes https://<server
name or IP address>.<domain name>:8143/ucmdb-browser/, which is the
URL of the CMS Ul embedded in CM.

Workaround: After Configuration Manager is installed, make sure you
change the port number of CMS Ul URL from 8143 back to 8443 (go to
UCMDB Ul > Administration > Infrastructure Settings Manager, locate
the UCMDB Browser URL setting by searching Name with a keyword
Browser, and then change the port number from 8143 to 8443 and save the
change.

Sometimes, the export of a report fails with the following error message: "Cannot
initialize class
net.sf.jasperreports.engine.util.JRStyledTextParser".

Workaround: Restart the CMS Ul server.
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QCCR1H110609

QCCR1H111482

QCCR1H106412

QCCR1H108187

QCCR1H107420

QCCR1H104887

QCCR1H104553

N/A

QCCR1H99251

QCCR1H92299
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Issue

The View Discovery Log action in the Discovery Progress Widget is supported
only with one of the following web browsers: Microsoft Internet Explorer 11 or
later versions, Google Chrome latest versions, and Mozilla Firefox latest
versions. This is because Grommet does not provide support for other web
browsers.

CMS Ul does not support the Platform for Privacy Preferences Project (P3P)
header in Internet Explorer for the widgets that can be directly embedded into
Micro Focus Service Manager.

Workaround: Follow these steps to open in the Internet Explorer the
widgets that can be directly embedded into Micro Focus Service Manager:

1. Assign the CMS Ul and the Service Manager to the same domain.
2. Addthe CMS Ul and the Service Manager in the hosts file.
3. Configure the CMS Ul URL with a fully qualified domain name (FQDN ).

Currently, in the Get Related Map, the double relations between two related Cls
are displayed as a single relation.

Currently, when more than 1000 Cls are displayed in the Get Related Map, you
might encounter a performance issue.

To view the TQLs for SM widgets (Defects widget, Incidents widget, and
Change Request widget) in UCMDB, go to the JMX console, set the value of the
ucmdb_browser.query_services JMX method to true, and then restart the
CMS Ul.

To view the error messages related to probe's issues under Probe Errors
discovery issues type in the UCMDB Browser module, after upgrading UCMDB
to version 10.22, manually redeploy the AutoDiscoverylnfra package located in
the <UCMDBServer>\content\basic_packages directory.

There are times when a Cl that is not visible in the Service Modeling map, has a
Discovery Indicator. When this happens, the indicator appears on all the Cls that
are in the map and have a direct or indirect link to the CI that is not visible.

Currently it is not possible to create two service models with the same name in
the UCMDB Browser module, even if different tenants are used. This is because
the Views that the service models use as resources must have a unique name.

If accessing the UCMDB Browser module from Configuration Manager, you
might not be able to use a lot of features like Notification and Reports.

For exporting the Stakeholder widget, when the Person CIT has an avatarimage
set and the CMS Ul is behind a proxy, the exported document will not contain the
avatar image, instead the default image is used for that person.

This is because the Java Environment on which the server runs cannot access
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the image. On the Web Browser, the configurations are set inside the LAN
Settings, so the link can be accessed.

QCCR1H99461 UCMDB Browser 4 may not load on Intemet Explorer 9 or 10 when Check for
newer versions of stored pages is set.

Workaround: In case you use Interet Explorer 9 or 10, set Check for
newer versions of stored pages to Automatically. To do that, in the
Internet Explorer window, go to Tools > Internet Options > General, and
then in the Browsing history section, go to Settings.

QCCR1H94718  Browser Cl Access Control permissions only apply when a user is connected in
Actual state.

N/A If many users run reports simultaneously, and those reports contain many
results, there will be increased memory usage on the CMS Ul web server
(Tomcat or Jetty).

Workaround: To decrease the load on the web server, do one of the
following:

« Increase the maximum heap memory size on the web server.
« Decrease the session timeout specified in the web.xml file.

« Set up high availability to spread the load over multiple CMS Ul
instances. For more information, see "Configure High Availability Mode
in the CMS Ul Help.

« Instruct users to log out after finishing to work with the CMS UI.

Deprecations

There is no deprecations for this release.
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Get started

This section provides information that helps you get started in using the latest version of the CMS UI.

LOgaING 1N 28
HOME Page oL 30
Add the UCMDB URL to the Trusted Sites List in Your Web Browser ............................... 32
UCMDB Browser Videos ...l 33

Logging In
Tolog into CMS Ul, enter the following in a web browser:
https://<server_name>:8443/ucmdb-browser

where <server_name> represents the fully qualified domain name (FQDN) of the UCMDB server.

Note:
e Tologinto CMS Ul , your UCMDB license must be valid.

« If you attempt to loginto CMS Ul and a UCMDB server is not available, an error message is
displayed.

« HTTP protocol is disabled by default, and embedded CMS Ul is not accessible with the HTTP
protocol. However, if necessary, you can still enable HTTP communication by adding the
following setting into the C:\UCMDB\UCMDB Server\confisettings.override.properties file,
and then restart the UCMDB server:

jetty.connections.http.enabled=true

If you enabled the HTTP communication, then the login for the embedded CMS Ul is not
possible on HTTPS protocol. The HTTP protocol and the port 8080 should be used.

« If you attempt to log in to the CMS Ul in a multi-customer environment and you have not been

assigned a role with the permission, an error message is displayed.
If a default password or password policy has been defined, and you attempt to log in to the CMS Ul

using that default password, you will receive a message asking you to change it. Select a new
password and log in again using the new password.
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After enabling or disabling the default password feature, the CMS Ul cache settings must time out once
before the new setting takes effect. To specify the cache value:

In UCMDB, go to Administration > Infrastructure Settings > UCMDB Browser Settings, and set
Time for which information in the Browser cache is valid=X, where X is a number of minutes.

You can specify a redirection URL when you log out of the CMS Ul. Use the Logout forward URL
setting in the Infrastructure Settings Manager in UCMDB. Be sure to add http:// to the URL if required.

No user administration is possible from within the CMS Ul (this is only performed in UCMDB).

Note:

« The initial launch after the installation of the CMS Ul (prior to login) can take from 30 seconds
up to a couple of minutes.

« When logging in to the CMS Ul for the first time with any given UCMDB Server, the login takes
longer (from 30 seconds up to a couple of minutes) due to automatic deployments.

« If you are using the CMS Ul, after login the logged-in user locale information is taken from the
UCMDB server and the CMS Ul uses the user’s locale. If there is no locale defined for the
user, the locale of the CMS Ul is used.

Login to the CMS Ul occurs as follows:

o UCMDB users. The users of the CMS Ul are the same as the users of UCMDB, therefore, only
users that exist in UCMDB are able to log in to the CMS Ul.

o LDAP users. When the UCMDB server is configured to authenticate on LDAP, the CMS Ul
automatically detects this and uses this configuration to authenticate users against the same
LDAP.

Note: All LDAP configuration and group mapping is performed only on the UCMDB server, as
well as all authentication processing, including LDAP integration.

How to Enable Logging In to CMS Ul Automatically

Advanced login options enables you to automate login, limit login access, and provide direct login
capabilities to specific pages in CMS Ul.

When automatic login is enabled from the login page, and when you close the browser tab without using
the Logout button, the next time you enter this URL to access CMS Ul (http://<server_
name>:<8088>/ucmdb-browser), the login page does not open, the login name and password do not
have to be entered, and the default page that is set to open opens automatically.
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Caution: This option could be considered a security risk and should be used with caution.
To enable automatic login:

1. Inthe CMS Ul login page, select the option Remember me.
2. When completing your session, do not click Logout, but close the browser tab.

When you open a new browser tab and navigate to link http://<server_name>:<8088>/ucmdb-
browser, the login page should be skipped.

The Remember me option can only be manually canceled by the user when he/she logs in next time,
by using the Logout button.

Home Page

You can remove any content from the Home page, rearrange or resize the existing widgets, or add new
widgets. Also, you can navigate through the available web-based CMS modules and access them
directly from the CMS Modules pane.

| Important: CMS Ul 2018.08 requires UCMDB server 2018.08.
The following table describes the user interface elements on the Home page.

Ul Element (A-Z) Description

m You can open the Home page from anywhere else in the CMS Ul simply by

clicking the @ icon in the upper left corner of the CMS Ul window.

E CMS Modules. Opens the CMS Modules pane, and allows you to navigate
through the available web-based CMS modules. For detailed information
about the available modules, see "CMS Modules" on page 114.

<Top SearchBar>  Search. Allows you to search within the following categories:

O\ « Configuration Item. Allows you to search for a Cl. The search results are
opened directly in the Configuration Item Search module.

» Queries and Models. Allows you to search for queries and models. The
search results are opened directly in the Resource Manager module.

» Views and Reports. Allows you to search for views and reports. The
search results are opened in the Resource Manager module or in the
Topology Map.

« Reconciliation. Allows you to search for a Cl and to view all its changes.
Also, you can view the reason why the Cl was changed. This includes a
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Ul Element (A-2)

<username=>

CMS Ul (2018.08)

Description

list of identification candidates, and the reasons for matching the searched
Cl with them. For detailed information about Reconciliation Analyzer, see
"Working with the Reconciliation Analyzer" on page 133

For more information, see "Search Functionality" on page 125.

<username>. Displays the user that is currently logged in to CMS Ul.
Clicking it allows you to log out from CMS Ul.

Help. Opens the Help menu:

« Help. Opens the CMS Ul Help page.

o Online Help for CMS Ul. Opens the online help for the current CMS Ul
version available on the Micro Focus Software Information Portal.

« Online Help for UCMDB Server. Opens the online help for the current
UCMDB Server version available on the Micro Focus Software
Information Portal.

o Online Help for Content Pack. Opens the online help for the current
Content Pack version available on the Micro Focus Software Information
Portal.

o About. Opens the About dialog box.

The ABOUT tab provides version, patch (if available), copyright, and third-
party notice information. For more information, see "About Window" on
page 122.

The LICENSE tab provides license information, including license status,
license summary, and a license status link. Clicking the license status link
opens the license summary report, which contains license consumption
summary and available licenses, and a link that allows you to export a
detailed license consumption report. For more information about licenses,
see "Universal Discovery Licensing Overview" on page 422.

Clicking OK exits the About window.

Walk-throughs. Opens a list of predefined workflow scenarios. Click one of
the available workflows to open a set of step-by-step-instructions. This allows
you to complete an end-to-end workflow by yourself.

The following walk-throughs are available:

« How to Search fora Cl

For more information, see "Run a Walk-through " on page 128

Add New Widget. Enables you to add different types of widgets to the Home
page. Opens the Add a New Widget layer.

The following types of widgets are available:
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Ul Element (A-Z) Description

« UCMDB Browser Widgets (History, Get Related, and Impact Simulation).
For more information, see "Add a UCMDB Browser widget to the Home
page " on page 126

« Reports. For more information, see "Add a report widget to the Home page
" on page 127

e Settings. Enables you to hide the out-of-the-box content. For more
information, see "Hide the out-of-the-box content" in the "Home Page
Overview" on page 115 section.

The following table describes the user interface elements on each tile on the Home page.

Ul Element (A-Z) Description

b 4 Delete <tile name>. Removes the widget from the Home page.

r:ﬁj Map mode. Opens the topology map for a view associated with a widget.

-@. Widget Settings. Allows you to customize the widget title, and to view some
of the widget properties.

To customize the title of a widget, follow these steps:

1. Inthe Home page, hover the mouse over a widget, and then click the
Settings icon ('%) in the top-right corner of the widget.

2. Inthe Widget Settings pane, replace the existing title with a new one, and
then click Save.

Re-size widget. Changes the size of the widget. To do this, click the icon and
then drag the mouse.

Add the UCMDB URL to the Trusted Sites List
in Your Web Browser

When you access CMS Ul, if the following error message appears:

Something went wrong. You're probably using a self signed certificate. Please click
'OK"' to visit the UCMDB URL, then add it as an exception in your browser and
refresh this page.

Add the UCMDB URL to your browser's list of Trusted Sites or Exceptions, and then refresh the CMS
Ul page.

Note: If you click OK and the UCMDB website does not open, check the address bar and if it is
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marked with Pop-ups blocked, allow the pop-ups for this site.

To add the UCMDB URL to the Trusted Sites list in your web browser, do the following:

Google Chrome

1. Click the Application menu button on the right side of the Address bar.

2. Goto Settings > Show Advanced Settings > Change proxy settings > Security > Trusted
Sites > Sites.

3. Enterthe UCMDB URL, and then click Add.
4. Click Close > OK.

Mozilla Firefox

1. Click the Application menu button on the right side of the Address bar, and then choose Options.
2. Goto Advanced > Certificates > View Certificates > Servers > Add Exception.

3. Enterthe UCMDB URL, click Get Certificate, and then click Confirm Security Exception.
Internet Explorer

1. Click the Tools button on the right side of the Address bar, and then choose Internet options.
2. Goto Security > Trusted Sites > Sites.

3. Enterthe UCMDB URL, click Add, and then click Close.

UCMDB Browser Videos

Version UCMDB Browser Videos

414 « Assisted Modeling Force Validation through TQL Query
« History

« Smart Software Analytics Demo
4.13 « UCMDB Browser 4.13 What's New

4.10 « Consume any service using the Service Modeling Dashboard

« Get related widget embedded in Service Manager

o Impact Simulation widget embedded in Service Manager

For more UCMDB Browser videos, see UCMDB Browser community on the ITOM Marketplace.
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Introduction

Before installing CMS Ul, ensure that your system meets the following requirements:

« UCMDB version. UCMDB Server 2018.08.

o CMS Ul Server. OpendDK 8 (64 bit) must be installed on the server where you install the CMS Ul
(the Apache Tomcat version gets its Java from the JAVA_HOME environment variable).

Important: The latest version of CMS Ul works only with the latest released version of UCMDB
server.

The CMS Ul installation currently comes in two formats:

« Windows Installation Package. A zip file called CMS_Ul-<display_version_number>_
Windows.zip that contains the following packages, depending on the type of installation you have:

o CMS Ul Package. A zip file called CMS_Ul-<display_version_number>-all-in-one-
standalone.zip that consists of the ucmdb-browser.war file, discovery-log.war file,
discovery.war file, and a /conf folder with the CMS Ul configuration files. Use this format if you
already have an Apache Tomcat Server installed, or you want to install the Tomcat server on
your own.

Note: If you are planning to install CMS Ul with a Tomcat server, it is not recommended to
do this on the same machine that runs the UCMDB Server. For details about installing both
applications on the same machine, see "Install CMS Ul on the Same Machine that Runs the
UCMDB Server" on page 54.

o Pre-configured Apache Tomcat Server package for Windows. A zip file called CMS_UI-
<display_version_number>-tomcat-assembly-windows.zip that consists of a pre-configured
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Apache Tomcat server for Windows with the ucmdb-browser.war file, discovery.war file, and
discovery-log.war file. The CMS Ul configuration files reside under the /conf folder.

o Existing Apache Tomcat server package. A zip file called CMS_Ul-<display_version_
number>-standalone.zip that consists of the ucmdb-browser.war file, and a /conf folder with
the CMS Ul configuration files. Use this format if you have an Apache Tomcat sever installed
and you want to upgrade the CMS Ul to the latest version.

« Linux Installation Package. A zip file called CMS_Ul-<display_version_number>_Linux.zip
that contains the following packages, depending on the type of installation you have:

o CMS Ul Package. An archive file called CMS_Ul-<display_version_number>-all-in-one-
standalone.tar.gz that consists of the ucmdb-browser.war file, discovery-log.war file,
discovery.war file, and the CMS Ul configuration files. Use this format if you already have an
Apache Tomcat Server installed, or you want to install the Tomcat server on your own.

Note: If you are planning to install CMS Ul with a Tomcat server, it is not recommended to
do this on the same machine that runs the UCMDB Server. For details about installing both
applications on the same machine, see "Install CMS Ul on the Same Machine that Runs the
UCMDB Server" on page 54.

o Pre-configured Apache Tomcat Server package for Linux. An archive file called CMS_UI-
<display_version_number>-tomcat-assembly-unix.tar.gz that consists of a pre-configured
Apache Tomcat server for Linux with the uemdb-browser.war file, discovery.war file,
discovery-log.war file, and the CMS Ul configuration files.

o Existing Apache Tomcat server package. An archive file called CMS_Ul-<display_version_
number>-standalone.zip that consists of the ucmdb-browser.war file, and the CMS Ul
configuration files. Use this format if you have an Apache Tomcat sever installed and you want
to upgrade CMS Ul to the latest version.

Caution: Apart from the OOTB files, DO NOT ADD any additional resources into the <UCMDB_
Server_Home>\deploy directory. Because UCMDB will try to deploy every file from this location,

which may cause the ucmdb-browser.war file not deployed completely, and as a result the CMS
Ul will fail to start.

Support Matrix
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CMS Ul Requirements

This section provides information about the supported hardware and software that you must have to
successfully install and run CMS Ul 2018.08.

Hardware

CMS Ul 2018.08 standalone is supported on the following hardware:

Component

Computer/proc
essor

Memory

CMS Ul (2018.08)

Requirement

Windows/Linux:

To fulfill the CPU requirements, you must have one of the following:
« Intel Dual Core Xeon Processor 2.4 GHz or later

o AMD Opteron Dual Core Processor 2.4 GHz or later

Recommended: The latest generation of Intel/AMD processors are
recommended.

In addition to the above requirements, you must have the following number of CPU
Cores, depending on your deployment configuration.

CPU Cores:
Deployment Minimum Recommended
Standard 2 Cores 4 Cores
Enterprise 8 Cores More than 8 Cores

Note: To ensure proper CMS Ul performance, it is recommended that you use
the fastest possible processor speed.

Windows/Linux:

Deployment

Minimum Recommended
Standard 8 GB RAM 16 GB RAM
Enterprise 32 GBRAM 32 GB RAM

Note: CMS Ul is dependent upon memory. To ensure proper CMS Ul
performance, it is recommended that you allocate memory as much as
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Component Requirement

Memory Swap

File

Free hard disk

space

possible from the machine where Tomcat is installed.

the physical memory.

Windows: The virtual memory for Windows should be at least 1.5 times the size of

Linux: The Linux swap file size should be equal in size to the physical memory.

Standard/Enterprise: At least 2.5 GB

Note: Support for Storage Area Network (SAN) is available for usable disk
space for CMS UI. You can install CMS Ul on Storage Area Network (SAN)
disk storage attached to a server.

Operating Systems

CMS Ul 2018.08 runs on the following operating systems:

0s

Windows Server 2012, 2012 R2, and 2016

Red Hat Linux v5.x

Edition

Platform (bit)

Essentials/Standard = 64 bit

Enterprise/Advanced @ 64 bit

Red Hat Enterprise Linux Server6.3, 6.7, 6.8, and 6.9

Hardware
Platform

x86-64

x86-64

x86-64

x86-64

x86-64

OS Type

Windows Server 2016

Windows Server 2012 R2

Windows Server 2012

Windows Server 2008 R2

Red Hat Linux Server 5.10

CMS Ul (2018.08)

OS Version and
Edition

Datacenter and
Standard, 64-bit
(without the Nano
Server installation
option)

Datacenter and
Standard, 64-bit

Datacenter and
Standard, 64-bit

Enterprise/Standard,
SP1, 64-bit

Enterprise/Advanced

64 bit

Supported Recommended

Yes Yes

Yes

Yes

Yes

Yes
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Hardware
Platform

x86-64

x86-64

x86-64

x86-64

Any

Supported Resolutions

OS Type
and 5.11

Red Hat Enterprise Linux
Server6.4~6.9,7.0~7.5

Oracle Enterprise Linux
Server with Red Hat
Compatible Kernel v6.4 ~
v6.9,v7.0~v7.4

Oracle Enterprise Linux
Server with Oracle
Unbreakable Enterprise
Kernel v6.4 ~v6.9, v7.0 ~
v7.4

Cent0S7.0,7.1,7.2,7.3,
and 7.4

SUSE Linux Enterprise
Server 11.3and 12

OS Version and
Edition

64-bit

64-bit

Enterprise/Advanced
64-bit

Enterprise/Advanced
64-bit

x86-64

Enterprise 64-bit

CMS Ul 2018.08 requires the following screen resolutions:

e Minimum resolution: 1024x768

« Recommended resolution: 1600x1050

o Recommended High Definition resolution: 1920x1080

Open-Source Software Dependencies

CMS UI 2018.08 requires the following open-source software dependencies:

o OpenJDK 8

Supported Recommended

Yes

Yes

Yes

Yes

Yes

To download OpendDK 8, go to the Azul's site at http://www.azul.com/downloads/zulu/.

CMS Ul (2018.08)
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Databases

CMS Ul 2018.08 does not use a database.

UCMDB Server Compatibility

Supported
Product Name UCMDB Version Comments
CMS Ul 2018.08 The latest version of CMS Ul requires the latest released
standalone version of UCMDB server.
2018.08
CMS Ul 2018.08 The latest version of CMS Ul can be embedded only in the
embedded latest released version of UCMDB server.
2018.08

Application Servers

The following supported application server is required to run CMS Ul 2018.08:

« Wildfly, version 11
o JBoss EAP, version 6.4.0

Web Application Servers

One of the following supported web servers is required to run CMS Ul 2018.08:

« Apache Tomcat, version 8.5.24

« Jetty versions that are included with UCMDB Server version 2018.08

Note: Jetty is not supported in standalone mode, only in embedded mode in UCMDB.
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Web Browsers and Plug-ins

One of the following supported web browsers with the following plug-ins is required to run CMS Ul

2018.08:
Browser Client OS Remarks
Internet Explorer 11 Windows OSs To enable CMS Ul to always retrieve data

from UCMDB server instead of loading
cached data in IE, make sure you do the
following:

1.

Google Chrome latest ~ Windows OSs
version

Mozilla Firefox latest Windows OSs
version

CMS Ul Compatibility

InIE, go to Settings > Internet
Options > General > Settings.

In the Website Data Settings dialog,
go to the Cashes and databases tab.

Make sure you deselect the Allow
website caches and databases
check box.

Click OK twice.

This section provides information about software and configurations that are compatible with CMS Ul

2018.08.

Network Level Support
CMS Ul supports the following network levels:

. IPv4
. IPV6

CMS Ul (2018.08)
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Virtualization Products
CMS Ul 2018.08 can be used with the following virtualization products:

» VMware ESX 4

o VMware ESX 4.1

o VMware ESXi5

o VMware ESXi 5 update 1

o Microsoft Hyper-V Server 2008 R2 SP1

SSO

Single Sign On  Web Server in
Product Front Comments

CA Site Minder s Only a stand-alone CMS Ul is supported. When the CMS
Ul runs on the jetty of the UCMDB server, you can only
use the http protocol (the SSL protocol is not available).

Apache
IBM WebSeal s

Apache

High-Availability Products

CMS Ul 2018.08 is compatible with the following high-availability products:

o The F5 BIG-IP version 10.x load balancer

For details on configuring the load balancer, refer to the High Availability section in the interactive
Universal CMDB Deployment Guide.

If you are using a different load balancer, the configuration should be performed by a network
administrator who has a wide knowledge about how to configure your load balancer, and similar
principles should be applied.
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Note: The load balancer used for High Availability must have the ability to insert cookies and

must be able to do health checks ("keepalive").

Micro Focus Software Integrations

Product Integrations

Product
Name

UuCMDB

UCMDB
Configuration
Manager

BSM

Service
Manager

ALM

Enterprise
View

Operations
Orchestration

Supported Version

2018.08

10.10 and later

9.12 and later

According to UCMDB
integration support - 9.30,
9.31, and 9.40

11
1

10.51

Widget Integrations

Widget
Properties

Environment

CMS Ul (2018.08)

Integrated Product
UCMDB
UCMDB

Comments

The latest version of CMS Ul requires the latest
released version of UCMDB server.

The latest version of CMS Ul can be embedded
only in the latest released version of UCMDB
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Widget
Impact
Policy
Change Requests
Incidents
Monitoring
Stakeholders
Automation
Security
Defects
Problems

History

Discovery Progress

Get Related

Integrated Product
UuCmMDB

UCMDB Configuration Manager
Service Manager
Service Manager

BSM

UCmMDB

Operations Orchestration
Enterprise View

ALM

Service Manager
UCMDB

UuCcmMDB

UCmMDB

Information about Micro Focus software that integrates with CMS Ul 2018.08 can be found at the Micro

Focus Software Support site (https://softwaresupport.softwaregrp.com/).

CMS Ul (2018.08)

UCMDB Server Version

UCMDB Server Coverage

Functionality

Properties Widget 2018.08
Environment Widget 2018.08
Impact Simulation Widget 2018.08
Policy Widget 2018.08
Change Request Widget 2018.08
Incidents Widget 2018.08
Monitoring Widget 2018.08
Stakeholder Widget 2018.08
Automation Widget 2018.08
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Functionality

Security Widget

Defects Widget

Problems Widget

History Widget

Embeddable Widgets

Enterprise Collaboration integration
Direct link to external application
Lightweight SSO

LDAP support

Multiple UCMDB Servers support
Server side configuration
Localization

Online Help

Data update

RTSM certification

Plain search

Advanced search engine

Search Auto-Completion
Properties categorization

Most Searched

Most Visited

Assisted Modeling (Lightweight Modeling)

Multi-tenancy

Reports

Notifications

Browser Cl Access Control

Categorization

CMS Ul (2018.08)

UCMDB Server Version
2018.08
2018.08
2018.08
2018.08
2018.08
2018.08
2018.08
2018.08
2018.08
2018.08
2018.08
2018.08
2018.08
2018.08
2018.08
2018.08
2018.08
2018.08
2018.08
2018.08
2018.08
2018.08
2018.08
2018.08
2018.08
2018.08

2018.08
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Functionality UCMDB Server Version
Dynamic Widgets 2018.08
Branding 2018.08
Service Modeling 2018.08
Get Related Widget 2018.08
Discovery Progress Widget 2018.08
Discovery 2018.08
Package Manager 2018.08
LDAP Manager 2018.08
Home 2018.08
Smart Software Analytics 2018.08
Probe Dashboard 2018.08
Integration Studio 2018.08
Resource Manager 2018.08

Micro Focus Software Coexistence

No coexistence information for CMS Ul 2018.08 is available.

Obsolescence Plans

CMS Ul support is aligned with the official Universal CMDB Product Obsolescence plans and
dependent on the compatibility against the main stream versioning (for example, 10.1x, 10.2x, and
10.3x). For example, CMS Ul versions supported only with Universal CMDB 10. 1x will be following the
Obsolescence plans of Universal CMDB 10.1x.

Change Log

The table below lists the changes to this document since the release of UCMDB Browser version 4.05.
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Document Date (product
version)

May 2016 (4.05)

September 2016 (4.10)

November 2016 (4.11)

December 2016 (4.12)

April 2017 (4.13)

CMS Ul (2018.08)

Change

Product Integrations:

Updated the UCMDB Supported Version to 10.01 and later
UCMDB Server Coverage:

Updated the Minimal UCMDB Server Version to 10.01
Application Server:

Updated Apache Tomcat version to 8.0.24

Added Support for the following:

« Red Hat Enterprise Linux Server 6.7
« Firefox 31 ESR and 38 ESR

« Safari on Mac OS X

Removed Support for the following:

« Windows Server 2008 SP2
o Windows Server 2008 R2 and R2 SP1

o Microsoft Internet Explorer 8
Reintroduced Automation Widget

o Added hardware requirements for UCMDB Browser 4.12
standalone

o Added support for Windows Server 2016
« Added open-source software dependencies

o Added the supported UCMDB version for UCMDB Browser 4.12
embedded

« UCMDB Server Coverage:
Added Package Manager functionality
« Web Browsers and Plug-ins

Added supported web browsers required for the Package
Manager

« Web Browsers and Plug-ins

Added supported web browsers required for the CMS-LDAP
Manager module

Added supported web browsers required for the Probe Dashboard

Added Internet Explorer as a supported web browser for the
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Document Date (product
version) Change

Package Manager module
« UCMDB Server Coverage:

Added CMS-LDAP Manager module

Updated the Minimal UCMDB Server Version to 10.10
« Application Server:

Updated Apache Tomcat version to 8.5.12

July 2017 (4.14) « Web Browsers and Plug-ins

Added supported web browsers required for the Smart Software
Analytics module

Added supported web browsers required for UCMDB Home
Updated supported web browsers required for UCMDB Browser
« UCMDB Server Coverage:
Added Smart Software Analytics module
Added UCMDB Home
o Application Server:

Updated Apache Tomcat version to 8.5.15

November 2017 (4.15.1) Added supported UCMDB version for UCMDB Browser 4.15.1
embedded
February 2018 (11.0) o Added IBM WebSeal as a Single Sign On product

« Updated the JBoss from version 7.0 to Wildfly version 11
« Updated Apache Tomcat version to 8.5.23

o Updated the UCMDB Supported Version to 2018.08

« Updated the Minimal UCMDB Server Version to 2018.08

« Added new supported modules

August 2018 (2018.08) « Updated Apache Tomcat version to 8.5.24

Install CMS Ul on a Different Server than the
UCMDB

This section includes:
Install CMS Ul on an Existing Tomcat .. ... . L 48
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Install CMS Ul with Preconfigured Apache Tomcat Serveron Windows _.......__.................. 49
Install CMS Ul with Preconfigured Apache Tomcat ServeronLinux ................................. 51
Install CMS Ul on the Wildfly 11 Application Server .. ... . 53

Install CMS Ul on an Existing Tomcat

Note:

« Itis strongly recommended to secure the existing Tomcat installation. To do this, enable the
HTTPS protocol, use the latest TLS, and use the latest ciphers.

« The installation directory must not contain spaces, and can use only English letters (a-z), digits
(0-9), the hyphen sign (*-'), and the underscore sign ().

Important: HTTP Protocol is disabled by default, and the standalone CMS Ul is not accessible
with the HTTP protocol. However, if necessary, you can enable HTTP communications by setting
to False the following settings into the <Tomcat installation path>\conflesapi\esapi.properties
file, and then restart the UCMDB Server:

HttpUtilities.SecureSession=false

HttpUtilities.ForceSecureCookies=false

1. Download and install Apache Tomcat version 8.5.24.

2. Unzip the file CMS_Ul-<display_version_number>-all-in-one-standalone.zip to an accessible
location.

3. Goto the folder where you extracted the contents and in the uemdb_browser_config.xml file
(located at <CMS_UI_installation_folder>\conf), configure the connection to UCMDB as
follows:

o protocol. CMDB Server protocol

o host_name. CMDB Server name
o host_port. CMDB Server port

o context_name. CMDB Server context name

Note:
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« If the root context has a default value “/” this setting can be omitted.

o UCMDB and CMS Ul must have the same protocol.

4. Change the UCMDB integration user credentials, as described in "Change the UCMDB
Integration User Credentials" on page 67

5. Update the context.xml file in the Tomcat conf folder to include the configuration files in the class
path. It can be found under <Tomcat installation path>\conficontext.xml.

Add under the <context> tag:

<Environment name="ucmdb_browser_home" value="<folder path of the CMS UI

installation_folder>" type="java.lang.String" override="false"/>
For example:

<Environment name="ucmdb_browser_home" value="C:\cms-ui-install\"

type="java.lang.String" override="false"/>

Note: The conf folder should not be part of the path setting for value, as shown in the
example above.

6. Place the .war files under the webapps folder of Tomcat (located at <Tomcat installation
path>\webapps).

7. Start the Tomcat server.

8. Go to http://<server name>:<tomcat port>/ucmdb-browser.

Install CMS Ul with Preconfigured Apache Tomcat
Server on Windows

Note:

« The Tomcat Server comes with a configured self-signed certificate. However, if you want to
change the SSL, follow the steps described in "Configure SSL" on page 79.

The SSL protocol is TLSv1.2.

TLSv1.1 and older versions are not supported.

« The default port value of the Tomcat Server is 8443, and the default protocol is HTTPS.
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If the port value of the UCMDB server is 8443, you need to change the port value of the Tomcat
Server, as described in "Change the Default Port of the Tomcat Server" on page 90.

« Theinstallation directory must not contain spaces, and can use only English letters (a-z), digits
(0-9), the hyphen sign (*-'), and the underscore sign ().

« To edit the Tomcat service properties, run the CMS-Browserw.exe file.

When upgrading from UCMDB Browser to CMS Ul 2018.05 or later versions, open the \bin
folder and manually rename the tomcat7w.exe file to CMS-Browserw.exe.

« Torun Tomcat as a service, OpenJDK 8 for Win 64 bit should be installed (not JRE). The
Apache Tomcat version gets its Java from the JAVA_HOME environment variable.

« The pre-configured Apache Tomcat Server has pre-defined user credentials to access the
Tomcat Manager Application. The user credentials for the pre-configured Apache Tomcat
Server are: admin/admin. It is strongly recommended to change these credentials after
installation to prevent unauthorized access to the Tomcat Manager Application.

To change the user credentials for the pre-configured Apache Tomcat Server go to the Tomcat
conffolder, and change the credentials in the file tomcat-users.xml. For more details, see the
Tomcat online documentation at: http://tomcat.apache.org/tomcat-8.5-doc/manager-
howto.html

Important: HTTP Protocol is disabled by default, and standalone CMS Ul is not accessible with
the HTTP protocol. However, if necessary, you can enable HTTP communications by setting to
False the following settings into the <Tomcat installation path>\confiesapi\esapi.properties
file, and then restart the UCMDB Server:

HttpUtilities.SecureSession=false

HttpUtilities.ForceSecureCookies=false
To install CMS Ul:

1. Unzip the file CMS_Ul-<display_version_number>-tomcat-assembly-windows.zip to an
accessible location.

2. Gotothe folder where you extracted the contents and in the uemdb_browser_config.xml file
(located at <CMS_UI_installation_folder>\conf) configure the connection to the UCMDB server
as follows:

o protocol. CMDB Server protocol

o host_name. CMDB Server name
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o host_port. CMDB Server port

Note: UCMDB and CMS Ul must have the same protocol.

3. Change the UCMDB integration user credentials, as described in "Change the UCMDB
Integration User Credentials" on page 67

4. Install the Tomcat server as a service using <CMS_UI_installation_folder>/install_ucmdb_

browser_service.bat.
Note: The above step must be performed using administrator privilege.

5. Start the Tomcat server using <CMS_UI_installation_folder>/start_ucmdb_browser_

service.bat.

6. Goto https://<server name>:8443/ucmdb-browser.

Note: Afterrestarting your computer, the Tomcat server starts automatically. To stop the
Tomcat server, run: <CMS_UI_installation_folder>/stop_ucmdb_browser_service.bat.
To uninstall the Tomcat server, run: <CMS_UI_installation_folder>/uninstall_ucmdb_

browser_service.bat.

Install CMS Ul with Preconfigured Apache Tomcat
Server on Linux

Note:

« The Tomcat Server comes with a configured self-signed certificate. However, if you want to
change the SSL, follow the steps described in "Configure SSL" on page 79.

The SSL protocol is TLSv1.2.
TLSv1.1 and older versions are not supported.
« The default port value of the Tomcat Server is 8443, and the default protocol is HTTPS.

If the port value of the UCMDB server is 8443, you need to change the port value of the Tomcat
Server, as described in "Change the Default Port of the Tomcat Server" on page 90.

« Theinstallation directory must not contain spaces, and can use only English letters (a-z), digits
(0-9), the hyphen sign (*-'), and the underscore sign ().
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« OpendDK 8 (64 bit) must be installed on the server where you install the CMS Ul (the Apache
Tomcat version gets its Java from the JAVA_HOME environment variable).

« The pre-configured Apache Tomcat Server has pre-defined user credentials to access the
Tomcat Manager Application. The user credentials for the pre-configured Apache Tomcat
Server are: admin/admin. It is strongly recommended to change these credentials after
installation to prevent unauthorized access to the Tomcat Manager Application.

To change the user credentials for the pre-configured Apache Tomcat Server go to the Tomcat
conffolder, and change the credentials in the file tomcat-users.xml. For more details, see the
Tomcat online documentation at: http://tomcat.apache.org/tomcat-8.5-doc/manager-
howto.html

Important: HTTP Protocol is disabled by default, and standalone CMS Ul is no longer accessible
with the HTTP protocol. However, if necessary, you can still enable HTTP communications by
setting to False the following settings into the <Tomcat installation
path>\conflesapi\esapi.properties file, and then restart the UCMDB Server:

HttpUtilities.SecureSession=false

HttpUtilities.ForceSecureCookies=false
To install CMS Ul:
1. Extract the contents of the archive file CMS_Ul-<display_version_number>.<build_number>-

tomcat-assembly-unix.tar.gz into the folder CMS_UI on your home directory.

2. Gotothe ucmdb_browser_config.xml file in the folder ./CMS_Ul/conf and configure the
connection to UCMDB as follows:

o protocol. CMDB Server protocol
o host_name. CMDB Server name

o host_port. CMDB Server port

Note: UCMDB and CMS Ul must have the same protocol.

3. Change the UCMDB integration user credentials, as described in "Change the UCMDB
Integration User Credentials" on page 67

4. Ensure that all shell scripts (./CMS_Ul/bin/*.sh files) have ‘execute’ permission. You can use the
command Is -1 ./CMS_UlI/bin/ to do this.
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If the shell scripts do not have 'execute’ permissions, add them by invoking chmod a+x ./CMS_
Ul/bin/*.sh.

5. Start the Tomcat server with the pre-installed CMS Ul by invoking ./CMS_Ul/bin/startup.sh.

Note:

« Tostopthe Tomcat server, use the command ./CMS_UI/bin/shutdown.sh.

« When CMS Ul is embedded on the UCMDB Server and installed on Linux, ensure that the
letc/hosts file is updated with: 127.0.0.1 localhost.

Install CMS Ul on the Wildfly 11 Application Server

1. Extract the contents of CMS_Ul-<display_version_number>-all-in-one-standalone.zip to an
accessible location on a local drive.

Note: The installation directory must not contain spaces, and can use only English letters (a-
z), digits (0-9), the hyphen sign ('-'), and the underscore sign ().

2. Gotothe folder where you extracted the contents, and deploy the ucmdb-browser.war file on
Wildfly 11.

3. Goto the folder where you extracted the contents and in the uemdb_browser_config.xml file

(located at <CMS_UI_installation_folder>/conf) configure the connection to the UCMDB server
as follows:

o protocol. CMDB Server protocol
o host_name. CMDB Server name
o host_port. CMDB Server port

4. Add system-properties in the server element in $JBOSS _
HOME\standalone\configuration\standalone.xml as follows:

<server ...>
<extensions>...</extensions>

<system-properties>

<property name="ucmdb_browser home" value="<CMS UI installation_
folder>"/>
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</system-properties>
<management>. . .</management>
</ser;é;>
where "<CMS_UI_installation_folder>" is the root folder to which you extracted the contents
of the installation zip file in step 1.
5. Restart the Wildfly 11 application server.

6. Optional: If you receive a timeout error message after performing the previous step, add the
attribute deployment-timeout="1200" to the deployment-scanner element in $JBOSS _
HOME\standalone\configuration\standalone.xml. For example:

<deployment-scanner path="deployments" relative-to="jboss.server.base.dir"
scan-interval="5000" deployment-timeout="1200"/>

It is possible to add a timeout value of even more than 1200 if needed.

7. If you performed the previous step, restart the Wildfly 11 application server.

Install CMS Ul on the Same Machine that Runs
the UCMDB Server

Note:

« The installation directory must not contain spaces, and can use only English letters (a-z), digits
(0-9), the hyphen sign ('-'), and the underscore sign ().

« CMS Ul should not be installed on the same machine that runs the UCMDB server if you want
the CMS Ul to work with multiple UCMDB Servers (as described in "Configure Multiple
UCMDB Servers" on page 88). Rather, you should install the CMS Ul on a separate machine.

Important: HTTP Protocol is disabled by default, and embedded CMS Ul is no longer accessible
with the HTTP protocol. However, if necessary, you can still enable HTTP communications by
adding the following settings into the <UCMDB installation
folder>\conflesapi\ESAPI.properties file, and then restart the UCMDB Server:

HttpUtilities.SecureSession=false

HttpUtilities.ForceSecureCookies=false

If the settings already exist, modify the value to False, and then restart the UCMDB Server.
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Important: The latest version of CMS Ul works only with the latest released version of UCMDB
server.

1. Unzip the file CMS_Ul-<display_version_number>-embedded.zip to an accessible location.
2. Stop the UCMDB server.

3. Goto the folder where you extracted the content and copy the file ucmdb-browser.war to the
UCMDB server in the folder %UCMDB-Server%\deploy\, overriding the existing file.

Note: %UCMDB-Server% is the UCMDB server root folder. For example:
C:\UCMDB\UCMDBServer.

4. Start the UCMDB server.
5. After starting the UCMDB server, open the CMS Ul with the following URL:

https://<UCMDB_server_name>:8443/ucmdb-browser

Connect CMS Ul to an RTSM Instance

| Note: RTSM must have the same version as UCMDB.

CMS Ul can connect to an RTSM by applying the RTSM port and an integration user. The RTSM port
is usually deployed on 21212. You should also modify the UCMDB user integration credentials that the
CMS Ul uses to connect. Create an integration user in the RTSM JMX or use an existing one and
modify it according to the instructions in "Change the UCMDB Integration User Credentials" on

page 67.

If the BSM is configured to authenticate users on LDAP, the RTSM should be configured with the same
LDAP settings as the BSM.

To copy BSM LDAP settings to the RTSM:

1. InBSM, goto Admin > Platform > Users and Permissions > Authentication Management.

2. Open another tab with the RTSM JMX console (http://<server-name>:21212/jmx-console) and
find the method LDAP Settings > configureLDAP.

Note: For <server-name>, enter the RTSM server name. 21212 is the default RTSM port.

3. Copy all LDAP settings from the BSM to the RTSM. The following table shows the
correspondence between setting names in the BSM and RTSM:
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RTSM JMX Setting
BSM Setting name Name Description
LDAP server URL IdapURL LDAP connection string
Users filter userFilter Users filter

Distinguished Name (DN) Resolution = isEnableSearchForDN = Distinguished Name (DN)

Resolution
Distinguished Name of Search- searchUser LDAP Search User
Entitled User
Password of Search-Entitled User searchUserPassword = LDAP Search User Password
Groups base DN groupBase Group Base
Groups search filter groupBasefFilter Group Base Filter
Root groups base DN rootGroup Root Group
Root groups filter rootGroupFilter Root Group Filter
Group class object groupClass Group class object
Groups member attribute groupMemberAttribute = Groups member attribute
Users object class userClass Users object class
UUID attribute userUID UUID attribute

4. From the same method RTSM JMX > LDAP Settings, invoke allowLDAPAuthentication with
the parameter “true”.

Note: Copying LDAP settings from the BSM to the RTSM does not influence RTSM integrations
since they do not work with LDAP.
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Upgrade

Upgrade CMS Ul

Upgrade CMS Ul

Important:

« You can upgrade UCMDB Browser to CMS Ul version 2018.08, only if the version of the
UCMDB serveris 2018.08.

« This section is relevant only for the CMS Ul standalone.

To upgrade to the latest version of CMS Ul, follow these steps:

1. Unzip the file CMS_Ul-<display_version_number>-standalone.zip to an accessible location:
2. Stop the web application (Tomcat or UCMDB Server).
3. Clearthe user preferences for the users that have scheduled reports as follows:

a. GotoJMX Console > UCMDB-Ul:name=User Preferences > clearUserPreferences.

b. Inthe user name field, enter the user's name.
c. Click Invoke.

4. Delete the old uemdb-browser.war file from <Tomcat installation path>\webapps. Also, in
<Tomcat installation path>\webapps delete the ucmdb-browser folder.

5. Copy the new ucmdb-browser.war file to <Tomcat installation path>\webapps.

Note: If the serveris running, use a cut-and-paste operation to put the new WAR file in place,
rather than copy-and-paste. Using cut-and-paste copies the file instantly and causes the
server to deploy the full application (instead of possibly deploying an incomplete WAR file).

6. Copy the necessary update resources, depending on the type of installation you have, as follows:

o If you have your own Tomcat installation (meaning, you installed the CMS Ul according to the
instructions in "Install CMS Ul on an Existing Tomcat" on page 48), copy the setenv.bat file to
the bin folder.

o If youinstalled the CMS Ul according to the instructions in "Install CMS Ul with Preconfigured
Apache Tomcat Server on Linux" on page 51, copy the setenv.sh file to the bin folder.
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o If youinstalled the CMS Ul according to the instructions in "Install CMS Ul with Preconfigured
Apache Tomcat Server on Windows" on page 49, copy the update_ucmdb_browser_
service.bat file to the root folder of your installation (the same place where the install_ucmdb_
browser_service.bat is located) and runiit.

7. Forthe SAML authentication mode to work properly, from the CMS_Ul-<display_version_
number>-standalone.zip/conf folder, copy the saml_configuration.properties file and the
server.truststore file to the <Tomcat installation path\conf folder.

8. Fromthe CMS_Ul-<display_version_number>-standalone.zip/conf/esapi folder, copy the
esapi.properties file to the <Tomcat installation path>\conflesapi folder.

9. Read the release notes for the latest version to determine which features and functionality you
want to use and update your CMS Ul settings accordingly.

10. Open the ucemdb_browser_lwsso_config.xml file in the \conf folder, and replace the following
lines:

<logoutURLs>
<url>.*/logout.jsp.*</url>
</logoutURLs>

with:
<logoutURLs>

<url>.*/logout*</url>
</logoutURLs>

11. Check if the following lines exist in the <Tomcat installation path>\conficontext.xml file, and
delete them:

<JarScanner>
<JarScanFilter defaultPluggabilityScan="false" />
</JarScanner>

12. Start the Tomcat server.

All features and functionality from the previous installation are active in the new installation, as well as
the new features and functionality for the latest version.
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Configure Integration with Service Manager ... ... 59

Configure a Direct Link to Service Manager for a Selected Problem, Incident, or Change Request 60

Configure Integration with SiteMinder . ... 60

Configure Integration with Configuration Manager . . ... ... ... 63

Configure Integration with Service Manager

1. InUCMDB, go to Data Flow Management > Integration Studio.

2. Create a new integration point with the following settings:

(o]

o

Adapter: select the appropriate adapter for the version of Service Manager that you have
installed.

Hostname/IP: enter the hostname or IP address of theService Manager server.
Credentials ID: select the credentials for the Service Manager server.

Data Flow Probe: select a data flow probe.

3. Select the Is Integration Activated checkbox.

4. Save the integration point.

5. Click the Federation tab of the integration point and verify that the relevant Service Manager items

are selected.

6. Create adata push job:

o

For integration points that use adapters earlier than the ServiceManagerAdapter9.x adapter,
create a data push job that includes the CI types and relation types that you need, and run the
job. For details, see the Data Flow Management section of the UCMDB Help.

o Forintegration points that use the ServiceManagerAdapter9.x adapter, synchronize data using

the out-of-the-box data push job.
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Configure a Direct Link to Service Manager for a
Selected Problem, Incident, or Change Request

1.

In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.

In the Name column, choose Service Manager application URL for problem Cls.

In the Value column, enter the Service Manager URL. Ensure that you enter the correct Service
Manager IP address or hostname and the correct port number. The URL must contain the element
{$PROBLEM_ID} for a Problem, {$INCIDENT_ID} for an incident, or {$RFC_ID} for a change
request. This element is replaced with the actual ID at runtime.

For example:

http://10.0.0.1:8080/webtier-
9.30/index.do?ctx=docEngine&amp;file=rootcause&amp;query=id%3D %22{$PROBLEM _
ID}%22

Click Save [E1.

Configure Integration with SiteMinder

1.

Note: Integration with SiteMinder can be performed only when the CMS Ul is configured to one
UCMDB Server, since there is no option to select a server from the server list on login.

Configure the CMS Ul to enable LW-SSO:
a. Follow the instructions in "Configure LW-SSQO" on page 68.

b. Add the following code to the ucmdb_browser_lwsso_config.xml configuration file, just
after the tag </in-ui-1lwsso> and before the tag </validation>:

<in-ui-identity-management>
<identity-management>
<userNameHeaderName>sm_user</userNameHeaderName>
<cookieName>SMSESSION</cookieName>
</identity-management>
</in-ui-identity-management>

2. Configure Reverse Proxy server and CA SiteMinder Client Agent
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Note: Itis strongly recommended to install and configure the Reverse Proxy web server
before installing the CA SiteMinder Client Agent. For more details, see to the SiteMinder
documentation.

Configure reverse proxy either for the Apache web server or Microsoft IS, according to the
following instructions:

o Configure Apache Web Server as Reverse Proxy

i. Prerequisites:
« Ensure that CA SiteMinder is installed on your user environment.

« Ensure that the Apache Web Server is installed on the same machine as the CA
SiteMinder Client Agent.

ii. Install Apache 2.2.x on Windows (Apache 2.4.x on Linux).
Download 32-bit binaries with OpenSSL (httpd-2.2.25-win32-x86-openssl|-0.9.8y).

iii. Goto C:\Apache24\conf\ and open the Apache Web Server httpd.conf configuration file
with a text editor.

« Uncomment the following two proxy modules:

LoadModule proxy module modules/mod_proxy.so
LoadModule proxy http _module modules/mod_proxy http.so

« Add the following lines:

ProxyRequests off

<Proxy *>

Order deny,allow

Deny from all

Allow from all

</Proxy>

ProxyPass / http://[UCMDB_SERVER_NAME]:8080/

ProxyPassReverse / http://[UCMDB_SERVER_ NAME]:8080/

ProxyPass /ucmdb-ui http://[UCMDB_SERVER_NAME]:8080/ucmdb-ui
ProxyPassReverse /ucmdb-ui http://[UCMDB_SERVER NAME]:8080/ucmdb-
ui

ProxyPass /status http://[UCMDB_SERVER_NAME]:8080/status
ProxyPassReverse /status http://[UCMDB_SERVER_NAME]:8080/status
ProxyPass /jmx-console https://[UCMDB_SERVER_NAME]:8443/jmx-
console

ProxyPassReverse /jmx-console https://[UCMDB_SERVER _

NAME] :8443/jmx-console

ProxyPass /ucmdb-browser http://[UCMDB_SERVER_NAME]/ucmdb-browser
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iv.

ProxyPassReverse /ucmdb-browser http://[UCMDB_SERVER_NAME]/ucmdb-
browser

If needed, feel free to add more URLs.

Restart Apache 2.2 service.

o Configure Microsoft IIS as Reverse Proxy

Prerequisites:

Before downloading and installing ARR, make sure that you have already installed
Internet Information Services (11S).

Install ARR from the following URL using the Microsoft Web Platform Installer:
http://www.iis.net/downloads/microsoft/application-request-routing

Once installed, the Server Farms item should be present in the Connections tree inside
the 11S Manager.

Right-click Server Farms and select Create Server Farm....
Specify Server Farm name (make sure the Online checkbox is checked) and click Next.

Enter the address of the CMS Ul together with the port on which the CMS Ul can be
accessed, and then click the Add button. (The port can be entered in the Advanced
settings....)

After [IS knows which is the server behind, it is necessary to create a simple URL
rewriting rule. When prompted for that, select Yes.

3. Configure SiteMinder LogoffUri

The CMS Ul logout page (logout.jsp) must be defined on CA SiteMinder to ensure correct logout
from the CMS UI. If you do not do this, you will need to open a new Browser window to re-enter the
CMS Ul application.

4. Verify successful integration of the CMS Ul with SiteMinder

Access the reverse proxy frontend URL. If all settings are correct, you are prompted to input your
user name and password in the CA SiteMinder authentication dialog. After successful
authentication, you are forwarded to the CMS Ul application without having to enter your UCMDB

user name and password.
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Configure Integration with Configuration
Manager

1. InUCMDB, go to Data Flow Management > Integration Studio.
2. Create a new integration point with the following settings:
o Adapter: select the CM New Policy Adapter.

o Configuration Manager Application URL: enter the hostname or IP address of the
Configuration Manager server.

o Credentials ID: select the credentials for the Configuration Manager server.
o Data Flow Probe: select a data flow probe.

3. Select the Is Integration Activated checkbox.

4. Save the integration point.

5. Click the Federation tab of the integration point and verify that the Policy and PolicyResult
checkboxes are selected.
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Grant Access to CMS Ul

For a user to access CMS Ul, you must assign access permission to the relevant role.

1. InUCMDB, go to Security > Roles Manager.
Select the role to which you want to add the permission.

Click the General Actions tab.

> w0 D

In the System Access Actions section, select Access to UCMDB Browser in the Available
Actions list and add it to the Selected Actions list.

5. Click Save |@|.

Create a UCMDB Integration User

You can create a dedicated user for integrations between other products and UCMDB. This user
enables a product that uses the UCMDB client SDK to be authenticated in the server SDK and execute
the APIs. Applications written with this API set must log on with integration user credentials.

Caution: Itis also possible to connect with a regular UCMDB user (for instance, admin).
However, this option is not recommended. To connect with a UCMDB user, you must grant the
user API authentication permission.

To create an integration user:

1. Launch the Web browser and enter the server address, as follows:
https://localhost:8443/jmx-console
You may have to log in with a user name and password (the default user name is sysadmin).
2. Under UCMDB, click service=sUCMDB Authorization Services.

3. Locate the createUser operation. This method accepts the following parameters:
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o customerld. The customer ID.

o username. The integration user's name.

o userDisplayName. The integration user's display name.
o userLoginName. The integration user's login name.

o password. The integration user's password.

The default password policy requires the password to include at least one of each of the four
following types of characters:

« Uppercase alphabetic characters

« Lowercase alphabetic characters

« Numeric characters

o Symbol characters ,\:/. _?&%=+-[J()|

It also requires the password to adhere to the minimum length, which is set by the Password
minimum length infrastructure setting.

4. Click Invoke.
5. Locate the setRolesForUser method and enter the following parameters:
o userName. The integration user's name.
o roles. SuperAdmin.
Click Invoke.
6. Locate the setUserServerAdministratorValue method and enter the following parameters:
o customerlD. The customer ID.
o userLoginName. The integration user's login name.
o serverAdministratorValue. Select True.
Click Invoke.

7. Either create more users, or close the JMX console.

Note: The integration user is per customer. To create a stronger integration user for cross-
customer usage, use a systemUser with the isSuperintegrationUser flag set to true. The
system user should have the same user name and password as the integration user.
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Change the UCMDB Integration User
Credentials

| Note: This section is relevant only for the CMS Ul standalone.

CMS Ul connects to the UCMDB server through the API using the UCMDB Ul integration user
credentials. If you changed the UCMDB integration user credentials from the initial default settings,
perform the following steps:

1. Create a credentials.txt file and put it in the same directory as the ucmdb_browser_config.xml
file.
2. Inthefile credentials.txt, enter the following content:
o user=<user-name>
o password=<user-password>
Where user-name is the integration user's user name and user-password is the integration user's
password.
o The integration user's name and password can contain Unicode characters \uFFFF, where
F can be replaced with the following characters: a-f, A-F, 0-9.

o If the integration user's name or the integration user's password contains the \ (backslash)
character, then in the credential.txt file, you must use \\ instead of \.

For example, if the integration user's name is admin, and the integration user's password
is admin12\3, in the credentials.txt file enter the following content:

user=admin

password=admin12\\3

3. Restart the Tomcat server.

Caution: For multiple UCMDB configurations (as described in "Configure Multiple UCMDB
Servers" on page 88, the same integration user should be defined on all UCMDB servers.

Note: Afterrestarting the Tomcat server and then logging in to the CMS Ul, a new encrypted
file credentials.bin is created and the file credentials.txt is removed.
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Configure the UCMDB Server URL

If UCMDB is deployed in a distributed configuration (in the case of Business Service Management
users, when the Gateway and Data Processing servers are not on the same machine), the UCMDB
server URL should be defined to allow correct access by direct links.

To configure the UCMDB server URL, add the following to the ucmdb_browser_config.xml
file:

<ucmdb_ui_url>http://[ucmdb-ui-server-name]:[ucmdb-ui-port]/ucmdb-ui/</ucmdb ui
url>

where [ucmdb-ui-server-name] is the UCMDB server name and [ucmdb-ui-port] is the UCMDB-
Ul server port.

Configure LW-SSO

1. Configure all external applications that integrate with the CMS Ul with LW-SSO settings. For
details about LW-SSO authentication, see the relevant section in the Hardening section of the
UCMDB Help.

Note: If you access CMS Ul by IP address (not by FQDN), you should add the CMS Ul IP
address to the UCMDB’s trusted hosts. You can do this from the JMX console. Under LW-
SSO Configuration Management, locate the addTrustedIPs method and invoke it using
the CMS Ul IP address value.

2. Open the ucmdb_browser_lwsso_config.xml file in the \conf folder in an XML editor and make
the following changes:

o Forthe domain tag, enter the domain name of the CMS Ul (for example, net or domain-
name.com).

o Forthe value of initString, enter the exact value of initString that is defined for the UCMDB
server and is retrieved when performing the procedure described in the section Retrieving
Current LW-SSO Configuration in Distributed Environment in the relevant document listed in
step 1.

Note:
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« Inthe case of an embedded CMS Ul, configure LW-SSO by going to Administration >
Infrastructure Settings Manager > General Settings and configure settings that start with
LW-SSO.

« The UCMDB server name in the ucemdb_browser_config.xml file (under the <host_name>
tag) should be the full DNS name (for example ucmdb-server.com).

« When working with LW-SSO, the URL of the CMS Ul should also contain the domain name (for
example http://UCMDB-SERVER.com:8088/ucmdb-browser/).

« When upgrading from UCMDB Browser to CMS Ul 2018.05 or later, open the ucmdb_
browser_lwsso_config.xml file in the \conf folder, and replace the following lines:

<logoutURLs>
<url>.*/logout.jsp.*</url>
</logoutURLs>

with:
<logoutURLs>

<url>.*/logout*</url>
</logoutURLs>

Enable SAML Authentication on CMS UI

This topic explains how to set up SAML login and logout on standalone CMS Ul. For general
information about using SAML with UCMDB and to learn how to set up SAML on the UCMDB server
and embedded CMS Ul, see "Enabling Login to Universal CMDB with SAML".

Note:
« The SAML version used is SAML 2.0.

« This functionality has been verified with Active Directory Federation Services (AD FS) 3.0 as
Identity Provider (IdP).

Prerequisites

« Active Directory Domain Services (AS DS) and a DNS Server must be installed. A new forest must
be set up in AD DS, using default values where applicable.
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e TheIP address and DNS must be a fixed IP address.

« Active Directory Certificate Services (AD CS) must be installed with the Certification Authority,
Certificate Enrollment Web Service, and Certification Authority Web Enroliment role services.

The Certification Authority and Certification Authority Web Enroliment role services must be
configured as follows:

o Therole service setup type is "Enterprise CA"
o The role service CA type is "Root CA"
o You must create a new private key, with a validity period of five years

The Certificate Enrollment Web Service role service must be configured to use the same CA
certificate as the Certification Authority and Certification Authority Web Enrollment role services.

« AD FS must be installed, and a Relying Party Trust must be added as follows.
Important: If you enable SAML on both UCMDB Server and standalone CMS Ul, you must
add a separate Relying Party Trust for both.

o When prompted, do not specify an optional token encryption certificate

o Select a profile that uses the SAML 2.0 protocol, and set the AD FS URL as the relying party
SAML 2.0 SSO service URL

o Setthe UCMDB Server URL as the relying party trust identifier
o Use the default access control policy settings
When the Relying Party Trust is created, configure it as follows:

o Add a WS-Federation Passive Endpoint that uses the UCMDB Server URL as the trusted URL
and that uses POST binding

o Add a SAML Assertion Consumer Endpoint that uses <Domain name of the AD FS
machine>/ucmdb-browser/login?samlLogin as the trusted URL and that uses POST binding

o Add a SAML Assertion Logout Endpoint that uses <Domain name of the AD FS
machine>/ucmdb-browser/logout?samlLogout as the trusted URL and that uses POST binding

o Add the following three claim rules:
« Show user login name in Common Name attribute in SAML response

o Show user group list in Group attribute in SAML response
« Show userlogin name in NamelD attribute in SAML response

Update AD FS to use the SHA-1 secure hash algorithm.
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o The AD FS server system clock must be set to a time later than that of the UCMDB Server or CMS
Ul server. If this is not the case, you must set a time skew to offset the time difference when you
update the saml_configuration.properties file when you enable SAML authorization.

Enable SAML Login and Logout

To enable SAML login and logout on CMS U, follow these steps:

1. Import the IdP certificate to UCMDB Server truststore.
a. Copy the IdP certificate to the following directory:
<CMS UI home>\conf

b. Run the following command to import the certificate alias into the saml_
configuration.properties file (<CMS Ul home>/conf/saml_configuration.properties):

<JDK home>\bin\jre\bin\keytool.exe -import -v -keystore <CMS Ul home
>\confisecurity\server.truststore -file <certificate> -alias <certificate alias>

c. Enterthe default password ("hppass").
d. When asked Trust this certificate?, press Y, and then press Enter.
e. Make sure the output Certificate was added to the truststore.

2. The SAML logout request must be signed before it is sent to the IdP. Therefore, you must import
your own private key into <CMS Ul home>/conf/server.keystore, and then import the public key
into the IdP (for example, in AD FS, do this in the Signature tab of Relying Party Trust in the AD
FS Management tool).

If you want to use the out of box certificate, follow these steps:
a. Run the following command as an Administrator:

<JDK home>\bin\jre\binkeytool -export -alias hpcert -keystore CMS U/
home\confiserver.keystore -rfc -storepass hppass -file <CMS Ul home>\confihpcert_
public.cer

b. Copy the <CMS Ul home>/conf /hpcert_public.cer file to an IdP folder.

c. Import the hpcert_public.cer file into the IdP (for example, in AD FS, do this in the Signature
tab of Relying Party Trust in the AD FS Management tool).

3. Update the saml_configuration.properties file (<CMS Ul home>/conf/saml|_
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configuration.properties) as described in the following table.

Property

mam.server.sso.sa
ml.auth.enabled

mam.server.sso.sa
ml.auth.idp

mam.server.sso.sa
ml.auth.username.cl
aimtype

mam.server.sso.sa
ml.auth.customer.cl
aimtype

mam.server.sso.sa
ml.auth.groups.clai
mtype

mam.server.sso.sa
ml.auth.sync.groups

mam.server.sso.sa
ml.auth.default.grou

p

mam.server.sso.sa
ml.auth.certificate.al
ias

mam.server.sso.sa
ml.logout.certificate.
alias

mam.server.sso.sa
ml.auth.request.issu
er

mam.server.sso.sa
ml.response.issuer

mam.server.sso.sa
ml.time.skew

CMS Ul (2018.08)

Value

"true"

"https://<ADFS
url>/adfs/Is"

"http://schemas.xmlso
ap.org/claims/Commo
nName"

Leave this property
blank.

"http://schemas.xmlso
ap.org/claims/Group"

"tI’UG"

A group in your
UCMDB server. This
group should have
rights tologin to
UCMDB server.

The certificate alias
that you used in step
1.d.

The alias of your own
certificate, or "hpcert" if
you use the default
certificate.

The UCMDB server
(for embedded) or
UCMDB browser (for
standalone) URL.

The ADFS URL.

The desired time skew
(in seconds) between

Example

mam.server.sso.saml.auth.enabled=true

mam.server.sso.saml.auth.idp=https://<
ADFS url>/adfs/ls

mam.server.sso.saml.auth.username.claimty
pe=http://schemas.xmlsoap.org/claims/Com
monName

mam.server.sso.saml.auth.customer.claimty
pe=

mam.server.sso.saml.auth.groups.claimtype
=http://schemas.xmlsoap.org/claims/Group

mam.server.sso.saml.auth.sync.groups=true

mam.server.sso.saml.auth.default.group=sa
mi

mam.server.sso.saml.auth.certificate.alias=t
oken_signing

mam.server.sso.saml.logout.certificate.alias
=hpcert

mam.server.sso.saml.auth.request.issuer=ht
tps://<UCMDB host>:8443/

mam.server.sso.saml.response.issuer=http:/
/I<ADFS URL>//adfs/services/trust

mam.server.sso.saml.time.skew=60
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the AD FS and
UCMDB hosts.

4. Create a group with permissions in UCMDB Server. The group must have the same name as the
value of the "mam.server.sso.saml.auth.default.group” setting.
To do this, in UCMDB Server, select Security > Users and Groups, and then create a group and
assign it the desired role (for example, SuperAdmin).

Note: This step is only required if you have not already enabled SAML on UCMDB Server.

5. Create a configproperties.txt file. To do this, follow these steps:

a. Open the <CMS Ul home>\conf directory, delete the configproperties.bin file, and then create
a configproperties.txt file.

b. Open the configproperties.txt file, and then enter the following lines:
truststorepassword=hppass
keystorepassword=hppass

c. Save the configproperties.txt file.

6. Configure LW-SSO. To do this, follow these steps:
a. InUCMDB Server, open JMX Console and search for "retrieveLWSSOConfiguration”.

b. Select Invoke, and then make a note of the value of the "mam.server.sso.init.string" setting.

c. Openthe <CMS Ul home>\conf directory, and open the ucmdb_browser_lwsso_config.xml
file.

d. Update the value of the initString parameter in the file with the value that you noted from the
"mam.server.sso.init.string" setting, as follows:

<lwssoValidation id="ID0©0001">

<domain>ucmdb browser domain name</domain>

<crypto cipherType="symmetricBlockCipher"
engineName="AES" paddingModeName="CBC" keySize="256"
encodingMode="Base64Url"

initString="Replace this value"></crypto>
</lwssoValidation>

7. Restart CMS UlI.
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Example Active Directory Installation and

Configuration

The following procedure demonstrates how to install and configure the various Active Directory
components in order to set up an IdP to use with SAML authentication.

1: Install AD DS and a DNS Server
1. Open Windows Server Manager, and then select the Add roles and features link in the main
panel to start the Add Roles and Features wizard.

2. Onthe Installation type page, select the Role-based or feature-based installation option, and
then select Next.

3. Onthe Server Selection page, select the Select a server from the server pool option, select
the local machine from the list, and then select Next.

4. Onthe Server Roles page, select the Active Directory Domain Services and DNS Server
options, and then select Next.

On the Features page, select Next to accept the default values.
On the AD DS page, select Next to accept the default values.

Onthe DNS Server page, select Next to accept the default values.

©® N o o

On the Confirmation page, select Install. When the wizard has installed AD DS and the DNS
server, select Close to exit the wizard.

2: Configure AD DS

1. Open Server Manager, and then select the Post Deployment Configuration task notification.

2. Onthe Deployment Configuration page, select the Add a new forest option, enter a domain
name in the Root domain name field, and then select Next.

3. Onthe Domain Controller Options page, select the functional level of the forest and domain,
enter a password for Directory Services Restore Mode, and then select Next.

4. Onthe DNS Options page, select Next without selecting any options.
5. Onthe Additional Options page, select Next to accept the default values.

6. Onthe Paths page, select Next to accept the default values.
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7. Onthe Review Options page, select Next, and then select Install. The wizard automatically
restarts the server after installing the forest.

3: Set the IP address and DNS address

Open Network and Sharing Center, and make sure that the local machine's IP address and DNS
address are both static.

4: Install Active Directory Certificate Services
1. Open Server Manager, and then select the Add roles and features link in the main panel to start
the Add Roles and Features wizard.

2. Onthe Server Roles page, select the Active Directory Certificate Services option, and then
select Next.

3. Onthe Features page, select Next to accept the default values.
4. Onthe AD CS page, select Next.

5. Onthe Role Services page, select the following options, and then select Next:
o Certification Authority

o Certificate Enrollment Web Service
o Certification Authority Web Enrollment
6. Onthe Web Server Role page, select Next.
7. Onthe Role Services page, select Next to accept the default values.

8. Onthe Confirmation page, select Install. When the wizard has installed AD DS and the DNS
server, select Close to exit the wizard.

5: Configure AD CS

1. Open the AD CS Configuration wizard.

2. Onthe Credentials page, enter <AD FS domain name>administrator in the Credentials field,
and then select Next.

3. Onthe Role Services page, select the following options, and then select Next:
o Certification Authority

o Certification Authority Web Enrollment

4. Onthe Setup Type page, select the Enterprise CA option, and then select Next.

5. Onthe CA Type page, select the Root CA option, and then select Next.
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6. Onthe Private Key page, select the Create a new private key option, and then select Next.
7. Onthe Cryptography for CA page, select RSA#Microsoft Software Key Provider as the
cryptographic provider. Select SHA1 as the hash algorithm, and then select Next.
8. Onthe CA Name page, enter a common name for the CA and a distinguished name suffix, and
then select Next.
9. Onthe Validity Period page, select 5 years, and then select Next.
10. Onthe Certificate database page, enter the certificate database location and the certificate
database log location, and then select Next.
11. Onthe Confirmation page, select Configure. When the wizard asks you if you want to configure
additional role services, select Yes.
12. Onthe Credentials page, enter <AD FS domain name>administrator in the Credentials field,
and then select Next.
13. Onthe Role Services page, select the Certificate Enroliment Web Service option, and then select
Next.
14. Onthe CA for CES page, select the CA name option, enter the target CA (<domain name\CA
name>), and then select Next.
15. Onthe Authentication Type for CES page, select the Windows integrated authentication
option, and then select Next.
16. Onthe Service Account for CES page, select the Use built-in application pool identity
option, and then select Next.
17. Onthe Server Certificate page, select the certificate that you created in steps 1-11, and then
select Next.
18. Onthe Confirmation page, select Configure. When the wizard has configured the role service,

select Close to exit the wizard.

6: Install AD FS

Open Server Manager, and then select the Add roles and features link in the main panel to start
the Add Roles and Features wizard.

On the Server Roles page, select the Active Directory Federation Services option, and then
select Next.

On the Features page, select Next to accept the default values.

On the AD FS page, select Next to accept the default values.

CMS Ul (2018.08) Page 76 of 446



CMS Ul Guide
Administer

5. Onthe Confirmation page, select Install. When the wizard has installed AD FS, select Close to
exit the wizard.

7: Configure AD FS

1. Open Server Manager, and then go to Tools > Configure Active Directory Federation
Services.

2. Onthe Welcome page, select the Create the first federation server in a federation server
farm option, and then select Next.

3. Onthe Connect to AD DS page, select Next to accept the default value.

4. Onthe Specify Service Properties page, enter a display name for the Federation Service, and
then select Next.

5. Onthe Specify Service Account page, select the Use an existing domain user account or
group Managed Service Account option. Enter <AD FS domain name>administrator in the
Account name field, enter the password, and then select Next.

6. Onthe Specify Database page, select the Create a database on this server using Windows
Internal database option, and then select Next.

7. Onthe Review Options page, select Next.

8. Onthe Pre-requisite Checks page, select Configure when the wizard has finished performing
the prerequisite checks. When the wizard has configured AD FS, select Close to exit the wizard.

8: Add and configure a relying party trust in AD FS

Important: You must add a relying party trust for both the UCMDB server and for the standalone
CMS UlI.

1. Open AD FS 2.0 Management Console, right-click Trust Relationships in the left-hand pane, and
then select Add Relying Party Trust to start the Add Relying Party Trust wizard.

2. Onthe Select data Source page, select the Enter data about the relying party manually
option, and then select Next.

3. Onthe Specify Display name page, enter a display name for the relying party trust, and then
select Next.

4. Onthe Configure Certificate page, select Next without configuring an optional token encryption
certificate.
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10.
1.

12.

13.

14.

15.

16.
17.

18.

On the Configure URL page, select the Enable support for SAML 2.0 WebSSO protocol
option, set the AD FS URL as the relying party SAML 2.0 SSO service URL, and then select
Next.

On the Configure Identifiers page, set the UCMDB server URL as the relying party trust
identifier, and then select Next.

On the Choose Access Control Policy page, select Next to accept the default values, and then
continue to accept the default values until the wizard has finished.

Right-click Relying Party Trusts in the left-hand pane, and then select Properties.
On the Identifiers tab, confirm that the relying party identifier is set to the UCMDB server URL.
Go to the Endpoints tab, and then delete any existing endpoints.

Select Add WS-Federation Passive Endpoints. Enter the UCMDB server URL in the Trusted
URL field, and then select OK.

Select Add SAML Assertion Consumer Endpoints. Enter <Domain name of the AD FS
machine>/ucmdb-browser/login?samlLogin in the Trusted URL field, select POST in the
Binding drop-down list, and then select OK.

Select Add SAML Assertion Logout Endpoints. Enter <Domain name of the AD FS
machine>/ucmdb-browser/logout?samilLogout in the Trusted URL field, select POST in the
Binding drop-down list, and then select OK.

Select Apply, and then select OK.

Right-click Relying Party Trusts in the left-hand pane, and then select Edit Claim Issuance
Policy....

Select Add Rule to start the Add Transform Claim Rule Wizard.

On the Choose Rule Type page, select Send LDAP Attributes as Claims in the Claim rule
template drop-down list, and then select Next.

On the Configure Claim Rule page, create the following three rules.

Claim rule Attribute Outgoing claim

name store LDAP attribute type

UserName Active SAM-Account-Name Common Name
Directory

Group Active Token-Groups - Qualified by Domain Group
Directory Name

NamelD Active SAM-Account-Name Name ID
Directory
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19. Select Apply, and then select OK.
20. Right-click AD FS in the left-hand pane, and then select Edit Federation Service Properties.

21. Onthe General tab, make sure that the value of the Federation Service identifier field is <AD
FS server URL>/services/trust.

22. Check that the AD FS server system clock is set to a time later than that of the CMS Ul server. If
this is not the case, you must set a time skew in the saml_configuration.properties file when you
enable SAML authorization.

You have now set up the IdP and are ready to enable SAML authentication.

Related Topics
"Troubleshoot SAML Authentication" on page 441

"Enable SAML Authentication" on page 1

Configure SSL

Note: If you disable SSL support, you compromise your system's security. You will be vulnerable
to data sniffing and other security attacks.

To install and configure SSL support on Tomcat:

1. Create akeystore file to store the server's private key and self-signed certificate by running one of
the following commands:
o ForWindows: %JAVA_HOME%\bin\keytool -genkey -alias tomcat -keyalg RSA
o For Unix: $JAVA_HOME/bin/keytool -genkey -alias tomcat -keyalg RSA

For both commands, use the password value changeit (for all other fields in the console dialog
that opens, you can use any value).

2. Inthe $CATALINA_BASE/conf/server.xml file (where $CATALINA_BASE is the directory in
which you installed Tomcat), do the following:

o Remove comments from the entry SSL HTTP/1.1 Connector.

o Set protocol="org.apache.coyote.http11.Http11Protocol” instead of
protocol="HTTP/1.1".
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This command defines a Java (JSSE) connector, regardless of whether or not the APR library

is loaded.

o Change the values of <keystore_location> and <keystore_pass>. This action is relevant
only if the CMS Ul is installed with Preconfigured Apache Tomcat Server, and you create a
new keystore file.

Note:

o This stepis relevant only for the CMS Ul installed on an existing Tomcat.

o For afull description on how to configure server.xml to use SSL, see the Apache Tomcat
official site: http://tomcat.apache.org/tomcat-8.5-doc/manager-howto.html

3. Restart the Tomcat server.
To use the HTTPS protocol for connection to the UCMDB server:
1. Inthe uemdb_browser_config.xml file, assign the value https to the tag<protocol> and assign

the UCMDB server HTTPS port value (8443 by default) to the tag <port>.

2. Download the UCMDB server public certificate to the CMS Ul machine (if you use SSL on the
UCMDB server, the UCMDB administrator can provide you with this certificate), and import it into
the cacerts trust store on the JRE that is going to connect to the server by running the following

command:

"%JAVA_HOME%\bin\keytool" -import -alias ucmdb -trustcacerts -file <UCMDB-Server-
certificate-file> -keystore "%JAVA_HOME%\jre\lib\security\cacerts"

where <UCMDB-Server-certificate-file> is the full path to the UCMDB server public certificate
file.

3. Restart the Tomcat server.

Enable SSL with a Certificate from a
Certification Authority

For CMS Ul standalone, in order to use a certificate issued by a Certification Authority (CA) the
keystore must be in Java format. The following example explains how to format the keystore for a

Windows machine.
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1. Prerequisites

Before starting the following procedure, if you already have a browser.keystore file, remove it
from the <CMS_UI_installation_directory>\conf folder.

2. Generate a Server Keystore
a. Generate a CA signed certificate and install it on Windows.

b. Export the certificate into a *.pfx file (including private keys) using Microsoft Management
Console (mmc.exe).

Enter any string as the password for the pfx file. (You are asked for this password when
converting the keystore type to a JAVA keystore.)
The .pfx file now contains a public certificate and a private key and is password protected.

Copy the .pfx file you created to the following folder: <CMS_UI_installation_
directory>\conf.

c. Open the command prompt and change the directory to %JAVA_HOME%\bin.

Change the keystore type from PKCS12 to a JAVA keystore by running the following
command:

keytool -importkeystore -srckeystore <CMS_UI installation_
directory>\conf\<pfx file name> -srcstoretype PKCS12 -destkeystore CMS_UI_
installation_directory\conf\browser.keystore

You are asked for the source (.pfx) keystore password. This is the password you supplied
when creating the pfx file in step b.

3. Modify the server.xml File

Open the server.xml file, located in <CMS_installation_directory>\conf. Locate the section
beginning with

Connector port="8443"

which appears in comments. Activate the script by removing the comment character and add the
following two lines:

keystoreFile="CMS _UI installation_directory\conf\browser.keystore"
keystorePass="password" />

Comment out the following line, if applicable:

<Listener className="org.apache.catalina.core.AprLifecyclelListener”
SSLEngine="on" />
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Note: Check that HTTPS communication works before closing the HTTP port.

4. Restart the Tomcat Server
Restart the Tomcat server.
5. Verify the Server Security

To verify that the CMS Ul is secure, enter the following URL in the Web browser: https://<CMS _
Ul name or IP address>:8443/ucmdb-browser.

6. In UCMDB, go to Infrastructure Settings Manager>General Settings and change the protocol
and port in UCMDB Browser URL, according to the values above.

Limitation: There can be only one server certificate in browser.keystore.

Configure High Availability Mode

The typical configuration for a high availability environment has two or more CMS Uls that connect to
the same UCMDB server, or to the same load balancer that manages a cluster of UCMDB servers.
The CMS Uls are configured to work behind a load balancer, meaning that the load balancer serves as
the entry point to the CMS Uls. All the CMS Uls are active at any given time and can handle requests
from users. Requests are distributed to the CMS Uls in the cluster by the load balancer, and are shared
evenly among all the CMS Uls.

Note:

« Theload balancer used for high availability must have the ability to insert cookies and must be
able to perform health checks ("keepalive").

« These instructions are certified for the F5 BIG-IP version 10.x and F5 BIG-IP version 11.x load
balancers.

If you are using a different load balancer, the configuration should be performed by a network
administrator who has broad knowledge about how to configure load balancers, and principles
similar to those described here should be applied.

« This procedure assumes that you already have at least one CMS Ul installed and configured.

To set up a high availability environment:

CMS Ul (2018.08) Page 82 of 446



CMS Ul Guide
Administer

1. Create acluster of CMS Uls.

Install one or more additional CMS Uls to create a cluster. For information about installing the
CMS UI, see "Install" on page 34.

Note:

o The machines used for all of the CMS Uls in the cluster should have similar hardware,
including the same amount of memory, and should be running the same operating system.

o CMS Uls in the cluster must use the same port number for HTTP, HTTPS, and so on. You
cannot configure multiple CMS Uls for high availability if they are using different ports.

2. Start the CMS Uls.

a. Ifthefirst CMS Ul is not started, start the process and wait for the startup process to
complete.

b. Start the additional CMS Uls.
3. Configure the load balancer.

The load balancer is used to balance the load that is sent to the CMS Uls in the cluster. Configure
the load balancer as follows:

a. Onthe load balancer, configure a Cluster VIP address that sends requests to the entire CMS
Ul cluster.

b. Configure a pool of back-end servers that represents all CMS Uls in the cluster. This pool is
monitored by a health monitor, which sends requests that can be processed by any CMS Ul in
the cluster.

c. Configure the health monitor by providing a keepalive address. The health monitor checks for
the keepalive page of each of the CMS Uls. For the Cluster VIP address, use the following
URL for the keepalive address: /Jucmdb-browser/public/ping.jsp.

Possible responses from this URL are:

Response HTTP Response Code
Up 200 OK (desired response)

Down 503 Service unavailable

d. Connect the health monitor to the CMS Ul pool configured in step b.

e. Configure session affinity on the load balancer:
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« Configure the load balancer to insert cookies to the responses that are sent back to CMS
Ul clients (internet browsers).

« Using the Insert method, add a persistence profile cookie for the VIP address.

Note:

« The cookie name and value are unimportant, as long as the load balancer knows how
to maintain stickiness with the cookies that it sends out.

o F5BIG-IP version 10.x adds a session cookie only to the first response per
connection to the server. Other load balancers you might use add a session cookie to
each response.

f. If the VIP is configured to accept secure connections and the load balancer forwards the
requests to the CMS Uls over HTTP, you must configure redirect rewrites. In the load
balancer software, enable the Redirect Rewrite select All option to configure the HTTP
profile associated with the Cluster VIP.

Configure CAC Support
| Note: Common Access Card (CAC) is not supported in a multi-customer or State environment.
This section describes how to configure Common Access Card (CAC) support on the CMS UI.
1. Make sure that you have access to the keystore, truststore, and crl files. If necessary, you can
create them using the following examples:
o Import the server certificate into the keystore:

$ keytool -importkeystore -deststorepass changeit -destkeypass changeit
-destkeystore keystore.jks -srckeystore ../../certtest/localhost.pl2

-srcstoretype PKCS12 -alias sercer
Enter source keystore password:
o Import the certificate authority (CA) certificate into the truststore:

$ keytool -import -keystore cacerts.jks -storepass changeit -alias my_ca
-file ../../certtest/ca.crt

Owner: EMAILADDRESS=ca@naive.sk, CN=CA Admin, OU=CA, O=Naive, L=Bratislava,
ST=Bratislava, C=SK

...too long...
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Trust this certificate? [no]: yes
Certificate was added to keystore
Important: After upgrading to UCMDB 10.32 or later,

o the deststorepass is the password set at UCMDB server upgrade.

o the destkeystore is the password set at UCMDB server upgrade.

o the storepass is the password set at UCMDB server upgrade.

2. Load the client certificate into your Web browser.

3. Open the server.xml file, located in <CMS_UI_installation_directory>\webapps\release\conf.
Add the following lines, if they do not exist:

o <Connector protocol="HTTP/1.1" port="8553" maxThreads="200"

This line specifies the port number. You can use any value, as long as it does not conflict with
an existing port. The default value is 8443.

o SSLEnabled="true" scheme="https" secure="true" sslProtocol="TLS"
This line configures SSL for the Tomcat server.

o truststoreFile="C:\Program Files\Apache Software Foundation\Tomcat

8.5.24\certificates\server.truststore” truststorePass="hppass"
This line provides the path to the truststore file and the password of the truststore file.

o keystoreFile="C:\Program Files\Apache Software Foundation\Tomcat

8.5.24\certificates\server.keystore" keystorePass="hppass"
This line provides the path to the keystore file and the password of the keystore file.

o crlFile="C:\Program Files\Apache Software Foundation\Tomcat
8.5.24\certificates\server.crl"

This line provides the path to the certificate revocation list file.
o clientAuth="true" />

This line specifies that login is permitted only when the client has a valid client certificate.

Important: After upgrading to UCMDB 10.32 or later,

« the truststorePass is the password set at UCMDB server upgrade.

« the keystorePass is the password set at UCMDB server upgrade.

CMS Ul (2018.08) Page 85 of 446



CMS Ul Guide
Administer

Disable access to other connectors ( to ensure that no user can connect to the Tomcat server with
unsecured HTTP access) by commenting out or deleting other connector tags that are referenced
in the file.

Save the server.xml file and restart the Tomcat server.

Note: If your Web browser cannot connect to the Tomcat server after following this procedure,
delete the following line from the server.xml file:

<Listener className="org.apache.catalina.core.AprLifecycleListener"
SSLEngine="on" />

Save the server.xml file and restart the Tomcat server again.

Configure CAC Support with Multiple CRL Files

CMS Ul can accept multiple CRL files. However, Tomcat only supports a single CRL file via the

crlFile Connector attribute. The following procedure highlights how to work around this Tomcat
limitation so that the CMS Ul can use multiple CRL files:

1.

Convert the CRL files from DER format to PEM format by using the following OpenSSL command
(DER format is binary and PEM format is Base64-encoded text). Make sure that the CRL file
name does not contain any space, because OpenSSL does not work well with spaces in file
names.

OpenSSL crl -inform DER -in <input path to CRL file> -outform PEM -out <output
path to CRL in PEM format>

Concatenate the contents of all PEM-formatted files in a proper order into a new file. The content
from Trust Anchor must be the first in the new file.

3. Update server.xml to reference the new file in the crlFile attribute.

The following example demonstrates how to perform the above procedure for two CRL files under the
test64 folder:

1.

Convert the CRL file format by using the following commands:

OpenSSL crl -inform DER -in c:/certs/test64/TrustAnchorCRLCP.01.01.crl -outform
PEM -out c:/certs/test64/TrustAnchor.pem

OpenSSL crl -inform DER -in c:/certs/test64/IntermediateCRLRL.02.01.crl -
outform PEM -out c:/certs/test64/Intermediate.pem
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2. Open TrustAnchor.pem and Intermediate.pem in a text editor.

3. Copy the entire contents of Intermediate.pem, and then paste the content at the bottom of
TrustAnchor.pem, as shown below.

MI1BbzCB2QIBATANBgkghkiGOwWOBAQUFADBeMQswCQYDVQQGEwJVUzEYMBY GA1
UE
ChMPVS5TLiBHb3ZIcm5tZW50MQwwCgYDVQQLEWNEbOQXEDAOBgNVBASTB1RIc3R
p
bmcxFTATBgNVBAMTDFRyYdXNOIEFuY2hvehcNOTkwMTAXMTIwWMTAWWhcNNDgwMT
Ax
MTIwMTAWW]AIMCACAScXDTkSMDEwWMTEYyMDAwWMFowDDAKBgNVHRUEAwOBAaA|
MCEw

CgYDVROUBAMCAQEWEWYDVRO0BAwwCoAIg5rr+cLnVI8wDQY JKoZIhveNAQEFBQA
D gYEAC7IgZwejJRW7QvzH11/7cYcL3racgMxH3PSU/ufvyLk7ahR++RtHary/WeCv
RdyznLilOA8ZBiguWtVPgsNysNn7WLofQlVa+/TD3T+lece4e1NwGQvj5Q+e2wRt
GXg+gCuTjTKUFfKRnWz70O7RyiJKKimOjtAF4RkCpLebNChY=

MIIBSzCBtQIBATANBgkghkiGOWOBAQUFADBeMQswCQYDVQQGEwJVUzEYMBYGA1
UE
ChMPVS5TLIBHb3ZIcm5tZW50MQwwCgYDVQQLEWNEb2QXEDAOBgNVBAsTB1RIc3R
p
bmcxFTATBgNVBAMTDENBMS1STC4wMi4wMRcNOTkwMTAXMTIWMTAwWWhcNNDgw
MTAX
MTIWMTAWWgAJMCEwCgYDVROUBAMCAQEWEWYDVROBAWwWCo0AIZdDTuglCqg/YwD
QYJ KoZIhveNAQEFBQADgYEAxrDHzKno1mkJgPTub0c9To6jC3CGTilV1E120D0kFjkX
gL40+W251qQ2wMC+G7ZrzBlc5dRuJ93feHZ7cc03/s3TziXDvSyfNOYpHzkPwT48
HuSgBYgJ3uswwk+tDiA64NzbOJgssxxhFRok90pwC8eQkzgpA3a6816v2I3XL9s=

4. Save the concatenated contents to a new file. For example, Trustint64.pem.
5. Modify the server.xml file so that the cr1File attribute points to this new file:
crlFile="C:/certs/test64/TrustInt64.pem”

6. Save the server.xml file, and then restart the Tomcat server.
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Configure Multiple UCMDB Servers

Itis possible to configure the CMS Ul to work with multiple UCMDB Servers. This is done by
replicating the section <ucmdb_configuration>..</ucmdb_configuration> in the ucmdb_browser_
config.xml file, as shown in the following example:

<ucmdb_configuration name="configuration-1">
<protocol>https</protocol>
<host_name>ucmdb-server-1</host_name>
<host_port>8443</host_port>
<context_name>/</context_name>
<customer>
<customer_name>company_a</customer_name>
<customer_number>1</customer_number>
</customer>
</ucmdb_configuration>
<ucmdb_configuration name="configuration-2">
<protocol>https</protocol>
<host_name>ucmdb-server-2</host_name>
<host_port>8443</host_port>
<context_name>/</context_name>
<customer>
<customer_name>company_b</customer_name>
<customer_number>6</customer_number>
</customer>
</ucmdb_configuration>

There is no limit to the number of UCMDB Servers that you can add in this manner.

Note:

« The value of the name attribute in each configuration (for example, configuration-1 or
configuration-2 in the example above) is optional, but if it is defined it must be a unique value.

« You can specify a default customer by name, ID, or both. If you include the
<customer>...</customer> tag, you must provide details for it. On the login page of the CMS
Ul, only the customer that you defined as the default customer for a particular UCMDB server
will be visible in the drop-down list.

« Configuring multiple UCMDB servers is not relevant to the embedded CMS Ul since the
embedded CMS Ul can connect to only one server. For more information, see "Multiple
Customer Support for the Embedded CMS UI" on page 90.
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For each configuration section, the customers for that UCMDB server are retrieved automatically at the
moment that the application server starts, and a connection for each customer is formed using the
value from the name attribute in the ucmdb_configuration tag (if the name attribute is not defined, the
value from the host_name tag is used) and the name of the customer. All these connections appear in
the drop-down list in the login screen. For example, in the case of the xml example above, if
configuration-1 has two customers and configuration-2 has three customers, then the drop-down list
will contain five connections, in the form of:

« configuration-1 — CustomerName1

« configuration-1 — CustomerName2

« configuration-2 — CustomerName1

« configuration-2 — CustomerName2

« configuration-2 — CustomerName3
If the UCMDB server defined in configuration-2 is inaccessible, then the connection for it is still
visible in the drop-down list (without any customer information), even if the user cannot login using that
server. Inthat case, the list will contain the connections:

« configuration-1 — CustomerName?1

« configuration-1 — CustomerName2

« configuration-2
If only one server is available, then the server name does not appear in the connection name.

Caution: If you have launched the CMS Ul with a given UCMDB server, you cannot open another
instance of the CMS Ul with a different UCMDB server with the same web browser. You can,
however, open another instance of the CMS Ul with a different UCMDB Server if you use a
different web browser. For example, if you opened the CMS Ul with Internet Explorer with a given
UCMDB server, you can open the CMS Ul using Google Chrome with another UCMDB server.

Note: The same LW-SSO settings from the ucmdb_browser_lwsso_config.xml file are used for
all UCMDB configurations.

Retrieving Customer States

You can specify whether to retrieve the state(s) for each customer so that the state appears next to the
customer name in the login drop-down list. Currently, the possible states are Actual and Authorized.
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The default value for this setting is false, meaning that the customer state does not appear in the login
drop-down list. If you change it to true, the state(s) for each customer is also retrieved, in addition to the
customer name. So if the server host has two customers, Customer-1 with an Actual state and an
Authorized state, and Customer-2 with an Actual state, then the connections will be host —
Customer-1 (Actual), host — Customer-1 (Authorized), and host — Customer 2 (Actual).

This setting also applies to the embedded CMS Ul, as described below.

To specify whether to retrieve the state for each customer:

In UCMDB, go to Administration > Infrastructure Settings > UCMDB Browser Settings, and set
the value for Enable customer states.

Multiple Customer Support for the Embedded CMS
Ul

The embedded CMS Ul can connect to only one UCMDB server and so configuration for multiple
UCMDB servers is not relevant. The information regarding the server is automatically sent by the
UCMDB server into which the CMS Ul is embedded. Similar to the case of login for the non-embedded
CMS Ul, the embedded CMS Ul searches for all the customers for that server, and for each customer it
creates a different connection. For example, if the host server has two customers, customer1 and
customer2, then the connection names customer1 and customer2 appear in the drop-down list on the
login page.

Also, if the setting to receive customer states has been set to true (as described above), then the
customer state appears next to the customer name in login drop-down for the embedded CMS UI.

Change the Default Port of the Tomcat Server

The default port value (8443) of the Tomcat Server may conflict with an existing application (for
example, another web application already uses this port). If such a conflict exists, change the default
port as follows:

1. Locate the file server.xml in SCATALINA_BASE/conf/ where $CATALINA_BASE is the
directory in which you installed Tomcat.

2. Inserver.xml, find a statement similar to the following:
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<Connector port="8443" maxHttpHeaderSize="8192"
maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
enablelLookups="false" redirectPort="8080" acceptCount="100"
connectionTimeout="20000" disableUploadTimeout="true" />

or
<Connector port="8443" protocol="HTTP/1.1"

connectionTimeout="20000"
redirectPort="8080" />

3. Change the Connector port="8443" port to any other port number.
For example:
<Connector port="8181" protocol="HTTP/1.1"

connectionTimeout="20000"
redirectPort="8080" />

4. Save the server.xml file and restart the Tomcat server.

Note: To use encrypted parameters on the Tomcat server, for example, an encrypted port number
in the server.xml file, see "Configure to Use Encrypted Parameters on the Tomcat Server" below.

Configure to Use Encrypted Parameters on the
Tomcat Server

To configure to use encrypted parameters on the Tomcat server,

1. Stopthe Tomcat server.

2. Locate the file catalina.properties in SCATALINA_BASE/conf/, where $SCATALINA_BASE is
the directory in which you installed Tomcat.

a. Open the the file catalina.properties.

b. Uncomment or add the following:
org.apache.tomcat.util.digester.PROPERTY_SOURCE=com.hp.ucmdb_
browser.tomcat_config.CustomPropertyDecoder

c. Savethefile.

3. Gotothe SCATALINA_BASE/lib/ directory, check that you have the following .jar file (if not,
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copy it from the CMS Ul 2018.08 - Tomcat assembly)
o tomcat-property-config.jar
4. Go back tothe SCATALINA_BASE/conf/ directory,

a. Create afile called configproperties.txt.

b. Add values in the form of: <key>=<value>. For example,

my . port=8088
5. Openthe SCATALINA_BASE/conf/server.xml file, and use those properties as follows:

This is the HTTP connector, note the my.port usage:

<Connector port="${my.port}" protocol="HTTP/1.1"
connectionTimeout="20000"
redirectPort="8443" />

6. Restart the Tomcat server.

Upon startup, an automatically generated configproperties.bin file, the encrypted version of the
configproperties.txt file, replaces the original configproperties.txt file.

The values of the parameters will be replaced on Tomcat startup, by the values defined in the
encrypted file.

There is now no clear text version of these parameters, they are all encrypted.

Deploy the CMS Ul with a Different Root
Context

You can change the default root context name /ucmdb-browser. To do this, rename ucmdb-
browser.war under <Tomcat installation path>\webapps.

For example, if you want to change the context name to /nice-application, rename ucmdb-
browser.war to nice-application.war.

You can also create a multilevel context name. For example, if you want to change the context name to
Iverylvery/nice-application, rename ucmdb-browser.war to very#very#nice-application.war.
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Disable the Embedded CMS Ul

To disable the embedded CMS Ul, follow these steps:

1. Stopthe UCMDB Server.

2. Delete the ucmdb-browser.war file, and the ucmdb-browser folder from the <UCMDB_
Server_install_folder>\deploy folder.

3. Delete the uemdb-browser.war folder from the <UCMDB_Server_install_
folder>\runtime\jetty-cache folder.

4. Startthe UCMDB server.

Note: In a High Availability environment, repeat the above procedure for each CMS Ul in the
cluster.

Configure Reverse Proxy for the Apache
Tomcat and |IS Servers

The client can configure reverse proxy on the CMS Ul for either the Apache Tomcat or IIS servers.

Configure Reverse Proxy for the Apache Tomcat
Server

1. Configure reverse proxy to append header X-Reverse-Proxy with the reverse proxy URL for
Apache-server. To do this, open file %eapache-home-directory%\confihttpd.conf (where
%apache-home-directory% is the Apache server home directory), and add the following lines:

LoadModule headers_module modules/mod_headers.so
RequestHeader set X-Reverse-Proxy http://srp-server-front-end-url

Where http://srp-server-front-end-url is the entire reverse proxy’s frontend URL.

2. Restart the Apache Tomcat server.

CMS Ul (2018.08) Page 93 of 446



CMS Ul Guide
Administer

Configure Reverse Proxy for the IIS Server

Prerequisites

Install Application Request Routing (ARR) by using one of the following methods:

« Install ARR by using the Microsoft Web Platform Installer.

« Download and install ARR from the following address:
http://www iis.net/downloads/microsoft/application-request-routing
Configure the IIS server
1. Open IIS Manager, expand the server node, right-click Server Farms, and then click Create

Server Farm. The Create Server Farm wizard opens.

2. Enter the name of the server farm, make sure the Online option is selected, and then click Next.

The Add Server page is displayed.
3. Addthe CMS Ul server by using the following steps:
a. Enterthe IP address of the CMS Ul server in the Server address field.

b. Click Advanced settings, expand the applicationRequestRouting section, and then
specify the port numbers for the CMS Ul server.

c. Click Add.
d. Click Finish.
4. Click Yes when IS Manager displays the following message:

[IS Manager can create a URL rewrite rule to route all incoming requests to this server farm
automatically. Do you want to create this rule now?
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Configure an Environment to Use Multiple
Reverse Proxies

When clients are connected to the same CMS Ul instance through multiple reverse proxies, the CMS
Ul needs to know each client’s frontend URL to build correct direct links to the Micro Focus
Configuration Manager and Micro Focus Service Manager servers. For example, a client who accesses
the CMS Ul by reverse proxy https://reverse-proxy-1 should get a direct link by the same
https://reverse-proxy-1.

Therefore, a configuration based on relative URLs instead of full URLs should be implemented. When
the CMS Ul receives a request with a header X-Reverse Proxyj, it relates to application URLs as
relative URLs and concatenates part of the header with a relative URL. To use this solution the
customer should:

1. Configure each reverse proxy in the environment to append header X-Reverse-Proxy with the
Reverse Proxy’s frontend URL.

2. Use arelative URL for all servers behind the reverse proxy in the CMS Ul configuration.
To perform the actual configuration:

1. Configure reverse proxy to append header X-Reverse-Proxy with the reverse proxy URL for
Apache-server. To do this, open file %apache-home-directory%\confihttpd.conf (where %apache-
home-directory% is the Apache server home directory), and add the following lines:

o LoadModule headers_module modules/mod_headers.so
o RequestHeader set X-Reverse-Proxy http://srp-server-front-end-url
Where http://srp-server-front-end-url is the entire reverse proxy’s frontend URL.

2. The CMS Ul configuration file should use relative URLs instead of full URLs. For example,
instead of http://cm-server/cnc, use /cnc. Specifically, it is very important that the value of tag
<ucmdb_ui_url> is defined and uses a relative path.

Note: To configure your environment to work properly, use the value of the UCMDB Browser

URL setting to access CMS Ul, by changing the value of the Override the Return to CMS Ul
link setting to True.
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Configure a One-Time Authentication Token

The one-time authentication token is an additional means for the user to access CMS Ul by a direct link
(URL with parameters). With such a URL, the user does not need input credentials. The advantage of
this method is that:

« The URL does not contain user credentials.

« The URL is for one time use only (after initial use, the URL cannot be used again).

Note: You must have administrator rights in order to generate an authentication token for another
user.

To configure and use the one-time authentication token:

1.

Create a URL for obtaining the one time authentication token as follows:

http://<server-name>:<port>/ucmdb-browser/generate-authentication-
token.jsp?username=<your_user_name>&password=<your-encrypted_
password>&server=<ucmdb-server>&logged-in-user=<logged_in_user_name>

where the parameters server and logged-in-user are optional.
The following is an example of a URL for obtaining one time authentication token:

http://server-name:8088/ucmdb-browser/generate-authentication-
token.jsp?username=johndoe&password=12345678&server=ucmdb-server

To generate the encrypted password:

a. GotoJMX console > UCMDB-Ul:name=UCMDB Integration >
getEncryptedPasswordForURL.

b. Inthe user name field, enter the user name.
c. Inthe password field, enter the user's password.

d. Click Invoke.

Note:

o Parameter names are case sensitive and should be used exactly as they appear in this
documentation.
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o When an optional parameter (such as server) is omitted, the first server from the
configuration is used.

o The server name in the [server] parameter should be taken from one of the <host_name>
fields in CMS Ul configuration file. If the [server] parameter is defined but it’s value does
not correspond to any of the values of the <host_name> field in CMS Ul configuration file,
the authentication token will be not generated.

o When you want to access CMS Ul in a multi-customer environment, the following URL
should be used:

http://<server-name>:<port>/ucmdb-browser/generate-authentication-
token.jsp?username=<your_user_name>&password=<your-encrypted_
password>&server=<ucmdb-server>&customer-id=<id>&logged-in-user=<logged_
in_user_name>

2. Execute the URL prepared in the previous step. After successful execution, the Authentication-
Token field in the response http-header contains the authentication token value created for the
parameters you entered in the previous step. The http field is used here for a return value to
enlarge security strength.

Note:

o The response http-header fields can be viewed by using any external request interceptor
(such as Fiddler) or tools embedded into a web browser (for example, in Chrome:
Developer Tools > Network tab).

o If the credentials provided in the previous step are not valid, the authentication-token field
is empty or not present at all.

Build the URL for the CMS Ul by using the parameter authentication-token and the token value
obtained in the previous step. For example:

http://server-name:8088/ucmdb-browser/?authentication-token=<token-value>
where token-value is the authentication token string obtained in the previous step.

After executing the URL, you are redirected to the CMS Ul without having to enter user credentials.

Important: For the one-time authentication token to work, you need to enable the LW-SSO
framework. To do this, in the ucmdb_browser_lwsso_config.xml file, make sure that the value
for enableLWSSOFramework, enableCookieCreation, and enableAutoCookieCreation is
True.

CMS Ul (2018.08) Page 97 of 446



CMS Ul Guide
Administer

<?xml version="1.0" encoding="UTF-8"?>
<lwsso-config
xmlns="http://www.hp.com/astsecurity/idmenablmentfw/lwsso/2.0">
<enablelLWSSO enableLWSSOFramework="true" enableCookieCreation="true"
enableAutoCookieCreation="true" cookieCreationType="LWSSO"
enableSAML2Support="false"/>

Note: Afterrestarting the server of the CMS Ul, all prepared authentication tokens are no longer
valid.

Configuration Mechanism

The configuration settings for CMS Ul and for the UCMDB Browser module are kept on the UCMDB
Server to which the CMS Ul is connected. The CMS Ul configuration settings on the UCMDB Server
are accessible from UCMDB (in Administration > Infrastructure Settings > UCMDB Browser
Settings). The settings appear only after initial login, which triggers a settings deployment on the
UCMDB Server.

For each group of configuration settings, there is a setting called: Enable XXX, where XXX is the name
of a CMS Ul feature (for example, Enable the Incidents Widget, and so on). This setting can be used
to enable/disable the group of settings. For example, if Enable the Incidents Widget is set to false,
the Incidents Widget is not available in the UCMDB Browser module.

Note: When upgrading to UCMDB 2018.08, the CMS Ul settings are not upgraded. The UCMDB
administrator should set them manually in Infrastructure Settings Manager in UCMDB.

Specify the Number of Concurrent Sessions

By default, a user can open an unlimited number of sessions. You can specify the maximum number of
sessions that a user may log into concurrently.
Note: This setting cannot be used for:

« CMS Ul in a high availability environment.

« astandalone CMS Ul that is connected to multiple UCMDB servers.

« astandalone CMS Ul that is connected to a UCMDB server with multiple customers.

« the embedded CMS Ul of a UCMDB that is configured with CAC.
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1. InUCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.

2. Inthe Name column, choose Maximum sessions per user.
3. Inthe Value column, enter a number.

4. Click Save |@|.

5. Log out from the CMS Ul, and then log in again (this loads the new settings).

Note: The change takes effect according to the time set in one of the following settings:
o Time for which information in the Browser cache is valid
o Time for which UCMDB Settings in the Browser cache is valid

For more information, see "Settings affecting overall system operation".

Enable/Disable Timeout of a CMS Ul Session

Itis possible to set a timeout for a CMS Ul session if the CMS Ul is not used for a certain period of
time. If the timeout is enabled and a user does not perform any actions in the CMS Ul for the set
timeout period, then when the user tries to perform an action in the CMS Ul a message appears for 2
seconds stating that the session has expired and the user is redirected to the CMS Ul login page.

Note: The default wait period for the timeout is 30 minutes. This value can be changed in the Java
web.xml file, located at:

%WEB_SERVER_HOME%\webapps\ucmdb-browser\WEB-INF\web.xml

By default this timeout is disabled, but you can change this setting according to the following
instructions.

1. InUCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.

2. Inthe Name column, choose Enable the Session Timeout.

3. Inthe Value column, choose True or False (depending on whether you want to enable or disable
the timeout) from the drop-down list .

4. Click Save [E1.

5. Log out from the CMS Ul, and then log in again (this loads the new setting).
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Note: The change takes effect according to the time set in one of the following settings:
o Time for which information in the Browser cache is valid
o Time for which UCMDB Settings in the Browser cache is valid

For more information, see "Settings affecting overall system operation".

Disable the Turn off Data URI Support Setting

When the Turn off Data URI support setting is not disabled, the icons are not displayed in the Internet
Explorer.

| Note: By default the Turn off Data URI support setting is not disabled.
To disable the Turn off Data URI support setting,

1. Click Start, type gpedit.msc in the Start Search box, and then press ENTER.

2. Inthe navigation pane of the Local Group Policy Editor window, expand Computer
Configuration > Administrative Templates > Windows Components > Internet Explorer >
Security Features.

3. Intheright pane, double-click Turn Off Data URI support.
4. Select Enabled, click Apply, and then click OK.

5. Go back to the navigation pane of the Local Group Policy Editor window, expand User
Configuration > Administrative Templates > Windows Components > Internet Explorer >
Security Features.

6. Repeat step 3 and step 4.

Authorize Access to Cls

Browser Cl Access Control enables you to assign granular access to the Cls in views or Cl types in
UCMDB, according to a user's assigned role. A role that has global View or Edit permission can see all
Cls and relationships in UCMDB. A role that has View or Edit permission for a particular view can see
only the Cls and relationships in that view. In addition, permission can be granted to view or edit
particular Cl types.

Note:
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« You must assign at least one permission for a view or CIT in order to see Cls in the UCMDB
Browser module.

« You must have View permission on a particular Cl in order to refocus on it, even if that Cl is
visible in a widget because of Browser Cl Access Control settings.

To authorize access to Cls:

1. InUCMDB, go to Security > Roles Manager.
Select the role to which you want to assign access.

Click the Browser Cl Access Control tab and add available actions as required.

> w0 D

Select an available view or Cl type for which you want to assign permissions.

5. When you are finished, click Save il

For additional details about permissions, see "User Permissions for the UCMDB Browser module" in
the Administer section of the UCMDB Help.

Note:

« If a Cl does not have Edit permission assigned through a view or Cl type, the Edit button will
not be displayed in the Properties widget and it will not be possible to change any property's
attributes in the UCMDB Browser module.

« A userwill be able to see the composite Cls of permitted Cls, even he has not been granted
specific permission for those composite Cls.

« If auserhas permissions on Cls of two Cl types and those Cls are not composite Cls, in order
to have permission on their relationship (for example, to view them in the Environment widget),
the necessary triplet should be added to the calculated link. This is named Authorized
Relationship Addition (UCMDB Browser), and it can be found in Cl Type Manager >
Calculated Relationships.

Use Cases

Enable a user to view or edit all Cls

« Read only: Assign the global permission View All to all Cls for a role.

« Read/Write: Assign the global permission Edit All to all Cls forarole.
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Enable a user to view or edit only specific Cls

« Readonly:
o Assign View permission to specific views.

o Assign View All Cls permission to a particular Cl type.

Note: By default, in the UCMDB Browser module, the Party and Location Cl types are
automatically assigned View All Cls permission.

o Read/Write:

Do one of the following:

o

To edit all Cls that you can view, assign Edit All Cls permission on all views.

(e}

To edit Cls in a specific view, assign Edit All Cls permission on only that view.

o

To edit only specific Cl types in relevant views, assign Edit By CIT permission to the views and
Edit In View permission to a particular Cl type.

Note: You can assign permissions to a group of views by selecting a node in the list of
Available Views, or apply the permissions to all views by selecting the Root node.

o

To edit all Cls of a specific Cl type, assign Edit All Cls permission to that Cl type.

Enable a user to view all Cls and edit only specific Cls
«» Assign the global permission View All to all Cls for arole.
Do one of the following:

« Toedit all Cls of a specific Cl type, assign Edit All Cls permission to that Cl type.

« Toedit only specific Cls:

o

To edit all Cls that you can view, assign Edit All Cls permission on all views.

(e}

To edit Cls in a specific view, assign Edit All Cls permission on only that view.

o

To edit only specific Cl types in relevant views, assign Edit By CIT permission to the views and
Edit In View permission to a particular Cl type.

Note: You can assign permissions to a group of views by selecting a node in the list of
Available Views, or apply the permissions to all views by selecting the Root node.

o

To edit all Cls of a specific Cl type, assign Edit All Cls permission to that CI type.
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Log User Statistics

The CMS Ul can log the user's functional activities, including aspects of the CMS Ul performance and
error messages. No user details are logged, and no UCMDB data, such as Cl attributes, are logged.
The log files are stored in the same folder as the CMS Ul log folder.

The log files and their data are not sent in any way and remain strictly in the customer's local
environment. Micro Focus may request that customers share the data in order to learn how the CMS Ul
is being used. By default, this logging functionality is disabled. It is possible to turn it on by setting the
Enable user statistics setting to true.

How to Set CMS Ul Session to Expire

To set a CMS Ul session to expire when LW-SSO is enabled,

1. InUCMDB, go to Administration > Infrastructure Settings Manager.

2. With all categories of infrastructure settings displayed, select Name for the Filter by column
field, and enter LW-SSO in the field next to it to display all LW-SSO settings.

3. Check if the LW-SSO cookie expiration period setting value is smaller than the LW-SSO ping
interval setting value. (Both of the settings are expressed in minutes.)

If not, modify the values for the two settings to ensure that LW-SSO cookie expiration period is
smaller than the LW-SSO ping interval.

When LW-SSO ping interval is lower than LW-SSO cookie expiration period, this means that
the session will never expire. The ping will keep the session active.

4. Click Save El.

5. Restart UCMDB Server.

Solr Auto Commit

Starting with UCMDB version 10.31, the SOLR auto commit feature is enabled by default, this means
that SOLR will automatically commit documents (indexed Cl data). A commit operation makes index
changes visible to new search requests. Solr uses two types of auto commit operations:
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« hard auto commit. Writes documents to disk, but the documents are not visible for searching. The
interval for hard auto commit is set to 15 seconds or 10000 documents.

« soft auto commit. Makes documents available for searching. The interval for soft auto commit is
set to 3 minutes.
Since UCMDB can run heavy data-in operations, by setting these values the updated data is often sent

to Soalr, therefor the Solr's performance is improved.

However, if necessary, you can change the auto commit interval as follows:

« Hard auto commit interval
a. Open the <Solr_home>\configsets\ucmdb_configs\confisolrconfig.xml file.

b. Inthe below lines replace the values of the maxTime and maxDocs parameters with the ones you
desired:

<autoCommit>
<maxTime>${solr.autoCommit.maxTime:15000}</maxTime>
<maxDocs>10000</maxDocs>
<openSearcher>false</openSearcher>
</autoCommit>

c. Restartthe UCMDB server.

« Soft auto commit interval
a. Open the <Solr_home>\configsets\ucmdb_configs\confisolrconfig.xml file.
b. Inthe below lines replace the value of the maxTime parameter with the one you desired:

<autoSoftCommit>
<maxTime>${solr.autoSoftCommit.maxTime:180000}</maxTime>
</autoSoftCommit>

c. Restart the UCMDB server.

Best Practices for Working with the UCMDB
Browser Module

This section provides a brief list of settings that impact system performance and enable you to
configure the UCMDB Browser module in a way that is faster for production, and reduces the time

needed to apply particular settings.

For more information about these and other settings, see the relevant section in this book.
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UCMDB Browser module URL

After each Tomcat/Jetty restart, when you first log in to the CMS Ul, the UCMDB Browser URL
setting is updated with the used URL. This URL is used to create the direct links needed in the
reports/notification emails.

To prevent the URL to be overridden, go to UCMDB > Administration > Infrastructure Settings
Manager > UCMDB Browser Settings, and change the value of the Override UCMDB Browser
URL on first login setting to False.

Settings affecting overall system operation

« Time for which information in the Browser cache is valid. The UCMDB Browser module uses
the Time for which information in the Browser cache is valid setting to cache the information
about the Cls and dynamic widgets. The default value is 5 minutes. This results in a faster login.
When you change the information about a Cl or a dynamic widget, it may take the same amount of
time for it to be visible. To clear this cache, go to Administration Console > Cache Operations,
and invalidate the UCMDB Browser module cache data by clicking the Invalidate EhCache Data
button.

« Time for which UCMDB Settings in the Browser cache is valid. The UCMDB Browser module
uses the Time for which UCMDB Settings in the Browser cache is valid setting to cache all
the settings that are read form UCMDB Server, and the information about the available widgets.

By default, the values stored in cache are valid for 120 minutes. If you increase this, more users will
be able to log in faster. For example, with a 150 minute value, the values in the cache are
considered valid for up to 150 minutes. This means that if user1 logs in, for 150 minutes after that,
all users that log in and read the same settings will use the values from the cache. This results in a
faster login and a better performance.

To change the default value, go to UCMDB > Administration > Infrastructure Settings >
UCMDB Browser Settings > Time for which UCMDB Settings in the Browser cache is valid
setting, specify a new value (in minutes), and then restart the CMS Ul for the change to take effect.

When you change a setting, it may take the same amount of time for it to be visible. To clear this
cache, go to Administration Console > Cache Operations, and invalidate the UCMDB Browser
module cache data by clicking the Invalidate EhCache Data button.
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o Maximum parallel calls from UCMDB Browser Ul to UCMDB Browser web server. The
UCMDB Browser module can throttle its asynchronous calls from the UCMDB Browser module Ul
to the UCMDB Browser module web server. If you have more than 8 widgets visible, increase this
setting for a faster loading Ul. The default value is 10. This value should always be a few
increments above number of widgets, since besides each widget that runs a call when selecting a
CI’s details, some other calls are also made (such as updating the most visited page).

« Enable user statistics. The logging of user statistics is disabled by default, for improved
performance.

« Enable notifications. The ability to receive notifications is useful; however, this feature does put a
load on the application. Notifications are enabled by default, but if you do not use them, you can
improve performance by disabling them. Searching would also be faster, since notification data is
not gathered for each CI returned by a search before results are displayed.

Settings affecting search

« Search results page size. This setting specifies the number of rows that are displayed in the
results grid on a single page. The default value should be fine, but you can increase it to see more
results in a single glance. A very high value will result in a slower overall performance, because
many more elements must be loaded in the Ul.

« Legacy search

o Show federated search results. This setting only affects the legacy search engine and
widgets. Disable it if issues occur such as the search not working, widgets failing to load, or you
notice exceptions from the UCMDB Federation engine in the logs. An alternative to disabling this
setting is to disable integration points (one by one, or all of them), and then enable them one at a
time.

o Return Cls belonging to classes that have MODELING_ENABLED qualifier in legacy
search engine. This setting affects only the legacy search engine. Its value is set to True by
default, which means the legacy search engine works in the same way it did since the first
version. However, search rules that used the MODELING_ENABLED qualifier took 50% more
search time. Changing the value to False reduces the time of the legacy search dramatically if
you have MODELING_ENABLED added to many classes. You can still add custom classes to
search results, using the CMS_BROWSER_SEARCH qualifier.

« Enhanced search
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o Search results update interval. This setting affects the enhanced search engine, and specifies
the time period (in milliseconds) after which the UCMDB Browser module asks for updates. The
default setting should be fine.

Configure Browser Internal Priorities (for the
Incidents and Problems Widgets)

For both the Incidents and Problems widgets, configuration of the UCMDB Browser module Internal
Priorities is performed in UCMDB.

1. Goto Administration > Infrastructure Settings Manager > UCMDB Browser settings.

2. Inthe Names column, find the following settings:
o List of statuses for an major priority incident or problem
o List of statuses for an minor priority incident or problem
o List of statuses for an none priority incident or problem
o List of statuses for an open incident or problem
o List of statuses for an urgent priority incident or problem

3. Inthe Value column, change the priority name for any of the settings above according to your
system needs.

Brand the UCMDB Browser module

You have the ability to apply a header and footer, add custom text and an icon in the header of the
UCMDB Browser module, and replace the image that appears on the landing page.

In all CMS Ul installations, the <CMS_UI_installation_directory>
\webapps\ucmdb-browser\public\branding folder contains sample icon, image, and stylesheet files.

You can replace or update these files as desired, and specify their location in the settings in UCMDB,
as described below.

Recommended image sizes are:

« foricons -20 x 20 pixels

« forthe landing page image - 135 x 135 pixels

Example of the CSS stylesheet:
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.bannerClass {
background-color: yellow;
color: blue;
font-weight: bold;
font-style:italic;

}

To brand the UCMDB Browser module:

1. InUCMDB, go to Administration > Infrastructure Settings Manager, and choose UCMDB
Browser settings.

2. Update the following settings as required:

Name Value

Banner stylesheet URL The URL of the stylesheet used for the banner text.
Banner text The text that will appear in the header and footer.
Custom masthead text Customized text that will appear in the masthead of the

UCMDB Browser module.

Custom icon for masthead The URL of the icon that will appear in the masthead of the
UCMDB Browser module.

Custom image for landing page = The URL of the image that will appear on the landing page of
the UCMDB Browser module.

Note: Forthe best visual effect, use a graphic with a
transparent background.

Custom product name The name of the product that will appear on the landing page
of the UCMDB Browser module.

Note: If you specify customized text and an icon for the masthead, they will appear in
addition to the current text and image, and not as replacements.

3. Click Save ||.

How to View the Java Metrics for the
UCMDB Browser module

You can use the Java Metrics to view the following information about the UCMDB Browser module:
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« Database connection summary
« Discovery processing statistics

o Operations information

Performance Statistics

The UCMDB Browser module automatically captures performance metrics and saves the data
statistically in .csv files under the <CMS_UI_log_folder>\metrics folder.

Log files are located in:

« CMS Ul Standalone: tomcat_folder\logs
o CMS Ul Embedded: UCMDB\UCMDBServer\runtime\log

By default, the interval at which the UCMDB Browser module gathers performance metrics is 15
minutes.

To change the default interval (measured in minutes):

o If Tomcat is started as a service:

a. Runthe CMS-Browserw.exe file.

b. Inthe dialog box that opens, go to the Java tab, and add -Dmetriclnterval=X in the Java
Options container, where X is a number of minutes.

« If Tomcat is started by invoking .\ucmdbbrowser\bin\startup.bat:

a. Create the setenv.bat file (if one has not already been created).

b. Addthe set CATALINA_OPTS=-Dmetriclnterval=X line to the setenv.bat file, where X is a

number of minutes.

Note: If the variable CATALINA_OPTS already exists, just append the —
Dmetriclnterval=X value to the variable, where X is a number of minutes.

« If Tomcat is started by invoking ./Jucmdbbrowser/bin/startup.sh:

a. Create the setenv.sh file (if one has not already been created).

b. Addthe set CATALINA_OPTS=-Dmetriclnterval=X line to the setenv.sh file, where X is a

number of minutes.
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Note: If the variable CATALINA_OPTS already exists, just append -Dmetriclnterval=x

to the existing value, where X is a number of minutes.

Note: If you do not want the performance metrics to be gathered, the value of the —

Dmetriclnterval parameter has to be 0.

The following table explains each column in the .csv files.

Column
t

count
max
mean
min
stddev
p50

p75

p95

p98

p99

p999
mean_rate
m1_rate
mb5_rate
m15_rate
rate_unit

duration_unit

Note:

Information

Timestamp (epoch)

Number of invocations

Max invocation duration '
Average invocation duration 1
Min invocation duration '
Standard Deviation of the values
50% quantile 1 2

75% quantile 12

95% quantile 12

98% quantile 12

99% quantile 12

99.9% quantile ' 2

Average event rate (per second)

Average event rate in the last minutes
Average event rate in the last 5 minutes
Average event rate in the last 15 minutes
Unit for the rate (for example, calls/second)

Unit for the durations (for example, seconds)

1. Allthese values are collected since the last metric reset. Every 15 minutes after dumping the

statistics to a CSV, the metrics (counters, durations) are reset to 0.
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invocation.

counts since the system startup.

Captured Metrics

2. A quantile is calculated by taking the entire data set, sorting it, and taking the value in the
middle (or 1% from the end, for the 99th percentile). For example, the 75% quantile shows the
median of the lower 75% values. These quantiles apply to the set of durations of each

Not all the counters are reset every 15 minutes, so their values keep growing and show overall

The following tables show the captured metrics.

Login statistics

Metrics Measurement Note

LoginService.<Step> Timer A breakdown of times in the Login process

LoginService.UIConfig.<Step> ' Timer A breakdown of times in the UIConfig process
during login

LoginCount Counter A counter that shows the number of users that

have logged in

SessionCount Counter The number of active sessions

Export statistics

Metrics Measurement Note

Export.Email.<Format> Timer

Export.Ul.<Format> Timer

Search statistics

Metrics Measurement
Search.Legacy | Timer
Search.SOLR Timer

SearchCount Counter

CMS Ul (2018.08)

A timer over the sending of scheduled
reports/notifications by email

A timer over the duration of exports

Note
A timer over the duration of a search using legacy search
A timer over the duration of a search using enhanced search

A counter over the number of searches

Page 111 of 446



CMS Ul Guide
Administer

RPC calls statistics

Metrics Measurement Note

RPCCall.<Call> Timer A timer over the execution of specific RPC calls
EhCache statistics

Metrics Note

net.sf.ehcache.Cache.<ServerName> Shows information about the state of the Cache

Initial Setup for Working with the
UCMDB Browser module

In order to enable a user to use the UCMDB Browser module, you must do the following in UCMDB:

» Enable access to the UCMDB Browser module
In the Roles Manager, assign UCMDB Browser access permission to the relevant role.
For details, see "Grant Access to CMS UI" on page 65

« Specify which widgets will be displayed for a role in the UCMDB Browser module

a. Goto Security > Roles Manager.
b. Click the Resources tab and select UCMDB Browser Widgets.

c. Select the widgets for which you want to grant View permission in the UCMDB Browser

module and click |-,
d. When you are finished, click Save ||.

Note: The list of available UCMDB Browser widgets will be visible in UCMDB only after
launching the CMS Ul for the first time.

For details, see "Roles Manager Page" in the Administer section of the UCMDB Help.

« Authorize access to Cls
In the Roles Manager, specify the specific access levels to Cls that you want to assign to the role.

For details, see "Authorize Access to Cls" on page 100

Note: Browser Cl Access Control is not supported for in multi-tenant installations. To enable
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Cls to be viewed in multi-tenant installations, select the View Cls action on the General
Actions tab in the Roles Manager.

Enable the Start Assisted Modeling link in the
UCMDB Browser module for specific users

In some cases, you may wish to grant users access to the Service Modeling module in the UCMDB

Browser module, but not to Assisted Modeling. To enable this functionality, a new
AssistedModelingVisible infrastructure setting control is introduced. This allows you to grant or
revoke access to Assisted Modeling to different user roles, which will enable or disable the Start

Assisted Modeling link in the Service Modeling module.

If you are upgrading to this version of UCMDB, you must manually grant access to Assisted Modeling

to each userrole. To do this, follow these steps:

1.

N o o bk~ w0 DN

Go to UCMDB Ul > Administration > Infrastructure Settings Manager, locate the
AssistedModelingVisible setting, and set its value to true.

Loginto the UCMDB JMX console. inthe Administer section of the UCMDB Help
Inthe UCMDB JMX Quick Search box, enter listResourceTypes.

Enter your Customer ID. (Default: 1)

Click Invoke to display the URM Services mbean.

Select Auth_ROLE to display the list of roles.

Click the Resource ID that corresponds to the user role to which you want to grant permission to
access Assisted Modeling, and then add the following lines of code to the resource XML:

<xmlGlobalPermittedAction>ASSISTED _MODELING</xmlGlobalPermittedAction>
<xmlGlobalPermittedAction>EXPORT_REPORT</xmlGlobalPermittedAction>

Click Save resource to apply your changes.
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This section contains information about how to use the modules in CMS UI.
CMS Modules

CMS Modules

Note: Only the modules for which you have the required permissions will be visible in the CMS
Modules menu.

This section provides information about the new web-based CMS Ul modules and the existing modules
of UCMDB Browser.

With improved user experience and ease-of-use, new modules in the CMS Ul simplifies administrative
and integration management, and provide capabilities that were previously available through the
UCMDB admin Ul.

From the CMS Modules menuicon (E), you can easily access the administrative and integration
management features through the out-of-the-box modules:
Module Description

Home Opens the CMS Ul landing page, which allows you to view the out-of-the-box
content, and add different types of widgets to the landing page.

Configuration Based on the existing Search module from the UCMDB Browser, the search

Item Search capability is enhanced and extended.

Integration Opens the new Integration Studio module, which enables you to manage your

Studio UCMDB integration points and connect and share information with external
repositories, such as other UCMDB, IT Performance Suite products, or third-
party products.

LDAP Manager Opens the LDAP Manager module, which enables you to associate Universal
CMDB groups with LDAP groups.

Package Opens the Package Manager module, which enables you to easily manage the
Manager capabilities of your system based on the packages you deploy.

Probe Opens the Probe Dashboard module. It retrieves and displays real-time
Dashboard information about data flow probes and workflow/discovery jobs in a centralized

view, allowing you to easily view all probes and jobs, and also drill down to
probe and job details.
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Module Description
Reports The existing Reports module from the UCMDB Browser.
Resource Opens the new unified Resource Manager module, which enables you to
Manager quickly search and consume various UCMDB resources in one place.
Service The existing Service Modeling module from the UCMDB Browser.
Modeling

Smart Software The Smart Software Analytics module relies on data analytics to analyze large

Analytics amount of scan files and suggest new software signatures, that can be used to
recognize installed software. It automatically teaches unrecognized software
by intelligently using Natural Language Processing (NLP) and machine learning
technology. Smart Software Analytics provides you with an enhanced software
recognition ratio that requires less manual effort.

UCMDB Browser Allows you to access UCMDB Browser in the legacy style.

Home

The Home module in the CMS Modules navigation pane opens the CMS Ul landing page, which allows
you to add different types of widgets to the Home page

This section contains the following:
Home Page OVervieW 115

Home Page User Interface .. ... .. L 119

Home Page Overview

The Home module is the landing page for the CMS Ul. When you access CMS Ul, you are on the
Home page. This module allows you to customize your experience with the product by quickly adding
different types of widgets (such as reports) or a selection of UCMDB Browser widgets to the Home

page.
Note: A role that has View permission for a particular view can see only that view in the CMS Ul.

You can quickly locate different types of resources using the Search functionality. The following
options are available:
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« Configuration Item. Allows you to search for a Cl. The search results are opened directly in the
Configuration Item Search module.

« Queries and Models. Allows you to search for queries and models. The search results are opened
directly in the Resource Manager module.

« Views and Reports. Allows you to search for views and reports. The search results are opened in
the Resource Manager module or in the Topology Map.

« Reconciliation. Allows you to search for a Cl and to view all its changes. Also, you can view the
reason why the Cl was changed. This includes a list of identification candidates, and the reasons
for matching the searched CI with them.

The content from the Home page is organized in tiles. Each tile offers a preview of the resource it points
to.

Every widget on the Home page can be opened with a simple click. For example:

« When you click a UCMDB Browser widget, the embedded widget opens in the Widget Details

mode. To return to the Home page, click X.

« When you click a report widget, the report opens in the Text mode.
You can remove any content from the Home page, rearrange or resize the existing widgets, or add new
widgets. Your changes are saved every time you perform one of the following actions:

« Access one of the available modules.

« Remove a widget from the Home page.

« Add awidget to the Home page.

« Logout from CMS UlI.

QOut-of-the-box content

Note: To view the out-of the-box content you must have one of the following:
. Data Consumer role
« Viewer role

« View permission for the Resource Groups > Views > OOTB_Reports UCMDB_Home
resource
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By default, when you access CMS Ul for the first time, you can view the following out-of-the-box report
widgets:

Report
name Description

Workstations = Displays the computers that are not servers (node role does not contain "server"),
by OS grouped by the DisocoveredOsName attribute.

Servers by Displays the computers that are servers (node role contains "server"), grouped by
0S the DisocoveredOsName attribute.

Databases Displays all the Databases grouped by child Cl Type.

by Type

Services Displays the Services grouped by child Cl Type.

Running Displays all the Running Software grouped by child CI.

Software

Installed Displays all the Installed Software grouped by Display Label on InstalledSoftware.
Software

Network Displays the Network Entities grouped by child Cl.

Structure

All Displays the current status of all integration jobs in all integration points.
Integration

Jobs

Network Displays the network devices grouped by the device type.

Devices

Storage Displays the storage devices grouped by the device type.

Devices

AWS Displays the AWS ec2 instances.

CLOUD

Note: If you see a "There is no data available for this report" message displayed for individual
default report widgets (such as Installed Software) on CMS Ul, either it is true that there is no data
available for the report, or the reports are querying over a large amount of data from the UCMDB
server which exceeds the maximum number of elements allowed in view (you may find "server
view query over limit" error in log).

In case of the second scenario, to resolve the display issue, go to UCMDB Ul > Administration
> Infrastructure Settings Manager, locate the Maximum number of elements (nodes) in TQL

result for view setting (default value: 30000) and increase its value to meet your need.
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Delete the out-of-the-box content

To delete the out-of-the box content from the CMS Home page, follow these steps:
1. InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click Home.

2. Click the Settings icon (e) to expand the Home Settings pane.

3. Click Delete.

Note: Once you have deleted the out-of-the-box widgets, you can manually add them back one by

one, using the Add a New Widget (‘0) option. For more information, see "Add a report widget to
the Home page " on page 127

Specify the maximum number of widgets that can be added to

the Home page

Note: Only users who have Server Administrator Privileges can perform the following procedure.

By default, the number of widgets that can be added to the Home page is limited to 100. To modify the
value, follow these steps:

1. GotoJMX Console > UCMDB:service=Settings Services > setGlobalSettingValue.

2. Inthe name field, enter uemdb.newui.dashboard.size.

3. Inthe value field, enter the value of the maximum number of widgets that you want to be added to
the Home page.

4. Click Invoke.
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Home Page User Interface

You can remove any content from the Home page, rearrange or resize the existing widgets, or add new

widgets.

| Important: CMS U12018.08 requires UCMDB server 2018.08.

The following table describes the user interface elements on the Home page.

Ul Element (A-Z) Description

m You can open the Home page from anywhere else in the CMS Ul simply by

clicking the m icon in the upper left corner of the CMS Ul window.

E CMS Modules. Opens the CMS Modules pane, and allows you to navigate
through the available web-based CMS modules. For detailed information
about the available modules, see "CMS Modules" on page 114.

<Top Search Bar> Search. Allows you to search within the following categories:

Q .

Configuration Item. Allows you to search for a Cl. The search results are
opened directly in the Configuration Item Search module.

Queries and Models. Allows you to search for queries and models. The
search results are opened directly in the Resource Manager module.

Views and Reports. Allows you to search for views and reports. The
search results are opened in the Resource Manager module or in the
Topology Map.

Reconciliation. Allows you to search for a Cl and to view all its changes.
Also, you can view the reason why the Cl was changed. This includes a
list of identification candidates, and the reasons for matching the searched
Cl with them. For detailed information about Reconciliation Analyzer, see
"Working with the Reconciliation Analyzer" on page 133

For more information, see "Search Functionality" on page 125.

<username>. Displays the user that is currently logged in to CMS Ul.
<usemame> Clicking it allows you to log out from CMS Ul.

Help. Opens the Help menu, which contains the following menu options:

Help. Opens the CMS Ul Help page.

« REST API Reference. Opens the new interactive REST AP| Reference

CMS Ul (2018.08)

documentation.

o The REST API Reference documentation now contains information
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Ul Element (A-2) Description

about all REST APls available with UCMDB.

o The Try it out button for each REST API call in the interactive REST
API Reference documentation allows you to try executing the REST
API code examples and to view returned responses.

o Online Help for CMS Ul. Opens the online help for the current CMS Ul
version available on the Micro Focus Software Information Portal.

o Online Help for UCMDB Server. Opens the online help for the current
UCMDB Server version available on the Micro Focus Software
Information Portal.

o Online Help for Content Pack. Opens the online help for the current
Content Pack version available on the Micro Focus Software Information
Portal.

« About. Opens the About dialog box.

The ABOUT tab provides version, patch (if available), copyright, and third-
party notice information. For more information, see "About Window" on
page 122.

The LICENSE tab provides license information, including license status,
license summary, and a license status link. Clicking the license status link
opens the license summary report, which contains license consumption
summary and available licenses, and a link that allows you to export a
detailed license consumption report. For more information about licenses,
see "Universal Discovery Licensing Overview" on page 422.

Clicking OK exits the About window.

Walk-throughs. Opens a list of predefined workflow scenarios. Click one of
the available workflows to open a set of step-by-step-instructions. This allows
you to complete an end-to-end workflow by yourself.

The following walk-throughs are available:

o How to Search fora Cl

For more information, see "Run a Walk-through " on page 128

o Add New Widget. Enables you to add different types of widgets to the Home
page. Opens the Add a New Widget layer.

The following types of widgets are available:

« UCMDB Browser Widgets (History, Get Related, and Impact Simulation).
For more information, see "Add a UCMDB Browser widget to the Home
page " on page 126

« Reports. For more information, see "Add a report widget to the Home page
" on page 127
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Ul Element (A-2) Description

0 Settings. Enables you to delete the out-of-the-box content. For more
information, see "Delete the out-of-the-box content" in the "Home Page
Overview" on page 115 section.

The following table describes the user interface elements on each tile on the Home page.

Ul Element (A-Z) Description

b4 Delete <tile name>. Removes the widget from the Home page.

[ﬁ_] Map mode. Opens the topology map for a view associated with a widget.

@ Widget Settings. Allows you to customize the widget title, and to view some
of the widget properties.

To customize the title of a widget, follow these steps:

1. Inthe Home page, hover the mouse over a widget, and then click the
Settings icon (@ )in the top-right corner of the widget.

2. Inthe Widget Settings pane, replace the existing title with a new one, and
then click Save.

<tile content> Displays a preview of the widget.

For the report widgets, the Cls displayed in the preview are grouped by CI
Type, or by attribute, according to the type of grouping you have defined for the
report.

« If the report has no grouping by attribute defined, then the Cls displayed in
the preview are grouped by CI Type.

« If the report has a grouping by attribute defined, then the Cls displayed in
the preview are grouped by attribute.

« If the report has more than one grouping by attribute defined, then the Cls
displayed in the preview are grouped by the first attribute from the top.

Important: Only the first nine groups are displayed in the preview.

The preview contains a graph and a legend.
« <Graph>. Displays the number of grouped Cls (maximum nine groups).
« <Legend>. Displays the legend for the graph.

In the following situations, the legend displays a new category called Other
Cls:

o When the total number of Cls is larger than the number of Cls grouped
by attribute. In this case, the Other Cls category includes all the Cls
that are not grouped by attribute. (Other Cls = The total number of Cls -

CMS Ul (2018.08) Page 121 of 446



CMS Ul Guide
Use

Ul Element (A-Z) Description

The Cls grouped by attribute).

o When the Cls are grouped by attribute, and there are more than nine
groups. In this case, the Other Cls category includes all the remaining
Cls (grouped by attribute and also the ones that are not grouped by
attribute). (Other Cls = The total number of Cls - The number of Cls
from the nine groups displayed in the legend).

Re-size widget. Changes the size of the widget. To do this, click the icon and
then drag the mouse.

About Window

From CMS Ul, clicking Help . - About opens the About window, which contains two tabs:

o ABOUT - Provides CMS version, copyright, and third-party notice information.

You can click » to expand the Version section to display more specific component information for

CMS Ul, UCMDB Server, and Content Pack. The component version information is displayed in
the xx.x.xx format, where xx.x is the internal reference number, the last xx is the build number. To
collapse the Component Information section, click =~

o LICENSE - Provides license summary and related information.
o License Status - Is license status compliant, noncompliant, or expiring in a number of days.

Clicking the link after License Status opens the License Summary Report page. For details, see
"License Summary Report" below.

o Total Units - Provides data about units of licenses consumed and units available, as well as the
units consumption rate.

o Is UCMDB Foundation — Indicates whether you have Foundation license or not.

o The Managed Data Repository (MDR) usage is displayed according to the Available 3rd Party
Integrations you have in UCMDB.

o OSs managed by CM usage displays the number of OSls belonging to the results of the
managed in CM views.

License Summary Report

The License Summary Report displays the following information:
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« Only Instant-On license is listed even though you have had some licenses installed when you
worked with the previous version. The license issued for version 10.33 (and earlier) are not
compatible with UCMDB 2018.08 and they are not visible.

« The Advanced UD license usage is not yet displayed even if there are discovered OSls in your
UCMDB.

« OSs managed by CM usage displays the number of OSlIs belonging to the results of the managed
in CM views.

« The Managed Data Repository (MDR) usage is displayed according to the Available 3rd Party
Integrations you have in UCMDB.

« Total Units usage provides data about units consumed and units available, as well as the units
consumption rate.

. Inthe Available Licenses section, you can click % to select whether you want to display All
licenses or licenses of Active or Expired status. You can also click [Tl to select columns you want

to display. By default all columns are displayed.

« You can click Export License Consumption Details Report > in the upper right corner of the

page, then select one of the following options to export the detailed report in Excel format:
o Unit Consumption Details
o MDR Consumption Details

You can open the exported Excel report and review the details, for example, the device name that is
identified.

The table below describes each column in the exported Unit Consumption Details report:

Column Description

instance_type Instance type of the resource. Valid values include server, workstation,
network, docker, and so on.

Units Units consumed.

Cl_type Cl type attribute value of the resource.

global_id Global ID attribute value of the resource.

name Name attribute value of the resource

node_role Whether the resource is of node type, but not of network or storage

device, and what node type the resource is: server or workstation. Value
example: [server, virtualized_system] or [virtualized_system] fora
server resource; [desktop, virtualized_system] for a workstation
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Column Description

resource.
os_family OS family of the resource: Windows, Linux, MacOS, or others.
discovered_os_ The discovered OS version of the resource (if applicable).
version
create_time Time the record for the resource is created.
created by Indcates who created the record of the resource.

Value example: UCMDBDiscovery: Host Connection by Shell
indicates that the record is created by the Universal Discovery Host
Connection by Shell job.

last_modified time Time the record of the resource was last updated.

data_updated_by Indicates the discovery job that last updated the record of the resource.

Value example: UCMDBDiscovery: Host Connection by Shell

root_ Is the CI candidate for deletion or not. Default: FALSE
iscandidatefordeletion

The table below describes each column in the exported MDR Consumption Details report:

Column Description

Integration name Name of the integration point.

Adapter name Name of the adapter used in the integration point.
Is Free Is the integration available free of charge or not.
Used MDR license: Number of MDR licenses used.
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Search Functionality

You can quickly locate different types of resources using the Search functionality. The following
options are available:

« Configuration Item. Allows you to search for a Cl. The search results are opened directly in the
Configuration Item Search module.

» Queries and Models. Allows you to search for queries and models. The search results are opened
directly in the Resource Manager module.

« Views and Reports. Allows you to search for views and reports. The search results are opened in
the Resource Manager module or in the Topology Map.

« Reconciliation. Allows you to search for a Cl and to view all its changes. Also, you can view the
reason why the Cl was changed. This includes a list of identification candidates, and the reasons
for matching the searched Cl with them. For detailed information about Reconciliation Analyzer,
see "Working with the Reconciliation Analyzer" on page 133

How to search for a Configuration Item

You can search for a Cl directly from the CMS Ul. This operation opens the Configuration Item Search
module with the search results page displayed.

To search for a Cl, follow these steps:

1. Inthe Top Search Bar, select Configuration Item from the drop-down list of available options.

2. Type atext string in the search field, and then select the required CI from the suggestions list or
press Enter.

Note: The suggestions list is limited to 10 items.

The Configuration item Search module opens and the search results page is displayed.

How to open a resource in the Resource Manager module directly

You can search for a resource directly from the CMS Ul. This operation opens your search results in
the Resource Manager module. The following types of resources are available:
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e Queries
« Views

« Models
To search for a resource and to open it in the Resource Manager module directly, follow these steps:

1. Inthe Top Search Bar, select Queries & Models or Views & Reports from the drop-down list of

available options.

2. Type atext string in the search field, and then select the desired resource from the suggestions list
or press Enter.

Note: The suggestions list is limited to 10 items.

The Resource Manager module opens and the search results are displayed. For detailed information
about Resource Manager, see the Resource Manager.

How to open a report or a view in the topology map directly

To quickly open areport or a view in topology map directly using the search functionality, follow these
steps:

1. Inthe Top Search Bar, select Views & Reports from the drop-down list of available options.

2. Type atext string in the search field.

3. Hover the mouse over an auto suggestion string, and then click the quick open icon (£b).

Note: The suggestions list is limited to 10 items.

The selected resource opens in the Topology Map directly. For detailed information about topology
map, see "Working with the Topology Map" on page 128

Add a UCMDB Browser widget to the Home page

To add a UCMDB Browser widget to the Home page, follow these steps:
1. InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click Home.

2. Click the Add New Widgeticon (o) to display the Add a New Widget pane.
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3. Select UCMDB Browser Widget from the drop-down list of available widget types.

4. Click the Search icon (Q ), enter your search terms in the Search box, select a Cl from the

suggestions list, and then press Enter.
5. Choose a Cl from the list of search results.

6. Select the desired UCMDB Browser widget from the drop-down list of available UCMDB Browser
widgets.

7. (Impact Simulation widget only) Select a severity level.

8. Select the UCMDB Groups for which you want to make this widget visible from the drop-down list
of UCMDB Groups.

| Note: This step can be performed only by the users with Administrative privileges.

9. Click the Save button to add the UCMDB Browser widget to the Home page.

Note: Toremove a widget from the Home page, click the X button.

Add a report widget to the Home page
To add a report widget to the Home page, follow these steps:
1. InCMS UlI, click the Menu icon (E) to expand the CMS Modules pane, and then click Home.

2. Click the Add New Widgeticon (o) to display the Add a New Widget pane.

3. Select Report from the drop-down list of available widget types.

4. Click the Search icon (Q ), enter your search terms in the Search box, and then select a report

from the suggestions list.

5. Select the UCMDB Groups for which you want to make the report widget visible from the drop-
down list of UCMDB Groups.

| Note: This step can be performed only by the users with Administrative privileges.

6. Click the Save button to add the report widget to the Home page.

| Note: Toremove a widget from the Home page, click the X button.
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Run a Walk-through

Walk-throughs provide step-by-step instructions that enable you to complete an end-to-end use case

by yourself. To launch a walk-through, click the button on the Home page, select one of the

available walk-throughs, and then follow the step-by-step instructions.

The following table describes the walk-through user interface elements.

Ul Element (A-Z) Description
Next. Proceed to the next step. The Next button displays your progress
Next 2/6 through the walk-through (for example, 2/6 means that two steps are

completed from a total of six steps).

Important: After completing an action described in a step, you have to
click the Next button.

Back. Go back to the previous step.
Back

n Last. Ends a walk-through.

] Skip. Allows you to close the walk-through, and gives you the possibility to
Skip continue your current activity.

@ Beacon. Appears when a step is incorrectly performed, when you press
Enter, or when you click the X button on a tooltip. Hovering your mouse over

the @ button opens a tooltip that displays the current step that has to
be performed, and allows you to continue the walk-through.

Working with the Topology Map

The Topology Map provides a graphical display of a view. All the Cls in a given layer of the view are
represented by icons together with connecting links that represent relationships between Cls. If there is
more than one relationship between the same two Cls, only one connecting link is displayed. The
connecting link is thicker, with no direction. To view all the existing relationships between the same two

Cls, click the connecting link, and then click the Configuration Item Details button ( ) to display
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the CI Links pane. In the CI Links pane, you can view the number of relationships between the two Cls,
relationships types and directions.

The topology map is automatically updated dynamically with changes in the IT Universe data, such as
new Cls discovered by the Data Flow Management process.

The Topology Map can display up to 200 objects in Internet Explorer and 2000 objects in other
browsers. Layers in views that contain more than this number of items, are split into chunks of 200 (in
Internet Explorer) or 2000 (in other browsers) Cls. If an object on the Topology Map has an additional CI
layer beneath it, a count indicator above the Cl icon displays the total number of Cls in all the sublayers
under it.

Display the Topology Map for a view
To display the Topology Map for a view, hover the mouse over the view's widget, and then click the

Map mode icon (&r‘:) in the top-right corner of the widget.

Tip:

« To switch between displaying the view in map mode and text mode, click the Map/Text toggle

button(ll"all‘ai::II O TE)(T)_

« Toopen areport in the Text mode directly, click the report widget in the Home page.

Navigate the Topology Map

The toolbar at the lower left of the Topology Map enable you to change the magnification level of the
Topology Map, quickly navigate around a large Topology Map, and configure the Topology Map.

-
"4

« Click the Fit to Screen icon ( ) to expand or shrink the Topology Map so that all Cls fit in the

pane.

o Click the Zoom Out ( )orZoom In ( )icons to zoom out or zoom in the Topology Map.

« Click the Original Size icon ( ) to return the Topology Map to its original zoom level.
L1

« Click the Overview icon ( ) to display the quick navigation map. The quick navigation map

overlays a selected area (which represents the currently displayed area of the Topology Map) over a
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representation of the whole Topology Map. You can drag and resize the selected area in the quick
navigation map to zoom in or out and to jump directly to a particular part of the Topology Map.

Configure the Topology Map

Change the layout of the Topology Map

To change the layout of the Topology Map, click the Layout Settings icon ( )in the toolbar. Then,

select one of the following options from the Layout drop-down list:

« Hierarchical layout.
« Orthogonal layout.
« Radial layout.

« Circular layout.

« Treelayout.

« Organic layout.

« Balloon layout.

« Swimlanes layout.

Change the grouping of the Topology Map

To change the grouping of Cls in the Topology Map, click the Layout Settings icon ( )in the
toolbar. Then, select one of the following options from the Grouping drop-down list:
« None.

o ClType.

Note: When you group the Cls by CI Type, the default layout of the Topology Map is Organic,
and you cannot change it. The Change Layout option is not visible.

When you change the grouping to None, the Change Layout option is available, and the
Organic layout is selected.
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Work with Cls on the Topology Map

Search for Cls

To search for a specific Cl or for all Cls of a single type in a Topology Map, follow these steps:

1.

Click the More icon (°) to expand the More menu, click the Locate Cl icon ( ), and
then click the Locate Cl search box.

To view all Cls of a certain Cl Type, select the CI Type from the drop-down list under the search
box.

To search for a specific Cl, enter its Global ID in the search box, and then select the CI from the
drop-down list under the search box. Or, enter the ClI label in the search box, and then select the
desired CI from the drop-down list.

View CI details

To view detailed information about a Cl, follow these steps:

1.

Search for or drill down to the relevant CI ( to drill down to the CI, double-click on the relevant
nodes in the Topology Map until the correct layer is displayed).

(@
Click the Cl to display the Configuration Item Details button ( ), and then click the button
to display the Cl details pane.

Add layers of Cls

To add a layer of Cls to a Topology Map, click the More icon (°) to expand the More menu, click

the Add layers icon ( ), and then select a layer from the list. If the layer that you want to add is

not included in the list, click More Layers to view the complete list.

Note: The Topology Map supports up to 10 layers.

Get related Cls

To identify the Cls that are related to a specific Cl, follow these steps:
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1. Search for or drill down to the relevant Cl ( to drill down to the ClI, double-click on the relevant
nodes in the Topology Map until the correct layer is displayed), and then click the CI.

Note: The related Cls functionality does not work if you select more than one CI.
2. Click the More icon (°) to expand the More menu, and then click the Get Related icon (

)

3. Click onaCl Type to display all the related Cls of that Cl Type, and then select the Cls that you
want to view in the Topology Map.

Tip: You can also search for specific Cls by typing the CI label in the Filter search box.

4. When you have selected all the related Cls that you want to view in the Topology Map, click
APPLY. Cls that are added to the Topology Map (that is, related Cls that are not in the currently
displayed View) are displayed in purple.

Note:

« If youclick the Get Related icon after you have added some related Cls to a Topology Map,
the related Cls that you added are no longer selected. However, they will remain on the
Topology Map until you click CLEAR ALL.

« If you add some related Cls to a Topology Map that already displays some related Cls, both
sets of related Cls are displayed together. To clear the Topology Map of the existing related
Cls, click CLEAR ALL before you add the new set of related Cls.

View the CI Types of the Cls

To view the Cl Types of the Cls, Zoom Out the Topology Map.

View the Core Properties of a Cl

To view the Core Properties of a Cl, search for or drill down to the relevant Cl, and then Zoom In the
Topology Map.

The following information is available for each ClI:

e Clicon

« Clname
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o ClType
. UCMDBID

o Maximum three Core Properties

A maximum of three Core Properties are displayed for the each ClI, according to the following
priorities:

o The properties that are specific for the Cl Type have the highest priority.
o Special or calculated attributes, according to the Cl Type:

« ForNode Cl Type: Memory Size, Discovered Model, Discovered OS Name
« For Running Software Cl Type: Application Category, Discovered Product Name

o ForBusiness Element Cl Type: Last Modified Time, Business Criticality

Note: The order in which the Core Properties are presented is the one listed above and cannot
be configured.

The following Core Properties are not displayed for a Cl:
o Name

o Display Label

o Attributes with empty values

o Attributes that are not visible

Configure the Core Properties to be displayed for a Cl

To configure the Core Properties to be displayed for a Cl in the Topology Map, follow these steps:

1. InUCMDB, go to Modeling > Modeling Studio.

2. Inthe editing pane, right-click the required query node and select Query Node Properties.
3. Click the Element Layout tab.

4. Select the attributes you want to include in the query result, and then click OK.

Working with the Reconciliation Analyzer

Note:
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« Reconciliation Analyzer is available only for users with Server Administrator Privileges, or
for users with Discovery and Integrations Admin role.

« The amount of memory (RAM) necessary for Reconciliation Analyzer to work properly is as
follows:

o Minimum: 16 GB

o Recommended: 24 GB

Reconciliation is the process of identifying and matching entities from different data repositories (for
example, UCMDB Universal Discovery, ticketing, or BSM). This process is designed to avoid
duplicate Cls in UCMDB. For detailed information about the reconciliation process, see
"Reconciliation" in the Data Flow Management section in the UCMDB Help.

The Reconciliation Analyzer helps you understand how the reconciliation process works. By using this
option, you can find what happened with a Cl that may have merged with another Cl. You can view the
following information:

« All the changes made to the searched ClI (create, update, or remove ClI)

« Thereasons why the Cl was changed. This includes a list of identification candidates, and the

reasons for matching the searched CI with them

The changes are listed in chronological order, grouped by reconciliation Operations. The most recent
operation is displayed on top of the page. You can view the following information for each reconciliation
operation:

« The type of operation performed: created, modified, or removed

« The date and time when the operation was performed

« Alist of changed attributes. For each changed attribute you can view the attribute name, the
previous value of the Cl attribute (before the change), and its new value.

Note: Reconciliation Analyzer displays only the changes that are performed after the
Reconciliation option is enabled. For detailed information about how to enable the
Reconciliation option, see " Enable the Reconciliation option" on the next page.

If some reconciliation operations are performed and the Cl is not changed, then those operations will
not be displayed the Reconciliation Analyzer module.
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Enable the Reconciliation option

The Reconciliation option is hidden by default. To enable or to disable the Reconciliation option,
follow these steps:

From JMX Console:

1. OnUCMDB server, go to JMX Console > UCMDB:service=Settings Services >
setGlobalSettingValue.

2. Inthe name field, enter cmdb.recon.analyzer.enabled.

3. Inthe value field, enter:
o true: if you want to enable the Reconciliation option
o false: if you want to disable the Reconciliation option

4. Click Invoke.

5. Restart the UCMDB server.

From UCMDB Ul:

1. On UCMDB Ul, go to Administration > Infrastructure Settings Manager.
Locate the Reconciliation Analyzer setting.
Set the value to True to enable Reconciliation Analyzer, False to disable Reconciliation Analyzer.

Save the change.

o M 0 b

Restart the UCMDB server.

View the list of operations that were applied to a Cl

To view the list of operations that were applied to a Cl, follow these steps:

1. Inthe Top Search Bar, select Reconciliation from the drop-down list of available options.

2. Type atext string in the search field, and then select the desired Cl from the suggestions list.

Note:
o The search can be performed only by Name or UCMDB ID.

o The suggestions list is limited to 10 items.

The Reconciliation Analyzer module opens, and all the changes made to the Cl are displayed.
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Display more information about a reconciliation operation

To view more information about a certain operation that was done for a Cl, follow these steps:

1. Inthe Top Search Bar, select Reconciliation from the drop-down list of available options.
2. Type atext string in the search field, and then select the desired Cl from the suggestions list.

3. Click the desired operation to display more information about it. The following details are
displayed:

o Changer. The source of the incoming data

o Operation ID.The operation ID. This can be used further to investigate the logs for more
details.

o Customer ID. The customer ID

o Details. Allows you to view the list of identification candidates, and the reasons for matching
the searched CI with them

View the list of identification candidates, and the reasons for matching
the searched Cl with them

To view the list of identification candidates, and the reasons for matching the searched Cl with them,
follow these steps:

1. Inthe Top Search Bar, select Reconciliation from the drop-down list of available options.
2. Type atext string in the search field, and then select the desired CI from the suggestions list.

3. Click the desired operation, and then click the Details button.

4. Click a Cl in the Identification candidates column. More details about the ClI are displayed, and
in the Match reason column you can view why the Cls were matched.

Tip: To go back to the list of operation, use the web browser's back button.

Remove old data of Cls from SOLR

Once you have enabled Reconciliation Analyzer, the scheduled job Clear Recon Analyzer index runs
every 15 days by default to remove the old data of Cls from Solr. To reschedule the job, you can go to
UCMDB Ul > Administration > Scheduler, locate the job and reschedule it.

You can also configure how many days the documents from the Reconciliation Analyzer are kept. To
do so, do either of the following:
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From UCMDB Ul:

1. Goto Administration > Infrastructure Settings Manager.
Locate the Remove old documents from Reconciliation Analyzer setting.

In the Value field, type the desired days.

> w0 D

Save the change.

The change takes effect immediately.
From JMX Console:

1. On UCMDB server, goto JMX Console > UCMDB:service=Settings Services >
setGlobalSettingValue.

2. Inthe name field, enter cmdb.recon.analyzer.keep.index.days.

3. Inthe value field, enter the desired days. (Default: 15)

4. Click Invoke.

Configuration Item Search

The Configuration Item Search option in the CMS Modules navigation pane opens the Configuration
Item Search module, which is based on the Search module from the previous UCMDB Browser, with
enhanced and extended search capability.

This section contains the following:
Search and Search Engine ... 138
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Search and Search Engine

Search

To access the Search module, use one of the following methods:

« InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click

Configuration Item Search.

« InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click
UCMDB Browser.

The Search module is automatically displayed when you access the UCMDB Browser module.

Enter a text string to perform a search in the database for any ClI.

Opening the Search module from anywhere else in the UCMDB Browser module displays the results of
your most recent search. To perform a new search, click the <product name> section in the upper left
corner of the UCMDB Browser module window, then enter a text string in the Search field and press
Enter.

Note: Results are displayed in thumbnail view by default. To switch to grid view, click To

return to thumbnail view, click

The first page of search results is presented once the search mechanism has returned at least the
number of results defined for page display or if the search has been completed. If the first page has
been displayed but the search is still in progress, the progress icon on the right of the filter combo-box
indicates that the search has not yet completed.

Each thumbnail includes:

« the Cl's name, icon, and type

« the Cl's color category

Note: You can change the Cl's color category simply by clicking the upper right corner of the
Cl's thumbnail, and selecting a category.
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« the Cl's discovery indicator, if one exists for the Cl. For more information, see "Discovery

Indicators" on page 417.

« the Cl's classification

While searching, you can specify a main Cl type and a related Cl type (as well as attribute conditions

for these Cl types), and then save these results as a basic report for future use. For more information,

see "Reports" on page 229.

Hovering your mouse over a Cl, allows you to access the following:

1. The Context Menu

Clicking the Context Menu ~ button allows you to select one of the following:

Note: Only the widgets that you have permission to view will be displayed.

Overview
Properties
Environment
History
Impact
Simulation
Policy
Change
Request
Incidents

Problems

Monitoring

CMS Ul (2018.08)

Displays Cl Overview mode for all of the widgets that contains information
about the selected ClI.

Displays the Properties widget for the selected Cl. For more information, see
"Properties Widget" on page 367.

Displays the Environment widget. For more information, see "Environment
Widget" on page 349.

Displays the History widget. For more information, see "History Widget" on
page 353.

Displays the Impact Simulation widget. For more information, see "Impact
Simulation Widget" on page 358.

Displays the Policy widget. For more information, see "Policy Widget" on
page 363.

Displays the Change Request widget. For more information, see "Change
Requests Widget" on page 333.

Displays the Incidents widget. For more information, see "Incidents Widget" on
page 360.

Displays the Problems widget. For more information, see "Problems Widget" on
page 364.

Displays the Monitoring widget. For more information, see "Monitoring Widget"
on page 363.
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Stakeholder

Dependent
Services

Security

Defects

Business
Topology

Storage Data

Dynamic (by
name)

Discovery
Progress

Get Related

Displays the Stakeholder widget. For more information, see "Stakeholder
Widget" on page 370.

Displays the Dependent Services widget. For more information, see
"Dependent Services Widget" on page 338.

Displays the Security widget. For more information, see "Security Widget" on
page 368.

Displays the Defects widget. For more information, see"Defects Widget" on
page 336.

Displays the Business Topology widget. For more information, see "Business
Topology Widget" on page 331.

Displays the Storage Data widget. For more information, see "Storage Data
Widget" on page 371.

Displays dynamic widgets that contain the selected CI. For more information,
see "Dynamic Widgets" on page 346.

Displays the Discovery Progress widget. For more information, see "Discovery
Progress Widget" on page 339.

Displays the Get Related widget. For more information, see "Get Related
Widget" on page 351.

2. The Settings menu #’

Clicking the Settings icon allows you to access the following:

o Assisted Modeling. See Assisted Modeling.

o Notifications. See "Notifications" on page 418.

o Choose Category. See "Assign Color Categories" on page 407.

o Create Service Model. See "Model a Business Service Starting from a Specific Entry Point"

on page 260.

Advanced Search

1. Onthe main search page, click Advanced Search, or hover the mouse over the Search module
and click Advanced Search.

2. Select the main Cl Type, and then click Next.
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To quickly locate a Cl type, you can filter the list of CITs by entering a text string, or click one of
the favorite Cl types above the list.

Note: You can add a custom favorite Cl Type, by assigning the CMS_BROWSER_
SEARCH qualifier to the Cl Type. For details on how to add a qualifier to a Cl Type, see "
Qualifiers Page" in the Modeling section of the UCMDB Help.

3. (Optional) Select an attribute condition for the main CIT (including an operator and value). To add
additional attributes, click [+] Add attributes. Click Next to select a related Cl type.

Note:

o When you use the Contains operator, the different values added to an attribute should be
separated by comma, and listed in one field. This is because the Contains operator
supports only one value in the UCMDB, and in the UCMDB Browser module the different
values that are added to an attribute are split into multiple conditions.

o When you use the In operator, the different values added to a string attribute should be
separated by comma, and listed in one field.

4. (Optional) Select a related Cl type from the tree, and then click Next.

To quickly locate a Cl type, you can filter the list of CITs by entering a text string, or click one of
the favorite Cl types above the list.

To clear this field completely, click Deselect.

5. (Optional) Select attributes for the related Cl type (including an operator and value). To add
additional attributes, click [+] Add attributes.

Note:

o When you use the Contains operator, the different values added to an attribute should be
separated by comma, and listed in one field. This is because the Contains operator
supports only one value in the UCMDB, and in the UCMDB Browser module the different
values that are added to an attribute are split into multiple conditions.

o When you use the In operator, the different values added to a string attribute should be

separated by comma, and listed in one field.

6. Click Search.

Note:

The following enhancements are supported on UCMDB 10.21 CUP1 or later versions:
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« Thefavorite Cl Types that do not have instances are grayed out.

« Only the CI Types that have instances are displayed in the tree. The CI Type's count
information is displayed in parentheses.

« Only the CI Types that have valid links for a selected Cl Type are displayed in the Related
Cl Type tree.

Most Visited

The Most Visited screen is accessed by hovering your mouse over the Search tab and selecting Most
Visited. This screen displays the eight most often visited Cls. A visited Cl is one whose details are
fetched from the server, regardless of how it was accessed, for the current logged-in user and state.
Each thumbnail includes:

« the Cl's name, icon, and type

« the last date that the Cl was selected

« the Cl's classification

« the Cl's color category

Note: You can change the Cl's color category simply by clicking the upper right corner of the
Cl's thumbnail, and selecting a category.

Clicking a thumbnail opens the selected Cl in the UCMDB Browser module.

Most Searched
The Most Searched screen is accessed by hovering your mouse over the Search tab and selecting
Most Searched. This screen displays the eight most frequently used search terms, for the current
logged-in user and state. A thumbnail is displayed for each item, containing information that is accurate
to the last time the search was performed (which may not reflect the current state). Each thumbnail
includes:

« thesearchterm

« the last date that the search was performed

« the total number of Cls found as the result of the search

« up to three ClI classification groupings

Clicking a thumbnail executes the search on the specified term.
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Note: The Most Visited and Most Searched screens will only preserve the correct data if a user
enters a username with the same case that has been defined in the LDAP settings. To force a user
tolog in with the correct case, set Is case-sensitivity enforced when authenticating with
LDAP=True in the LDAP General category in the Infrastructure Settings Manager in UCMDB.

When you are viewing the details of a Cl in the context of any widget, by default you are viewing the
details in Overview mode. You can switch to the Navigation Context mode to see:

« the search results, if the Cl was selected from the Search Results list

« the most visited Cls, if the Cl was selected from the Most Visited screen

« all Cls inthe map, if the Cl was selected from the Service Modeling map.

Configure the Enhanced Search Engine

The Enhanced Cl search engine translates free text queries to TQL queries, with much better
performance and accuracy than the legacy search engine and flexible searching language. The syntax
of the search queries is based on the class model.

Note: The Enhanced Cl search engine does not support any of the class model configurations
used by the legacy search engine.

The search engine can be configured in the following three areas:

« Indexing. Configure what is indexed, which Cl types are "searchable", which attributes are
"searchable", and what are types of the attributes. This configuration is performed with the Search_
Indexer_Configuration_XML and Search_Ranking_Configuration_XML files.

This configuration file includes a list of class types that are indexed and a list of attributes for each
one of the class types. This configuration influences the manner in which the search by property
condition is performed.

« Parsing. Configure class model synonyms. Synonyms translate the user input string query into a
graph structure, TQL. This configuration is performed with the Search_Parser_Configuration_
XML file.

This configuration file includes a set of class synonyms, attribute synonyms, date synonyms,
relation synonyms, and a set of redundant words.

Note: The list of redundant words must contain only single words, with no spaces (no phrases
are permitted).
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« Ranking. Configure which ClI types are presented and the order of presentation. Prioritization is
according to class model. This configuration is performed with the Search_Ranking_
Configuration_XML file.

This configuration file contains a list of attributes that are associated with five data fields, called
data0, data1, data2, data3, and data4. These fields are prioritized, where data4 has the highest
priority and data0 has the lowest priority.

This configuration influences the order of Cls in the search results.

The CMS Ul can be used out-of-the-box without initial configuration of the search engine. However, if
an attribute is not in the Indexer or Ranking lists, it does not appear in the search results.

Modify the currently indexed list

Enable/Disable the Enhanced Search Engine

1. GotoJMX Console > UCMDB:service=Topology Search Services.

2. Choose one or more of the following operations:

o editindexerConfiguration —displays and enables editing of the Search_Indexer_
Configuration_XML file.

o editParserConfiguration —displays and enables editing of the Search_Parser_
Configuration_XML file.

o editRankingConfiguration —displays and enables editing of the Search_Ranking_
Configuration_XML file.

3. Foreach operation, enter the relevant customer ID and click Invoke.

For the enhanced search engine to work, it must be enabled in UCMDB. By default, it is enabled
(unless it was disabled during UCMDB installation).

To change the enable/disable setting:

1. GotoJMX Console > UCMDB:service=Settings Services > setGlobalSettingValue.
2. Inthe name field enter cmdb.search.enabled.

3. Inthe value field enter:
true: If you want the search enabled.

false: If you want the search disabled.
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4. Click Invoke.
5. Restart the UCMDB server.

Note: If you disable the Enhanced Search Engine, the UCMDB Browser module automatically
reverts to the legacy search engine.

Enable/Disable Searching for Federated Data

The enhanced search engine can be configured to perform searches on federated data. By default, it is
disabled. To enable searching for federated data, you must set the "federated search enable" flag to
True in the JMX Console and in the UCMDB Infrastructure Settings Manager.

Enable or disable searching for federated data (Enhanced Search Engine)

You can enable or disable searching for federated data when the Enhanced Search Engine is enabled,
in the JMX Console or in the UCMDB Infrastructure Settings Manager.

Enable or disable searching for federated data in the JMX console:

1. GotoJMX Console > UCMDB:service=Settings Services > setSettingValue.
2. Inthe name field enter cmdb.federation.search.enabled.
3. Inthe value field enter:
true: If you want to enable searching federated data.
false: If you want to disable searching federated data.
4. Click Invoke.
5. Restartthe UCMDB server.

Enable or disable searching for federated data in the UCMDB Infrastructure Settings Manager:

1. InUCMDB, go to Administration > Infrastructure Settings Manager, and choose General
Settings.
2. Inthe Name column, choose Federation in Search Engine Enabled.

3. Inthe Value column, choose True or False from the drop-down list.

4. Click Save 1,
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Enable or disable searching for federated data in the UCMDB Infrastructure
Settings Manager (Legacy Search Engine and widgets)

Follow the instructions in the section "Specify Data stores Used for Data Loading" in the Administer
section of the UCMDB Help.

Enable searching of federated Cls by Cl display name

To search for a federated CI by the ClI display name (or sub-string of the display name), the Cl type
must be assigned the qualifier CMS_BROWSER_SEARCH in the Cl Type Manager.

Specific Configuration Options

Configure Search by Data

In the Search_Ranking_Configuration_XML file, you can associate attributes of a Cl to a data field
according to the data field priority. This enables a search of the values of those Cl attributes and affects
the order of Cls returned in the search results.

Configure Search by Topology

In the Search_Parser_Configuration_XML file, you can configure relationship synonyms that
associate phrases with class types. For example, in the example below, the phrase "owned by" is
associated with the class type "person".

<relationship>
<synonym>owned by</synonym>
<className>person</className>
</relationship>

As a result of the above configuration, if the user enters the search query "all windows owned by John",
the search engine looks for all windows Cls that are connected to a Cl of type 'person' with the name
"John'.

Configure Search by Path

In the Search_Parser_Configuration_XML file, you can define compound classes by inserting a list
of class types. In the example below, all the class types in the <string> tag make up the compound
class, which triggers the search by path. If this list is empty, no search by path is initiated.

You can change the number of linked paths through which you want to search, starting from the original
search term. To do this, go to the Infrastructure Settings Manager in UCMDB and change the Search
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Engine Compound Depth setting to the value you want. For details, see "Infrastructure Settings

Manager" in the Administer section of the UCMDB Help.

<compoundClasses>
<string>msdomain</string>
<string>person</string>
<string>osuser</string>
<string>location</string>
<string>business_element</string>
<string>cluster</string>
<string>party</string>

</compoundClasses>

Configure Search by Cardinality Condition

In the Search_Parser_Configuration_XML file, you can define a set of cardinality synonyms that

associate phrases with cardinality types. For example, if you define

<cardinalitySynonym cardinalityType="MIN" cardinalityPhrase="with at least"/>

and then a user enters the search query "all NT with at least 2 CPUs", the search engine looks for all

Cls with class type 'NT' that have two or more Cls of type CPU related to them.

The out-of-the-box cardinality synonyms are as follows:

<cardinalitySynonyms>
<cardinalitySynonym cardinalityType="MIN"
<cardinalitySynonym cardinalityType="MIN"

cardinalityPhrase="min"/>
cardinalityPhrase="with minimum"/>

<cardinalitySynonym cardinalityType="EQUAL" cardinalityPhrase="with"/>

<cardinalitySynonym cardinalityType="MAX"
<cardinalitySynonym cardinalityType="MAX"
<cardinalitySynonym cardinalityType="MIN"
<cardinalitySynonym cardinalityType="MAX"

cardinalityPhrase="max"/>
cardinalityPhrase="with maximum"/>
cardinalityPhrase="minimum"/>
cardinalityPhrase="before"/>

<cardinalitySynonym cardinalityType="MAX_EXCLUDED" cardinalityPhrase="with

less than"/>

<cardinalitySynonym cardinalityType="EQUAL" cardinalityPhrase="with

exactly"/>
<cardinalitySynonym cardinalityType="MIN"

cardinalityPhrase="with at least"/>

<cardinalitySynonym cardinalityType="MIN_EXCLUDED" cardinalityPhrase="with

more then"/>
<cardinalitySynonym cardinalityType="MIN"
<cardinalitySynonym cardinalityType="MIN"
<cardinalitySynonym cardinalityType="MIN"
<cardinalitySynonym cardinalityType="MAX"
<cardinalitySynonym cardinalityType="NOT"

cardinalityPhrase="since"/>
cardinalityPhrase="from"/>
cardinalityPhrase="at least"/>
cardinalityPhrase="till"/>
cardinalityPhrase="without"/>

<cardinalitySynonym cardinalityType="MIN_EXCLUDED" cardinalityPhrase="with

more than"/>
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<cardinalitySynonym cardinalityType="MIN" cardinalityPhrase="after"/>

<cardinalitySynonym cardinalityType="MAX" cardinalityPhrase="with at most"/>

<cardinalitySynonym cardinalityType="MAX" cardinalityPhrase="maximum"/>

<cardinalitySynonym cardinalityType="MAX_EXCLUDED" cardinalityPhrase="with
less then"/>

<cardinalitySynonym cardinalityType="MAX" cardinalityPhrase="at most"/>
</cardinalitySynonyms>

Configure Search by Property Condition

This search is based on attribute synonyms. In the Search_Parser_Configuration_XML file, you can
define synonyms for the CI attribute names that are defined in UCMDB. In the following example, the
Cl attribute display_label has four different synonyms defined for it:

<attributeSynonym>
<synonym>name</synonym>
<attributes>
<attributeName>display label</attributeName>
</attributes>
</attributeSynonym>
<attributeSynonym>
<synonym>display label</synonym>
<attributes>
<attributeName>display label</attributeName>
</attributes>
</attributeSynonym>
<attributeSynonym>
<synonym>display</synonym>
<attributes>
<attributeName>display label</attributeName>
</attributes>
</attributeSynonym>
<attributeSynonym>
<synonym>label</synonym>
<attributes>
<attributeName>display label</attributeName>
</attributes>
</attributeSynonym>

Another type of search by property condition occurs when a cardinality synonym is followed by a
number, which can also include a unit. For example, if the user enters the search input text windows
with at least 4GB memory, since memory is a synonym for the attribute types memory_size and
nt_physical_memory as shown in the code example below, this triggers a search by property
condition.

<attributeSynonym>
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<synonym>memory</synonym>
<attributes>
<attributeName>memory_ size</attributeName>
<attributeName>nt_physicalmemory</attributeName>
</attributes>
</attributeSynonym>

<unit>
<multiplyBy>1073741824</multiplyBy>
<synonym>gigabytes</synonym>
<synonym>g</synonym>
<synonym>giga</synonym>
<synonym>gb</synonym>

</unit>

You can add additional synonyms for cardinality phrases, synonyms for attribute names, and
synonyms for unit types in order to refine this type of search. In the example above, the memory size
attribute is stored in bytes, and in order to search by gigabytes, the search engine uses the conversion
defined in the <multiplyBy> tag (this definition is provided out-of-the-box). In addition to the conversion
for gigabytes, out-of-the-box conversions are also provided for megabytes and kilobytes.

Note: Units and numbers are rounded according to the range definitions defined by the Use
Update Value Policy qualifier. For more information on setting range definitions, see "The Use
Update Value Policy Qualifier" in the Modeling section of the UCMDB Help.

Configure Search by Category

In the Search_Parser_Configuration_XML file, you can specify labels to be used when searching for
Cls. In the following example, the labels "category" and "color" enable you to search for the strings “all
windows color green” and “all servers category editable”.

<categoryLabelSynonyms>
<categorylLabelSynonym>category</categorylLabelSynonym>

</categorylLabelSynonyms>

<categoryColorSynonyms>
<categoryColorSynonym>color</categoryColorSynonym>

</categoryColorSynonyms>

Configure Class Name Conditions

In the Search_Parser_Configuration_XML file, you can create synonyms for class names. In the
following example, the synonym "windows" was created for the class name "nt".
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<classSynonym>
<synonym>windows</synonym>
<className>nt</className>

</classSynonym>

Configure String Replacement

In the Search_Parser_Configuration_XML file, you can configure string replacements. The code
example below enables the search engine to retrieve all nodes that have the attribute Host is virtual
set to True. The ClI property 'host_isvirtual' is a boolean property, and is true if the node is virtual, but
the user does not need to know this and this string replacement converts his search query without the
user knowing these details.

<replace>
<from>virtual node</from>
<to>node host_isvirtual true</to>
</replace>

String replacement can be implemented using the '%' wildcard character. With the following code
example, if the user enters the search query "linux nodes" or "linux machine", the search engine
converts this to "nodes version linux" and “machine version linux”, respectively.

<replace>
<from>linux %1</from>
<to>%1 version linux</to>
</replace>

Configure Enriching Capability

The enriching mechanism executes enriching queries over the search results. Enriching queries are
defined in two ways, one is user-defined and the other is based on existing folding rules.

The enriching mechanism reviews the Cls in the search results and extends the results by applying
each one of the enriching queries as a perspective over the Cl. The enriching process is executed
repeatedly, where after each execution search results are received and then enriched again by the
enriching TQLs, which in turn produces more search results. By default, this process is repeated 3
times, but this can be changed by means of the cmdb.search.enriching.depth parameter. For
instructions on configuring this parameter, see "Configure Repetition of the Enriching Mechanism" on
page 152.

User-Defined Enriching Queries

To create user-defined enriching queries:
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1. InUCMDB, go to Modeling > Modeling Studio and click New L:

2. From the drop-down list, select Query. The Query Definition editor opens.

3. Click Query Definition Properties £, The Query Definition Properties dialog box opens.
4. Inthe Type field, select Perspective from the drop-down list.

LLL]

In the Bundles field, click Select Bundles

From the Bundles list, select search_result_enriching_tqls and click OK.

Define the query according to your system needs.

® N o o

Define one of the nodes of the query as Set as Contact Query Node. The query definition is
similar to the perspective definition and therefore should include at least one contact node, where
the contact node is the ClI that should be enriched.

There are also two out-of-the-box enriching queries provided in the Modeling Studio. You can view and
edit them as follows:

1. GotoModeling > Modeling Studio, and select the Resources tab.
From the Resources Type drop-down list, select Queries.

In the list of queries, go to Search Engine > Enriching TQLs.

> w0 D

Under Enriching TQLs, choose one of the enriching queries. You can view it and edit it according
to you system needs.

Enriching Queries Based on Existing Folding Rules

As mentioned above, in addition to the user-defined enriching queries, there is an existing set of
predefined enriching queries based on folding rules.

To view, add, or edit enriching queries based on folding rules:
1. GotoModeling > Cl Type Manager.

From the CI Types drop-down list, choose Calculated Relationships.

In the list of Calculated Links, select Folding Rules (Configuration Manager).

A w0 b

Select the Triplets tab on the upper right. The list of Triplets appears.

From each one of the listed triplets there is an automatic mechanism that creates at run-time an
enriching query. It enriches the Target Cl type by the Source Cl type. In this case, the Target Cl
type is the contact node of the query.
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5. Toadd a new triplet, click Add |*.. If you select the forward relationship direction (from Source to

Target), the Target Cl type is enriched by the Source Cl type. If you select the backward
relationship direction (from Target to Source), the Source Cl type is enriched by the Target ClI

type.

6. Toedit atriplet, select the triplet in the list and click 24

Note: Todisable the use of folding rules, change the Specify whether Search Engine
Enriching should use folding rules setting in the Infrastructure Settings Manager to False.

Configure Repetition of the Enriching Mechanism

To configure the number of times that enriching is performed on search results:

1. GotoJMX Console > UCMDB:service=Settings Services > setSettingValue.
2. Inthe name field enter cmdb.search.enriching.depth.

3. Inthe value field enter the number of times that you want enriching to be repeated on search
results.

4. Click Invoke.
5. Restart the UCMDB server.

Note: Changing the cmdb.search.enriching.depth parameter value to a higher value can
introduce performance issues due to generating a large search result.

Version 10.31 added fuse cmdb.search.max.query.max.results to protect against performance
issues when the enriching process is done during CMS Ul Search. The number of results retrieved
during enriching is limited by the value specified for the cmdb.search.max.query.max.results
parameter. In case this setting is not present, the default is 1000.

When the max number of records retrieved through enriching
(cmdb.search.max.query.max.results value) is reached, the value of
cmdb.search.enriching.depth is no longer taken into consideration and the enriching process is
stopped.

Configure Redundant Words

There is a set of words that the search engine ignores when parsing the search query. To configure this
list, go to the Search_Parser_Configuration_XML file and go to the <blacklist> section. Add to or
edit the list as needed.

The current list of redundant words is a follows:
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<blacklist>
<blacklistItem>to</blacklistItem>
<blacklistItem>such as</blacklistItem>
<blacklistItem>with</blacklistItem>
<blacklistItem>for</blacklistItem>
<blacklistItem>or</blacklistItem>
<blacklistItem>a</blacklistItem>
<blacklistItem>the</blacklistItem>
<blacklistItem>like</blacklistItem>
<blacklistItem>in</blacklistItem>
<blacklistItem>and</blacklistItem>
<blacklistItem>of</blacklistItem>
<blacklistItem>if</blacklistItem>
<blacklistItem>an</blacklistItem>
<blacklistItem>on</blacklistItem>
<blacklistItem>linked</blacklistItem>
<blacklistItem>all</blacklistItem>

</blacklist>

Configure Search of Cls Changed in a Specific Time Period

In the Search_Parser_Configuration_XML file, there are a sets of words defined as month-name
synonyms and day-name synonyms. For example:

<monthSynonym>
<monthName>january</monthName>
<monthNumber>0</monthNumber>

</monthSynonym>

<monthSynonym>
<monthName>jan</monthName>
<monthNumber>0</monthNumber>

</monthSynonym>

<daySynonym>
<dayName>sunday</dayName>
<dayNumber>1</dayNumber>

</daySynonym>

<daySynonym>
<dayName>sun</dayName>
<dayNumber>1</dayNumber>

</daySynonym>

Values in the tags <monthNumber> and <dayNumber> should not be modified. These configurations
allow support of search queries like “all windows created last Sunday” and “all nodes changes between
August 8th 1980 and 25/5/2011”.
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Configure Date Format

The search engine supports two dates formats: day-month-year (DMY) and month-day-year (MDY),
which can be configured as follows:
1. GotoJMX Console > UCMDB:service=Settings Services > setSettingValue.
In the name field enter: cmdb.search.date.format.
In the value field enter the desired date format: DMY, MDY, or both.

Click Invoke.

o & w BN

Restart the UCMDB server.

Configure Autocompletion

In the Search_Autocompletion_Configuration_XML file, you can expand the CMS Ul's search
capabilities by configuring the UCMDB server to suggest matches for substrings of words in a search,
including ClI attribute values.

1. GotoJMX Console > UCMDB:service=URM Services > listResourceTypes and click
Invoke.

2. Click Topology AUTOCOMPLETION_CONFIGURATION.
3. Click Search_Autocompletion_Configuration_XML.

4. Enter the fields of classes that you want to index for autocompletion. Since the class name
supports inheritance, you can enter the following:

<supportedAutocompletionFields>
<autocompletionField>
<className>managed_object</className>
<attributeName>display label</attributeName>
</autocompletionField>
</supportedAutocompletionFields>

or, for example:

<supportedAutocompletionFields>
<autocompletionField>
<className>nt</className>
<attributeName>display label</attributeName>
</autocompletionField>
<autocompletionField>
<className>unix</className>
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<attributeName>display label</attributeName>
</autocompletionField>
</supportedAutocompletionFields>

5. Click Save resource.

Configure Query Search Filter

By default, the search algorithm filters out the queries that are too general. If you wish to tumn off the
filter, follow these steps:

1. GotoJMX Console > UCMDB:service=Settings Services > setSettingValue.
2. Inthe name field, enter cmdb.search.filter.queries.

3. Inthe value field, enter false.
Note: Enter true if you want to turn on the filter.

4. Click Invoke.

Perform a Full Reindex of All Cls

Use either of the following approaches to perform a full reindex of all Cls available for search in the
CMS Ul:

« GotoJMX Console > UCMDB:service=Topology Search Services and invoke the reindex()
method.

This method removes all Cls information stored inside the SOLR index files without removing any
internal SOLR files.

Note: You can also invoke the reindexCiType() method to re-index all the Cls of a given CI
type from the CMDB model database. For more information, refer to the JMX Reference
section of the UCMDB Help.

« Stopthe UCMDB server, delete the <UCMDB_Server_Home>/search folder, and then start the
UCMDB server.

The deletion of the folder forces a full reindex for all UCMDB customers and reverts the SOLR
configuration to the out of the box values. This process removes all internal SOLR files and hence
takes longer time than the previous one.

Note: In a High Availability environment, a full reindex can be performed only for embedded Solr.
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When the Solr is standalone, only the writer can alter the index.

Troubleshooting - Configure the Enhanced Search Engine

éJCN(IjDB doesn’t start because of the search subsystem manager. What
ol do?

Stop UCMDB, delete the folder <UCMDB installation folder>/search, then restart UCMDB.

If the search still does not start, disable it, as explained in "Enable/Disable the Enhanced Search
Engine" on page 144 and revert to the legacy search engine.

The search doesn’t return any results.
In the Topology Search JMX, invoke the following methods:

« restoreFactoryDefaults: This restores factory configuration for the search.

« reindex: This recreates a search index for Cls in the UCMDB model. Note, this can take up to
several hours for large databases (approx 1M Cls/hour).

You can also invoke the reindexCiType method to re-index all the Cls of a given ClI type from the
CMDB model database.

The search doesn't find Cl types that | want.

There are several different possible causes for this. Check the following:

« Check that the attribute and CI type are indexable according to the indexing configuration. If they
are not, add the class attributes configuration item as explained "Modify the currently indexed list"
on page 144.

« Check that you have correct synonyms defined for the class in Class synonyms.

« Check that rating and pageltemCount for this Cl| are non-zero. Check for rating in the Attribute
ranking and for pageltemCount in Presentable Cl types.

Cardinality conditions don't work or return incorrect results.

In addition to checking attribute synonyms, check that the attribute type is defined as numeric in
Indexing Configuration and that units configuration matches attribute units in Search_Parser_
Configuration_XML.
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The search presents too many unwanted results.

« Check if you are you using queries with natural language. This can limit results of the "best guess”
of what the user intended.

« If you need to be 100% certain that your query returns results only of one specific Cl type, use type:
ci-type filter in the query.

« If the two suggestions above don't help, contact the R&D team with your use case and status report
from JMX.

Problem with configuration - restore factory defaults

To restore the default configuration XML files from the factory content, go to JMX Console >
UCMDB:service=Topology Search Services and invoke the restoreFactoryDefaults() method.

Caution: This method overwrites the current configuration. You should back up the configuration
files before invoking it.

Logs and debugging info
Logs

search.log logs everything related to searches. Default log level is INFO, only statistics are printed.
The log level and number of logs are configured with the search.loglevel variable in
conf/llog/cmdb.properties.

Status Report

The topology search JMX status report displays all current configuration tables and statistics for the
search engine component. It is useful to include it when reporting issues to R&D.

Content of Solr Database

By default, the Solr search engine is embedded inside UCMDB server. To query it directly, go to JMX
Console > UCMDB:service=Topology Search Services and invoke the debugSolrQuery()
method.

Example queries:

« empty query returns all Cls

« "id:a6693cd46cfd1bdfab0c3551bac9289e" returns a Cl with cmdbld
a6693cd46¢cfd1bdfab0c3551bac9289e. This uses Solr/Lucene syntax.
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Using the Enhanced Search Engine

The UCMDB'’s powerful enhanced search engine analyzes the input search text to retrieve Cl data
from UCMDB. Based on the input search text, the search engine performs various types of searches
simultaneously to provide optimum and comprehensive results to the user. The search engine makes
extensive use of synonyms so you do not need to enter the precise name or data of the items you are
looking for.

Note: Starting from UCMDB version 10.31, the SOLR auto commit feature is enabled by default.
The soft auto commit interval is set at 3 minutes, this means that the Cls' changes are visible after
3 minutes. For more details, see the Administer section of the UCMDB Help.

To enhance your ability to obtain better search results, examples and explanations of the available
types of searches are provided here.

Note:

« The search engine is provided ready to use out-of-the box. However, it is highly configurable
and the various types of searches described here can be modified by the UCMDB
Administrator to meet your system needs. For more information on configuring the enhanced
search engine, see "Specific Configuration Options" on page 146.

« The enhanced search engine is not case sensitive.

« The free text search in the enhanced search engine can only be performed in English, other
languages are currently not supported. However, Cl names, attributes, and values in other
languages can be found by the enhanced search engine.

« When the enhanced search engine is enabled and you perform a search in the CMS Ul, the
maximum number of search results that are displayed and can be exported is 1200.

« When the enhanced search engine is enabled and a full reindex is in progress, the CMS Ul
automatically uses the legacy search engine. In this case, when you perform a search in the
CMS Ul, legacy search results are retrieved, and a notification message is displayed.

When the reindexing process has completed, the CMS Ul switches back to the enhanced
search engine.

Note that the legacy search results and features are different from the enhanced search
results.
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Simple Search

The simple search is the most basic type of search. The search engine searches for Cls according to
Cl data and synonyms for Cl data. Cl data can include class names and attributes.

Simple Search Examples

« If you enter all Unix or all business application, this triggers a search by class name, since Unix
and business application are class names. The search results include all Unix machines in the
system (when searching for all Unix), or all business applications in the system (when searching
for all business application).

« Ifyou enter all Windows, since windows is a class name synonym for NT, a search by class type
is triggered for all Windows PCs in the system.

For information on how to configure class name synonyms, see "Configure Class Name
Conditions" on page 149.

« If you enter Windows version 2008, since version is a synonym of the property discovered_os_
name, this triggers a search for all Windows PCs where the property discovered_os_
name = 2008.

« If you enter Windows with more than 4GB of memory, since memory is a synonym of the
property memory_size, this triggers a search by property condition for all Windows PCs with the
attribute memory_size > 4GB.

Note: Searches can be performed with any type of pre-defined unit, as explained in "Configure
Search by Property Condition" on page 148. Out-of-the-box definitions are provided for kilobyte,
megabyte, and gigabyte.

For more information on how to configure attribute synonyms, see "Configure Search by Property
Condition" on page 148.

« Ifyou enter all nodes changed last week, all Unix machines created today, or all Windows
changed since Aug 21st 2013, the search engine can interpret this correctly to yield appropriate
results.

For information on how to configure this search, see "Configure Search of Cls Changed in a
Specific Time Period" on page 153. For information on configuring date formats, see "Configure
Date Format" on page 154.
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Search According to CMDB Structure

Searches Based on Cl Relationships

If you enter Windows 2008, the search engine looks for Cls with the class name or property Windows
that have a related CI with a property value 2008. This could include, for example, a Windows server
connected to SQL server 2008.

For information on how to configure searching based on CI relationships, see "Configure Search by
Topology" on page 146.

Search by Path

« If you enter Windows London, this triggers a search that yields results of all Windows PCs in the
system that are connected directly or indirectly to the London CI.

For more information on how to configure this type of search, see "Configure Search by Path" on
page 146.

« Ifyou enter all Windows owned by John, the search engine returns all Windows PCs owned by
the user called John.

« Ifyou enter Oracle 16.55.158, the search engine yields search results with all Oracle servers in the
16.55.158.* IP address range.

Search by Cardinality Condition

Certain words or phrases trigger a cardinality search, such as with more than or with less than. If you
enter Windows with more than 5 CPUs, this triggers a search that yields results of all Windows PCs
with at least 5 Cls of type CPU connected to them. The term that follows the cardinality phrase must
be a class name or class synonym. In the example here, CPU is a class synonym.

For information on how to configure the search by cardinality, see "Configure Search by Cardinality
Condition" on page 147.

Note: The example above triggers a search based on Cl relationships, since inthe UCMDB
CPUs are modeled separately from servers (with direct relationship between them) and this
information may be transparent to the user.

Different Types of Search Results Based on the Same Input Text

As mentioned above, based on the input search text, the search engine can perform various types of
searches simultaneously. For example, if you enter Windows 2008, the search engine returns the
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following results:

« Cls with the class name or property Windows that have a related CI with a property value 2008
(search based on Cl relationships, as described above).

« All Cls that have both a property called Windows and a property called 2008.

« All Cls with the class name Windows and a property called 2008.

Special Support

Phrase Replacement
If you enter Linux machine, this triggers a search of all Unix machines with version = Linux.

For information on how to configure this search, see "Configure String Replacement" on page 150.

Search with Keywords

The search engine supports a set of pre-defined keywords that allow you to perform special searches.
The keywords are type, view, and query.

Search with type Keyword

You can use the type: keyword to filter search results. To do this, use the syntax: term1 type:term2.
For example, John type:windows return all Windows owned by John.

Search with view Keyword

You can search for Cls in a view by using the keyword view: followed by the view name. For example,
view:myView returns all Cls in the myView view result.

Note: The view name is case sensitive (in the UCMDB the user can define two views myView
and MyVIEW). Also, if the view name contains more than one word (separated with spaces) the
view name should be surrounded with quotation marks, for example view:"My view".

Search with query Keyword

You can also search for Cls in query results. This is similar to searching for Cls in view results, but for
the active query defined in UCMDB. For example, query:myQuery returns all Cls in the myQuery
result.
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Searches Based on Logical Operators

You can use a combination of conditions separated by logical operators. The search engine parses the
search input string from left to right without regards to the prioritization of logical operators, and not
according to the standard rules of logical operator prioritization. For example, A or B and C is treated
as (A or B) and C, and not as A or (B and C).

Examples

« If you enter Nodes owned by John or Jim, this triggers a search that yields results of all nodes in
the system with an owner John and all nodes in the system with an owner Jim.

« If you enter All Windows with more than 4 CPUs and with at least 4 GB memory, the search
engine yields results of all Windows PCs in the system that have both more than 4 CPUs and at
least 4 GB memory.

« If you enter All Windows versions not 2008, the search engine yields results of all Windows PCs
in the system that are not version 2008.

Enriching Search Results

Explanation and Examples

Since the user is not always aware of how IT entities are modeled in UCMDB, he may enter search
input text for one thing while his real intention was something else. The search engine has been
designed with an enriching mechanism that can "guess" the user’s real intention. For example, if the
user searches for the IP address 16.59.188.16, he may be actually interested in the IP’s connected
node, and so the enriching mechanism looks for all nodes connected to the IP address.

Itis possible that the user enters London, but what he really wants to know are the nodes at this
location. The enriching mechanism has been designed to look for all nodes connected to a location Cl,
so in this example the search engine would return all nodes connected to the London CI.

For information on how to configure the search engine's enriching capability, see "Configure Enriching
Capability" on page 150.

Federated Search

Explanation and Examples

All the types of searches described above are not performed on federated data. However, the search
engine contains some predefined hard-coded topological queries for performing searches on federated
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data. For example, if you enter myServer name and the server name is a federated Cl, there is a
federated query that tries to retrieve the Cl by its name. This TQL is executed for the Cl types node,
business element, and Cl collection, that have attributes of string type, and are marked with the
CMS_SEARCHABLE_ATTRIBUTE qualifier.

Note:

« The search on federated data (legacy search and widgets) can only be performed if the Show
federated search results setting is enabled. By default, the Show federated search results
setting is disabled.

« The search for federated Cls according to their display names (or sub-string of their display
names) is performed if the Cl type has been configured for this.

For instructions on enabling/disabling the search on federated data and enabling a search of a
federated Cl by the Cl display name, see "Enable/Disable Searching for Federated Data" on
page 145.

Note: The search on federated data (legacy search and widgets) can only be performed if the
Show federated search results setting is enabled. By default, the Show federated search
results setting is disabled.

The user can also retrieve data on relationships between federated Cls. For example, the user can
retrieve Cls by their IP address. If you enter 16.1.100.45 and this is the IP address of a federated Cl,
the search engine returns the actual node connected to this IP address.

Auto-Completion Search Entry Capability

Auto-completion capability is added to the search field and supports the following language entries:

« CI Type names and synonyms (for example: Windows=NT)
« Attribute names and synonyms (for example: version=DiscoveredOsName)
« Relationship names and synonyms (for example: linked to and located in)

« Cardinality phrases (for example with more than and at least)

Legacy Cl Search Engine

The search is performed in the most intuitive way possible using natural language, in the same manner
as modern search engines. The UCMDB Browser module currently supports searches for Cls
according to the following attributes:
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« ID

« Display Label

« Location

« IP Address

o Party (that is, owner)

« Any attribute marked with the CMS_SEARCHABLE_ATTRIBUTE qualifier. For details on how to
add this qualifier to an attribute, see "Adding the Search Qualifier to an Attribute" on page 166.

Note: By default, Cls with the MODELING_ENABLED qualifier are included in the search
results. To improve performance, you can exclude these Cls by setting Return Cls with
MODELING_ENABLED qualifier (legacy search engine) in the Infrastructure Settings
Manager to False. The CMS_SEARCHABLE_ATTRIBUTE qualifier on an attribute overrides
this setting.

« If searching for a term that matches a Cl Type Display Label, all the instances of the matching ClI
Type are displayed along with the results of the normal search.

The following are some search examples:
« Searching for John Doe, who is a project manager, yields all Business Elements and Nodes whose

owner is John Doe

« Searching for 172.16, which is the most significant part of an IP address, yields all Nodes with an
IP-address starting with “172.16” (that reside in that subnet)

« Searching for Ohio yields all Nodes residing in data centers located in the state of Ohio, USA
« Searching for Oracle yields all nodes and relevant running software related to the Oracle DB

« Ifthe DiscoveredOsName attribute is marked with the CMS_SEARCHABLE_ATTRIBUTE
qualifier, searching for Windows 2008 Server yields all Nodes with the DiscoveredOsName
attribute equal to Windows 2008 Server.

Search Results: Search results (in the current version — Cls) are the heart of the UCMDB Browser
module. Users get results of their search criteria, view relevant information at a glance, and, if required,
zoom into the results for a more detailed view. Search results include only Star Cl types, which are the
most important Cl types. Star Cl types receive special treatment from all (or most) widgets, thus
allowing users to receive more comprehensive and relevant information regarding them.

The following is a list of all Star Cl types:
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« Business Elements Related
o CI Collection

« Node

« Running Software (excluding Agent, Inventory Scanner)

« All Cl types with the Modeling Enabled or CMS_BROWSER_SEARCH qualifier

Composite Search: A Composite Search allows searching for any Cl Type (not just Star Cl types).
The search terms must be in the form: X + Y (two search terms, separated by the "+" character). Any of
the search terms can be a possible Cl Type display label (for example, "Windows + server_partial_
name" is equivalent to "server_partial_name + Windows").

Note: The Composite Search can only be performed if the Enhanced search engine is disabled.

Performing a Composite Search greatly increases the number of Cls that can be found in the UCMDB
Browser module. Searching is performed on the Cl Type represented by one of the search terms. The
other search term is considered as input for the normal search algorithm (described above). Federated
datais also searched, if federation is enabled from the configuration file. For details, see "Specify Data
Stores Used for Data Loading (legacy search engine)" on page 167.

The matching algorithm attempts to find an exact match on the first term. If nothing is found, it attempts
to find a partial match on the first term (for example, entering "dows" matches the "Windows" CI Type,
entering "nix" matches "Unix" Cl Type). If no results are found, the algorithm attempts to find an exact
match on the second term, and if nothing is found, it attempts to find a partial match on the second
term. If no results are found on the second term, the algorithm performs a search on both terms together
including the '+' character.

The Composite Search is not case sensitive. If there are multiple Cl Type matches, only the first one
will be returmed. If there are more than two terms (for example, a+b+c), the search is performed on the
entire expression, including the '+' character.

Search by Global ID: The user can perform a search for a Cl according to its Global ID. This is useful
in the case of federated Cls, where the Global ID and the CMDB ID differ. For example, if a Cl has a
Global ID with a value of daily%0Ant%0A1%0ACMDB_ADAPTER_
ID%3DSTRING%3Df37a5e73a861db7f417ba1ee4192544b%0A %03%03%03rmiron1%0Ant
%0A1%0ACMDB_ADAPTER_ID, you can use the Global ID value as search input in the UCMDB
Browser module.

Cl Refocus: Each Cl presented in the UCMDB Browser module, either as a search result or as part of
a specific widget, can be refocused by simply selecting it. Refocusing a Cl presents its data using the
information widgets.
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Note: When you refocus a Cl, the visualization mode in the preview panel automatically changes
from Overview to Navigation Context. You can switch back to the Overview mode to see the Cl's
details.

Adding the Search Qualifier to an Attribute

The CMS_SEARCHABLE_ATTRIBUTE qualifier can be added to a Cl attribute, thus enabling that ClI
to appear in search results performed in the UCMDB Browser module.

Note: This qualifier should not be added to an attribute that does not support the LIKE_IGNORE _
CASE operator (for example integer attributes). This qualifier should only be used with attributes
that support LIKE_IGNORE_CASE operator, such as string attributes.

To add the CMS_SEARCHABLE_ATTRIBUTE qualifier to an attribute:

1. InUCMDB, go Modeling > Cl Type Manager.

Select the class in which you want to change an attribute.

Select the Export to XML button in the upper right of the Cl Types tree.
Save the XML file containing the exported class on a local drive.

Open the XML file for editing.

o o M~ w BN

Find the section corresponding to the attribute to which you want to add the CMS_
SEARCHABLE_ATTRIBUTE qualifier.

An attribute section appears like this:

<Attribute name="attr_name" type="type">
<Attribute-Qualifiers>
<Attribute-Qualifier name="ATTRIBUTE_QUALIFIER1"/>
<Attribute-Qualifier name="ATTRIBUTE_QUALIFIER2"/>

</Attribute-Qualifiers>
</Attribute>

Note: If the attribute you want to edit does not have the <Attribute-Qualifiers> section, add
it as specified above.

7. Inthe <Attribute-Qualifiers> section, add the new <Attribute-Qualifier> tag as follows:
<Attribute-Qualifier name="CMS_SEARCHABLE_ATTRIBUTE”/>

8. Save the XML file.

9. Go back to the CI Type Manager.
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10.
1.
12.
13.

Select the class that you previously exported.
Select the Import from XML button in the upper right of the tree.
Select the XML file that you previously modified.

Wait for the import to complete. You will see a success notification message if the import process
is successful, or a failure message with errors if the process fails.

Specify Data Stores Used for Data Loading (legacy search

engine)

The flag federated_search_enabled is used to enable or disable the use of federation regarding
several operations in the UCMDB Browser module. If this flag is set to False (this is the default value),
the legacy search engine, and the widgets use only the local data store for gathering data. If this flag is
set to True, all data stores are used when running a search in the legacy search engine and the

widgets.

This flag is set on the UCMDB server.

Set the federated_search_enabled flag

1.

In UCMDB, go to Administration > Infrastructure Settings Manager, and choose UCMDB
Browser settings.

In the Name column, choose Show federated search results.

In the Value column, choose True or False from the drop-down list.

Click Save Ll

Limitations on Using Federated Data

The use of federated data has the following limitations:

« The Environment widget cannot load data from a completely remote ClI (that is, a Cl that exists only

in a remote data store and does not exist in the local data store).

For completely remote Cls, the Properties widget does not display properties calculated from
related Cls.
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Specify Cl Types Returned in Search Results (legacy search
engine)

In the legacy search engine, this Boolean configuration allows the user to control which Cl types are
returned in search results.

In UCMDB, configuring the Cl Types to be returned in Search Results is done through the Show only
results with Cl Types with CMS_BROWSER_SEARCH class qualifier setting. This Boolean
determines the Cl candidates for search. The default option (false) searches for Star Cls and also Cls
with the CMS_BROWSER_SEARCH qualifier. When this Boolean is true the search is conducted on
Cls with the CMS_BROWSER_SEARCH qualifier only.

Export Search Results

You can perform a search and export the search results to a CSV or Excel file.

To specify the attributes to be exported:

1. InUCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.

2. Dothe following:

o Inthe Name column, choose Minimal export of search results and choose True if you want
to export only the display label, class name, CI ID, and Global ID attributes for each CI.
Choose False if you want to export all attributes that are displayed in the Properties Widget.

Additional attributes can be excluded if they are marked in the Cl Type Manager in UCMDB.
For details, see the description of the Hide in Export Search Results qualifier in the Modeling
section of the UCMDB Help.

o Inthe Name column, choose Remove logical attributes (owner, location) from export of
search results and choose True to remove the owner and location attributes from the exported
search results.
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To export search results to a file:

1. Click Export results [= in the search results toolbar. The following options are available:
o Current page > XLS, XLSX, or CSV
o All pages > XLS, XLSX, or CSV

2. Click Open, Save, or Cancel.
The created file is named with the date and time that the export was performed.

Note: Inthe exported file, the ' character is added in front of any CI attribute name that begins with
one of the following characters: @ + - =.

How to Configure Custom Cl Types or Cl Attributes for
Enhanced Search

After adding a custom CI Type or a Cl attribute, in order to successfully search for the custom Cl Type
or attribute with the Enhanced Search feature, you need to perform some necessary steps to make
CMS UIUCMDB Browser and the Solr search engine aware of the new CI Type or Cl attribute.

To achieve this, edit configuration files by using the following JMX methods:
« editindexerConfiguration — This determines what gets indexed by the Solr search engine, if you
do not have the new CIT or attribute defined, then it will never be indexed in the first place.

« editParserConfiguration - This controls what synonyms you want to declare, so you can translate
custom words to TQL useful variables.

« editRankingConfiguration — This controls what is the order (ranking) in the data displayed in the
CMS UIUCMDB Browser module.

Let us use a custom CIT ts_ex as an example. ts_ex is not a child of any particular CIT, and has
important attributes like ts_id, ts_name and ts_version.

1. Add the custom CIT and its attributes to the indexer configuration by using the
editindexerConfiguration JMX method.

a. Onthe server, launch the Web browser and enter the following address:
https://localhost:8443/jmx-console.

b. Enterthe JMX console authentication credentials (Login name = sysadmin).
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c. Locate the editindexerConfiguration operation in the UCMDB:service=Topology Search
Services category.

d. Provide Customer ID (default: 1) and click Invoke.

In the returned result page, the Resource XML window lists all Cl types and the attributes that
are indexed.

e. Scroll down to the bottom and add the custom CIT and attributes by following the out-of-the-
box (OOTB) structure below:

<classAttributes>
<className><CIT></className>
<index>true</index>
<attribute><CI Attribute 1></attribute>
<attribute><CI Attribute 2></attribute>
</classAttributes>

In this case, add the following:

<classAttributes>
<className>ts_ex</className>
<index>true</index>
<attribute>ts_version</attribute>
<attribute>ts_id</attribute>
<attribute>ts_name</attribute>
</classAttributes>

Tip: Itis recommended to always add your customizations to the end of the XML file and
to keep the XML formatting, so that you will always save a valid and usable resource.

f. Save the change.

2. Add the custom CIT to the parser configuration by using the editParserConfiguration JMX
method.

Note: UCMDB is designed to parse a simple text string as a search request for the display_
label attribute on managed_object and its child CITs. If you want to search for a custom
attribute like ts_id, then we need to teach the parser that we are interested in this particular
attribute. This can translate to:

<attributeSynonym>
<synonym>tsid</synonym>
<attributes>
<attributeName>ts_id</attributeName>
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</attributes>
</attributeSynonym>

To search such an attribute in CMS UIUCMDB Browser, we need to enter in the search box
the string tsid <my_ID value>. This is interpreted by the parser that you are requesting a
search only on the custom attribute ts_id with the search string <my_ID_value>.

a. InUCMDB server JMX console, locate the editParserConfiguration operation in the
UCMDB:service=Topology Search Services category.

b. Provide Customer ID (default: 1) and click Invoke.
In the returned result page, the Resource XML window lists all CITs that are parsed.

c. Scroll down to the bottom and add the custom CIT by following the out-of-the-box (OOTB)
structure below:

<classSynonym>
<synonym><synonym></synonym>
<className><CIT></className>
</classSynonym>

In this example, add the following:
<classSynonym>
<synonym><Technical service></synonym>

<className>ts_ex</className>
</classSynonym>

d. Savethe change.

This tells the parser that when you search the keywords Technical service, you are actually
interested in Cls from the CIT ts_ex.

Note: Itis also recommended to familiarize yourself with the entire OOTB list in order to be
able to perform better and more useful CMS UIUCMDB Browser searches.

3. Add rankings of the custom CIT and its attributes by using the editRankingConfiguration JMX
method

a. InUCMDB server JMX console, locate the editRankingConfiguration operation in the
UCMDB:service=Topology Search Services category.

b. Provide Customer ID (default: 1) and click Invoke.

In the returned result page, the Resource XML window lists ranking of all CITs and their
attributes.
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d.

The XML file is split into several categories, but the first 2 categories are the most relevant
and important ones: classesByPriority and attributesByPriority.

In the classesByPriority section, add the name of your custom CIT (as illustrated below),
either for priority 2 or 3 depending on your business needs, but not both of them.

<classesByPriority>
<priorityList>
<priority>2</priority>
<name>running_software</name>
<name>ci_collection</name>
</prioritylList>
<prioritylList>
<priority>3</priority>
<name>node</name>
<name>location</name>
<name>party</name>
<name>business_element</name>
<name>configuration_document</name>
<name>ts_ex</name>
</prioritylList>
</classesByPriority>

In the attributesByPriority section, add the names of your custom ClI attributes to the target
priority level section.

You might have already noticed the priorities for attributes are 0,1,3 and 4. Based on your
preferred usage for the custom CIT, make sure you add each of three example attributes into
one of the priority categories.

Note: Each attribute should be added only once. The higher the priority number is, the
better chance to have that search result listed on the first result page.

For example,

<attributesByPriority>
<prioritylList>
<priority>0</priority>
<name>creation_time</name>

</priorityList>
<prioritylList>

<priority>3</priority>
<name>cluster_network_address</name>
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<name>ts_version</name>

<name>ts_id</name>

<name>ts_name</name>
</priorityList>

e. Savethe change.
4. Index the custom CIT and attributes by invoking the reindexCiType JMX method.

a. InUCMDB server JMX console, locate the editRankingConfiguration operation in the
UCMDB:service=Topology Search Services category.

b. Provide Customer ID (default: 1) and the CIT name in the value field for ciType.

c. Click Invoke.

Related Topics

« "How to Configure the Enhanced Search Engine" on page 1

Integration Studio

The Integration Studio option in the CMS Modules navigation pane opens the new Integration Studio
module, which enables you to manage your UCMDB integration points and connect and share
information with exteral repositories, such as other UCMDB, IT Performance Suite products, or third-
party products.

This section contains the following:

Integration Studio OVervieW . . ... 173
Working with integration points ... ... ... .. 175
Working with integration JODS ... L 179

Integration Studio Overview

Note: The Integration Studio module is available for users with the Data Acquisition permission.

Integration Studio is where you manage your UCMDB integration points and connect and share
information with external repositories, such as other UCMDB, IT Performance Suite products, or third-
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party products. Integration with other products is performed over secure communication channels
through Data Flow Probes.

Alternatively, if your remotely-managed data repositories are accessible from UCMDB server machine,
non-Jython-based integrations can be performed using UCMDB Integration Service, enabling the Data
Flow Probe resources to be used for other discovery tasks.

Note: UCMDB Integration Service is supported only in standalone UCMDB environments.

Integration points in UCMDB are based on adapters, which are entities that are capable of
communicating with external data repositories. A basic set of adapters is provided with UCMDB;
however, you can also create additional adapters.

Integration points can be of one of the following types.

Population

Population type integrations copy data from an external data repository into UCMDB, so that UCMDB
now controls the data.

You use population integrations in the following scenarios:

« You need to track changes made by UCMDB at the Cl level.

« A remote repository is not reliable in terms of response time. For example, a network delay prohibits
you from setting up run-time federation with the repository.

« Aremote repository does not support federation capabilities (that is, no appropriate adapter exists).

Data Push

Data Push type integrations copy data from UCMDB to an external data repository, so that UCMDB no
longer retains control over this data.

You use data push integrations to feed important data from UCMDB into an external system to
facilitate your necessary business processes. For example, pushing data discovered by DFM to Micro
Focus Service Manager, where tickets may be opened that are connected to the actual Cls in your IT
infrastructure.

Integration Reports

You can configure Integration Studio to send you the following reports:
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« Integration Summary Report (contains basic information about all activated integration points and
their related jobs)

« Integration Job Report (contains basic information about the integration jobs and every related
query)

For more information about integration reports and how to enable Integration Summary Report, see the
"Use > Integration Reports" section of the UCMDB Help.

For details about how to enable the Integration Job Report in CMS Ul, see Working with integration
jobs.

Working with integration points

Create a new integration point

To create a new integration point, follow these steps:

1. InCMS UlI, click the Menu icon (E) to expand the CMS Modules pane, and then click

Integration Studio.

2. Click the New integration pointicon (+) to display the New Integration Point pane.
3. Enter a name and description for the integration point.

4. Select the appropriate integration adapter. The Adapter Properties section is populated with the
relevant adapter properties.

5. Enter the adapter properties.

6. If the adapter protocol requires credentials, click the Credentials text box to open the Choose
Credentials pane, select a credential from the list, and then click OK.

If the required credential is not displayed, click the Add icon (+) in the Choose Credentials

pane, enter the credential information, click Save, and then click OK.

7. Click OK to create the new integration point.

8. Add integration jobs to the integration point. For more information about how to do this, see
"Working with integration jobs".
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Note: Only the following protocols can be created in CMS Ul. To use other protocols, create them
firstin UCMDB, and then select them in CMS UI.

« Asset Manager Protocol

« BSM Kpi Adapter HTTPS Protocol
« CA CMDB Protocol

« Generic Protocol

« Generic DB Protocol (SQL)

« HP Network Automation Java Protocol
« HP SIM Protocol

« HTTP Protocol

« NNM Protocol

« Remedy protocol

« Salesforce Rest Protocol

« SANSscreen Protocol

« ServiceNow Protocol

Import or export an integration point

To import or export an integration point, follow these steps:

1. InCMS UlI, click the Menu icon (E) to expand the CMS Modules pane, and then click

Integration Studio.

2. Click the Import/Exporticon (»*:), and then select Import or Export to open the Import & Export

pane.

3. Toimport an integration point, click the Add icon (@ ), select the desired integration point .xml
file, and then click IMPORT.

To export an integration point, select the desired integration point from the drop-down list, and then
click EXPORT.

Search for an intfegration point

To search for an integration point, follow these steps:
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1. InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click

Integration Studio.

2. Click the Search icon ( O\ ), enter your search terms in the Search box, and then press Enter.

Note: To display all available integration points again once that you have performed a search,
click the Search icon, clear the Search box, and then press Enter.

Activate or deactivate integration points

To activate or deactivate an integration point, follow these steps:

1. InCMS UlI, click the Menu icon (E) to expand the CMS Modules pane, and then click

Integration Studio.

2. Locate the integration point that you want to activate or deactivate, and then switch the toggle

button ( .) next to the adapter name to the desired position.

Note: When an integration point is deactivated, the toggle button appears dimmed, and the
status is displayed as a question mark icon. When you activate an integration point, the
connection is tested, and the status is displayed as a tick icon if the test is successful.

To deactivate all integration points, click the Deactivate All icon (® ), and then click Deactivate
to confirm the action. A pop-up progress bar displays the number of integration points that have
been disabled.

Change the grouping of the displayed integration points

When you view integration points in Integration Studio, the displayed integration points are grouped by
adapter or by status. To change which type of grouping is used, follow these steps:

1. InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click

Integration Studio.

2. Click the Filtericon (?), and then select the desired grouping.
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View the details and overview of an integration point

To view the details and overview of an integration point, follow these steps:

1. InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click

Integration Studio.
2. Click the name of the desired integration point to display details of the associated integration jobs.

3. Click the Overview icon (58) to display an overview of the integration point, including the

associated integration jobs and a graphical representation of the job status.

Edit or delete an intfegration point

To edit or delete an integration point, follow these steps:

1. InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click

Integration Studio.

2. Point the mouse to the integration point that you want to edit or delete. The Edit (f*f"\} ), Delete (|E| ),

and Pin (ﬁ?) icons are displayed.

3. Toedit an integration point, click the Edit icon to display the Edit Integration Point pane, make the
required changes, and then click OK.

To delete an integration point, click the Delete icon, and then click Yes to confirm the deletion.

Refresh the integration points

To refresh an integration point so that current status information is displayed, follow these steps:

1. InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click

Integration Studio.

2. Click the Refresh icon (G)to refresh the integration points.

Pin an integration point to the Home Page

To pin an integration point to the Home Page, follow these steps:
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1. InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click

Integration Studio.

2. Point the mouse to the integration point that you want to edit or delete. The Edit (f*f"\} ), Delete (|E| ),
and Pin (ﬁ?) icons are displayed.

3. Click the Pinicon to display the integration point widget on the CMS Ul Landing Page.
To unpin the widget from the Home page, click the Unpin from Dashboard icon (-™) or remove it

directly from the Home page.

Note: From the integration point widget on the Home Page, you can activate or deactivate
the integration point by using the toggle button, and you can click the integration point name to
view the list of integration jobs for the integration point. You cannot edit or delete an
integration point from its widget on the Home Page.

Working with integration jobs

Create a new integration job

To create a new push or population integration job, follow these steps:

1. InCMS UlI, click the Menu icon (E) to expand the CMS Modules pane, and then click

Integration Studio.

2. Click the name of the integration point to which you want to add a new integration job.

3. Click the Add integration job icon (+), and then select the type of integration job that you want

to add. Depending on your choice, the Population Job or Push Job pane opens.

4. Enter a name for the integration job.

5. Click the Add icon (+) to add an available integration query to the job definition. If the integration
job has multiple queries, click the Up Arrow (A )and Down Arrow icons (**) to change the order
in which the queries are run. To remove a query, click the Delete icon (|ﬁ| ).

6. (Non-Jython-based population jobs only) Select the Allow integration job to delete removed

data option to enable the deletion of Cls or relationships from the local CMDB. When this option is
selected, any Cls or relationships that are removed from the remote source are also deleted from
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the local CMDB when you next perform a full synchronization.

7. (Data push jobs only) Select the Enable live job option if you want the integration job to
automatically perform delta synchronization when its TQL query result changes.

Note: If you enable this option, the job's scheduler will be disabled.

8. (Datapush jobs only) Select DELTA SYNCHRONIZATION if you want the integration job to
synchronize only the data has changed since the job last ran, or select FULL
SYNCHRONIZATION if you want the integration job to synchronize all data every time that it
runs.

9. Select Email Notification Enabled if you want to enable the Integration Job Report that is sent
immediately through emails when an integration job is finished.

o Inthe Job Status drop-down list, select one of the following options:
» Failed. Sends email notifications when the integration job status is On Failure.
« All. Always sends email notifications regardless of the job status.
o Inthe Synchronization Type drop-down list, select one of the following options:
« Full Sync. Sends email notifications when the integration job runs full synchronizations.

« Full Sync / Delta Sync. Always sends email notifications regardless of whether the
integration job runs full or delta synchronizations.

o Inthe Recipients field, enter the public recipient's email address.
« Click + to add more recipients.
« Click — toremove the recipient.
Note: The maximum number of recipients is 30.

Before you fill in this field, you must configure the following settings in the Infrastructure
Settings Manager pane in UCMDB:

i. GotoAdministration > Infrastructure Settings Manager > Mail Settings.
ii. Configure the following Mail Settings:

« Activate TLS/SSL connection. Set the value to True if SMTP server requires the
secure connection via TLS/SSL and UCMDB was configured with SMTP server
certificate. Set the value to False if SMTP server accepts non-secure connection.

« Email sender. Enter the name to appear in reports that Universal CMDB sends.
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« SMTP server. Enter the address of the SMTP server.
« SMTP server port. Edit the SMTP server port. The default value is 25.

ii. Inthe Filter by column field, select Name and then enter Scheduled Reports trusted
email domains for UCMDB Browser.

iv. Inthe Value field of Scheduled Reports trusted email domains for UCMDB
Browser, enter the email domain that you want. For example, microfocus.com.
Separate email domains with semicolons (;).

10. Select the Scheduler Enabled option to choose scheduling options for the integration job.
o Inthe Repeat drop-down list, select how often you want the integration job to run. You can also
select to schedule the integration job by using a Cron expression.

o Provide the information that corresponds to the Repeat option that you selected. For example,
select the days of the week if you selected "Weekly", or enter a valid Cron expression if you
selected "Cron Expression".

o Inthe Time Zone drop-down list, select the time zone to which the schedule applies.

o Inthe Starts field, click the Clock icon (f::' ) to select the date and time when the integration job

will start to run.

o Inthe Ends field, click the Calendar icon (=) to select the date when the integration job will

stop running. If you want the integration job to run indefinitely, select the Never option.

11. Click OK to create the integration job.

Search for an integration point

To search for an integration job, follow these steps:

1. InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click

Integration Studio.

2. Click the Job Listicon ( —_— ) to display the list of integration jobs.

3. Click the Search icon ( Q ), enter your search terms in the Search box, and then press Enter.

Note: To display all available integration jobs again once that you have performed a search,
click the Search icon, clear the Search box, and then press Enter.
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View the integration jobs

To view the details and statuses of integration jobs, follow these steps:

1. InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click

Integration Studio.

2. Click the Job Listicon ( —_— ) to display the list of integration jobs.

Sort and filter the displayed integration jobs

To sort and filter the displayed integration jobs, follow these steps:

1. InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click

Integration Studio.

2. Click the Job Listicon ( —_— ) to display the list of integration jobs.

3. Click the Filter icon (? ) to display the filter pane.

o You can sort integration jobs by job name or by integration name. Click the Up Arrow (") or

Down Arrow icons (**) to change the sort order.

o You canfilter integration jobs by job category (push or population) or by job status.

Synchronize an infegration job

To synchronize an integration job, follow these steps:

1. InCMS UlI, click the Menu icon (E) to expand the CMS Modules pane, and then click

Integration Studio.

2. Click the name of the integration point which contains the integration job that you want to
synchronize.

3. Select the job that you want to synchronize, click the Synchronize integration job icon (':-'), and

then select Full Sync or Delta Sync.
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A full Synchronization synchronizes all data, whereas a delta synchronization synchronizes only
the data that changed since the job last ran .

Delete integration jobs

To delete one or more integration jobs, follow these steps:

1. InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click

Integration Studio.

2. Click the name of the integration point from which you want to delete integration jobs.

3. Select the check-box beside the integration job or jobs that you want to delete, click the Delete

icon (Iﬁl ), and then click DELETE in the confirmation window.

Edit an integration job

To edit an integration job, follow these steps:

1. InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click

Integration Studio.
2. Click the name of the integration point that contains the integration job that you want to edit.
3. Select the integration job that you want to edit to open the job details pane.
4. Select DEFINITION, and then edit the integration job as required.

5. Click OK to save your changes.

View integration job information and statistics

To view integration job information and statistics, follow these steps:

1. InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click

Integration Studio.

2. Click the name of the integration point that contains the integration job that you want to view.

3. Select the integration job that you want to view to open the job details pane.

Select DEFINITION to view the integration job details.
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Select STATISTICS to view the statistics for each query in the integration job. If a warning or error icon
is displayed beside a query, you can click the icon to display more detailed information about the issue.

Note: In population jobs only, you can click the Filter icon (? ) to define a time range for the

displayed statistics.

Pin the integration jobs to the Home Page

To pin a widget that displays the status of all integration jobs to the Home Page, follow these steps:

1. InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click
Integration Studio.

2. Click the Job Listicon ( —_— ) to display the list of integration jobs.

3. Click the Pin to Dashboard icon (F?)to display the integration job widget on the Home page.

To unpin the widget from the Home Page, click the Unpin from Dashboard icon () or remove it

directly from the Home Page.

Note: The integration job widget is displayed on the Home Page by default. When you click
on each integration job status on the widget, the integration job list in Integration Studio opens
and displays the integration jobs that currently have that status.

LDAP Manager

The LDAP Manager option in the CMMS Modules navigation pane opens the LDAP Manager module,
which enables you to associate Universal CMDB groups with LDAP groups.

This section contains the following:

LDAP Manager OVerVIEW ... 185
LDAP Manager User Interface ... il 186
LDAP Manager Page ... 186
LDAP RESOUICES Page . .. ... 188
Number of users requested from the LDAP Server .. ... . . . 189
EXisting Mappings Page ... ... 192
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LDAP Manager Overview

Note: The LDAP Manager module is available for users with the following permissions:

« Administration

« LDAP Mapping

When using an LDAP server to authorize users, it is necessary to map user groups on the LDAP server
to user groups in Universal CMDB.

You can associate Universal CMDB groups with LDAP groups or LDAP users using the LDAP
Manager module.

For detailed information about how to configure LDAP authentication, see the section on enabling
LDAP authentication in the Hardening section of the UCMDB Help.

Note:

« You must configure LDAP mapping for both the actual and authorized states.

« UCMDB can be configured to work with every LDAP server which implements the standard
LDAP protocol.

« Itis recommended to set the Passwords must use default policy infrastructure setting to
False when LDAP authentication is enabled.

LDAP security policies should be used if LDAP is enabled.
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LDAP Manager User Interface

This section includes:

LDAP Manager Page

This page allows you to associate Universal CMDB groups with LDAP groups or LDAP users.

To access the LDAP Manager page, go to CMS Ul, click the menuicon (E) on the upper left corner to

expand the CMS Modules pane, and then click LDAP Manager.

Important: The LDAP Manager module requires CMS Ul 2018.08 or later, and UCMDB server

2018.08 or later.

The following table describes the user interface elements on the LDAP Manage page:

Ul Element (A-Z)

Description

CMS Modules. Opens the CMS Modules pane, and

allows you to navigate through the available web-
based CMS modules. For detailed information about
the available modules, see the Universal CMDB Home
Help.

<username>

<username>. Displays the user that is currently
logged in to CMS UI. Clicking it allows you to log out

from CMS UI.

CMS Ul (2018.08)

Help. Opens the Help menu:

Help. Opens the LDAP Manager Help page.

Online Help for CMS Ul. Opens the online help
for the current CMS Ul version available on the
Micro Focus Software Information Portal.

Online Help for UCMDB Server. Opens the
online help for the current UCMDB Server version
available on the Micro Focus Software Information
Portal.

Online Help for Content Pack. Opens the online
help for the current Content Pack version available
on the Micro Focus Software Information Portal.

About. Opens the About dialog box.
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Ul Element (A-Z) Description

The ABOUT tab provides version, patch (if
available), copyright, and third-party notice
information. For more information, see "About
Window" on page 122.

The LICENSE tab provides license information,
including license status, license summary, and a
license status link. Clicking the license status link
opens the license summary report, which contains
license consumption summary and available
licenses, and a link that allows you to export a
detailed license consumption report. For more
information about licenses, see "Universal
Discovery Licensing Overview" on page 422.

Clicking OK exits the About window.

H Walk-throughs. Opens a list of predefined workflow
scenarios. Click one of the available workflows to
open a set of step-by-step-instructions. This allows
you to complete an end-to-end workflow by yourself.

The following walk-throughs are available:

« How to Delete Existing Mappings Grouped by
LDAP.

« How to Delete Existing Mappings Grouped by
UCMDB.

For more information, see "How to Run a Walk-through
" on page 200

Select an LDAP Server. Enables you to select an
myd-vm04030.hpswlabs.a N/ LDAP server from the drop-down list of available
LDAP servers.

4 EDIT SERVER Edit LDAP Server. Enables you to edit the
configuration of an existing LDAP server. Opens the
Edit LDAP Server menu. For more information, see

"Edit an LDAP Server configuration" on page 196.

+ ADD SERVER Add Sever. Enables you to add a new LDAP server.
Opens the Add LDAP Server menu. For more
information, see "Configure a new LDAP server" on

page 194.

Existing Mappings Displays a list of existing mappings, grouped by
LDAP or UCMDB.

LDAP Resources Displays alist of LDAP resources.
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LDAP Resources Page

This page allows you to select LDAP resources (LDAP groups, or LDAP users), and then map them to
existing UCMDB groups.

To access the LDAP Resources page, click the LDAP Resources tab on the LDAP Manager page.

The following table describes the user interface elements on the LDAP Resources page:

Ul Element (A-Z) Description

Q Search. Enables you to search for an LDAP resource by its name.

Type a keyword in this field to search within the list. All the LDAP resources
with the name that matches the keyword are displayed below.

Q Add Mappings. Enables you to add mappings for the selected groups or
users. Opens the Add Mappings menu. For more information, see "Add new
mappings" on page 199.

% Clear Selections. Allows you to clear the selections you have made.

Filter by Filter by. Allows you to filter the LDAP resources by group or by user.
« None. Displays a list of all LDAP resources.
« Group. Displays alist of LDAP groups.
« User. Displays alist of LDAP users.

When this filter is applied, you can search for an LDAP user within the list.
In this case, the search is performed by Display name.

Note: The search performed by Display name is based on a partial
match. (All the users that have the entered value in their Display name
are returned).

o UID. Displays alist of LDAP users.

When this filter is applied, you can search for an LDAP user within the list.
In this case, the search is performed by user unique ID (UID).

Note: The search preformed by UID is based on a perfect match.
(Only the users that have the UID identical to the entered value are
returned).
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Number of users requested from the LDAP server

Sometimes, when you access the LDAP Manager module or the LDAP Resources page, or you
perform a search in the LDAP Resources page, the following error message is displayed: “The number
of users requested from the LDAP server exceeds the size limit”. This happens because the

LDAP server has a size limit configured for the search results. In this case, only a certain number of
entries can be returned. If the number of users requested from the LDAP server exceeds the number of
maximum results (size limit) defined for the LDAP server, the application is not able to get all of them.

To help you reduce the number of LDAP entries returned so that you do not reach the defined limit, and
to minimize the calls to the LDAP Server, the following LDAP server settings are added to the
configureLDAPServer JMX method.

« nrOfUsersRetrievedAtOnce: Allows you to specify the number of users that may be retrieved at
once from the LDAP server. The default value is 0.

o 0:the LDAP Server does not restrict the number of users retrieved at search (unlimited search)

o Greater than 0 (between 1 and 400): the LDAP Server restricts the number of users retrieved
at search (limited search)

. distinguishedNameAttr: Allows you to specify the Distinguished Name Attribute as it is defined
on the current LDAP Server. By default, this field is empty.

o when this is empty (default), the users are retrieved one by one
Note: The search process takes a while when the users are retrieved one by one.

o when the Distinguished Name Attribute as it is defined on the current LDAP Server is provided,
multiple users are retrieved at once.

Caution: Make sure you enter the exact value of the distinguished name attribute. If you do
not the know the LDAP Server’s distinguished name attribute, leave this setting empty.

The distinguishedNameAttr setting is relevant only in combination with the
nrOfUsersRetrievedAtOnce setting.

How to configure the number of users that may be retrieved at once
from the LDAP server

To configure the number of users that may be retrieved at once from the LDAP server, follow these
steps:
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1. Onthe UCMDB server machine, launch your Web browser and enter the following address:
https://localhost:8443/jmx-console.

You may need to log in with a user name and password.
2. Locate the configureLDAPServer method in the UCMDB:service=LDAP Services category.
3. Provide values for the following fields:
nrOfUsersRetrievedAtOnce: A number smaller than the size limit configured for the LDAP server

distinguishedNameAttr: The Distinguished Name Attribute as it is defined on the current LDAP
Server.

4. Click Invoke.

Example: How to properly configure the number of users that may be
retrieved at once from the LDAP server

This is just an example to help you understand how to use the newly added settings
(nrOfUsersRetrievedAtOnce, and distinguishedNameAttr).

In this example, the following values will be used:

« Group 1—with 10 users
o Group 2 —with 15 users
» Group 3 —with 48 users

o LDAP server size limit: 20 (this means that the LDAP server has limited the search results to 20
users)

« Distinguished Name Attribute: LDAPattr

The following scenarios show what happens when different values are used for the
nrOfUsersRetrievedAtOnce and distinguishedNameAttr settings.

Scenario 1

Input

« nrOfUsersRetrievedAtOnce: 0

« distinguishedNameAttr: (empty)

Output

CMS Ul (2018.08) Page 190 of 446



CMS Ul Guide

When performing a search in the LDAP Resources page, the following error message is displayed:
“The number of users requested from the LDAP server exceeds the size limit”.

This error happens because the LDAP server is limited to 20 users, and the number of users requested
from the LDAP serveris 73 (Group 1 + Group 2 + Group 3).

Scenario 2.1
Input

« nrOfUsersRetrievedAtOnce: 40

« distinguishedNameAttr: (empty)

Output

When performing a search in the LDAP Resources page, all the three groups (73 users) are retrieved.
Since the distinguishedNameAttr setting has no value added, the users are retrieved one by one, and
the LDAP server size limit is not reached.

The search process takes a while when the users are retrieved one by one.

Scenario 2.2
Input

« nrOfUsersRetrievedAtOnce: 40

« distinguishedNameAttr: LDAPattr

Output

In this scenario, the search functionality works for Group 1 and Group 2 (since the number of users is
smaller than the LDAP server size limit), and it fails for Group 3 with the following error message: "The
number of users requested from the LDAP server exceeds the size limit." The error appears because
the chunk we want to retrieve is of 40 users, and the LDAP server size limit is 20.

Scenario 3.1

Input

o nrOfUsersRetrievedAtOnce: 19

« distinguishedNameAttr: (empty)

Output
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When performing a search in the LDAP Resources page, all the three groups (73 users) are retrieved.
Since the distinguishedNameAttr setting has no value added, the users are retrieved one by one, and
the LDAP server size limit is not reached. The search process takes a while when the users are
retrieved one by one.
Scenario 3.2
Input

« nrOfUsersRetrievedAtOnce: 19

« distinguishedNameAttr: LDAPattr
Output
When performing a search in the LDAP Resources page, all the three groups (73 users) are retrieved.
This is because the users are retrieved in chunks of 19 users at once. The search process takes less
time than it does in the scenario 3.1.
Scenario 4

Input

« nrOfUsersRetrievedAtOnce: 0

« distinguishedNameAttr: LDAPattr
Output

When performing the search in the LDAP Resources page, the following error message is displayed:
“The number of users requested from the LDAP server exceeds the size limit”.

This error happens because the LDAP server is limited to 20 users, and the number of users requested
from the LDAP serveris 73.

Existing Mappings Page

This page allows you to view the existing mappings grouped by LDAP or UCMDB groups. Also, you
can select either LDAP groups or LDAP users to create new mappings.

To access the Existing Mappings page, click the Existing Mappings tab on the LDAP Manager page.

The following table describes the user interface elements on the Existing Mappings page:
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Ul Element (A-Z) Description

Q Search. Enables you to search for an existing mapping by its name.

Type a keyword in this field to search within the list. All the existing mappings
with the name that matches the keyword are displayed below.

g Add Mappings. Enables you to add mappings for the selected resources.

Opens the Add Mappings menu. For more details, see "Add new mappings"
on page 199.

ﬁ Clear Selections. Allows you to clear the selections you have made.

] Delete. Allows you to delete an existing mapping.

Allows you to select all the LDAP groups that are already mapped to the
UCMDB groups. The selection is added in the Add Mappings menu.

" Allows you to manually expand a group and view its mappings.

Collapse All Collapses the entire structure, leaving only the root groups.

Expand All Expands the entire structure, displaying all the available mappings.

Grouped by: Grouped by. Enables you to group the existing mappings by LDAP or
UCMDB groups.

« LDAP. Displays alist of existing mappings grouped by LDAP.
« UCMDB. Displays a list of existing mappings grouped by UCMDB.
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Work with LDAP Manager

Configure a new LDAP server

To configure a new LDAP server, follow these steps:

1. InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click
LDAP Manager.

2. Click the button to display the Add LDAP Sever pane.

3. Enterthe values for all the settings.

4. Click the Save button.

Note:

« If you have an exported file containing the LDAP server configuration saved on your computer,
you can choose to import the LDAP server values, which are automatically entered in the right
fields. For more information, see "Export orimport an LDAP Server configuration " on page 197

« You can also configure LDAP authentication settings using the JMX console. For details, see
"How to Define LDAP Servers and Enable LDAP Authentication Method" in the Hardening
section of the UCMDB Help.

« Foran example of LDAP authentication settings, see "LDAP Authentication Settings -
Example" on the next page.

« Every LDAP user has a first name, last name, and email address saved in the local repository.
If the value of any of these parameters that is stored on the LDAP server differs from the value
in the local repository, the LDAP server values will overwrite the local values at each login.

« The value of the userUID setting must be unique across all LDAP servers.

« You can specify the order in which the LDAP servers are presented in the drop-down list of
available LDAP servers by entering a value in the Priority field. If two or more LDAP Servers
have the same priority, the order in which they are presented is alphabetical.

« If youwant to view the group information of LDAP users, enable the Display Users Group
toggle button.
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LDAP Authentication Settings - Example

The following table contains an example of setting values for LDAP authentication:

Connection
Setting Value
URL Idap://myldap.example.com:389/0OU=Users,OU=Dept,
OU=US,DC=example,DC=com??sub
Search user Full user name, for example, John Smith
Search user password LDAP Search User Password
Distinguished Name (DN) true
Resolution

Group. Use bottom up algorithm: enabled

Group search

Setting Value

Base OU=AMRND,OU=Security
Groups,DC=example,DC=com

Filter (objectclass=group)

Scope sub

Root group search

Setting Value
Base OU=Users,OU=Security
Groups,DC=example,DC=com
Filter (objectCategory=group)
Scope sub
Static Group
Setting Value
Group class group
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Static Group, continued

Setting

Name attribute
Description attribute
Display name attribute

Member attribute

User

Setting

Userclass

Display name attribute
Unique ID attribute

User filter

Display Users' Group

Integration

Setting
Priority

Default Group

Dynamic group. Enabled

Value

cn
description
cn

member

Value

user

cn
sAMAccountName

(&(sAMAccountName=*)
(objectclass=user))

enabled

Value
2

AdminsGroup

Edit an LDAP Server configuration

To edit an existing LDAP server configuration, follow these steps:

1. InCMS UlI, click the Menu icon (E) to expand the CMS Modules pane, and then click

LDAP Manager.

2. Click the button to display the Edit LDAP Server pane.

3. Modify the values for the relevant settings.
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4. Enterthe password in the Search user password field.

5. Click the Save button. A message that indicates whether the LDAP authentication settings were
updated successfully appears on the LDAP Manager page.

Important:

« If you do not enter a new value for a setting, the setting retains its current value.

« You have to provide the password each time you edit the LDAP server configuration.

« You can choose to export an LDAP server configuration and use the exported file when
configuring a new LDAP server. For more information, see "Export or import an LDAP Server

configuration " below

Export or import an LDAP Server configuration
You can export and import an LDAP server configuration. In this way you can easily configure a new

LDAP server, by using the configuration of an existing LDAP server.

To export the LDAP server configuration:

1. InCMS U, click the Menu icon (E) to expand the CMS Modules pane, and then click
LDAP Manager.

2. Select an LDAP Server from the drop-down list of available LDAP servers.

3. Click the button, and then click Export Configuration.

4. Save the file on yourlocal machine.

| Note: For security reasons, the password is not saved in the exported file.

To import the LDAP server configuration:

1. InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click
LDAP Manager.

2. Click the + ADD SERVER button, and then click Import Configuration.

3. Gotothe folder where you saved the exported file, select the required file, and then click Open.
The LDAP server values are automatically entered in the right fields.
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4. Enterthe password in the Search user password field.

5. Click the Save button.
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Delete an LDAP server

To delete an LDAP server, follow these steps:

1. InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click
LDAP Manager.

2. Select the LDAP server from the drop-down list of available servers.

3. Click the button to display the Edit LDAP Server pane.

4. Click the Delete button. A confirmation message is displayed. This allows you to choose whether
to delete the selected server, or to cancel the action.

Add new mappings

To map an LDAP group or an LDAP user to a UCMDB group, follow these steps:

1. In CMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click
LDAP Manager.

2. Select an LDAP server from the drop-down list of available LDAP servers.
3. Select the LDAP Resources tab on the LDAP Manager page.

4. Select the LDAP groups or LDAP users you want to map.

2

5. Click the Add Mappings icon ( ) to open the Add Mappings pane.

6. Inthe Add Mappings pane > UCMDB Groups drop-down list, select the UCMDB groups you
want to be mapped to the selected LDAP resources.

7. Click the liuiimdbebatat] b tton.

Your changes are added in the existing mappings list. You can view the existing mappings
grouped by UCMDB or LDAP groups.

Delete an existing mapping

To delete an existing mapping, follow these steps:
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1. InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click

LDAP Manager.

2. Select an LDAP server from the drop-down list of available LDAP servers.

3. Select the Existing Mappings tab on the LDAP Manager page, and from the Grouped by drop-

down list filter the existing mapping by LDAP.

4. Expand the required LDAP group, and then click the Delete icon (IEI ) to delete a mapped UCMDB

group.

How to Run a Walk-through

Walk-throughs provide step-by-step instructions that enable you to complete an end-to-end use case

by yourself. To launch a walk-through, click the E button on the LDAP Manager page, select one of

the available walk-throughs, and then follow the step-by-step instructions.

The following table describes the walk-through user interface elements.

Ul Element (A-Z)

Mexr 2/&

Back

skip

CMS Ul (2018.08)

Description

Next. Proceed to the next step. The Next button displays your progress
through the walk-through (for example, 2/6 means that two steps are
completed from a total of six steps).

Important: After completing an action described in a step, you have to
click the Next button.

Back. Go back to the previous step.
Last. Ends a walk-through.

Skip. Allows you to close the walk-through, and gives you the possibility to
continue your current activity.

Beacon. Appears when a step is incorrectly performed, when you press
Enter, or when you click the X button on a tooltip. Hovering your mouse over

the @ button opens a tooltip that displays the current step that has to
be performed, and allows you to continue the walk-through.
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Package Manager

The Package Manager option in the CMS Modules navigation pane opens the Package Manager
module, which enables you to easily manage the capabilities of your system based on the packages
you deploy.

This section contains the following:

Package Administration ... il 201
Package Manager User Interface .. ... ... . . 212
Work with Package Manager ... iiiiiiiiiil.. 219

Package Administration

Package Administration Overview

Note: The Package Manager module is available for users with the following permissions:

o Administration
« Deploy Packages
« Run Discovery and Integrations

« Package Manager

A package contains resources that are grouped together by defined criteria. For a list of the default
resource types, see "Resource Types" on page 205.

Package Manager fulfills several functions:

« Enables the discovery of specific IT infrastructure assets. For example, deploys the SQL_Server
package to discover Microsoft SQL servers.

« Enables you to define the Cl Type model through the ClI types that are included in the packages. For
example, some of the Cl types included in the Host_Resources _Basic package are File System,
CPU, Process, and Print Queue.
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« Enables you to move groups of resources from one system to another, for example, from atesttoa
production environment.

There are two types of packages:
« Factory package. Contains resources that are deployed with the installation and are used to
initialize .
By default, factory packages are located in the <UCMDB_installation_folder>\content\basic_
packages folder.

« Custom package. A package that is user created. You may want to create a custom package if the
factory packages do not contain the resources needed for the tool you are developing, or if you want
to export resources from system to system. For details, see "How to Create a Custom Package" on
page 219.

Caution: If you create custom packages for the resources or tools you develop, do not place
them in the <UCMDB_installation_folder>\content\basic_packages folder. This folder is
only for factory packages.

Export and deployment of packages from system to system is performed through the Package
Manager interface.

You can:

« Export some or all of a package's resources to your local directory. For details, see "How to Export
a Package" on page 222.

« Deploy some or all of a package's resources to the from your local directory. For details, see "How
to Deploy a Package" on page 220.

Package Locations

There are three pre-defined folders with out-of-the-box, automatically deployed packages under
<UCMDB_installation_folder>\content:

« basic_packages
Internal packages

« adapters
Adapter packages

. CPx.zip
Content Pack packages

CMS Ul (2018.08) Page 202 of 446



CMS Ul Guide

Package Manager User Interface

Each package in the Package Manager User Interface includes the following:

A Package Name representing the name of the .zip file (optional)
The Category as allocated in the descriptor.xml file (optional)
A Readme file that corresponds to the package (optional)

The Version number
The Build number

Factory identifying the package as factory or custom. A check mark represents the factory
packages.

A Description that corresponds to the description located in the descriptor.xml file

Package Resources

This section contains a list of the resources a package can contain. For a list of the available resource

types and their descriptions, see "Resource Types" on page 205.

acl. The definition of a role such as Administrator or Guest. For details, see "Roles Manager" in the
Administer section of the UCMDB Help.

adapter. Contains a description and the capabilities of the deployed federated adapter.

adapterCode. Contains compiled classes (normally ajar), based-on * jar files, and configuration
files needed for federated adapters. Place these files in the adapterCode\<adapter ID> folder in
the zip package. For details, see "Add an Adapter for a New External Data Source" in the Developer
Reference section of the UCMDB Help.

calculatedlinks. Contains the calculated super class for each of the calculated links defined.

calculatedlinkstriplets. Contains the calculated relationships and their triplets as defined in the ClI
Type Manager.

categories. Contains the State definitions used by Impact Analysis. For details on States, see
"State Manager" in the Administer section of the UCMDB Help For details on Impact Analysis, see
"Impact Analysis Manager" in the Modeling section of the UCMDB Help.

class. Cl type descriptions, such as host, file, switch, and so on. For details, see "CI Type
Manager" in the Modeling section of the UCMDB Help.
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« cmdbview. Contains the hierarchy rules defined for the base TQL query of each view. For details,
see "Modeling Studio" in the Modeling section of the UCMDB Help.

« correlation. Impact rule definitions. For details, see "Impact Analysis Manager" in the Modeling
section of the UCMDB Help.

« datamodel. Used to import Cl instances into the system. If the Cl does not exist in the , an
instance of the Cl is created. If a Cl already exists in the , the values of the CI from the package
resource overwrites the values of the Cl in the .

« datamodelcreateonly. Used to import Cl instances into the system. If the Cl does not exist in the ,
aninstance of the Cl is created. If a Cl already exists in the , the values of the Cl from the package
resource does not overwrite the values of the Cl in the .

« datamodelgenerateids. Used to import Cl instances into the system for CITs that require the ID to
be calculated dynamically upon deployment (such as CITs with no key attributes).

« dataStore. Contains the integration point defintion.

« discoveryConfigFiles. Configuration files include properties and parameters that are needed to
discover components on the system. For details, see "Adapter Configuration" in the Data Flow
Management section of the UCMDB Help.

« discoveryJobs. A Data Flow Management (DFM) job includes configuration data, scheduling
information, and TQL assignments needed to activate discovery of components. For details, see
"Introduction to Universal Discovery" in the Data Flow Management section of the UCMDB Help.

« discoveryModules. A DFM module includes all the jobs needed to discover a specific component
in the system. For details, see "Introduction to Universal Discovery" in the Data Flow Management
section of the UCMDB Help.

« discoveryPatterns. DFM adapters define which code to run and in which order, declare the input
and output CI Types and parameters to be configurable on the DFM jobs related to them. The
adapater can be used as an integration adapter or a Discovery adapter. For details, see "Adapter
Configuration" in the Data Flow Management section of the UCMDB Help.

« discoveryResources. External resources include all external resources that are needed in DFM,
for example, a Visual Basic file, an additional jars file, and so on. For details, see "Adapter
Configuration" in the Data Flow Management section of the UCMDB Help.

« discoveryScripts. DFM Jython scripts populates the with data, either by performing Discovery on
a network component or during integration with an external data repository. For details, see
"Adapter Configuration” in the Data Flow Management section of the UCMDB Help.

« discoveryWizard. Used to define the Discovery Activity dialog box contents. For details, see the
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section on discovery activities in the Universal CMDB Discovery and Integrations Content Help.

« enrichment. Enrichment rule definitions. For details, see "Enrichment Manager" in the Modeling
section of the UCMDB Help.

« identification. Contains the identification defintion of a specific Cl type.
« integrationUsers. Used to define a user of type integration.

» modelnotification. Contains filter definitions for model notifications. The data model notification
system gives notification of changes that occurred in the . For example, items in the that have been
removed, updated, or added.

« report. Report rule definitions, as described in "Topology Reports Overview" in the Modeling
section of the UCMDB Help.

« schedulerJob. Tasks that have been defined to run in the Scheduler. For details, see "Scheduler”
in the Administer section of the UCMDB Help.

« singletqlref. Contains TQL template and perspective instances. For details, see "Modeling Studio"
in the Modeling section of the UCMDB Help.

« tgl. TQL query definitions. For details, see "Topology Query Language (TQL) Overview" in the
Modeling section of the UCMDB Help.

« typedef. Predefined Enumeration definitions that relate to attributes of type Enumeration, such as
severity levels, admin states, and so on. For details, see "System Type Manager" in the Modeling
section of the UCMDB Help.

« users. The definition of a user and the user's role. For details, see "Users and Groups" in the
Administer section of the UCMDB Help.

« validlinks. All predefined, valid connections (relationships) between CITs.

Resource Types
This section contains a list of the available resource types and their descriptions. For a list of the

resources a package can contain, see "Package Resources" on page 203.

Administration

« Users. The users defined in the Users and Groups module. For details, see "Users and Groups" in
the Administer section of the UCMDB Help.

« User Groups. The user groups defined in the Users and Groups module. For details, see "Users
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and Groups" in the Administer section of the UCMDB Help.

« Resource Groups. The resource groups defined in the Resource Groups module. For details, see
"Resource Groups" in the Administer section of the UCMDB Help.

« Roles. The roles defined in the Roles Manager module to assign permissions to users. For details,
see "Roles Manager" in the Administer section of the UCMDB Help.

« Role Assignments. The role assignments to users defined in the Users and Groups module. For
details, see "Users and Groups" in the Administer section of the UCMDB Help.

Settings

« Type Definitions. Predefined Enumeration definitions that relate to attributes of enumeration type,
such as severity levels, admin states, and so on. For details, see "System Type Manager" in the
Modeling section of the UCMDB Help.

« Job Scheduler. Tasks that have been defined to run in the Scheduler. For details, see "Scheduler”
in the Administer section of the UCMDB Help.

» State Categories. The states defined in the State Manager. For details, see "State Manager" in the
Administer section of the UCMDB Help.

Model

« Configuration Item Types. The CITs defined in the Cl Type Manager. For details, see "CI Types
Overview" in the Modeling section of the UCMDB Help.

« ldentifications. The configuration files containing the identification rules for Cls. For details, see
"Identification Service" in the Data Flow Management section of the UCMDB Help.

« Relationships. The relationships defined in the Cl Type Manager. For details, see "Cl Type
Relationships" in the Modeling section of the UCMDB Help.

« Calculated Relationships. Contains the calculated relationships and their triplets as defined in the
Cl Type Manager.

« Valid Links. All possible predefined valid connections (relationships) between the CITs that are
defined in the CIT folder.

« Service Models. The pattern-based models defined in the Modeling Studio that were not defined
over an existing model. For details, see "Pattern-based Models" in the Modeling section of the
UCMDB Help.
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Discovery

« Adapters. DFM adapters define which scripts need to be run and in which order, declare the input
and output CI Types and the parameters to be configurable on the Discovery jobs related to them.
For details, see "Adapter Configuration" in the Data Flow Management section of the UCMDB
Help.

« Discovery Documents. A Discovery document is a customized document describing the usage
and functionality of a specific package. For details, see "How to Attach Discovery Documentation
to a Discovery Package" in the Data Flow Management section of the UCMDB Help.

« Discovery Modules. A Discovery module includes all the jobs needed to discover a specific
component on the system. For details, see "Discovery Modules/Jobs - Discovery Modules Pane" in
the Data Flow Management section of the UCMDB Help.

» Discovery Jobs. A Discovery job includes configuration data, scheduling information, and TQL
assignments needed to activate discovery of components. For details, see "Introduction to
Universal Discovery" in the Data Flow Management section of the UCMDB Help.

« Discovery Configuration Files. Configuration files include properties and parameters that are
needed to discover components on the system. For details, see "How to Define Discovery Rules"
in the Data Flow Management section of the UCMDB Help.

« Discovery Jython Script. Discovery Jython Scripts are Jython scripts used by the discovery
process to discover and map the various network entities.

- Discovery External Resource. Includes resources not used by the Data Flow Probe directly, but
rather indirectly by the DFM scripts. It can contain binary executable files or DLLs, XML
configuration files, or any other essential resource needed for the discovery to function properly. For
details, see "Adapter Configuration” in the Data Flow Management section of the UCMDB Help.

« Discovery Wizard Resource. Used to define the Discovery Activity dialog box contents. For
details, see the section on discovery activities in the Universal CMDB Discovery and Integrations
Content Help.

« Software Application Library. Contains software application and version descriptions that are
used to identify files that are discovered during the inventory discovery process. For details, see the
Software Application Index section in the Universal CMDB Discovery and Integrations Content
Help.

« Inventory Scanner Configuration. Configuration settings that control how inventory is collected,
which information is gathered, and the level of detail to be included. For details, see the section on
the Scanner Generator in the Universal CMDB Discovery and Integrations Content Help.
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« Scanner Package for Scanner Generator. The base file used by the Scanner Generator to build a
manually-deployed executable scanner file. For details, see the section on the Scanner Generator in
the Universal CMDB Discovery and Integrations Content Help.

« Service Discovery Activity Type. Defines jobs used by service discovery and their trigger TQL
queries as well as default job parameters. For details, see the section on "Service Discovery " in the
Data Flow Management section of the UCMDB Help, and also the section on "Service Modeling" in
the Universal CMDB Browser Online Help.

« Service Discovery Activity Template. Specifies parameter overrides for selected jobs of the
Service Discovery activity. For details, see the section on "Service Discovery " in the Data Flow
Management section of the UCMDB Help.

Query

« Queries. The TQL queries defined in the TQL Editor in the Modeling Studio. For details, see
"Topology Query Language" in the Modeling section of the UCMDB Help.

« Views. The views defined in the View Editor in the Modeling Studio. For details, see "View
Formats" in the Modeling section of the UCMDB Help.

o Enrichments. The Enrichment rules defined in the Enrichment Manager. For details, see
"Enrichment Manager" in the Modeling section of the UCMDB Help.

« Impact Rules. The Impact Analysis rules. For details, see "Impact Analysis Manager" in the
Modeling section of the UCMDB Help.

« Policies. The policies used in Universal CMDB Configuration Manager. For details, see "Policies
in the Configuration Manager section of the UCMDB Online Help.

Package Zip File Contents and Format

The package's resources are stored in the . To export a package from system to system, you use the
Package Manager interface (for details, see "Package Manager Page" on page 213). Package Manager
creates a zip file containing the resources to enable the export of the resources.

When you export resources from the Package Manager to your local directory, the resource definitions
are stored in various formats, for example, XML format.

In the sample Network.zip below, the router.xml file contains a Router CIT definition and the
Switch.xml file contains a Switch CIT definition.
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File Actions View Jobs Options Help
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Packages for Integration Adapters

You deploy Integration adapters by creating a package and placing them in the appropriate folder. For
details, see "Add an Adapter for a New External Data Source" in the Developer Reference section of
the UCMDB Help.

How to Use the JMX Console to Perform Package Manager

Tasks

This section describes the Package Manager tasks you can perform using the JMX console.

Note:

« Itis recommended that you use the Package Manager to perform these tasks instead of the
JMX console.

« View Package Deployment History cannot be performed by the Package Manager.

This section includes the following tasks:

« "Deploy a Package" on the next page

« "View Package Deployment History" on the next page
« "Undeploy a Package" on page 211

» "Display Currently Deployed Packages" on page 211
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« "Export Packages" on the next page

« "Package Name Rules" on page 212

Deploy a Package

Follow these steps to deploy a package using the JMX console.

1.

6.
7.

8.

Launch your Web browser and enter the following address: https://<server_name>:/jmx-
console, where <server_name> is the name of the machine on which is installed.

Under UCMDB, click UCMDB:service=Packaging Services to open the JMX MBEAN View
page.

Locate deployPackages.
In the Value box for the parameter customerlD, enter the <customer id>.

In the Value box for the parameter dir, enter the name of the folder that contains the package's zip
file. Ensure that you include the full path to the folder.

Note: To deploy the package from the basic_packages directory, leave this box empty.

In the Value box for the parameter packagesNames, enter the name of the packages.
Select True to override job configurations changed in Universal Discovery.

Click Invoke to deploy the package.

View Package Deployment History

Each time you deploy packages, a report is created displaying the deployment status of those
packages. Use the JMX console to view the deployment status report.

1.

Launch the Web browser and navigate to: http://<server_name>:/jmx-console, where <server_
name> is the name of the machine on which is installed.

Under UCMDB, click UCMDB:service=Packaging Services to open the JMX MBEAN View
page.

Locate displayResourcesDeploymentHistory.
In the Value box for the parameter customerlD, enter the <customer id>.
In the Value box for the parameter reportNum, enter the number of the report you want to view.

Click Invoke to view the deployment status report of the packages.
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Undeploy a Package

Follow these steps to undeploy a package using the JMX console.

1. Launch the Web browser and navigate to: https://<server_name>:/jmx-console, where
<server_name> is the name of the machine on which is installed.

2. Under UCMDB, click UCMDB:service=Packaging Services to open the JMX MBEAN View
page.

3. Locate undeployPackages.
4. Inthe Value box for the parameter customerlD, enter the <customer id>.

5. Inthe Value box for the parameter packagesNames, enter the name of the package you want to
remove.

6. Click Invoke to undeploy the package.

Display Currently Deployed Packages

Follow these steps to display currently deployed packages using the JMX console.

1. Launch the Web browser and navigate to: https://<server_name>:/jmx-console, where
<server_name> is the name of the machine on which is installed.

2. Under UCMDB, click UCMDB:service=Packaging Services to open the JMX MBEAN View
page.

3. Locate displayDeployedPackages.
4. Inthe Value box for the parameter customerID, enter the <customer id>.

5. Inthe Value box for the parameter packagesNames, specify the names of the packages you
want to display.

6. Click Invoke to display the packages that are currently deployed.

Export Packages

Follow these steps to export resources from the to the server on which is installed using the JMX
console.

1. Launch the Web browser and navigate to: https://<server_name>:/jmx-console, where
<server_name> is the name of the machine on which is installed.
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2. Under UCMDB, click UCMDB:service=Packaging Services to open the JMX MBEAN View
page.
3. Locate exportPackages.

4. Inthe Value box for the parameter customerlD, enter the <customer id>.

5. Inthe Value box for the parameter packagesName, enter the name of the package you want to
export.

6. Inthe Value box for the parameter outputDir, enter the name of the folder on the server to which
you want to export the package's zip file. Ensure that you include the full path to the folder.

7. Inthe Value box for the parameter userOnly, select one of the following:
o True. Export only the custom packages.
o [False. Export both custom and factory packages.

8. Click Invoke to export the package.

Package Name Rules

The rules for entering a package name are as follows:

« Wildcard characters (*) are not supported.
« The package name is case sensitive.
« The package name must have a.zip extension.

« When deploying more than one package, separate the package names by commas.

Package Manager User Interface

This section includes (in alphabetical order):

Content Overview

This page allows you to view the main information of a package.
To access the Content Overview page, open a package, and you can view its content overview.

The following table describes the user interface elements on the Content Overview page:
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Ul Element (A-2)
Build Number
Category
Description

Last modified

Version

Filter Menu

Description

The build number of the package.

The category of the package.

The description of the package.

The time and date on which the package was last modified.

The version of the package.

This option allows you to display only specific packages on the Package Manager page.

To access the Filter menu, click the FiIterv button on the Package Manager page.

The following table describes the user interface elements on the Filter Menu page:

Ul Element (A-2)

Description

SO Vs nlre) Bipd | Click the Add To List button, to save the filter condition.

CANCEL

Condition

Field
Value

Filter List

Click Apply tofilter the task list according to your selections.
Click Cancel to cancel your selections.

Click the drop-down list and select the required operator. For details, see
"Attribute Operator Definitions" in the Modeling section of the UCMDB Help.

Filter the task list according to any of the visible columns.
Click inside the box and enter the required value.

Displays the filter conditions that were selected.

X .

Note: To remove a filter condition added to the list, click

Package Manager Page

This page allows you to create a package out of existing resources or edit an existing package to suit

your IT management needs.

CMS Ul (2018.08)

Page 213 of 446



CMS Ul Guide

To access the Package Manager page, go to CMS Ul, click the menuicon (E) on the upper left

corner to expand the CMS Modules pane, and then click Package Manager.

Important: The Package Manager module requires CMS UI2018.08 or later, and UCMDB server

2018.08 or later.

The following table describes the user interface elements on the Package Manager page:

Ul Element (A-2) Description

E CMS Modules. Opens the CMS Modules panes, and allows you to
navigate through the available web-based CMS modules. For details on
available modules, see the Universal CMDB Home Help.

<username>. Displays the current user that logs in to CMS UlI. Clicking
<username> it allows you to log out of the CMS UI.

Help. Opens the Help menu:

Help.Opens the Package Manager Help page.

Online Help for CMS Ul. Opens the online help for the current CMS
Ul version available on the Micro Focus Software Information Portal.

Online Help for UCMDB Server. Opens the online help for the
current UCMDB Server version available on the Micro Focus
Software Information Portal.

Online Help for Content Pack. Opens the online help for the current
Content Pack version available on the Micro Focus Software
Information Portal.

About. Opens the About dialog box.

The ABOUT tab provides version, patch (if available), copyright, and
third-party notice information. For more information, see "About
Window" on page 122.

The LICENSE tab provides license information, including license
status, license summary, and a license status link. Clicking the
license status link opens the license summary report, which contains
license consumption summary and available licenses, and a link that
allows you to export a detailed license consumption report. For more
information about licenses, see "Universal Discovery Licensing
Overview" on page 422.

Clicking OK exits the About window.

CREATE PACKAGE Cr.ea.te custom package. Enables you to create a package outlof
existing resources. Opens the Create Package menu. For details, see

"How to Create a Custom Package" on page 219.
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Ul Element (A-2)

% INSTALL PACKAGE

Packages

Resources

Packages Page

Description

Install Package. Enables you to upload and install a Package. In the
Select file for upload field, select the required Package from your local
file system to upload and install on the server.

Content Pack. Enables you to upload and install a Discovery and
Integrations Content Pack. In the Select file for upload field, select the
required content pack from your local file system to upload and install on
the server. For details, see "How to Install/Deploy a Discovery and
Integration Content Pack" on page 223

Note: Only the content packs that are located in the
C:\UCMDB\UCMDBServer\content\content_packs can be
installed on the server. If the required content packs are not located
in the C:\UCMDB\UCMDB Server\content\content_packs, you
have to upload them first, using the Upload button.

Export Package List. Enables you to generate a report which contains a
list of packages that are deployed in the system, or a list of filtered
packages. Choose the export format for the table data from the drop-
down list. The available options are:

. CSV.

« XLS. The table data is formatted as an Excel (.xIs) file that can be
displayed in a spreadsheet.

« PDF. The table data is exported in PDF format.
Displays a list of existing packages.

Displays a list of existing resources.

This page allows you to view the list of existing packages. Also, you can select existing packages and

perform bulk actions on them.

To access the Packages page, click the Packages tab on the Package Manager page.

The following table describes the user interface elements on the Packages page:

Ul Element (A-2) Description

Q Find. Enables you to search for a package by its name.

Type a keyword in this field to search within the list. All the packages with the
name that matches the keyword are displayed below.
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Ul Element (A-2) Description

v Filter. Opens the Filter menu. You use the Filter menu to show only the
packages you want displayed on the Package Manager page. For details, see
"Filter Menu" on page 213.

Manage Visible Columns. Opens the Manage Visible Columns pane
where you can select the columns you want to be displayed in the Package
Manager page. By default, all the columns are selected. You can hide a
column simply by deselecting it.

Q Bulk Actions. Enables you to perform bulk actions on the selected
N packages. The available options are:

« Undeploy. Performs bulk undeploy on some or all of the selected
packages.

« Delete. Performs bulk delete for some or all of the selected packages.
This action deletes the selected packages from the Package Manager
while the resources from the packages remain in the system.

« Content Overview. Enables you to view the resources included in the
selected packages.

« Export. Performs bulk export for some or all of the selected packages.

fit] Click to read a description of the package, as well as other relevant
information.

Build Number The build number of the package.

Category The text you want to set as the category for the package.

Description The description of the package, as displayed on the Package Properties page

of the Create Custom Package.

Factory A check mark that identifies the package as a factory package.

Note: A factory package indicates a default package that is deployed
with the installation.

Name The name of the package.

Sort by Enables you to sort the packages according to any of the visible columns,
either upward or downward, using the arrows. Sorting is done by default using
the Name field in ascending order.

Version The version of the package (the UCMDB version or the content pack
version).
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Package Properties

This option allows you to edit an existing package.

To access the Package

Properties page, open a package, and then select the Package Properties

item to edit an existing package.

The following table describes the user interface elements on the Package Properties page:

Ul Element (A-Z)

Description

Package Build Number The build number of the package.

Package Category
Package Description

Package Name

Resources Pag

This page allows you to

A text for any notes you want to associate with the package.
A description of the package.

The name of the package.

| Note: The package name cannot be edited.

e

view the list of existing resources.

To access the Resources page, click the Resources tab on the Package Manager page.

The following table describes the user interface elements on the Resources page:

Ul Element (A-2)

Q
Y

Added at

CMS Ul (2018.08)

Description
Find. Enables you to search for a resource by its name.

Type a keyword in this field to search within the list. All the resources with the
name that matches the keyword are displayed below.

Filter. Opens the Filter menu. You use the Filter menu to show only the
resources you want displayed on the Package Manager page. For details, see
"Filter Menu" on page 213.

Manage Visible Columns. Opens the Manage Visible Columns pane
where you can select the columns you want to be displayed in the Package
Manager page. By default, all the columns are selected. You can hide a
column simply by deselecting it.

The time when the resource was added in the package.
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Ul Element (A-2) Description

Extension The extension of the resource.

Package Name The package that contains the resource.
Resource Name The name of the resource.

Sort by Enables you to sort the resources according to any of the visible columns,
either upward or downward, using the arrows. Sorting is done by default using
the Resource Name field in ascending order.

System Type The type of the resource.

Version The version of the package (the UCMDB version or the content pack version).

Resource Selection

This option allows you to add the required resources to the package, by selecting the required
resources from the various resource types.

To access the Resource Selection page, open a package, and then select the Resource Selection
item.

Note: You can make multiple selections from each resource type.
The Resource Selection page contains two tabs:

» Manage Resources

« Package Content Overview

Manage Resources tab

This tab allows you to add the required resources to the package.

The following table describes the user interface elements on the Manage Resources page:

Ul Element
(A-2) Description

Q Find. Enables you to find a resource in the list of resources.
Clear all Clears all the selected resources.

<Resource Contains the resource types from which you can choose the required resources to
types> add to the package.
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Ul Element

(A-Z) Description
For details of a list of the available resource types and their descriptions, see
"Resource Types" on page 205.

Select all Selects all the resources.

Package Content Overview tab

This tab enables you to view the resources included in the package.

The following table describes the user interface elements on the Package Content Overview page:

Ul Element (A-Z) Description

<Selected Displays the resources that were selected to be part of the package, divided
resources> by their type.

Work with Package Manager

How to Create a Custom Package

When you create a new package, you give the package a unique name and description, and then select
the resources you want included in the package.

. - . CREATE PACKAGE
To create a custom package using existing resources, click the button on the

Package Manager page.

The following table describes the user interface elements on the Create Package page:

Ul Element (A-Z) Description

Package Build Number The build number of the package.

Package Category A text for any notes you want to associate with the package.
Package Description A description of the package.
Package Name The name of the package.

For example, you want to create a custom package. To do this, follow these steps:
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_ CREATE PACKAGE o _ ,
1. Click the button, enter the required information, and then click Go and

Manage Resources.

2. Select the resources to be included in the package, and then click Save. To view the resources
selected, click the Package Content Overview tab.

How to Deploy a Package

You can deploy some or all of a package's resources to the from your local directory. The package
must be on your local directory in order to deploy its resources.

To deploy resources from packages on your local directory:

) % INSTALL PACKAGE
1. Click the button to open the Install Package menu.

2. Click the Install Package tab.

3. Click the Select file for upload field, select a package zip file, click Open, and then click the

UPLOAD
button.

4. Select the resources that you want to deploy. All the resources are selected by default.

5. When you have selected all the resources you want to deploy, click Deploy Selected.
Note: Every time a package related to a change in the class model is deployed or undeployed, a
zip file is generated in the runtime\log\packageage_reports\customer_1\classModel folder.

The zip file contains the class model file before the change, the class model file after the change,
and the package deployment report.

How to Delete a Package

You can delete a package from the Package Manager page while the resources from the package
remain in the system. The package that is deleted is removed from the list of packages on the Package
Manager page.

To delete an existing package, open the package, and then select the Delete Package item.
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For example, you want to delete a package called MyPackage.zip from the system. To do this, follow

these steps:

1. Open the MyPackage.zip package.
2. Click the Delete Package item in the left pane.

3. Click the Delete button in the Delete Package page.

How to Delete Multiple Packages

You can delete multiple packages from the Package Manager page while the resources from the
packages remain in the system. The packages that are deleted are removed from the list of packages
on the Package Manager page.

To delete multiple packages, select the packages, click the - 9 button in the right comer, and then

click the Delete item.

For example, you want to delete multiple packages from the system. To do this, follow these steps:
1. Select the required packages.

Click the ==~ 9 button in the right corner.
In the Bulk Actions menu, click the Delete item.

Select the packages you want to delete.

o > w0 N

Click the Delete Selected Packages button.

How to Export the Packages List

You can generate a report which contains a list of packages that are deployed in the system, or a list of
filtered packages.

For example, you want to generate a report which contains a list of packages that are deployed in the
system. To do this, follow these steps:

1. Click the button.

2. Select Export all Packages.
3. Inthe Type drop-down list, select the export format for the table data.

4. Click the Export button.
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Note: If you want to generate a report that contains a list of filtered packages, select Export
filtered packages option.

How to Export a Package

You can export some or all of a package's resources, or a whole package to your local directory.
To export a package, open the package, and then select the Export Package item.

For example, you want to export only some of the resources contained in a package to your local
directory. To do this, follow these steps:

1. Open the package.
Click the Export Package item in the left pane.

In the Export Package page, choose the Export Resources Only option.

> w0 D

Click the Export button.

Note: If you want to export the whole package, click the Export Whole Package option, and then
click Export.

How to Export Multiple Packages
K]

To export multiple packages to your local directory, select the packages, click the - button in the

right corner, and then click the Export item.

For example, you want to export multiple packages to your local directory. To do this, follow these
steps:

1. Select the required packages.

2. Click the == = button in the right corner.
In the Bulk Actions menu, click the Exportitem.

Select the packages you want to export.

o A~ w

Click the Export Selected Packages button.
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How to Install/Deploy a Discovery and Integration Content

Pack

Universal CMDB is released together with the latest version of Discovery and Integration Content
Pack. You can install a later Content Pack release by performing the following procedure:

1. If the required Content Pack is available on the local file system of the UCMDB server, access the

B INSTALL PACKAGE
Package Manager module. Click to open the Install Package menu.

2. Click the Content Pack tab.

B EXPLORE CONTENT PACK _ _
3. Click , select the package's files, and then click Install

Selected.
4. UCMDB begins to install the Content Pack.
When installation is complete, a message is displayed with the results of the installation.

5. If the required Content Pack is not available on the UCMDB server, access it from the ITOM
Marketplace site. To access the site: Data Flow Management > UD Community.

6. Download the zip file and extract it to an accessible location on your drive.

7. Inthe Package Manager > Install Package > Content Pack tab, click the Select file for
upload field, select the required content pack from your local file system, click Open, and then

i UPLOAD i
click the button to add the content pack on the local file system of the UCMDB

server.

FS EXPLORE CONTENT PACK
8. Click , select the package's files, and then click Install

Selected.
9. UCMDB begins to install the Content Pack.

When the installation is complete, a message is displayed with the results of the installation.

How to Undeploy a Package

This option allows you to delete the resources from the system and to remove them from the selected
package.
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Important:

« When you undeploy a package, the resources are removed from the system, and from the other
packages that contain these resources. You can restore the resources only when a package
containing those resources is deployed.

« If you delete all the resources from the package, the package is automatically deleted and
removed from the list of packages on the Package Manager page.

The following table describes the user interface elements on the Undeploy Package page:

Ul Element (A-
Z) Description
Q Find. Enables you to find a resource in the list of resources.
Clear all Clears all the selected resources.
<Installed Displays the resources contained in the selected package. Select the resources
Resources> you want to delete from the system.
Select all Selects all the resources.

For example, you want to undeploy a package. To do this, follow these steps:

1. Open the package.
Click the Undeploy Package item in the left pane.

In the Undeploy Package page, select all the resources.

> w0 b

Click the Undeploy Package button.

How to Undeploy Multiple Packages

To undeploy multiple packages, select the packages you want to undeploy, click the -+ 9 button in

the right corner, and then click the Undeploy item.

The following table describes the user interface elements on the Bulk Undeploy page:

Ul Element (A-Z) Description

Q Find. Enables you to find a resource in the list of resources.
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Ul Element (A-Z) Description

Clear all Clears all the selected resources.

<List of Displays the packages selected. Select the packages you want to delete from
packages > the system.

Select all Selects all the resources.

For example, you want to undeploy multiple packages. To do this, follow these steps:
1. Select the packages.

2. Click the = = button in the right comner.

In the Bulk Actions pane, click the Undeploy item.

Select the packages you want to undeploy.

o M

Click the Undeploy Selected Packages button.

Probe Dashboard

The Probe Dashboard option in the CMS Modules navigation pane opens the Probe Dashboard
module. It retrieves and displays real-time information about data flow probes and workflow/discovery
jobs in a centralized view, allowing you to easily view all probes and jobs, and also drill down to probe
and job details.

This section contains the following:
Probe Dashboard Overview ... 225

Probe Dashboard Overview

Note: The Probe Dashboard module is available for users with the Show Status Snapshot
permission.

The Probe Dashboard module retrieves and displays real-time information about data flow probes and
workflow/discovery jobs in a centralized view, allowing you to easily view all probes and jobs, and also
drill down to probe and job details from CMS Ul, without having to logging into the UCMDB server.
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The snapshot of probes is automatically updated every 30 seconds, and the snapshot of jobs is

automatically updated every 5 minutes.

Probe Dashboard User Interface

To
access

Go to CMS UlI, click the menu icon E on the upper left corner to expand the
CMS Modules pane, and then click Probe Dashboard.

Probe Dashboard window

User interface elements of the Probe Dashboard main window are described below:

Ul Element
(A-2) Description
E CMS Modules. Opens the CMS Modules, and allows you to navigate through the

available web-based CMS modules. For details on available modules, see the
Universal CMDB Home Help.

<username> <username>. Displays the current user that logs in to CMS UlI. Clicking it allows to
ﬁ log out of the CMS UI.

CMS Ul (2018.08)

Help. Opens the Help menu:

Help. Opens the Probe Dashboard Help page.

Online Help for CMS Ul. Opens the online help for the current CMS Ul version
available on the Micro Focus Software Information Portal.

Online Help for UCMDB Server. Opens the online help for the current UCMDB
Server version available on the Micro Focus Software Information Portal.

Online Help for Content Pack. Opens the online help for the current Content
Pack version available on the Micro Focus Software Information Portal.

About. Opens the About dialog box.

The ABOUT tab provides version, patch (if available), copyright, and third-party
notice information. For more information, see "About Window" on page 122.

The LICENSE tab provides license information, including license status, license
summary, and a license status link. Clicking the license status link opens the
license summary report, which contains license consumption summary and
available licenses, and a link that allows you to export a detailed license
consumption report. For more information about licenses, see "Universal
Discovery Licensing Overview" on page 422.
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Ul Element
(A-2) Description
Clicking OK exits the About window.
O\ Search. Type keyword(s) in this field to search within the probes list.
| Note: The searchis performed only on the Probe Name field.
? Filter. Opens the Filters pane, where you can filter the probes by selecting All ora
specific status of the following fields as filters:
» Connection Status
» CPU Status
» RAM Status
» Hard Disk Status
[[[]] Choose Columns. Opens the Choose Columns pane, where you can select the

columns to display. Required columns are selected by default.

<Pie chart The pie chart view section comprises of four charts:

view> Connection Stat
section « Connection Status
« RAM Status
. CPU Status, and
« Hard Disk Status
By default the total count of probes is displayed in each pie chart. When you hover
the mouse over a specific pie section, the probe count displayed in the pie chart
varies accordingly. When you click a specific pie section, the table view section
below the pie charts displays details about the corresponding probes accordingly.
<Table By default the table view section displays the following information about all probes.
view> you click a specific pie section, the table view section display varies accordingly.
section

« Domain*. Domain where a specific probe belongs to.

« Probe Name*. Probe name. Clicking a probe name opens the probe details
window. See "Probe Details window".

« Connection Status*. Connection status of a specific probe with the UCMDB
server: Active or Inactive.

« IP. IP address of the probe.

« CPU Usage*. CPU usage rate.

« RAM Usage*. RAM usage rate.

« Hard Disk Usage*. Hard disk usage rate.
« Unsent Cls. Total count of unsent Cls.

« Total Discovered Cls. Total count of discovered Cls.
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Ul Element
(A-2) Description

« Running Jobs. Count of running workflow/discovery jobs.
« Total Jobs. Total count of workflow/discovery jobs.
« Active Workers. Count of the active worker threads.

« Total Workers. Total count of the worker threads.

| Note: *indicates a required column.

Probe Details window

Clicking a probe name in the Probe Dashboard table view section opens the probe details window,

which displays details about the selected probe.

User interface elements of the Probe Details window are described below:

ul

Element

(A-2) Description

é Back to Dashboard. Allows you to return to the Probe Dashboard window.

/ [) Collapse / Expand. Clicking a header with a Collapse or Expand icon allows you to
collapse or expand a subsection in the probe details window.

<Probe Displays the following information:
Details>

window « Basic Information. Basic information about the selected probe.

» Discovery Progress. Discovery progress of the workflow/discovery jobs.

« Jobs. Displays the following details about the workflow/discovery jobs: Job Name,
Progress, Thread Number, Succeeded Triggers, Total Triggers, Previous
Invocation, and Next Invocation.

You can drill down to more details about a selected job by clicking the job row in this
section to opens the Probe Details pane in the right side of the window. For more
details, see "<Job Details> pane".

» Discovery Result. Discovery result of Cls returned by all the jobs, including CI
Type, total count of Cls and Cls created, updated, or removed.

<Job You can access this pane by clicking a job row in the Jobs section of the Probe Details
Details> | main window.

ane
P The Probe Details pane comprises of the following sections:
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ul
Element
(A-2) Description

« Basic Information. Basic information about the selected job.

« Job Progress. Progress of the selected job. For a discovery job, a progress bar is
displayed. For a workflow job, specific workflow steps are displayed.

« Job Schedule. Schedule information about the selected job.

« Discovery Result. Discovery result of Cls returned by the selected job, including
Cl Type, total count of Cls and Cls created, updated, or removed.

Reports

The Reports module provides a method of displaying the data from views in a report format.

Tip: Toview a query in a report format, use the following URL: http://<server_
name>:<port>/ucmdb-browser/ucmdb_widget.jsp?server=<ucmdb-
server>&locale=en#isQuery=true;tab=reports;report=<queryName>

To access the Reports module, use one of the following methods:

« InCMS UlI, click the Menu icon (E) to expand the CMS Modules pane, and then click Reports.

« InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click
UCMDB Browser. In the UCMDB Browser module, click Reports.

The Reports module is divided into two sections:

Reports Dashboard

The Reports dashboard is divided into two sections:

- Basic Reports
Basic reports list the Cls for a main and related Cl type that you select. Each thumbnail includes:
o The Report's name

o The Report's icon
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o The Report's description
o The Report's labels

Hovering your mouse over a Basic report allows you to access the following:

o

Execute Report

(e}

Delete Report

o

Edit Description

(e}

Labels

You can create Basic reports in the UCMDB Browser module.

Note: You must be assigned the permission to create views and queries in UCMDB in order to
create basic reports in the UCMDB Browser module.

« Topology Reports

This section displays the 20 most visited topology reports. Each thumbnail includes:

(e}

The Report's name

o

The Report's icon

(e}

The Report's description

o

The Report's labels

Hovering your mouse over a Topology report allows you to access the following:

o Execute Report
o Labels

Every view defined in the Modeling Studio in UCMDB has a corresponding topology report.
UCMDB Browser reports are based on one of the following:

o Pattern views - A pattern view is based on a particular TQL query that defines the structure of
the view. When the view is displayed or refreshed, the Modeling Studio queries the CMDB for all
elements that fit the query, and automatically updates the view with those elements.

o Templates - A template is a view that is based on a reusable pattern view (template) and has
defined parameters which are saved as part of the template. The view displays only those Cls
and relationships that satisfy the query definition and the conditions of the template. You cannot
schedule this type of report or change its parameters in the UCMDB Browser module.

The report settings are defined in the view definition in Report mode in the Pattern View Editor. For
details, see "Pattern View Editor" in the Modeling section of the UCMDB Help. You cannot create
Topology reports in the UCMDB Browser module.
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Reports Right Panel

The right panel allows you access the following features:

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

<search
reports> field

CATEGORIES-
LABELS switch

Expand button

Collapse button

Clear All button

CMS Ul (2018.08)

Allows you to search for reports by entering a keyword.

Note: Inthe Reports module, the search field acts as a filter for the reports.

Allows you to switch between the Labels view and the Categories view.
CATEGORIES view

Displays the reports available in tree mode.

LABELS view

In the Labels view of the Reports module, you can quickly locate a group of
reports that have certain labels. UCMDB administrators can manage the labels
and assign labels to reports.

To switch to the Labels view, click the CATEGORIES-LABELS switch at the
top-right corner in the Reports tab. The right pane then lists all the labels.

The Labels view works in the following manner:

« If you do not select any label, the left pane displays all the reports.

« If you select one or multiple labels, the left pane only displays the reports
that have one of the selected labels.

When a label is assigned to a report, the report icon shows the label name at the
bottom. When a report has multiple labels and the icon cannot contain all the

label names,a ™ icon appears. You can click this icon to view all the labels
assigned to the report.

For more details about how to group reports with labels, see "Use labels to
group reports" on page 245.

Available in the CATEGORIES view only. Clicking the button expands the
entire tree view of reports.

Available in the CATEGORIES view only. Clicking the button collapses the tree
view of reports.

Available in the LABELS view only. Clicking the button clears all labels.

Page 231 of 446



CMS Ul Guide

Ul Element (A-Z) Description

Refresh Reports button. Refreshes the reports.

View Scheduled Reports button. Clicking the button opens the View
Scheduled Reports pane. See "View scheduled reports" on page 242.

Available in the LABELS view only.
Create Label

Create Label. When you click the button, a Label Name text field displays. To
create a label, in the Label Name text field, enter the label name, and then click

Create Label +
or press Enter.

Available in the LABELS view only.
Create Label «

Create Label +. Indicates you are in the process of creating a label. Click the
button to confirm the label creation.

Available in the LABELS view only.
Manage Label

I I I 1

Manage Label. Opens the Manage Label dialog box, where you can rename or
delete labels. See "Rename or delete a label" on page 245.

Create a basic report

1. Inthe Basic Reports section of the Reports module, click o The Basic Report Wizard opens.

2. Enter a name (and optional description) for the report, and click Next.

Note:

o The name cannot contain the following characters: , ; & =@ % / \

o The description will appear in the report icon and at the top of the generated report.

You can edit the description after you create the report. To do this, point to the report, and
then click Edit Description from the context menu.

3. Select the main Cl type that you want to appear in the report, and then click Next.

To quickly locate a Cl type, you can filter the list of CITs by entering a text string, or click one of
the favorite Cl types above the list.

4. (Optional) Select an attribute condition for the main CIT (including an operator and value) that you
want to appear in the report. To add additional attributes, click [+] Add attributes. Click Next to
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select arelated Cl type.

Note:

o When you select the first attribute condition for the main CI Type, if the attribute selected
is Display Label and the operator is Like case insensitive, after you save the report,
these selections will be removed from the attribute conditions list and the value you
added will be displayed in the Name field.

o When you use the Contains operator, the different values added to an attribute should be
separated by comma. This is because the Contains operator supports only one value in
the UCMDB, and in the UCMDB Browser module the different values that are added to an
attribute are split into multiple conditions.

o When you use the In operator, the different values added to an attribute should be
separated by comma.

5. (Optional) Select a related Cl type, and then click Next.

To quickly locate a Cl type, you can filter the list of CITs by entering a text string, or click one of
the favorite Cl types above the list.

You can only include one related Cl type in a report. If you click more than one related Cl type, the
last item you clicked is the one that will be included in the report. To clear this field completely,
click Deselect.

6. (Optional) Select attributes for the related ClI type (including an operator and value) that you want
to appear in the report. To add additional attributes, click [+] Add attributes.

Note:

o When you use the Contains operator, the different values added to an attribute should be
separated by comma, and listed in one field. This is because the Contains operator
supports only one value in the UCMDB, and in the UCMDB Browser module the different
values that are added to an attribute are split into multiple conditions.

o When you use the In operator, the different values added to a string attribute should be

separated by comma, and listed in one field.

7. When you are finished, click Save.
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Create a report from search

1. Onthe main search page, click Advanced Search.

2. Select the main Cl type that you want to appear in the report, and then click Next.

To quickly locate a Cl type, you can filter the list of CITs by entering a text string, or click one of
the favorite Cl types above the list.

3. (Optional) Select an attribute condition for the main CIT (including an operator and value) that you
want to appear in the report. To add additional attributes, click [+] Add attributes. Click Next to
select arelated Cl type.

4. (Optional) Select a related Cl type, and then click Next.

To quickly locate a Cl type, you can filter the list of CITs by entering a text string, or click one of
the favorite Cl types above the list.

You can only include one related Cl type in a report. If you click more than one related Cl type, the
last item you clicked is the one that will be included in the report. To clear this field completely,
click Deselect.

5. (Optional) Select attributes for the related Cl type (including an operator and value) that you want
to appear in the report. To add additional attributes, click [+] Add attributes.

6. Click Search.

7. Inthe left pane, click Select Attributes for Report. The Select Attributes for Report dialog box
appears.

8. (Optional) select the specific attributes that you want to be included in the report.
9. Click Apply and go to Reports.

10. (Optional) Perform the following steps if you want to save the report for later use:
a. Click Save Report =]

b. Enterareport name and optional description, and then click Save.

The report is added to the basic reports.

Open a report

Note: To open areport, you can either select the report, or click the I Execute Report option that
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appears when you hover the mouse over the report.

1. Inthe Reports tab, select the basic report to open.

2. Click » Execute Report
The following actions are available in an opened report:
. Delete Report
Note: Delete Report . action is available only for the basic reports.
. Save Report B
. Select Attributes for Report Qo
. Schedule Report I

« Exports Results [=

« URL to Report 2
The following features help you quickly locate an item in the opened report:

« Expand All: Click this button to expand all Related Cls.
« Collapse All: Click this button to collapse all Related Cls.

« Search Results: Type the keyword in this field and then press Enter to search within the generated
report.

Note: The search is performed only on the Display Label field.

You can change the order of the columns in a report by dragging them to the desired position.

Note: If you move the Display Label column and you save or export the report, the Display
Label column restores to its initial position.

Generate a report

Note: You can generate only the template-based topology reports.

1. Inthe Reports tab, select the template-based topology report that you want to generate.

2. Click Generate Report .
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The content of the report is generated according to the template that is specified in UCMDB. You
can specify parameters for the included Cls that will be included in the generated report. To return
to the default parameters, click Reset parameters to default C.

The following actions are available in a generated report:

. Generate Report

« Reset parameters to default G
« Save Report B

. Select Attributes for Report Qo
. Schedule Report <

« Exports Results =

« URL to Reportza
The following features help you quickly locate an item in the generated report:

« Expand All: Click this button to expand all Related Cls.
« Collapse All: Click this button to collapse all Related Cls.

« Search Results: Type the keyword in this field and then press Enter to search within the generated
report.

| Note: The search is performed only on the Display Label field.

Edit a report

1. Inthe Reports tab, select the basic report that you want to edit.

2. Do one or more of the following:

o To change the main or related Cl type, click the name of the existing Cl type.
o Tochange attributes, click Edit attribute conditions %1 next to the main or related CI type.

3. When you are finished, click Save =]
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Delete a report

1. Inthe Reports tab, select the basic report that you want to delete.

2. Click Delete Report 2. A confirmation message appears.

3. Click OK to delete the report.

Note: To delete a report, you can also hover the mouse over the report and click the  Delete
Report option.

Select content to be displayed in a report

1. Inthe Reports tab, select the report (basic or topology) that you want to configure.

2. (Optional) Select Attributes for Report Qo to select the specific attributes that you want to be
included in the report.

You can select attributes from the tabs that represent the Cl Types in the selected report.
o Toinclude all attributes in the report, click #.

o Toinclude a specific attribute in the report, select it in the left pane and click k.

o Toremove a specific attribute from the report, select it in the right pane and click 4.

o Toremove all attributes from the report, click #.

3. Inthe Attribute Order tab, select an attribute and use the up or down arrows to change the display
order in the report.

Note: The attribute order is kept as it is defined by its owner in the UCMDB UI.

However, if a user changes the order in the UCMDB Browser module and saves it, the new
order will be kept for the user who changed it (the changes are saved in the user preferences).

You can revert the changes and you can view the attribute order as it is defined in the
UCMDB Ul, by clearing the user preferences as follows:

a. Goto JMX Console > UCMDB-Ul:name=User Preferences > clearUserPreferences.

b. In the user name field, enter the user's name.
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| c. Click Invoke.

4. When you are finished, click OK.

Schedule a report

| Note: Scheduled reports do not work properly in a high availability environment.

1. Inthe Reports tab, select the basic report or pattern view-based topology report that you want to

schedule.
2. Click Schedule Report 5.

3. Enter the following information:

Field Description

Recipients Enter the email addresses to which the report should be sent. If there
is more than one recipient, separate the entries with semicolons.

The administrator has to add every domain name you need to use to
a list of allowed domains. (For example, mydomain.com.)

To add a domain name to the list of allowed domains, follow these
steps:

a. InUCMDB, go to Administration > Infrastructure Settings
Manager > UCMDB Browser settings.

b. Inthe Name column, choose Scheduled Reports trusted email
domains for UCMDB Browser.

c. Inthe Value column, enter the needed domain name. If there is
more than one domain required, separate the entries with
semicolons. For example, mydomain.com; mydomaini.com.

To allow all the domains to be used, in the value column enter ;
(semicolon).

Templates Select one of the available templates from the drop-down list. A
predefined text message appears in the Email content field.

Email Enter the subject line of the email.

subject

Email Enter the text that will appear in the body of the email.
content
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Field

Select
report
formats

Select
action to
perform

Repeat

CMS Ul (2018.08)

Description

Note: If you select an existing template, a predefined text
message appears in the Email content field. You can either
leave it as it is, or modify it.

Select one or more of the formats (XML, XLS, XLSX, PDF, or CSV)
of the attachments that will be included when the report is sent. By
default, all formats are included.

Select one of the following options:

[e]

e}

Save to disk

In Administration > Infrastructure Settings Manager >
UCMDB Browser Settings> Scheduled Reports Save Folder
for UCMDB Browser setting, specify the destination folder for
the exports of the scheduled reports. The full path name must be
specified, beginning with the drive letter (absolute path).

Note:

« The destination folder is on the CMS Ul machine, not on
the local (user's) machine. The report will be saved in the
sub-folder named after the user who scheduled the report.

« After changing the default value, you must log in again in
CMS Ul for the change to take effect.

« Ifapathis not specified, the Save to Disk option will be
grayed out.

Send email. The report will be sent by email.

Select the frequency at which the report will be generated:

[e]

[e]

Once. The report will be sent at once, with no delay.

Interval. The report will be sent at a specific interval. You must
specify the interval in minutes (0-59 minutes).

Hourly. The report will be sent once per hour. You must select the
minute (0-59 minutes).

Daily. The report will be sent once per day. You must select the
hour (0-23 hours) and minute (0-59 minutes).

Weekly. The report will be sent once per week. You must select
the hour (0-23 hours), minute (0-59 minutes), and day of the week.

Monthly. The report will be sent once per month. You must select
the day (1-31), hour (0-23), and minutes (0-59 minutes).
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Field Description

Note: If you select 31 as the day for the report to be sent, it
will be sent only in months that contain 31 days (that is, only
7 times per year). To schedule reports to be sent on the last
day of the month, use the Cron scheduling option.

o Cron. You can use a Cron expression to schedule a job. For more
information, see "Cron Expressions" in the Data Flow
Management section of the UCMDB Help, or http://quartz-
scheduler.org/documentation/quartz-2.x/tutorials/crontrigger.

Exclude Select this checkbox to prevent the report from being sent on
weekends weekends.

To specify the days of the week that are weekend days, in UCMDB,
go to Administration > Infrastructure Settings Manager >
UCMDB Browser Settings and set the Days of the weekend
setting.

4. When you are finished, click OK.

How to create an email template

As an administrator, you can save the email content as a template, and then other users can reuse it at
any time.

To create an email template:

1. Enter the text that will appear in the body of the email.
2. Enter the name in the Template name field.

3. Click the Save button.

The newly created template is added in the Templates drop-down list.

Note:

o You can delete a template by clicking the Delete button.

o You can also update an existing template, by modifying the text message, and then
clicking the Save button. The email content of the reports that are already scheduled will
not be updated.

Specify the maximum number of templates that can be created

By default, the number of templates that can be created is limited to 100. To modify the value, follow
these steps:
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1. GotoJMX Console > UCMDB:service=Settings Services > setSettingValue.
2. Inthe name field, enter uemdb_browser.number_of_allowed_templates.

3. Inthe value field, enter the value of the maximum number of templates that you want to be
created.

4. Click Invoke.

Specify the maximum number of allowed emails that can be sent

By default, the number of emails that can be sent per second by an user is limited to five. To modify the
value, follow these steps:

1. InUCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.
2. Inthe Name column, choose Number of allowed emails.

3. Inthe Value field, enter the value of the maximum number of emails that you want to be sent per
second by an user.

4. Click Save.

5. Log out from CMS Ul, and then log in again for the change to take effect.

Note: The change takes effect according to the time set in one of the following settings:
o Time for which information in the Browser cache is valid
o Time for which UCMDB Settings in the Browser cache is valid

For more information, see "Settings affecting overall system operation".

How to use Extended Simple Mail Transfer Protocol (ESMTP)

The email transfer mechanism uses Extended Simple Mail Transfer Protocol (ESMTP), which allows
you to send emails to a server that requires secure connection.

To send an email using ESMTP:

1. InUCMDB, go to Administration > Infrastructure Settings Manager > Mail Settings.

2. Configure the following mail settings as described in the table below:
Activate TLS/SSL If SMTP server requires secure connection via TLS/SSL then the

connection value should be True, and UCMDB client properly configured. For
instructions on how to configure UCMDB client, see "How to
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Configure the UCMDB Mail Server" in the Administer section of the
UCMDB Help.

Else if SMTP server accepts non-secure connection, the value should
be changed to False.

SMTP server Enter the address of the SMTP server.

SMTP server port Edit the SMTP server port. The default value is 25.

The username of Enter the user name of the primary SMTP server. If no authentication
SMTP server is required, leave this filed empty.

The password of Enter the password of the primary SMTP server. If no authentication
SMTP server is required, leave this filed empty.

3. Gotothe UCMDB Browser module, and then follow the steps described in the "Schedule a
Report" section.

Caution: If SMTP server requires secure connection via TLS/SSL but the Activate TLS/SSL
connection setting is set to False, the email is not sent and the following error message appears
after 10 minutes: "An error has occurred, check serverlogs". If this happens, set the Activate
TLS/SSL connection setting to True.

View scheduled reports

1. Toview all the scheduled reports, click View Scheduled Reports B in the Reports tab.

2. If you are an administrator, select one of the following:

o Mine. Displays all scheduled reports for the currently logged-in user.

o All. Displays all scheduled reports, grouped by user.
The scheduled reports view contains the following columns:

« Report Name

o Schedule Owner

» Current Status

« Last Execution Time
» Last Execution Status

« Next Execution Time
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When viewing the scheduled reports, you can perform the following tasks:

« Sort scheduled reports by column title

To do this, hover the mouse over a column title, click the down arrow = , and then select Sort

Ascending or Sort Descending.

« Filter scheduled reports by column title

To do this, hover the mouse over a column title, click the down arrow ™ , and then hover over

Filters to display the filters that are available for that column. Available filters are displayed in the

following table.

Column
Report Name
Schedule Owner

Current Status

Last Execution
Time

Last Execution
Status

Next Execution
Time

Filters
available

Custom text
Custom text

o Completed
o Pending
o Paused

o Running
o Before

o After

o Success
o Failure

o None

o Before
o After

Description
Enter the desired text in the text box.
Enter the desired text in the text box.

Select one or more filters.

After selecting afilter, click the calendar icon fg] to
specify a date.

Select one or more filters.

After selecting afilter, click the calendar icon fg] to
specify a date.

To clear afilter, hover the mouse over the filtered column title, click the down arrow = , and then

clear the Filters checkbox. To clear all filters, select the Clear filter icon (\I-?I).

o Delete a job

To do this, select the desired job, and then select the Delete Job icon (E). Note that you cannot

delete a currently running job.

« Runajob

To do this, select the desired job, and then select the Run Now icon (D‘). Note that you cannot run

a currently running job.
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. Pause ajob

To do this, select the desired job, and then select the Pause Job icon (["] ). To resume a paused

),

job, select the Resume Job icon (U
« Refresh the list of jobs

To do this, select the Refresh icon (ﬂ).

Export a report

1. Select the report (basic or topology) that you want to generate.
2. Click Export results [

3. Select the desired export format (XLS, XLSX, CSV, PDF, or XML). The report is exported in the
selected format.

4. Click Open, Save, or Cancel.

Note:

« You can cancel the export of a report by clicking the E button. The cancel button remains
active while the export is in progress, even if you navigate to another module. Thus, you can
cancel the export when you return to the respective report in the Reports module.

« Inthe reports that are exported to XLS, XLSX, and CSV, the ' character is added in front of any
Cl attribute name that begins with one of the following characters: @ + - =.

Link to a report

1. Select the report (basic or topology) to which you want to link.
2. Click URL to Report =a.
3. Select one of the following:

o Copy URL. Opens the URL to Report dialog box. Select the URL and click Control+C to
copy the link to the clipboard.

To send reports from other Micro Focus applications, use the following URL formats:
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« For pattern-based reports:
<domain>/ucmdb_browser.jsp#report=<ReportName>;tab=reports
« Fortemplate-based reports:

<domain>/ucmdb_

browser.jsp#report=<

ReportName
>&<param1>=<value1>&<param2>=<value2>&<paramn>=<valuen>;tab=reports

Note: The ‘tab=reports’ section may appear either before or after can be before or after
report.

o Email link. Opens an email that contains a link to the report.

Use labels to group reports
Administrators can use labels to group related reports.

Create a label

1. Inthe Reports tab, switch to the LABELS view.

2. Click Create Label :
3. Inthe Label Name text field that displays, enter the label name, and then click

or press Enter.
Rename or delete a label

1. Inthe Reports tab, switch to the LABELS view.

2. Click Manage Label . The Manage Label dialog box appears.

3. Perform the following actions to rename or delete a label:

o Torename alabel, click Rename, enter the new label name, and then click Save Changes

Save Changes«’
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o Todelete alabel, click Delete.

4. Click OK .

Assign labels to a report

1. Inthe Reports tab, point to the report that you want to label.

2. Point to Labels in the context menu, and then click one or multiple labels in the label list that
appears.

3. Move the mouse out of the context menu.

Note: You can assign labels to a topology report only when the topology report appears under the
Topology Reports section.

Remove labels from a report

1. Inthe Reports tab, point to the report.
2. Point to Labels in the context menu, and then clear the checkboxes before the assigned labels.

3. Move the mouse out of the context menu.

Resource Manager

The Resource Manager option in the CMS Modules navigation pane opens the Resource Manager
module, which enables you to quickly search and consume various UCMDB resources in one place.

This section contains the following:
Resource Manager OVeIVIEW . ... o 246

How to Search and Consume Resources in Resource Manager .................................... 247

Resource Manager Overview

The web-based Resource Manager module is designed to allow users to quickly search and consume
various UCMDB resources in one central place. You can search for a specific UCMDB resource that is
supported to be consumed in the web-based modules accessible in CMS Ul.
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Compared to the traditional UCMDB Ul, there is no longer the need for you to switch between Views
and Query tree in the Modeling > Modeling Studio module to search for a view and a query.

You can consider the Resource Manager module as a search engine for UCMDB resources. The
search scope for different roles is determined by the privileges each role has. If you are an ADMIN, you
can search for any UCMDB resource; If you are a consumer, you can search only the resources that
you have rights for.

The Resource Manager is easily accessible anywhere in the CMS Ul through the top search bar with
dedicated filters available for each supported resource type for accurate results.

This release supports the following resources types:
« Queries. Including Views, Integrations, Discovery, Templates, Perspectives, Impact Analysis,
Enrichments.

« Views. Including Pattern Views, Templates, Perspectives, Perspective Based Views, Template
Based Views, Dynamic Widgets, Automation Flow Mapping, and Basic Reports.

« Models. Cl Types with the SERVICE_MODEL qualifier. By default, the following CITs can be

searched: BusinessApplication, BusinessService, InfrastructureService.

Users can only focus on the resources they have permissions.

After locating a resource, if the resource is a view or a query, users can open it in topology map; if a
model, then users can open it in the Service Modeling model if users have the required permissions for
the corresponding modules.

How to Search and Consume Resources in Resource

Manager

This chapter describes how to search and consume resources (views, queries, and models) with the
Resource Manager module.

Note: Users who search and consume various resources in the Resource Manager module need
the corresponding permissions for the resources and the modules they access.

If users do not have enough general action permissions, an error message will pop up asking them
to check the logs for details about which permission is missing.
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Prerequisites

For non-admin users who need to access the Resource Manager module, the administrator needs to
assign them the following permissions:

1. InUCMBDB Ul, go to Security > Roles Manager.

2. Inthe Roles pane, select the role for the target users, then in the General Actions tab pane for the
role, select the following actions in the Available Actions pane and move them to Selected Actions

pane:

o Data Retrieval Actions > Run Query by Definition

o System Access Actions > Access to SDK

o Configuration Management Actions > Deploy Packages
3. Inthe Resources tab pane for the role you selected, assign View permission for the desired view

and/or query resources.

Tip: It is recommended to add desired view/query resources into resource groups, then
associate View permission with the resource groups.

4. Save the change.

Note:

« A modelis a Cl, therefore non-admin users will get the same results as an admin user gets
when navigating and searching models.

« Ifamodel is assigned to a user tenant (say, TenantA), while a non-admin user (for example, a
user with view permission only) is not assigned to TenantA, then the non-admin user does not
have the permission to search this model.

How to search resources with admin privileges

1. Loginto CMS Ul as an admin user.

2. Expand the drop-down list to the right of the top search bar, select Queries & Models or Views &

Reports, and then type a search string (for example app) in the search bar.

Some auto suggestion strings pop up, select the desired string or press Enter.
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10.

1.

Note: If you selected Views & Reports, when hovering the mouse over an auto suggestion
string, a quick open icon (&) appears. Clicking the icon opens the selected resource in

Topology Map directly.
Search results display in two columns: Name and Path.
The search results counts are displayed at the top of page.

Scroll down to load more resources. Every time you scroll down, 50 more results are loaded.

Click the Filter icon (¥) in the upper right corner of the window. The Filters pane opens.
Select one or more query types, the resources displayed vary with the filters you selected.

Note: If yousearchin Views & Reports, the Filter icon displays in blue (), where filters of

the View type are selected by default.

Click afolder name or Path of any resource, the resources under the folder or path display
accordingly.

Click a breadcrumb. You are navigated to the corresponding folder.

Click the Back icon (<-). You return to the search result page.

Click the Filter icon (¥) in the upper right corner of the window. The Filters pane opens.
Select one or more view types, and type a string in the search bar to search view resources.
Or, select the Model type, and type a string in the search bar to search model resources.
View a specific resource.

o Click any query or view. The query or view opens in Topology Map.

o Click any model. The model opens in Service Modeling.

Click the Close view button (><). You return to the Resource Manager.

How to search resources with limited user permission

Loginto CMS Ul as a non-admin user.

Expand the drop-down list to the right of the top search bar, select Queries & Models or Views &
Reports, and then type a search string (for example app) in the search bar.

Some auto suggestion strings pop up, select the desired string or press Enter directly.

CMS Ul (2018.08) Page 249 of 446



CMS Ul Guide

Note: If you selected Views & Reports, when hovering the mouse over an auto suggestion
string, a quick open icon (£&) appears in the right. Clicking the icon opens the selected

resource in Topology Map directly.

3. Search results limited by the user permission display in two columns: Name and Path.
The search results counts display at the top of page.

4. Scroll down to load more resources. Every time you scroll down, 50 more results are loaded.

5. Click the Filter icon (¥) in the upper right corner of the window. The Filters pane opens.
Select one or more query types, the resources that display vary with the filters you selected.

Note: If yousearchin Views & Reports, the Filter icon displays in blue (), where filters of

the View type are selected by default.

6. Click afolder name or Path of any resource, the resources under the folder or path display
accordingly.

7. Click a breadcrumb. You are navigated to the corresponding folder.
8. Click the Back icon (<). You return to the search result page.
9. Click the Filter icon (¥) in the upper right corer of the window. The Filters pane opens.
10. Select one or more view types, and type a string in the search bar to search view resources.
Or, select the Model type, and type a string in the search bar to search model resources.
11. View a specific resource.
o Click any query or view. The query or view opens in Topology Map.
o Click any model. The model opens in Service Modeling.

Click the Close view button (><). You return to the Resource Manager.

How to navigate Resource Manager with admin privileges

1. Loginto CMS Ul as an admin user.

Once logged in, you are on the CMS Ul landing page.

2. Click the CMS Modules E icon in the upper left comner, then in the CMS Modules navigation

pane, click Resource Manager.
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Root folders are displayed: Query, View, and Model.
3. Click the Query folder. Query resources display.
In navigation mode, there is only one column: Name.

4. Expand a query resource and drill down.
5. Click a breadcrumb. You are navigated to the corresponding folder.

6. Click the Filter icon (') in the upper right corner of the window.

The Query filters are expanded and displayed, with filters for other resource types collapsed and
grayed out.

7. Click the Back icon (). You return to the root folder.

8. Do the same for the View and Model folders.

9. View a specific resource.
o Click any query or view. The query or view opens in Topology Map.
o Click any model. The model opens in Service Modeling.

Click the Close view button (><). You return to the Resource Manager.

How to navigate Resource Manager with limited user

permissions

1. Loginto CMS Ul as a non-admin user.

2. Click the CMS Modules E icon in the upper left corner, then in the CMS Modules navigation

pane, click Resource Manager.
Root folders are displayed: Query, View, and Model.

3. Click the Query folder. Only the query resources that the user has permissions display.
In navigation mode, there is only one column: Name.

4. Click the Filter icon (%) in the upper right corner of the window.

The Query filters are expanded and displayed, with filters for other resource types collapsed and
grayed out.

5. Expand a query resource and drill down.
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6. Click a breadcrumb. You are navigated to the corresponding folder.

7. Click the Back icon (). You return to the root folder.

8. Repeat the same steps to navigate Views and Models.

9. View a specific resource.
o Click any query or view. The query or view opens in Topology Map.
o Click any model. The model opens in Service Modeling.

Click the Close view button (*<). You return to the Resource Manager.
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Service Modeling

Note: Service Modeling is supported on UCMDB 10.22 (or later) with Content Pack 18 (or later).

Service Modeling enables you to model the infrastructure of a business service. A service can be
regarded as a perspective-based view on a particular Cl. When the discovery process runs,
relationships between a Cl and its owner and a Cl and its stakeholders are found, triggering additional
rounds (also referred to as "hops") of discovery for those related Cls.

To access the Service Modeling module, use one of the following methods:

o InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click Service
Modeling.

o InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click
UCMDB Browser. In the UCMDB Browser module, click Service Modeling.

Note:

« Thelink for a consumer-provider relationship between Cls is indicated with a blue line;
otherwise the link is indicated with a black line. Also, all the incoming and outgoing links for a
selected Cl are represented with bolded lines.

« Previously created models in the UCMDB Ul and in the UCMDB Browser module can now be
opened from Service Modeling. This includes Instance Based Models, Pattern Based Models
that do not contain the @ character in the name, models created in the Service Discovery
module in UCMDB Ul, and models created through Assisted Modeling. The Discovery and
Save Layer actions are disabled for these models.

You can model services, as well as run discovery and troubleshoot the discovery process. New
service models are based on Cl types that have the SERVICE_MODEL qualifierin UCMDB. After
running discovery, you are able to view the discovered Cls in the context of that business service.

When you create a new service model in the UCMDB Browser module, a discovery activity and a
perspective-based view with the same name are created in UCMDB, based on the Service_template
perspective. In addition, when you create a template-based model, the view also contains the specific
perspective that you select when you create the model.

You can also access the Assisted Modeling feature in the UCMDB Browser module through the
Service Modeling module. For more information, see Assisted Modeling.
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Note:

« Toenable a userto access the Service Modeling module in the UCMDB Browser module, in
the Roles Manager in UCMDB, click the General Actions tab and add the Service Modeling
permission (in the Data Flow Management Actions group) to the selected role.

« Toenable a user to create service models, assign Create permission for at least one Cl type
that has the SERVICE_MODEL qualifier assigned to it.

« Users who have only View permission for a Cl (and not Edit permission) will view the topology
map in read-only mode.

« Toenable access for a user to access a particular view, in the Roles Manager in UCMDB, click
the Browser Cl Access Control tab and assign View permission to that view.

« Toenable a user to run discovery in the Service Modeling module starting from a URL, in the
Roles Manager in UCMDB, click the General Actions tab and add the Run Discovery and
Integrations permission (in the Data Flow Management Actions group) to the selected role.

For more information about models, see the Modeling section of the UCMDB Help.

The Service Modeling module is divided into two sections:

1. Service Modeling Dashboard

The Service Modeling dashboard displays existing service models. The last service model
displayed automatically opens when you open the Service Modeling module.

The Service Modeling Dashboard displays a thumbnail for each service model, grouped by the
state at which the model was deployed. You can hide the service models from a specific group
simply by clicking the group's name. Each thumbnail includes:

o The name of the service model.

o The CI type on which the service model is based.

o The owner, if one exists for the service. If no owner exists, you can select one on the map by
clicking {+} Add Owner_

o Anicon showing the business criticality, indicating the relative importance of the service to the
business.

2. Service Modeling Left Panel
In the left panel you can do one of the following:
o Create a service model.

o Start assisted modeling. For more information, see Assisted Modeling.
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o Search for a service model by name.
o Filter the discovered models by owner.

o Expand or collapse the service models in the dashboard according to their state at which the
model was deployed.

Quick Start

This chapter lists the most common tasks and introduces the general concepts to help you start using
the Service Modeling module.

Required Setup of Service Modeling

See "Service Modeling Setup" on page 258.

How to Run Automated Service Modeling

See "Model a Business Service Starting from a Specific Entry Point" on page 260.

How to View the Topology Map
See the following topics:

« "Add Layers to an Existing Model" on page 269
« "Set Border Rules on a Link" on page 278

« "Simulate the Impact of a Cl's Failure" on page 271

Providers and Consumers

You connect to providers using connection strings. For example, if an Oracle database is a provider, to
connect to its services, you might need:

o The IP address of the machine

« The SID
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o The TCP port

These three pieces of information would comprise the connection strings required by a consumer,
which are needed to connect to a service offered by that provider. For example, an Oracle connection
string could contain the following information:

o IP addresses: 1.1.1.1,2.2.2.2
o Port: 1521
o SID: abcd

A consumer is aware of at least one connection string for a provider, and this connection string is found
in a known location, such as a configuration document, a database table, Windows registry, and so on.
By searching through these locations, dependencies between consumers and providers can be
discovered.

If the connection strings of a provider are found in a certain configuration document, then the provider
and the container of the configuration document are connected with a consumer-provider relationship.

Service Border Rule

You use service-border rules to define when one service ends and another one starts. These rules
enable the discovery process to categorize consumer-provider relationships as either internal or
external.

« An external consumer-provider relationship connects two components that belong to different
business services.

« Aninternal consumer-provider relationship connects two components that belong to the same
business service.

The discovery process can report this category for consumer-provider relationships, since it is
populated as the value of an attribute of the consumer-provider relationship.

You can therefore define the service scope to be all the components reachable from the start-point
component by a path made only of internal consumer-provider relationships (that is, only consumer-
provider relationships labeled as internal).

While discovering a service's components, the discovery process halts when it reaches a new provider
that is connected by an external consumer-provider relationship. This means that the discovery
process does not discover a provider's neighbors. To enable this functionality, you must define service-
border rules before you initiate the discovery process.
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However, in many cases, you want to discover the service before defining the service-border-rules.
You want to see which components make up the service, and only then define the service-border-rules
for these discovered components. To limit the discovery process and prevent it from endlessly
discovery neighbors of neighbors, use the Hop Limit setting when you create a Service Discovery
activity.

Hop Limit

You use the Hop Limit setting to limit the discovery process and prevent it from endlessly discovering
neighbors of neighbors.

The hop count for a Cl in a topology map is the total number of steps along the path from the root of the
map (Business Element) to the CI.

The discovery process halts when the discovery reaches a new provider and the hop count for this
provider reaches the hop limit. This means that the discovery process does not discover the provider's
neighbors.

When you create a Service Discovery activity in the UCMDB Browser module, the initial value of the
hop limit is set to 10. You can edit the value in the UCMDB User Interface.

AWS RDS Tunnel Job

ASM supports Relational Database Service (RDS) deployed in Amazon Web Services (AWS). A new
job AWS RDS Tunnel Job is introduced to correctly discover RDS database in AWS, allowing you to
capture service models more accurately in AWS.

When a RDS Database Cl is discovered by the AWS by Web Services job, the AWS RDS Tunnel Job
will be triggered, which will then create an Ownership relationship between ServiceConnectionPoint
and RDS Database ClI, and then the Running Software Dependencies job will create a consumer-
provider link. Below is an example of the final service map:
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Supported Technologies

For the supported technologies of Automated Service Modeling (ASM), refer to ASM Content Support
Matrix in the following document of the corresponding Content Pack that is deployed on the UCMDB
Server:

Universal CMDB Discovery and Integrations Content Help

Service Modeling Setup

This chapter describes the necessary setup before running Service Modeling.

Set up the Data Flow Probes

« Verify that the Data Flow Probe is installed on a Windows machine

Note: The Data Flow Probe installed on a Linux platform is intended for the CMS Sync
integration only, but not for discovery.

« Determine the network range of the network to be discovered

Note:
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o You must configure the probe's IP address in the probe range.

o A Service Discovery activity will only try to connect to those IP addresses that may
potentially be relevant for the discovered services, not to every IP address in the range.
Make sure the network range is wide enough and contains all the IP addresses for your
discovered services.

o Set the relevant credentials

To enable the Data Flow Probes to connect to servers or applications using specific protocols, you
must set the relevant credentials. Make sure the credentials have enough privilege; the root or root-
equivalent privilege is highly recommended.

Note: The Data Flow Probe tries to connect to a node by using each credential in turn.
Universal Discovery then saves the successful credential. The next time the Data Flow Probe
connects to this node, it first tries to connect using the successful credential.

Prerequisites

o The related credentials (NTCMD, SSH, and Universal Discovery Protocol) have been imported and
verified.

« The load balancers are discovered.

If the services to be discovered contain a load balancer, run the load balancer discovery before you
discover any services.

« Thelsof utility is installed on UNIX machines.

The Isof utility can capture the TCP traffics between the discovered UNIX machines, and can
check which process is listening on which port.

« The credentials have sudo permissions on UNIX machines.

« The web access management products are discovered.

If the services to be discovered contain web access management products (such as WebSEAL),
run the discovery jobs for them before you discover any services.

« The services are not deployed on Solaris Local Zone.
Solaris Local Zone is not supported by ASM.

o ThellS Web Server should be 1S 7.0 (or later) on Microsoft Windows Server 2008 (or later).
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Using Service Modeling

This chapter introduces how to use the Service Modeling feature.

Model a Business Service Starting from a Specific Enfry Point

This section introduces how to model a business service starting from a URL and from a Running
Software CI.

Starting from a URL

1. Inthe Service Modeling tab, click .

2. From the Choose Application Type drop-down list, select URL Entry Point.
3. Inthe IP-Port Entry Point field, enter the address that is the starting point for the discovery

activity.
4. Click Check URL Availability to verify that the address is available.

5. To further refine the model that will be created, you can click More Properties (optional) and
define the following:

Field Description

Name Enter a name for the service model.

For template-based models, a predefined name is assigned, consisting of the
name of the Cl on which the model is based and the type of the service.

Owner Select an owner from the drop-down list. This list includes all Cls connected to
the business service Cl type with an Ownership relationship.

Stakeholders = Select a stakeholder from the drop-down list. This list includes all Cls
connected to the business service Cl type with a Usage relationship.

Business Select the desired business criticality from the drop-down list. This attribute of

Criticality the Cl type indicates the relative importance of the service to the business. For
more information, see "Cl Type Manager Page" in the Modeling section of the
UCMDB Help.
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Field Description

Type Select a Cl type from the drop-down list. By default, the BusinessApplication
type is selected. This Cl type represents the service on which the Service
Model is based. Only ClI types that have the SERVICE_MODEL qualifier
assigned in the Cl Type Manager in UCMDB appear in this drop-down list and
can be used to model services.

Description Enter an optional description for the model.

Category Select a category for the model. Possible categories might be Draft, Test,
Development, or Production.

6. When you are finished, click . This runs the service discovery activity in

UCMDB (which is automatically created when you model a service) to discover the actual Cls
that comprise the business service.

When you model a business service starting from a URL, the URL protocol of the Entry Point URL is
http:// or https://.

Starting from a Running Software CI

You can model a business service starting from a Running Software CI.

To do this, follow these steps:

1. Search for the Running Software Cl that you want to use as the starting point.

2. Inthe search result, hover the mouse over the Running Software Cl, click the o icon, and then

click Create Service Model.

The Create Service Model page opens, and the IP-Port Entry Point drop-down list shows all the
related IpServiceEndpoint of the Running Software CI.

Note: If the Running Software Cl does not have any related IpServiceEndpoint Cl, the
Create Service Model page does not open and the following message pops up:

Service Discovery activity creation failed. Running software Ip-Port Entry

Point not found.

3. (Optional) Select an IP-Port entry point or type in a new IP-Port entry point.
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By default, the IP-Port Entry Point field uses the most possible IP and port from all the related
IpServiceEndpoint Cls. However, this value may be incorrect. In this case, you need to perform
this step to specify the correct IP and port.

Start Modeli o
4. Click -

When you model a business service starting from a Running Software ClI, the URL protocol of the
Entry Point URL is rs://.

Identify and Model Applications from Existing Data

1. Inthe Service Modeling tab, click .

2. From the Choose Application Type drop-down list, select one of the available templates.

Note: To add a perspective-based view to this list of templates, add it to the UCMDB_
Browser_Service_Modeling bundle as part of the TQL query definitionin UCMDB.

3. Select one or more of the displayed Cls. You can filter the list of displayed Cls by typing a string in
the Quick Search field.

The Cls that are displayed in the list are the results of running a perspective-based view in
UCMDB, but only the Cls that were returned by the contact node of the view. For example, if a
view contains a Node (the contact node) connected to an IP address, only Node instances that are
connected to IP addresses will appear in the list, and not all Nodes.

4. When you are finished, click . The Template Modeling pane opens, which

allows you to define properties for each of the models you are creating. You can change the
following properties:
Field Description

Name Enter a name for the service model.

For template-based models, a predefined name is assigned, consisting of the
name of the Cl on which the model is based and the type of the service.

Owner Select an owner from the drop-down list. This list includes all Cls connected to
the business service Cl type with an Ownership relationship.
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Field Description

Stakeholders = Select a stakeholder from the drop-down list. This list includes all Cls
connected to the business service Cl type with a Usage relationship.

Business Select the desired business criticality from the drop-down list. This attribute of

Criticality the Cl type indicates the relative importance of the service to the business. For
more information, see "Cl Type Manager Page" in the Modeling section of the
UCMDB Help.

Type Select a Cl type from the drop-down list. By default, the BusinessApplication

type is selected. This Cl type represents the service on which the Service
Model is based. Only Cl types that have the SERVICE_MODEL qualifier
assigned in the Cl Type Manager in UCMDB appear in this drop-down list and
can be used to model services.

Description Enter an optional description for the model.
Category Select a category for the model. Possible categories might be Draft, Test,

Development, or Production.

Note: Click Apply same to all models to apply each setting to all of the models you are
working on.

5. Click . A new CI of type BusinessApplication is created, and is

connected in UCMDB to the Cl on which the model is based.

6. If desired, you can change how information is displayed on the topology map. For more
information, see:

o "Show Additional Information on a Topology Map" on page 268
o "Add Layers to an Existing Model" on page 269
o "Simulate the Impact of a Service's Failure" on page 271

o "Simulate the Impact of a Cl's Failure" on page 271

Edit a Service Model

1. Inthe Service Modeling dashboard, open an existing service model.

2. Click Edit . The Service Properties widget opens.

3. Click EDIT MODE.

CMS Ul (2018.08) Page 263 of 446



CMS Ul Guide

4. Change one or more of the following properties:
a. Business Criticality
b. Owner
c. Location
d. Deploy Type
e. Description
f. Stakeholders
g. Name

Note: Inthe Name field, type in a new name for the service model. Renaming a model
changes the name of:

« The Cl that was created when the model was created.

e Theview in UCMDB with the same name.

« The associated discovery activity.

5. Click Save changes.

Delete a Service Model

1. Inthe Service Modeling dashboard, click an existing service model.

o Click Delete

Deleting a model deletes:

o The Cl that was created when the model was created.
o The view in UCMDB with the same name.
o The associated discovery activity.

3. Click OK to confirm the deletion.

Add an IP Range Manually

If the Probe shows the error message "the IP address is not in the discovery IP Range", you can
manually add a new IP range.
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1. Onthe Service Modeling dashboard, click an existing service model
2. Click Discovery Issues > Probe Errors. The Probe Errors pane displays.

3. Click a probe error entry with "the IP address is not in the discovery IP Range" error message.

The error message displays in details.

Add IP Range
4. Click .

The Add IP Range section displays.
5. Find the probe of your interest to which you want to add an IP range.

Click in the Search box, enter the IP address that is not in the discovery IP range, and then press
Enter. The returned result displays which probe the searched IP address belongs to.

6. Inthe Probe List section, expand the data flow probes/probe clusters tree, and locate the probe.

a. Select the probe of your interest. All IP Range(s) available for the selected probe are displayed
in the right pane.

b. Click in the right pane. The IP range editing section appears below the list of

existing IP ranges.

Define the new IP range as described below:

Ul Element Description

Range Define arange of IPv4 addresses using the following rules:
« The IP address range must have the following format:
start_ip_address — end_ip_address
For example: 10.0.64.0 - 10.0.64.57

« Thefirst decimal value (octet) of the start IP address and the
end IP address must be identical.

For example, 10.1.2.3-10.4.5.6

« Therange caninclude an asterisk (*), representing any number in
the range of 0-255.

« If you use an asterisk, you do not need to enter a second
IP address. For example, you can enter the range pattern
10.0.48.* to cover the range from 10.0.48.0 to 10.0.48.255.

« Use an asterisk in the lower bound IP address of the IP range
pattern only. If you use an asterisk in the lower bound IP address
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Ul Element

Description

Excluded IP
Ranges

CMS Ul (2018.08)

Description

and also enter an upper bound IP address, the upper bound
IP address is ignored.

« You can use more than one asterisk (*) in an IP address as long
as they are used consecutively. The asterisks cannot be situated
between two numbers in the IP address, nor can they be
substituted for the first digit in the number.

For example, you can enter 10.0.*.* but not 10.*.64.*.

A description about the IP range you specified above.

L. Add Excluded IP R .
Clicking enables you to define a new range of

IP addresses to exclude from the full range specified above, and enter a
description about the excluded range if desired.

Note:

« Therules for entering an excluded range are the same as for
entering a range. For details, see Range.

« The excluded range must be defined in the same IPv4 format as
the full network range.

To delete an excluded IP range that is still in the editing stage, click e
at the right end of the corresponding entry.

Examples:

You can divide a network range into several sub-ranges.
For example, if the range is 10.0.64.0 — 10.0.64.255

and you define three excluded ranges:

» 10.0.64.45-10.0.64.50
» 10.0.64.65-10.0.64.70
» 10.0.64.89-10.0.64.95

-

Network range
10.0.64.0 — 10.0.64.255

-

the ASM Discovery is performed over:
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Ul Element Description
o 10.0.64.0-10.0.64.44
« 10.0.64.51-10.0.64.64
« 10.0.64.71-10.0.64.88
o 10.0.64.96 —10.0.64.255

“ OK. Click this button to confirm adding the IP range you specified
above.

el Cancel. Click this button to cancel adding the IP range you specified
dance

above.

Il Delete Once you have added an IP range to the selected probe by clicking
“, this icon appears at the right end of the IP range
entry.

Click this icon to delete an IP range you added to the selected probe.
Note:

« You cannot delete any existing ranges.

« You can only delete the IP range(s) you have added to the
selected probe from the Probe Errors pane by clicking
“ and before clicking Save
Once clicking Save , you will not be able to delete any
IP ranges you added from the Probe Errors pane.

LVTFS Expand/Collapse the editing pane for adding IP range.

—— Save. Click this button to save the IP range you just added to the

selected probe.

7. Click

Note: It takes around 30 seconds for the newly defined IP range to populate the value for the IP
Probe Name property for the ClI of type ipAddress on the UCMDB server side. Make sure you
wait about 30 seconds before rerunning the discovery job. Otherwise the job may fail again due to
an empty value for the IP Probe Name property.
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View a Service Model in the Text Navigation Mode

1. Inthe Service Model dashboard, click an existing service model.

5 Click Show MNavigation Tree_

The right pane opens and lists all the Cls contained in the selected model.
The following features help you quickly locate a Cl in the model:
o Search for a Cl: Type the keyword in this field to search within the model

o Collapse All: Click this button to collapse all folded Cls and to see only the first level Cls

Show Additional Information on a Topology Map

1. Inthe Service Modeling dashboard, click an existing service model.

£ ACTIONS
2. Click and then click Additional Info to expand the

Additional Info section.

3. Select one or more of the following checkboxes to see the specific information indicators:

History Displays changes on Cls that are in the model during the specified time period.

Changes & To display history changes:

a. Select History Changes. The number of history changes according to the
current settings is displayed.

b. Click Change Settings to select the beginning and ending dates for the
changes.

c. Click to update the topology map.

Monitoring Displays the number of KPlIs on the Cls in the model.

Note: This option is displayed only when you are using the Monitoring
widget. Setup for the Monitoring widget is described in "Configure the BSM
Health Indicator (for the Monitoring Widget)" on page 395.

Policy Status | Displays the number of policy results on Cls in the model.
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Note:

o This option is displayed only when there is a live Configuration Manager
(CM) system deployed in the UCMDB environment.

o Policy indicators are counted for both the indicated Cl and the service in
which that Cl is located.

Incidents (@  Displays incidents on Cls that are in the model during the specified time period.
To display incidents:

a. Select Incidents. The number of incidents according to the current settings
is displayed.

b. Click Change Settings to select the beginning and ending dates for the
changes.

Update Incidents
c. Click to update the topology map.

Request for  Displays change requests on Cls that are in the model during the specified time
Changes #& | period.

To display change requests:

a. Select Request for Changes. The current number of change requests is
displayed.

b. Click Change Settings to select the time span for change requests.

Update RFCs
c. Click to update the topology map.

Problems Displays the number of problems on Cls in the model.

Owner Displays the Cl's owner.

Infrastructure = Displays the composite data.
Info

Discovery Displays the discovery progress indicators.

Note: Your selections are saved for all the service models in your user preferences.

Add Layers to an Existing Model

Four out-of-the-box layers (perspectives) are provided:
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Storage: Represents the generic relation of storage-related data, starting from Running Software
via Node to exported storage pieces.

Networking: Represents Node-related network topology. Depicts Node to Switch connectivity with
all interfaces, ports and VLANS relations.

Virtualization: An overall virtualization representation of Node virtual dependency with Running
Software iniit.

Clusters: Represents Cluster Topology from the perspective of Running Software and its relation
to CRG, Cluster, and Physical Node.

The following layers are available if ASM Enhanced Package or Content Pack 17 (or later) is deployed:

Related Node: Select this layer to display the related nodes of all running software.

Usually, the Related Node layer shows the Operating System of the computer on which the
software is running.

Service Connection Point: Select this layer to display the Service Connection Point (SCP) Cls.

A SCP is created during service modeling when the discovery job finds the next hop. The SCP ClI
contains the information for the next hop. For example, IP address, port number, and reference
information (such as context root, DB name). The SCP ClI triggers the discovery job for the next
hop.

Load Balancers: When you select this layer, the topology map displays load balancers.

You can add layers to the topology map in the following way:

1.

In the Service Model dashboard, click an existing service model.

3 ACTIONS
Click and then click Add Layers.
Show Layers
Click to execute the selected perspectives and to add new content

to the current map.

Do one of the following:

o Click Close and Save Selected Layers to save the selected layers, so that the next time you
open this service model, the perspective and content that you added will be visible in the
topology map.
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o Click Close without Saving Selected to discard the selected layers and to close the Add
Layers menu. Selected layers are not saved, but added content remains in the topology map
for the duration of the current session.

Simulate the Impact of a Service's Failure

Dependent Services presents services (Cls of types that have the SERVICE_MODEL qualifier) that
will impact the business service at a specified severity level, if they fail.

1. Inthe Service Modeling dashboard, click an existing service model.

£ ACTIONS

2. Click and then click Dependent Services.

3. SelectaClinthe map.

4. Specify the level of failure that you want to simulate.

Run Simulation

5. Click
will be displayed.

. The Cls that are most likely to impact your service if they fail

For more information, see "Dependent Services Widget" on page 338

Simulate the Impact of a Cl's Failure
1. Inthe Service Model dashboard, click an existing service model.

£ ACTIONS

2. Click and then click Impact Simulation.

3. SelectaClinthe map.

4. Specify the level of failure that you want to simulate.

Run Simulation

5. Click
in the model.

. The impact of the failure of the selected Cl will be displayed
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Run Discovery Manually for a Service Model

Run Discovery Manually for a Service Model

By default, service discovery jobs run automatically once each day. If necessary, you can use the
following procedure to run a discovery job manually.

1. Inthe Service Modeling dashboard, click an existing service model.

(¢} DISCOVERY
2. Click .

3. Check and edit the entry point before running the discovery process:

Click the Entry Point value to enter the Edit Entry Point mode, where you can add or edit the
URL that is the starting point of the service.

Once you have provided the entry point URL, you can click Check URL Availability to validate
the URL.

o Ifthe URL is available, URL Online is displayed with a success indicator @
o Ifthe URL is not available, URL Offline is displayed with an error indicator ®.

You can click URL Online or URL Offline again to check the current status of the entry point
URL.

To exit the Edit Entry Point mode, simply click .

. Save & Run Discovery L
4. Click .

Indicators for the discovery progress of each Cl are displayed on the topology map.

While the discovery process is running, the status Running Discovery is displayed, and the

. . . . . Stop Discovery L
number of discovery issues found is updating. You can click to
i i i
deactivate the currently running process, or click torestart the

process.

After the discovery process completes, you can see a message indicating the discovery process
has finished successfully or finished with errors.
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In case of errors, you can click Discovery Issues to open the Discovery Issues pane, which lists
errors grouped by the types of discovery issues . For details, see "Discovery Issues" below.

When you click a discovery issues type a pane opens and lists all the errors within the selected
category.

To see inthe Discovery Issues pane only the relevant discovery issues for a specific Cl and for its
trigger Cls, simply click the Cl's Discovery indicator.

5. After you have provided the required information, click torerun

discovery.

Discovery Issues

The Discovery Issues pane lists errors grouped by the types of discovery issues . The following types
of discovery issues may occur during discovery:

« Internal Errors

« Connection Errors

« Credential-Related Errors

For credential-related errors, you can provide new credentials for the selected protocol, and you can
save multiple protocols. When specifying credentials, you can specify the network scope for those
credentials:

o |IPv4 (either as IP range or as Classless Inter-Domain Routing (CIDR)

o |Pv6

Note: The newly provided credentials takes effect only after the discovery process has been
restarted.

« Timeout Errors

« Unexpected/Invalid Behaviors

« Information Retrieval Errors

» Resources-Related Errors

« Parsing Errors
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Encoding Errors

SQL Related Errors

HTTP Related Errors
Specific Application Errors

Probe Errors

For probe errors, you can see a pause indicator and meaningful error messages in the

following situations:

Clicking Probe Errors in the Discovery Issues pane opens the Probe Errors pane, where you can
click each of the probe errors to display detailed meaningful error messages.

Detailed error messages are available in the following situations:

o When the discovery job cannot run because the probe is suspended or disconnected, or there is
no setup for the probe.

o When the discovery job cannot run because the probe or the activity is in a blackout period.
o When the discovery job cannot run because the IP is not in the discovery IP ranges.

To fix this probe error, you can create a new IP range to contain the problematic IP address. To

do so, click the probe error entry and then click Add IP Range . For details, see

"Add an IP Range Manually" on page 264.
Software Related Errors

For Software Related Errors, you can see the ignored TCP connections of a running software and
you can add the missing ports in the portNumberToPortName.xml file. See "Add a missing port
manually" on the next page.

Others

For all other types of errors, you can click the B Email Administrator link to send a message to an

administrator for assistance.

Note: In some cases, if the message is too long, there might be an HTML limitation or an
Email client limitation, and the message may not be displayed entirely in the email.
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Add a missing port manually

1.

o > 0 b

6.

In the Discovery Issues pane, click Software Related Errors, and then select an error entry with
the following Problem Source message: "Some outgoing ports are filtered".

Click the Application Signature button.
Enter an Application Name.
Select all the ports you want to add in the portNumberToPortName.xml file.

Click Save Mapping.

Note:

o You can see the newly added ports in the UCMDB Ul > Data Flow Management >
Adapter Management > portNumberToPortName.xml file.

o You can also click the E3Email Administrator |ink to send a message to an administrator

for assistance.

After adding the missing ports, click to rerun discovery.

Manually Add an Entry Point to a Service Model Component

Sometimes the service map modeled by ASM may not be as complete as you expected. For example,

you know there is another running software behind a load balancer, or your organization's policy

stopped ASM to discover and model some Cls.

As a service modeler, if you fully understand your topology and know all the details about the topology,
to achieve a full modeling topology diagram, you may extend the service map by manually adding an
entry point to any component of a service model (business application or running software), so that the

new entry point can trigger further ASM discovery to find the next hop from the service model

component.

Caution: Perform this action only when you fully understand your topology.

To add an entry point manually to a service model component,

1.

From the Service Modeling dashboard page, click the service model (business application or
running software) of your interest.
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2. Onthe service map, hover your mouse over or click the component to which you want to add an
entry point.

3. Inthe context menu, click o and then select Add Entry Point == Add Entry Point .

4. Inthe Add Entry Point pane that appears, provide values for the following settings:
Field (*
required) Description

IP* Provide the IP address in IPv4 format.
For details about IPv4 format, see "New/Edit Range Dialog Box" in the Data Flow
Management section of the UCMDB Help.

Port* Provide the port number

Context | Provide a context string. The context string is optional and is used to identify the
unigue module. For example, if the entry point refers to an application in Web Server
as http://1.1.1.1:8080/test, the context string should be "/test".

5. Click OK.

After the new entry point is added successfully, it will automatically trigger new instances of the
Host Discovery by Shell jobs in this service activity to discover the target RunningSoftware Cls.

View a Service's Details
Note: Only the widgets that you have permission to view are displayed.

1. Inthe Service Modeling dashboard, open an existing service model.

2. Hoveryour mouse over a Cl in the model and click the button. Select one of the following:

Overview Displays CI Overview mode for all of the widgets that contains information
about the service model.

Service Displays the Service Properties widget, only for the Service CI.

Properties This option is present only if a Service Cl is selected. The information displayed

here is similar to the Properties widget. For more information, see "Properties
Widget" on page 367.

Note: Inthe Service Properties widget, you can change the name of an
existing service model. For more information, see "View a Service's
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Properties
History
Policy
Change
Requests
Incidents
Problems
Stakeholder
Business
Topology
Storage Data
Environment
Impact
Simulation
Defects
Dependent
Services
Monitoring
Dynamic (by
name)

Security

Automation
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Details" above.

Displays the Properties widget for the selected Cl. For more information, see
"Properties Widget" on page 367.

Displays the History widget. For more information, see "History Widget" on
page 353.

Displays the Policy widget. For more information, see "Policy Widget" on
page 363.

Displays the Change Request widget. For more information, see "Change
Requests Widget" on page 333.

Displays the Incidents widget. For more information, see "Incidents Widget" on
page 360.

Displays the Problems widget. For more information, see "Problems Widget"
on page 364.

Displays the Stakeholder widget. For more information, see "Stakeholder
Widget" on page 370.

Displays the Business Topology widget. For more information, see "Business
Topology Widget" on page 331.

Displays the Storage Data widget. For more information, see "Storage Data
Widget" on page 371.

Displays the Environment widget For more information, see "Environment
Widget" on page 349.

Displays the Impact Simulation widget. For more information, see "Impact
Simulation Widget" on page 358.

Displays the Defects widget. For more information, see "Defects Widget" on
page 336.

Displays the Dependent Services widget. For more information, see
"Dependent Services Widget" on page 338.

Displays the Monitoring widget. For more information, see "Monitoring Widget"
on page 363.

Displays dynamic widgets that contain the selected CI. For more information,
see "Dynamic Widgets" on page 346.

Displays the Security widget. For more information, see "Security Widget" on
page 368.

Displays the Automation widget. For more information, see "Automation
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Widget " on page 330.

Discovery Displays the Discovery Progress widget. For more information, see "Discovery
Progress Progress Widget" on page 339.

Get Related  Displays the Get Related widget. For more information, see "Get Related
Widget" on page 351.

Set Border Rules on a Link

By default, consumer-provider relationships between Cls are internal, meaning that they are contained
within a service model. Use the service border rules functionality to define which relationships are
actually external to your service trees.

1. Inthe Service Model dashboard, click an existing service model.

2. Hover your mouse over a Cl in the map and select Border rules on link from the context menu

g

3. Select alink from the displayed list.

4. Click . The following settings for the

border rule are displayed:

Field Description
Name* Enter a name for the border rule. (Mandatory)

References ' Describes one or more conditions on the References attribute of the selected
consumer-provider link.

You can enter comma-separated values.

Consumer  Inthis section, you define specify a Cl type and attribute conditions for End 1 of
the consumer-provider link.

Attributes that have already been defined on the model automatically populate the
corresponding fields here.

Note: Only attributes of type string or enum appear in the list.

Provider In this section, you specify a Cl type for End 2 of the consumer-provider link.

Note: Carefully verify that the attributes you set actually contain values that you specify for
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border rules. Otherwise, you will not be able to access the border rule in the UCMDB Browser
module. You will be able to access the border rules in UCMDB in Data Flow Management >
Adapter Management > <<No Package>> resource > Configuration Files.

5. When you are finished, click .

When a link is affected by a border rule during a discovery run, the Data Flow Probe updates the
following attributes on the consumer-provider dependency link:

« Is External is updated from False to True.

« Service Border Rules is updated to include the names of the border rules that affect the link.

Note:

« When you add a border rule, the link does not immediately change to External (indicated with a
dotted line for the link). Adding a border rule updates a configuration file on the Data Flow
Probe. After the discovery process runs, the relationship in the topology map will be marked as
External, providing that the relationship matched the conditions on at least one service border
rule.

« When avirtual link is marked as External, and that link contains multiple links, if at least one
contained link is external, this link will show up as External.

Group the Cls in a Service Model by Cl Type

1. Inthe Service Modeling dashboard, click an existing service model.

2. Click the Change Layouticon in the map toolbar at the left bottom of the window, and from

the Group by drop-down list, select Cl Type.

Fe i, m
"\_,_,J' \.._,—\_/A-r L N
l CHAMNGE GROUPING

Group e | O Type b

EWY IFgdding

;R

The topology map now displays the grouped Cls.
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o

-

You can expand the grouped Cls, simply by clicking the displayed number.

Arrange the Cls in a Service Model by Layers

You can arrange the Cls displayed in the topology graph by layers, according to the layer attribute that
is assigned to the CIT.

1. Inthe Service Modeling dashboard, click an existing service model.

2. Click the Change Layouticon in the map toolbar at the left bottom of the window, and from
the Layout drop-down list, select Swimlanes: layer.

Y e o S R N

CHANGE LAYOUT

Lagoust: | Swismlanesdayer S

CHANG: 1y

When you hover the mouse over a layer, the layer's label is displayed and the layer is emphasized.

o

Note:

To group Cls by CITs and also arrange them by layers, from the Layout drop-down list, select
Layers, and from the Group by drop-down list, select Cl Type.
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CHANGE LAYOUT
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CHANGE GROUPING
Greup e | €1 Type i
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The topology map now displays the Cls grouped by Cl Types and arranged by layers.
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Access a Service Model Using a Direct Link

As a user, you can access a service model using a direct link

The direct link to a Service Model is functioning exactly like the one for Reports. When a Service is
opened from the dashboard, the view=service_name item is added to the Internet browser URL. When
you switch back to the dashboard, this item is dropped. The link that is created when you select a
service can be used as a direct link. That is to say, when another user uses it (or the same user, in a
different internet browser), it leads the user directly to the selected service, without having to select the
Service Modeling tab in the header and then select the service from the service dashboard.

Map Toolbar

When information is displayed in a topology map format, the map toolbar is available in the left bottom
corner of the screen.

m-s-um--rmE

To access Click an existing Cl or service model from the UCMDB Browser module.

The map toolbar elements are described below:
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Ul
Element
(A-2)

11

+

Description

Full Screen. Changes the view to Full Screen.

Open quick navigation. Turns on the quick navigation map.

In the quick navigation map, the elements from the canvas are represented. You can
drag and resize the selection in the map overview.

If the map is too large, a big overview of the map is available, which allows you to use
the map overview navigator to jump directly to a particular part of the map.

A toggle button is available in the map to allow you to turn on/off the minimap. If the map
is larger than 20 Cls, the state of the button is saved in your user preferences.

Fit to screen. Sets the display of the topology map to fit to the current screen.
1:1. Change the map topology view to 1:1 scale

Zoom out. Zooms out the map topology.

Zoom in. Zooms in the map topology

Change Layout. Displays the LAYOUT SETTINGS option menu.
« General

o Deactivate Re-Layout. This toggle buttons allows you to set if you want to
deactivate re-layout.

o Auto-fit to screen. This toggle button allows you to set if you want the layout to
auto-fit the screen.

« CHANGE LAYOUT
o Layout: <option>. Select to use one of the following layout options:
« Swimlanes: layer
« Swilanes: classification
« Hierarchic: vertical
« Hierarchic: horizontal
« Organic
« Circular
« Directed Orthogonal
« CHANGE GROUPING
o Group by: <VIEW Folding> Select to use one of the following grouping options:

« VIEW Folding
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Ul
Element
(A-2) Description
o ClType
[ Export to SVG. Allows you to export the topology map in an SVG format.

Troubleshooting Automated Service Modeling (ASM) -

General Guideline

This chapter introduces the general troubleshooting guidelines for problems that may occur during the
Service Modeling process.

When an error occurs with a particular Cl in the topology map, an error icon appears on the Cl.

b

2
The following steps demonstrate the basic troubleshooting procedure for such an error:

1. View the error message in the UCMDB Browser module.
a. Click the erroricon on the ClI.

The Discovery Issues pane appears and lists all the related discovery issues.

Discovery Issues X
All Discovery Issues 1
Credential-Related Errors 1

b. Click one of the categories.

A list of errors of the category appears.
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c. Click an error to view the detailed error message.

Software Related Errors
The following outgoing ports are filtered because they are not in portNumberToPortName.xml: 13080, 61447, 61448,

61449, 61450, 61451, 61452, 61453, 61454, 61455, 61456, 61457, 61458, 65121, 65305, 65306
&, Download Discovery Log B Email Administrator % Troubleshooting Guide
2. Perform one of the following actions when appropriate.

o Forsome errors under Software Related Errors, you can directly provide some missing
information in the UCMDB Browser module. As in the above example, if you click the Add
Port Number button, you will be able to add the missing port numbers.

[http]16.155.155.45:8080 /webtier-9.51/index.do .
Problem Source: Some outgoing ports are filtered Back fo List

Add Port Number

PORT UPDATE

We have discovered new port numbers

Application Name

Port Number Select All  Deselect All
O 13080 =

61447 =

O a

61448

61449

oo

61450
] 61451

M a1457 =

Save Mapping

o Search the error message in this chapter, and try the suggested solutions.

3. Rerun the Service Modeling task.

Troubleshooting ASM - Host Discovery by Shell job

This chapter describes the error messages you may receive from the Host Discovery by Shell job and
provides suggested solutions.

Error Message: The IP address is not in the discovery IP Range

Error Category: Probe Errors
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Probe Errors
16BN is not in the discovery IP Range. You need fo create a new IP range.

The following jobs are impacted:
1.5D_3_Host Discovery by Shell Add IP Range

o4 Download Discovery Log B Email Administrator ¥4 Troubleshooting Guide

Solution: Add the IP address or range to the Ranges setting of the probe. For more details, see "Add
an IP Range Manually" on page 264.

Error Message: Inaccessible network path to target server. Perhaps it is a virtual IP address.

Error Category: Connection Errors

Others
Inaccessible network path 16,36 to target server. Perhaps it is a virfual IP address.

Add Physical IPs
ok Download Discovery Log B Email Administrator 4 Troubleshooting Guide

Solution: Add physical IPs as entry points of next hop

(https]16. I 36:8443 /
Probiem Source: Inaccessible network path to farget server Backfol
Add Physical IPs

1p* Port* Context

Add Physical IP

Error Message: Need credential to the host
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Error Category: Credential-related Errors

Credential-Related Errors
Mo valid credentials to the host 16.155.155.155 are found. You need to create valid credentials.

ok, Download Discovery Log B Email Administrator {4 Troubleshooting Guide
Solution: Add the valid credentials. For more information about how to do this, see "Add or Edit
Credentials" on page 440.

[https]16.155.155.155:8743 /webtier-9.51/index.do i
Problem Source: Ne valid credentials found Back to List

ENTER CREDENTIALS

Possible Applicable Protocols

NTCMD ~
User Label
Network Scope
'@ all Discovery Issues ) Selected Range
username password
Confirm password connection_timeout
20000
windows_domain run_windows_commands_impersonated

Otrue @ false

remote_share_path

local_share_path

Error Message: Connection timeout

Error Category: Timeout Errors

Timeout Errors
SSH: Timeout trying to connect to the remote agent. Try increasing the timeout value.

o, Download Discovery Log B4 Email Administrator  {# Troubleshooting Guide
Solution:

« Increase the timeout value in protocol settings.

« For Windows machines, wait for a few minutes and then try again.

Error Message: The discovery job did not find any process listening on port: <port_number>

Error Category: Software Related Errors
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Solution:

« Check if the configured account has sufficient privileges to run relevant commands. Specifically,
o ps -e
o netstat -nap
o lsof
Elevate privilege for UNIX credentials.
« Verify if the service is still accessible.

« Check if Isof is installed on the target machine if it runs UNIX.

Error Message: No application signature matches the process <process_info> listening on port <port
number>

Error Category: Software Related Errors

Solution: Add the signature for the application. For more information about how to do this, see "Add or
Edit Application Signatures" on page 441.

Error Message: The following outgoing ports are filtered because they are not in
portNumberToPortName.xml

Error Category: Software Related Errors

Software Related Errors

Mo application signature matches the process [Process(ucmdb_serverexe’, 2632, "jre\bin\ucmdb_server” =
-server -X:+PrintCommandLineFlags -X+UseG1GC -XX:+UnlockExperimental\VVMOptions E
“XX:MaxGCPauseMillis=2000 -Dsun.rmidgc.client.gcinterval=0x 7 ffffiffiffffffe

-Dsun.rmi.dge.server.gcinterval=0x7ffffffffffffffe -verbose:gc -XX:+PrintGCDetails -Ducmdb.home=.. . )

. L . - Add Application Signature
-Dcom.sun.management,jmxremote -Djava.io.tmpdir=./runtime/jetty-cache
-Djava.naming.factory.url.pkgs=org.mortbay.naming

Pilmiim smmmnbimm frnmtbom e lnibialonrm snmtho s namins lnitialCantautTastam: Pismmdb hesesses hama—

& Download Discovery Log B Email Administrator {4 Troubleshooting Guide

Solution: Add the port number to portNumberToPortName.xml.

To do this, click the Application Signature button in the error message and then follow the

instructions. Alternatively, you can directly modify the portNumberToPortName.xml file to add the
port number.
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[https]16.187.187.87:8443 fucmdb-uiflogin_page.jsp
Problem Source: No application signature matches the process

Add Application Signature
Software Library Software Signature
Add Delete Refresh Expand ID
(! Software Element Categories Category

Supported Version

Created Cl Properties

€l Type RunningSoftware

Discovered Product
MName

Vendor

Processes
Add Edit |

Key Main Name Port Command Line

Save Cancel

Error Message: The following outgoing ports are filtered because they are not in
portNumberToPortName.xml.

Error Category: Software Related Errors
Software Related Errors
The following outgoing ports are filtered because they are not in portNumberToPortNamexml: 13080, 61447, 61448,
61449, 61450, 61451, 61452, 61453, 61454, 61455, 61456, 61457, 61458, 65121, 65305, 65306 Add Port Number
&, Download Discovery Log B Email Administrator ¥4 Troubleshooting Guide

Solution: Add the port number to portNumberToPortName.xml.

To do this, click the Add Port Number button in the error message and then follow the instructions.
Alternatively, you can directly modify the portNumberToPortName.xml file to add the port number.
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[http]16.155.155.16:8080 /webtier-9.51findex.do
Problem Source: Some outgoing ports are filtered

Add Port Number

PORT UPDATE
We have discovered new port numbers

Application Name

Port Number Select All  Deselect All
[0 13080 =
[0 1447 E
[0 61448
[0 61as9
[0 61450

[0 s1451

1 #1457

Save Mapping

Back to List

Error Message: Failed to resolve host name to IP
Error Category: |P-related Errors

Solution: Check DNS server configuration.

Error Message: Need sudo permission
Error Category: Software Related Errors

Solution: Elevate privilege for UNIX credentials to run the relevant command.

Error Message: No Isof installed on the host
Error Category: Software Related Errors

Solution: Install Isof on the target machine.

Error Message: The host is a Solaris local zone

Error Category: Software Related Errors

Solution: None for this release. Currently Solaris local zone is not supported by ASM.

Error Message: No SCP reported from configuration signature.

Error Category: Others

CMS Ul (2018.08)

Page 289 of 446



CMS Ul Guide

Solution: No SCP reported from configuration signature for application <Application Name>. Check

the ConfigurationFileSignature.xml file to make sure all parameter values for your application are
correct.

Troubleshooting ASM - References

This chapter provides instructions for some of the solutions mentioned earlier.

Add an IP Range to the Ranges Setting

1. Goto Data Flow Probe Setup > Domains and Probes pane > Domains and Probes root node
> adomain > Data Flow Probes > a Data Flow Probe.

2. Inthe Ranges pane, click New Range |

3. Provide the necessary information on the New Ranges dialog box, and then click OK.

Discover Load Balancers

1. Run the Host Connection by SNMP job.

2. Run one of the following jobs depending on the type of the load balancer:
o F5BIG-IP LTM by SNMP
o Alteon application switch by SNMP
o Cisco CSS by SNMP

Add or Edit Credentials

1. Goto Data Flow Probe Setup > Domains and Probes pane > Domains and Probes root node
> a domain > Credentials > a protocol.

2. Intheright pane, perform one of the following actions to add or edit an entry:

o Toadd a new connection detail, click Create new connection details for selected protocol

type =

o To edit an existing credential, select the entry and then click Edit connection details for
selected protocol type 2.

3. Provide the information on the dialog box that pops up, and then click OK.
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Edit the portNumberToPortName.xml File

1. GotoData Flow Management > Adapter Management.
2. Click the Search button =/, and then search for portNumberToPortName.xml.

3. Edit the portNumberToPortName.xml file, and then click Save.

Add or Edit Application Signatures

1. GotoData Flow Management > Adapter Management.
2. Inthe Resources pane, select Host_Resources_By TTY > Adapters > TTY_HR_AII.

3. Inthe Adapter Definition tab > Global Configuration Files section, select

applicationsSignature.xml and then click Edit 2l

Smart Software Analytics

The Smart Software Analytics option in the CMS Modules navigation pane opens the Smart Software
Analytics module. It relies on data analytics to analyze large amount of scan files and suggest new
software signatures, that can be used to recognize installed software. It automatically teaches
unrecognized software by intelligently using Natural Language Processing (NLP) and machine learning
technology. Smart Software Analytics provides you with an enhanced software recognition ratio that
requires less manual effort.

This section contains the following:

How to Access Smart Software Analytics ... ... .. 291
Administration .. 292
Work with Smart Software Analytics ... . 304
Troubleshooting and Limitations — Smart Software Analytics ........................................ 321

How to Access Smart Software Analytics

The following software products are required to access the Smart Software Analytics module:
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« UCMDB Server2018.08.

« CMS Ul 2018.08. For detailed instructions about installing CMS Ul, access the following website:
Installing CMS Ul

« Configure the REST API. For detailed instructions about how to configure the REST API, access
the following website: REST API Configuration.

To access Smart Software Analytics, follow these steps:

1. Goto CMS Ul using either of the following methods:

o Access CMS Ul, using the following URL: https://<server_name or IP>:<port>/ucmdb-
browser. Provide user name and password if required. Once you are logged in, you are on the
CMS Ul landing page.

o Access UCMDB Browser legacy mode, using the following URL: https://<server_name or
IP>:<port>/ucmdb-browser/ucmdb_browser.jsp. On the Search page, click Return to
CMS Ul under the search box.

Note:

Add the UCMDB URL to your browser's list of Trusted Sites or Exceptions, and then
refresh the UCMDB Browser's page if the following error message appears:

Something went wrong. You are probably using a self signed certificate.
Please click 'OK' to visit UCMDB URL, then add it as an exception in your
browser and refresh this page.

It is recommended that you access CMS Ul using Chrome.

2. Click the CMS Modules E icon in the upper left corner to expand the navigation bar, and then
select Smart Software Analytics.

Administration

This chapter includes:

Smart Software Analytics Overview

Note: The Smart Software Analytics module is available for users with the Software Library
permission.
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Accurate and fast software recognition brings a lot of benefits for the enterprise. It helps point out
overspent software, avoid new purchases, respond quickly and accurately to external and internal
software audits, reduce manual effort involved with the Software Asset Management (SAM) activities.

Due to limited labor resource and traditional inflexible recognition algorithm, the existing SAl teaching
process is becoming a bottleneck in the whole software identification process to catch up with the
latest software title publications.

Thus, with the aim to enhance software recognition ratio with less manual effort, version 10.33 of the
Micro Focus Configuration Management System introduces a new feature called Smart Software
Analytics(SSA), which automatically teaches unrecognized software by intelligently using Natural
Language Processing (NLP) and machine learning technology.

With SSA, you can have an autoteach.zsai file automatically generated, as scheduled, from the
unrecognized files in the scan file. This could significantly raise recognition ratio. In addition, you will
have a monthly KPI report on how much work SSA has done that month, for example, number of
processed scan files.

What's New
What's new in SSA 2018.08

No new features were implemented.

What's new in SSA 2018.05

o Encrypted all sensitive datain SSA with AES 256 algorithm.
« Added support to change the store pass for Keystore and Truststore.

« Updated the IDOL library license for the machine learning model.
What's new in SSA 3.0

« Merged Sraas Server and SSA Scheduler services into one service SSA Server to reduce
resource costs and improve the performance.

« Improved the instructions displayed in the command prompt window when you run install_ssa_
service.bat, to remind you to check whether the prerequisite steps are performed before installing
SSA.

Smart Software Analytics Workflow

The following chart illustrates the use case workflow of SSA:
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5
1. Enable and configure SSA 1.
—
6. Review the SSA result
8. Pick SAl and sync to UCMDB serve

5. Teach scanfile and
generate temp user SAI

downloaded
as SSA resource

3. Configuratik

7. Pass the review decision

1. Users enable and configure the SSA settings from the CMS Ul. A JSON file is generated.
The CMS Ul uses the UCMDB RESTAPI to send the JSON file to the UCMDB server.

The JSON file is automatically downloaded as a resource to the Data Flow Probe.

> w0 DN

The Data Flow Probe sends generated/processed scan files to the SSA server according to the
SSA configuration JSON file that has been downloaded.

5. The SSA server processes and teaches the scan files. Then, an autoteach.zsai file and a report

file are generated.

6. Librarians review the autoteach.zsai from the CMS Ul and save the reviewed signature to

specific user SAl file.
7. CMS Ul passes the review decision to the SSA server.

8. Librarians select and sync user SAl files to the UCMDB server.

Deploy Smart Software Analytics

Pre-deployment Considerations

This section covers the pre-deployment requirements that your organization should meet when
planning the SSA deployment.

o System Requirements

o Get Installation Resources
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« Security Consideration

System Requirements

« Hardware
Component Requirement
Operating System 64-bit
Memory 16G
Number of Processors 8 or more processors

Note: SSA would consume more resources on the UCMDB server and the Data Flow Probe
server. It is strongly recommended to assign adequate hardware resources.

« Operating System

Hardware
Platform OS Type OS Version and Edition Supported Recommended
x86-64 Windows Datacenter and Standard, 64-bit Yes Yes
Server (without the Nano Server
2016 installation option)
x86-64 Windows Standard/Datacenter editions, 64- = Yes
Server bit
2012 R2
x86-64 Windows Standard/Datacenter editions, 64- = Yes
Server bit
2012
x86-64 Windows o SP2, Standard/Enterprise Yes
Server editions, 64-bit
2008

o R2andR2SP1,
Standard/Enterprise editions,
64-bit

- Additional Requirement

o Microsoft Visual C++ 2010 x64 Redistributable Package

Get Installation Resources

Before deploying Smart Software Analytics, make sure that you have installed and configured the
following:
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« UCMDB Server2018.08
« CMS UI 2018.08

Also, get the following resources ready:

« SSA installation package

« (Optional) The latest Discovery Knowledge (DK) package for SSA, which is a monthly released .zip
file including the full DK package and some configuration files specific to SSA.

Security Consideration

To enable SSA to work with CMS Ul and UCMDB Server, make sure you deploy SSA service on the
same domain as CMS UlI.

For example, if you can visit CMS Ul via https://[<CMS_UI_hostname>.microfocus.com:8090. Your
SSA service should be deployed on https://<SSA_hostname>.microfocus.com as well.

Tip: Itis recommended that you deploy these two products on the same machine.

Before starting SSA, to make sure that SSA could work with CMS Ul and UCMDB Server, configure
SSA as follows:

1. Goto<SSA_HOME>\ssa-server\config\ssa_lwsso_config.xml and then modify the following
configuration:

initString="This string should be replaced"
<domain></domain>

Note:

o The initstring should be the same as configured in UCMDB's LWSSO configuration. It
can be retrieved by using the JMX method retrieveLWSSOConfiguration.

o A value for the <domain></domain> element is required. Specify here the domain which
can be visited by both the SSA service and the CMS Ul service.

In the meantime, the LW-SSO configuration for CMS Ul should be modified in the same way. For
details about configuring LW-SSO for CMS Ul, see "Configure LW-SSO" in the CMS Ul Online
HelpCMS Ul Online Help.

2. Goto <SSA_HOME>\ssa-server\config\config.properties and modify the settings as shown
below:
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UCMDB connection configuration:

ucmdb. schema=https
ucmdb.domain=FQDN or IP
ucmdb.port=8443

CMS Ul domain information:
browser.schema=https
browser.domain=FQDN Only

browser.port=8090
allowed.access.ip=*

3. (Optional) Change the certificate.

SSA could work with UCMDB and Data Flow Probe with the out-of-the-box certificate
configuration.

If you want to change the OOTB certificate in the ecosystem, follow the procedure as described
below:

a. When UCMDB's certificate is changed, make sure that you perform the following steps:
i. Export UCMDB's public certificate.
A. Open the command prompt and run the command:
C:\UCMDB\UCMDBServer\bin\jre\bin\keytool.exe -export -alias

<keystore alias> -keystore <Keystore file path> -file
C:\UCMDB\UCMDBServer\conf\security\server.cert

where:
« keystore alias is the name given to the keystore.

« Keystore file path is the full path of the location of the keystore file.

For example, for the out-of-the-box server.keystore use the following
command:

C:\UCMDB\UCMDBServer\bin\jre\bin\keytool.exe -export -alias
hpcert -keystore
C:\ucmdb\ucmdbserver\conf\security\server.keystore -file
C:\HP\UCMDB\UCMDBServer\conf\security\server.cert

B. Enterthe keystore password.

C. Verify that the certificate was created in the following directory:
C:\UCMDB\UCMDBServer\confisecurity\server.cert
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ii. Delete the old certificate in SSA server's Truststore by using the following command:

<SSA_HOME>\jre\bin\keytool -delete -alias "ucmdb server" -keystore
<SSA _HOME>\ssa-server\config\interface.truststore -storepass ssapass

ii. Import the new certificate which comes from UCMDB by using the following command:

<SSA_HOME>\jre\bin\keytool -import -trustcacerts -keystore <SSA
HOME>\ssa-server\config\interface.truststore -storepass ssapass -
alias "ucmdb server" -file <UCMDB CERT FILE>

b. When SSA server's certificate is changed, make sure that you perform the following steps:

i. Generate a new keystore (by using the command below to replace the ssa-server
keystore under <SSA_HOME>\ssa-server\config\interface.keystore

<SSA_HOME>\jre\bin\keytool -keystore <temp
folder>\interface.keystore -genkey -alias interface -keyalg RSA -
keysize 2048 -storepass ssapass -keypass ssapass

ii. Export the public certificate from new keystore of ssa-server:
<SSA_HOME>\jre\bin\keytool -export -alias interface -keystore <SSA

HOME>\ssa-server\config\interface.keystore -storepass ssapass -file
<temp folder>\interface.crt

ii. Import interface.crt to the Data Flow Probe's Truststore.
A. Open the command prompt and execute the following command:
C:\UCMDB\DataFlowProbe\bin\jre\bin\keytool.exe -import -v -
keystore

C:\UCMDB\DataFlowProbe\conf\security\ProbeTrustStore.jks -file
C:\UCMDB\DataFlowProbe\conf\security\interface.crt -alias ssa

Enter the keystore password: logomania

C. When asked Trust this certificate?, press y and then Enter.
The following message is displayed:
Certificate was added to keystore.

c. When Data Flow Probe's certificate is changed, make sure that you perform the following
steps:
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i. Export Data Flow Probe's public certificate.

A. Open the command prompt and run the command:

C:\UCMDB\DataFlowProbe\bin\jre\bin\keytool.exe -export -alias
<ProbeName> -keystore
C:\UCMDB\DataFlowProbe\conf\security\client.keystore -file
C:\UCMDB\DataFlowProbe\conf\security\<ProbeName>.cert

B. When asked, enter the keystore password.
The following message is displayed:

Certificate stored in file
<C:\UCMDB\DataFlowProbe\confisecurity\<ProbeName>.cert>

ii. Replace the certificate in ssa-server using the following command:

<SSA_HOME>\jre\bin\keytool -import -trustcacerts -keystore <SSA
HOME>\ssa-server\config\interface.truststore -storepass ssapass -
alias <ProbeName> -file <PROBE CERT FILE>

Note: If SSA is already installed, you can still reconfigure the above security consideration
settings.

Set up a Smart Software Analytics Server

Before the installation, review the "Pre-deployment Considerations" section above and make sure that
you meet all the requirements.

Note:

« Itis recommended to create a user with Administrator privileges. SSA must be installed and
started by a user with Administrator privileges.

« SSA supports only Windows platforms.

« (For upgrade only) It is recommended to uninstall SSA 3.0 or 2018.05 before you install SSA
2018.08. If you want to keep your customized configurations made in SSA 3.0 or 2018.05, for
example, the scheduler.cron parameter, keystore, and truststore, back up those
configurations and copy them back to the corresponding folders in SSA 2018.08 after the
installation.

Installing SSA server

Toinstall the SSA server, follow these steps:
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1. Extract the ZIP packages for Windows platform.

2. Check if there is a newer version of master SAl files that have been released. If yes, download the
latest master SAI files and replace the older ones under the <SSA_Install_Dir>\ssa-
server\ssa\data\masterSAl folder.

3. Execute the <SSA_Install_Dir>\install_ssa_service.bat script to register SSA as the Windows
service: CMS SSA Server

4. Input the store pass for SSA (at least six characters) in the command prompt window:

Please input new store pass for SSA Keystore and Truststore: ******
Please repeat new store pass for SSA Keystore and Truststore: ******

Please input new safe word for your store pass:

Note: If SSA is already installed and you want to change the store pass, run
StorePassManager.bat under the ssa-server\bin directory, and then input the original store
pass, new store pass, and new safe word.

5. Execute the <SSA_Install_Dir>\start_ssa_service.bat script to start the service.

Now you can launch and configure SSA from CMS UI.

Post-Installation Setup

To ensure that Smart Software Analytics works in the best condition, it is recommended that you
perform the following after installing Smart Software Analytics:

o Monitor SSA

o Back up User SAl Files

« Maintain the Master SAI Files

Monitor SSA

To monitor SSA, perform the following in a regular basis:

« Confirm that the SSA service is running properly.

« Check the log file for errors. In the log file, every change to the user SAl file and the autoteach.zsai
file should be logged.
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« Check the <SSA_Install_Dir>\ssa-server\ssa\data\scanFile folder. By checking the last modified
time of each scanfile, you can have a clear understanding of the work done by SSA.

Back up User SAI Files

Always back up user SAl files timely in a regular basis to avoid potential data loss. All user SAl files are
saved under the <SSA_Install_Dir>\ssa-server\ssa\dataimasterSAl folder.

Tip: As the SSA data is saved on the Windows file system, a backup system is used to prevent
data loss due to file corruption. Whenever the SAl file is changed, a *.bak file would be saved in
the same folder as backup.

Maintain the DK Package

The auto teach results would be more accurate with the latest DK package. Therefore, it is strongly
recommended that you keep the DK package content on SSA up to date by downloading the latest
package, which is released on ITOM Marketplace in a monthly base. Upload the master SAl files
contained in the latest package when you finish downloading.

Understand Data Flow Inside Smart Software Analytics

Toleverage SSA in away to best suit your IT management needs, it is recommended that you
understand the structure of SSA data folder and the data flow inside SSA before use.

Structure of SSA Data Folder

Path Description

<SSA Install Dir>\ssa- To save report files. The Ul reports are generated based on the
server\ssa\data\report data here.

<SSA Install Dir>\ssa- To save the received scan files as backup. The scan file of
server\ssa\data\scanfile same name would be overwritten.

<SSA_Install Dir>\ssa- To save all SAl files, including master and custom user SAl
server\ssa\data\masterSAl files.

<SSA_Install_Dir>\ssa- The suggestions given by SSA. The contents contained here

server\ssa\data\runtime\autoteach = can not be used as SAI until users review and commit them to a
specific user SAl file.

<SSA Install Dir>\ssa- The log information.
server\ssa\data\runtime\logs

<SSA Install Dinssa- The scan files to be processed by SSA.
server\ssa\data\runtime\scanFile
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Note: The runtime folders are used to save the temp information generated by SSA.
Data Flow inside SSA

1. The scan files are uploaded by Data Flow Probe to the <SSA_Install_Dir>\ssa-
server\ssa\data\runtime\scanFile folder.

2. By default, SSA will process the scan files in daily base at 1:00 am. You can customize the
processing time by configuring the scheduler. cron parameter in <SSA_Install_Dir>\ssa-
server\config\application.properties:

scheduler.cron=0 0 1 * * *

#Example of scheduler.cron

#"0 @ * * * *" = the top of every hour of every day.

#"*/10 * * * * *" = avery ten seconds.

#"0 0 8-10 * * *" =8, 9 and 10 o'clock of every day.

#"0 0 6,19 * * *" = 6:00 AM and 7:00 PM every day.

#"0 0/30 8-10 * * *" = 8:00, 8:30, 9:00, 9:30, 10:00 and 10:30 every day.
#"0 © 9-17 * * MON-FRI" = on the hour nine-to-five weekdays

#"0 0 0 25 12 ?" = every Christmas Day at midnight

3. Restart the SSA service.

4. After SSA finishes processing, the scan files will be copied to <SSA_Install_Dir>\ssa-
server\ssaldata\scanFile as backup. Meanwhile, the result will be added to <SSA_Install_
Dir>\ssa-server\ssa\data\runtime\autoteach\autoteach.zsai.

5. If you access the View Teaching Status page for TEACH SERVER on the SSA Ul, when you
modify auto-taught SAI entries in the TEACH SERVER page, the modifications will be reflected
in <SSA_Install_Dir>\ssa-server\ssa\data\runtime\autoteach\autoteach.zsai.

6. If youcommit any datain the View Teaching Status page for TEACH SERVER, the data would
be removed from <SSA_Install_Dir>\ssa-server\ssa\data\runtime\autoteach\autoteach.zsai
and added to the selected User SAl file.

7. You can further modify the user SAl files under <SSA_Install_Dir>\ssa-
server\ssa\data\masterSAl via the SSA Ul.

8. You can push the SAl files under <SSA_Install_Dir>\ssa\data\masterSAl to UCMDB server via
SSA UI.

9. Afterarunning of the Inventory Discovery by Scanner job on UCMDB side, the newly
processed scan file will be sent to SSA for the next auto teach. Signatures that have been
confirmed will not be suggested anymore.
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Enable and Configure Smart Software Analytics
To enable and configure Smart Software Analytics, follow these steps:

1. Access the Smart Software Analytics module.

a. Access CMS Ul, using the following URL: https://<server_name or IP>:<port>/ucmdb-
browser. Provide user name and password if required. Once you are logged in, you are on the
CMS Ul landing page.

It is recommended that you access CMS Ul using Chrome.

b. Click the CMS Modules E menu icon in the upper left corner to expand the navigation bar,
and then select Smart Software Analytics.

2. Click the SSA CONFIGURATION button. The Settings pane is

displayed.

3. Enable and configure SSA settings as described in the following table.

Ul Element Description
Enable SSA Switch to enable or disable SSA.

SSA Server  Provide the fully qualified domain name (FQDN) of your SSA server. For

Domain example, ssa.microfocus.com. CMS Ul automatically checks whether the
SSA server can be connected. If not, the following message is displayed: "SSA
Serveris not available."

Note: Forthe first time to connect to an SSA server with self-signed
certificate, you need to open another web browser window to accept the
certificate by visiting the following URL:

https://<SSA_domainname>:9554

Define the Select the Data Flow Probe for which you will define the schedule. You can
schedule to = define the schedule for all probes or a specific probe.

send

scanfile to

SSA

<The Define how frequently the selected probe or probes are scheduled to send scan
frequency files.

drop-down

list>

CMS Ul (2018.08) Page 303 of 446



CMS Ul Guide

Ul Element Description

Hour Define the exact hour when the selected probe or probes are scheduled to send
scan files.

Important: Before using SSA, check the Date and Time settings on the
machines where SSA server, UCMDB server and CMS Ul are deployed.
Make sure that these settings are consistent with each other. Otherwise,
there might be overtime issues when SSA runs.

SUBMIT Click this button to submit the SSA schedule configuration to the UCMDB
server.

Work with Smart Software Analytics

Smart Software Analytics User Interface

This chapter includes:

Smart Software Analytics Page

To Go to CMS Ul, expand the navigation bar on the left, and then click Smart Software
access Analytics. For details, see How to Access Smart Software Analytics.

User interface elements are described below:

Ul Element (A-Z) Description
Click to display the LOGOUT button.

Click to open the Help page.

Avalable use sa A4 SSA data type drop-down box: Click the arrow to get the user SAl list,
master SAl list or the KPI report.

Click to sync all SAl files on SSA server, including both user and master

SAl files, to UCMDB server. For more information, see "How to Sync SAI
Files to UCMDB Server" on page 310.

AR YR U Click to open the SSA CONFIGURATION page. For more information, see
"Enable and Configure Smart Software Analytics" on the previous page.
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Ul Element (A-Z) Description
Click to open the View Teaching Status page for the autoteach.zsai file.
>k Click to open the Create User Sai page.

Note: This option is only available when Available user sai is
selected from the Sai data type drop-down box.

T Click to open the Upload User/Master Sai page.

]ﬁ[ Click to delete the selected user SAl files.

Note: This option is only available when Available user sai is
selected from the Sai data type drop-down box.

<SAl file name> Click to open the View Teaching Status page for this SAI file.
Click to push the selected user SAl files to UCMDB server. For more

information, see "How to Sync SAI Files to UCMDB Server" on page 310.

View Teaching Status Page

This page enables you to check, create, edit, review or delete SAI entries contained in the
autoteach.zsai file on SSA server.

To access On the Smart Software Analytics page, click TEACH SERVER.
User interface elements are described below:

Ul Element (A-2) Description
Click to display the LOGOUT button.

Click to open the Help page.

« Click to go back to the Smart Software Analytics page.

Search Filter: Click the arrow to select the level of the SAI entries for which

Fblisher v you want to search: publisher, application, release, version, or file.
<Search box> Type here the search keywords.
Click to trigger the search.
AL Click to return all available entries contained in the SAl file.
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Ul Element (A-2)

_|_
]

<Left pane>/<Right
pane>

Description

Click to create a publisher entry.
Click to batch review SAl entries.

Click to delete batch delete user SAl files.

Click to show or hide the left-hand pane that contains entries of publisher and
application level.

In the left pane, you can a list of SAl entries which are grouped by publisher.
Each publisher entry is a hierarchical tree that consists of contents up to five
levels:

« The top level: publisher

« The second level: application

« Thethird level (if any): release

« Thefourth level (if any): version

« Thefifth level (if any): file

If the information in an SAI entry has been previously recognized and

included in master SAl files, then the color of the icon in front of this entry is
green. Otherwise, the color is gray.

You can expand an SAl entry down by clicking to get entries of sub-levels.
The release, version and file information, if any, is expanded under the right
pane.

View User Sai Page

This page enables you to check, create, edit, or delete contents of user SAl files on SSA server:

To On the Smart Software Analytics page, select Available user sai in the SAl data type
access drop-down box, and then click a user SAI file name from the file list.

User interface elements are described below:

Ul Element (A-Z)

a8
0

\'-n_.-""

r—
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Description

Click to display the LOGOUT button.

Click to open the Smart Software Analytics's Help page.

Click to go back to the Smart Software Analytics page.
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Ul Element (A-2) Description

Search Filter: Click the arrow to select the level of the SAl entries for which

Fublisher - you want to search: publisher, application, release, version, or file.
<Search box> Type here the search keywords.
m Click to trigger the search.
AL Click to return all available entries contained in the SAl file.
=+ Click to create a publisher entry.
|| Click to delete batch delete user SAl files.

Click to show or hide the left-hand pane that contains entries of publisher and
application level.

<Left pane>/<Right | Inthe left pane, you can alist of SAl entries which are grouped by publisher.
pane> Each publisher entry is a hierarchical tree that consists of contents up to five
levels:

« Thetop level: publisher

« The second level: application

« Thethird level (if any): release

« Thefourthlevel (if any): version

« Thefifth level (if any): file

If the information in an SAIl entry has been previously recognized and

included in master SAl files, then the color of the icon in front of this entry is
green. Otherwise, the color is gray.

You can expand an SAIl entry down by clicking to get entries of sub-levels.
The release, version and file information, if any, is expanded under the right
pane.

View Master Sai Page

This page enables you to check contents of master SAl files on SSA server.

To On the Smart Software Analytics page, select Available master sai in the SAl data type
access drop-down box, and then click a master SAI file name from the file list.

User interface elements are described below:
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Ul Element (A-Z)

Publigher =

<Search box>

0, SEARCH

<Left pane>/<Right
pane>

Description

Click to display the LOGOUT button.

Click to open the Smart Software Analytics's Help page.

Click to go back to the Smart Software Analytics page.

Search Filter: Click the arrow to select the level of the SAl entries for which
you want to search: publisher, application, release, version, or file.

Type here the search keywords.

Click to trigger the search.

Click to return all available entries contained in the SAI file.

Click to show or hide the left-hand pane that contains entries of publisher and
application level.

In the left pane, you can a list of SAl entries which are grouped by publisher.
Each publisher entry is a hierarchical tree that consists of contents up to five
levels:

« The top level: publisher
« The second level: application
« The third level (if any): release
« Thefourthlevel (if any): version
« Thefifth level (if any): file
You can expand an SAl entry down by clicking to get entries of sub-levels.

The release, version and file information, if any, is expanded under the right
pane.

How to Check SAI Files on SSA

Through the SSA user interface, you can check contents of both master and user SAl files. To do this,

follow these steps:

To check contents of SAI files on SSA through user interface, follow these steps:

1. Access the Smart Software Analytics module. For details, see How to Access Smart Software

Analytics.
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2. Onthe Smart Software Analytics page, select Available user sai or Available master sai in the
SSA data type drop-down box.

3. Open an SAl file by clicking the file name.
4. Check the contents included in the SAl file.

If you are checking a user SAl file, you can perform edit, create or delete operations on the SAl
entries in addition to check operation. For details, refer to the following tasks:

"How to Create SAI Entries" on page 320
"How to Edit SAI Entries on SSA" on page 313

"How to Delete SAI Entries on SSA" on page 319

Note: For master SAl files, you only have read permission.

How to Check SSA KPI Report

To check SSA KPI report through user interface, follow these steps:

1. Access the Smart Software Analytics module. For details, see How to Access Smart Software
Analytics.

2. Onthe Smart Software Analytics page, click the drop-down arrow of the SSA data type box, and
then select KPI Report.

How to Upload SAl Files to SSA

Note: It is not recommended to manually copy SAl files to <SSA installation directory>\ssa-
server\ssa\data\masterSAl. If you want to do so, restart the SSA service after manually copying
SAl files to SSA.

Through the SSA user interface, you can upload user SAl files and master SAl files to SSA server. To
do this, follow these steps:

User SAI

Toimport a user SAI file to SSA server through user interface, follow these steps:

1. Access the Smart Software Analytics module. For details, see How to Access Smart Software
Analytics.
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N o o » »

On the Smart Software Analytics page, select Available user sai in the SAl data type drop-down
box.

F)

Click the UPLOAD USER SAlicon —' . The Upload User Sai window opens.
Click the text box to the left of the UPLOAD button. The File Upload window opens.
Select the user SAl file that you want to upload to SSA and then click Open.

Click UPLOAD. An upload status message is prompted.

Wait for a few seconds until the upload is finished.

Master SAI

To import a master SAI file to SSA server through user interface, follow these steps:

Access the Smart Software Analytics module. For details, see How to Access Smart Software

Analytics.

2.

N o o b~ »

On the Smart Software Analytics page, select Available master sai in the SAl data type drop-
down box.

o

Click the UPLOAD USER SAlicon — . The Upload Master Sai window opens.
Click the text box to the left of the UPLOAD button. The File Upload window opens.
Select the Master SA file that you want to upload to SSA server and then click Open.
Click UPLOAD. An upload status message is prompted.

Wait for a few minutes until the upload is finished.

How to Sync SAI Files fo UCMDB Server

Through the SSA user interface, you can sync the SAl files on SSA server to UCMDB server.
Currently, 2 options are provided for syncing SAl files on SSA server to UCMDB server through user

interface:

Sync all SAl files to UCMDB server

With this option, SSA will try to send all SAI files, both user and master, on SSA server to UCMDB
server. For two SAl files with the same name, the system will automatically compare which file is
newer before executing the push action. The newer one will be kept on the UCMDB server.
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« Sync selected user SAl files to UCMDB Server

With this method, you can push the selected user SAl files to UCMDB server.

Sync All SAl files to UCMDB server

To do this, follow these steps:

1. Access the Smart Software Analytics module. For details, see How to Access Smart Software
Analytics.

2. Onthe Smart Software Analytics page, click SYNC ALL To UCMDB at the upper right corner of
the page. All available user SAl files and master SAl files are then synced to your UCMDB server.

Sync Selected User SAI Files to UCMDB Server
To do this, follow these steps.

Access the Smart Software Analytics module. For details, see How to Access Smart Software
Analytics.

2. Onthe Smart Software Analytics page, select the user SAl files that you want to sync to your
UCMDB server.

3. Click PUSH to UCMDB at the bottom of the page.

SAl files successfully synced from SSA server to UCMDB server will be saved under the <UCMDB
Server installation directory>\runtime\sai folder.

How to Create User SAI Files
To create a user SAI file on SSA through user interface, follow these steps.

1. Access the Smart Software Analytics module. For details, see How to Access Smart Software
Analytics.

2. Onthe Smart Software Analytics page, select Available user sai in the SAl data type drop-down
box.

3. Click the CREATE USER SAlicon X . The New Sai window opens.

4. Fillinthe Name and Description fields as necessary.

5. Click SAVE.
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How to Delete User SAIl Files on SSA

Through the SSA user interface , you can delete user SAl files contained in SSA server. To do this,
follow these steps:

1.

Access the Smart Software Analytics module. For details, see How to Access Smart Software
Analytics.

On the Smart Software Analytics page, select Available user sai in the SAl data type drop-down
box.

Select the user SAl file that you want to delete.

Click the DELETE USER SAl icon ]ﬂl . A confirmation dialog box is displayed, asking whether
you want to delete the selected SAl file.

Click DELETE.

How to Check SAIl Entries on SSA

To check SAl entries on SSA through user interface, follow these steps:

1.

Access the Smart Software Analytics module. For details, see How to Access Smart Software
Analytics.

Perform one of the following depending on the type of SAI file where the entries to be checked are
included:

o Entries in autoteach.zsai: On the Smart Software Analytics page, click TEACH SERVER.

o Entries in a user SAI file: On the Smart Software Analytics page, select Available user sai
in the SAI data type drop-down box, and then click the user SAI file name from the file list

o Entries in a master SAIl file: On the Smart Software Analytics page, select Available
master sai in the SAIl data type drop-down box, and then click the master SAI file name from
the file list

Locate the SAI entry that you want to check.

To help locate the SAI entry fast, you can filter the displayed SAI entries by using the search
function on the page.

Tofilter the displayed SAI entries by using the search function, follow these steps:
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a. From the drop-down list to the left of the search box, select one of the following filter
conditions:

« Publisher

« Application

« Release

« Version

. File
b. Inthe search box, type the keyword as needed.
c. Click Search.

Click ALL under the drop-down list to return all entries in this SAI file.

How to Edit SAlI Entries on SSA

Through the SSA user interface, you can edit SAl entries contained in the autoteach.zsai file and other
user SAl files. To do this, follow these steps:

1. Access the Smart Software Analytics module. For details, see How to Access Smart Software
Analytics.

2. Perform either of the following depending on the type of SAl file where the entries to be edited are
included:

o Entries in autoteach.zsai: On the Smart Software Analytics page, click TEACH SERVER.

o Entries in a user SAI file: On the Smart Software Analytics page, select Available user sai
in the SAIl data type drop-down box, and then click the user SAI file name from the file list.

3. Alist of SAl entries which are grouped by publisher is displayed. Locate the SAI entry that you
want to edit.

To help locate the SAI entry fast, you can filter the displayed SAI entries by using the search
function on the View Teaching Status page. For details, refer to Search for an SAI Entry.

4. Hover your mouse over the SAI entry that you want to edit, click the ellipsis icon that appears, and
then select Edit.

5. A properties window is displayed. Modify the properties as needed. Refer to the following
examples of properties window for SAI entries of different levels.
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Note:

o Properties may vary slightly subject to the specific SAl entry to be edited.

o When you modify the value in a text box , the system will help validate the new value you
type by giving an instructive message in red.

Example of the Publisher Properties window:

Field / Element Name Description

Name

Description

A text field to state the publisher name.

A text field to briefly describe the publisher of the application.

Example of the Application Properties window:

Field /
Element Name

Publisher
Application
Description
Application
Type

APPLICATION
RULE

CMS Ul (2018.08)

Description

A text field to state the publisher of the application.

A text field to state the application name.

A text field to give a brief description about the application.

A drop-down list of application types from which you can select an
appropriate one to describe the application, for example: administrative
software.

Click this button to open the App Rules Editor. You can see a list of
application rules, with brief information regarding rule name, rule type, release
format and version format. To edit or delete an application rule, hover your
mouser over the application rule, click the ellipsis icon that appears, then
select Edit or Delete as needed.

Once you click Edit, the App Rules Editor opens, instructing you to modify
the rule details:

o Rule Type
o Rule Description
o Installed Package to Match
« Package Name
« Package Type
« Recognize the app even if the package has no files?

« Number of package occurrences
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Field /

Element Name Description

o Properties for the version to be created
o Operating System
« Commercial
« Language
» Regular Expression
o Format/ map matched group
o Format
« Regex group index

« Mapping

Example of the Release Properties window:

Field / Element

Name
Publisher

Application

Name

Description
A text field to state the publisher with which this release is associated.

A text field to state the application with which this release is
associated.

A text field to state the release name or number.

Example of the Version Properties window:

Field /
Element
Name

Publisher
Application

Release

Version

Version
Desc

oS
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Description
A text field to state the publisher with which this version is associated.
A text field to state the application with which this version is associated.

A text field to state the release information with which this version is
associated.

A text field to the detailed version information.

A text field to give a brief description about the version.

A drop-down list of operating systems, from which you can select an appropriate
one to describe the operating system on the computer where this application is
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Field /
Element
Name

Language

Description
recognized.

A drop-down list of languages used to state which language this application
supports. For example, you can select Neutral to indicate multi-language
support.

Commercial A drop-down list with options to state whether this application is for commercial

Install
Strings

Match all
install
strings

or for free.

From the Commercial drop-down list, you may select any of the following:
o Free

o Commercial

o Unknown

Click this field to open the Install Strings Editor. You can see a list of install
strings, containing information regarding xxx, xx and xxx. To edit the said
information or to delete the entire application rule, hover your mover overs the
item, click the ellipsis icon that appears, and then select Edit or Delete.

With this check box selected, all imported install strings regarding this version
should be matched for it to be recognized successfully by SSA.

Size Matters Select this check box to show file size. If this check box is not selected, file

size will be “N/A".

Example of the File Properties window:

Field /
Element
Name

File
Name

Relation
to App
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Description

A text field to state the file name.

A drop-down list with options to state the relation between the file and the
application:

o Main
o Associated
o Third-party
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Field /
Element
Name

Size

Size
Matters

Exe File
Type

Signature

Version
Data

oS

Language

Description

Tip: You can click the batch edit icon E] on the upper right of the file list to
modify the relation for multiple files.

A text field to state the file size.

Select this check box to show file size. If this check box is not selected, file size
will be “N/A".

A drop-down list with options used to state the file type.

A text field to state the signature of the file.

A text field to state the version data of the file.

A drop-down list of operating systems, from which you can select an appropriate
one to describe the operating system on the computer where the application of this
version is recognized.

A drop-down list of languages used to state which language the application of this
version supports. For example, you can select Neutral to indicate multi-language
support.

6. Saveyourchanges.

How to Review SAIl Entries on SSA

Through the SSA user interface, you can review SAl entries in the autoteach.zsai file and commit
them to a user SAl file of your interest. To do this, follow these steps:

1. Access the Smart Software Analytics module. For details, see How to Access Smart Software

Analytics.

2. Onthe Smart Software Analytics page, click TEACH SERVER. The View Teaching Status page
for the autoteach.zsai file opens and a list of SAl entries which are grouped by publisher is

displayed.

3. Locate the SAIl entry that you want to review.
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To help locate the SAI entry fast, you can filter the displayed SAl entries by using the search
function on the View Teaching Status page. For details, refer to Search for an SAI Entry.

Hover your mouse over the SAl entry that you want to review, click the ellipsis icon that appears,
and then select Review.

A reviewed icon then appears to the left of the entry. Meanwhile, a dialog box appears at the

bottom of the page, asking you to commit the reviewed SSA result to a user SAl file.

For example, if you have reviewed the contents of a publisher, you will see a dialog box
resembling the following:

iy 1 Publisher committa  Test.zsai 7 CAMNCEL m

Click the drop-down arrow to select the user SAl file to which you want to commit the reviewed
entry. Then, click COMMIT.

Note:

o If no user SAl file is available, a text box with a grayed new.sai hint inside will appear
where the drop-down combo box is located as shown in the screen shot above. Directly
click COMMIT so that a user SAI file named new.sai will be created and the reviewed
SSA result will be moved to this user SAl file. Or, type a different name in the text box for
the SAl file to be created and then click COMMIT.

o When you commit an entry to a user SAl file, all contents under this entry, including
information of its sub-levels, will be committed to that user SAl file.

6. The reviewed entry is then moved from the autoteach.zsai file to the specified user SAl file.

You can also review multiple SAIl entries at the same time by using the batch review icon on the toolbar
of the left or right pane.

Recommended Review Process

When reviewing SAl entries, you can refer to the following process that we recommend:

1.

Before reviewing SAl entries, expand the Publisher, Application, Release, Version and File layer
one by one.

Check and edit the entries starting from the lowest level to the top level, in an order as shown
below:
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3.

a. Check and edit the properties of all files under the same version

b. Check and edit the properties of all versions under the same release

c. Check and edit the properties of all releases under the same application
d. Check and edit the properties of all applications under the same publisher
e. Check and edit the properties of the publisher

With information of all levels checked and confirmed, review the publisher and commit it to a user
SAl file of your interest.

Note: If you want to review and commit properties contained in a sub-level instead of reviewing
and committing the whole publisher, do remember to commit the properties timely because if you
re-log in the Ul without the commit operation, the uncommitted information would be lost.

How to Delete SAI Entries on SSA

Through the SSA user interface, you can delete SAl entries contained in the autoteach.zsai file and

other user SAl files. To do this, follow these steps:

. Access the Smart Software Analytics module. For details, see How to Access Smart Software

Analytics.

Perform either of the following depending on the type of SAl file where the entries to be deleted are
included:

o Entries in autoteach.zsai: On the Smart Software Analytics page, click TEACH SERVER.

o Entries in a user SAI file: On the Smart Software Analytics page, select Available user sai
in the SAIl data type drop-down box, and then click the user SAI file name from the file list.

A list of SAI entries which are grouped by publisher is displayed. Locate the SAI entry that you
want to delete.

To help locate the SAI entry fast, you can filter the displayed SAI entries by using the search
function on the View Teaching Status page. For details, refer to Search for an SAI Entry.

Hover your mouse over the SAl entry that you want to delete, click the ellipsis icon that appears,
and then select DELETE.

A confirmation dialog box appears, asking whether you want to delete the entry, with the following
options provided:
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o CANCEL
o DELETE AND BLACKLIST

o DELETE

Note:

o When you delete an SAl entry, all contents under this entry, including those of its sub-
levels, are deleted.

o The DELETE AND BLACKLIST button is only available when you try to delete an SAI
entry of publisher or application level.

o If you BlackList a publisher or application, the signatures of this publisher or application
will never be suggested again. To have SSA suggest signatures of that publisher or
application, go to the <SSA_Install_Dir>\ssa\data\report folder on the SSA server, and
then remove that blacklisted publisher or application from the Blacklist.txt file.

6. Theresult is then deleted.

You can also delete multiple SAIl entries by using the batch delete icon on the toolbar of the left or right
pane.

How to Create SAIl Entries

Through the SSA user interface, you can create SAIl entries for the autoteach.zsai file or other user
SAl files. To do this, follow these steps:

To create SAl entries through CMS Ul, follow these steps:

1. Access the Smart Software Analytics module. For details, see How to Access Smart Software
Analytics.

2. Perform either of the following depending on the type of SAl file where you want to create the
entries:

o Entries in autoteach.zsai: On the Smart Software Analytics page, click TEACH SERVER.

o Entries in a user SAI file: On the Smart Software Analytics page, select Available user sai
in the SAIl data type drop-down box, and then click the user SAI file name from the file list.

3. Perform the following respectively to create SAl entries of different levels:
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o Publisher: Click the T icon on the left pane to create a new publisher entry.

o Application: Hover your mouse over the publisher entry under which you want to create a new
application entry, click the ellipsis icon that appears, and then select Create.

o Release: Hover your mouse over the application entry under which you want to create a new
release entry, click the ellipsis icon that appears, and then select Create.

o Version: Hover your mouse over the release entry under which you want to create a new
version entry, click the ellipsis icon that appears, and then select Create.

o File: Hover your mouse over the version entry under which you want to create a new file entry,
click the ellipsis icon that appears, and then select Create.

4. Follow the on-screen instructions to fill in the required information for the entry you are creating.

Troubleshooting and Limitations — Smart Software

Analytics

Troubleshooting Smart Software Analytics

This section includes:

« Is My SSA working
« How to Reset SSA

o Overtime Issues Occur When SSA Runs

Is My SSA Working

To check if SSA works properly, perform the following:

1. Check if the SSA service is still running.
2. Check the log files for errors.

3. Monitor <SSA_Install_Dir>\ssa-server\ssa\data\runtime\scanFile folder against accumulated
files, which indicate that error occurs.

4. If SSA does not work, restart the SSA service. Then, SSA will reload all SAI files.
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If SSA still fails to work normally after you restart the SSA service, it is possible that some SAl
files are corrupted and a reset is needed.

How to Reset SSA

Restarting the SSA service could solve most problems. But if any SAl file is corrupted, you will need to
reset SSA.

Toreset SSA, follow these steps:

1. Delete all runtime folders.
2. Clean <SSA_lInstall_Dir>\ssa-server\ssa\data\report if you do not need the report information.

3. Back up the user SAl files and only leave Master SAl files under SSA_Install_Dir\ssa-
server\ssa\data\masterSAl.

4. Restart the SSA service.

5. Re-import all user SAl files. For details, see "How to Upload SAI Files to Through User Interface
in the CMS Ul Online HelpCMS Ul Online Help.

Note: In addition to uploading the SAI files to SSA server using SSA Ul on CMS Ul, you can
also manually copy back the user SAl files into <SSA_Install_Dir>\ssa-
server\ssa\data\masterSAl. But you need to restart the SSA service after doing so.

Overtime Issues Occur When SSA Runs

Check the Date and Time settings on the machines where SSA server, UCMDB server and CMS Ul
are deployed. Make sure that these settings are consistent with each other. Otherwise, there might be
overtime issues when SSA runs.

Limitations — Smart Software Analytics
This version of SSA has the following limitations:

« Multiple-session is not supported. Only one user has write permission on the SAIl data via the SSA
Ul. Other users only have read rights.

« As part of the security mechanism, a self-signed certificate is used for the communication between
CMS Ul and UCMDB Server. When the CMS Ul is accessed for the first time on a machine, the
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web browser would pop up a warning message for the self-signed certificate. Users need to
acknowledge that to continue with the log-in. You can refer to the Hardening section of the UCMDB
Help for instructions about how to replace it with a more secure certificate.

« Data Flow Probes that are upgraded to version 2018.08 do not contain the out-of the-box certificate
from SSA. Therefore, these Data Flow Probes cannot upload scan files to SSA server.

Workaround: Import SSA’s certificate into these Data Flow Probes. To do so, follow the
instructions in step 3.b.iii. "Import interface.crt to the Data Flow Probe's Truststore" in Smart
Software Analytics - Pre-Deployment Considerations > Security Configuration.
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UCMDB Browser

The UCMDB Browser module in the CMS Modules navigation pane allows you to access the legacy
UCMDB Browser in a new window.

To access the UCMDB Browser module, use one of the following methods:

« InCMS Ul, click the Menu icon (E) to expand the CMS Modules pane, and then click
UCMDB Browser.

« Use the following URL: https://<server_name or IP>:<port>/ucmdb-browser/ucmdb_
browser.jsp. Provide user name and password if required.

« Toaccess the UCMDB Browser legacy mode using this URL https://<server_
name>:8443/ucmdb-browser, go to UCMDB > Administration > Infrastructure Settings
Manager > UCMDB Browser settings, and then set the value of the Redirect to dashboard
page setting to False.

This section contains the following:

Getting Started with the UCMDB Browser module . . . ... . . 324
UCMDB Browser Landing Page ... il 325
Accessing the Administration Console for the UCMDB Browsermodule __......................... 327

Enable the Start Assisted Modeling link in the UCMDB Browser module for specific users _..__. 328

Getting Started with the UCMDB Browser module

The UCMDB Browser module is a lightweight web-based client used to access UCMDB data.

What does it do?

The UCMDB Browser module provides a simple and intuitive search for Configuration Items (Cls)in
the UCMDB and displays important data in the context of the selected Cl. It is an ideal tool for
providing quick access to specific Cl information.

The UCMDB Browser module also enables users to model services using automated service modeling
and assisted modeling technologies. As part of its capabilities the UCMDB Browser module let users
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report on any data from the UCMDB, thus making it the primary tool for users to interact with UCMDB

and federated data.

For a Cl that is found as a result of a search query, relevant data is presented and gathered into

information widgets (for example, Properties, Environment, and Impact Simulation widgets). Data is

presented by default in a Cl overview mode, with the option to view more comprehensive data in a

widget details mode.

The UCMDB Browser module has a lightweight Ul that ensures simple access to UCMDB information.
No user administration is required (this is handled by UCMDB), and no upgrades are needed when

updating to a newer version.

The UCMDB Browser module is HTML-based that runs on standard web browsers and has iPad tablet
support. See the Support Matrix section of the Universal CMDB Browser Help for specific versions.

Who should use it?

The UCMDB Browser module is targeted for the following customers:

« Non-UCMDB administrators, such as business owners or subject matter experts.

« Mobile device users, such as tablet users, wishing to take advantage of mobility and the more

intuitive Ul found on those devices.

« UCMDB administrators, who need quick Cl access.

UCMDB Browser Landing Page

The Search page and the CMS Ul header are automatically displayed when you access the UCMDB

Browser module.

Ul Element

Search module

CMS Ul (2018.08)

Description

You can open the Search page from anywhere else in the UCMDB Browser

module simply by clicking the m icon in the upper left corner of the
UCMDB Browser module window.

Enables you to locate a specific Cl.

Hovering your mouse over the Search tab allows you access to the following
modules:

o Quick Search
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Ul Element Description
« Advanced Search
« Most Visited
» Most Searched
For details, see "Search" on page 138.

Reports module Provides a method of displaying the data from views in a report format. For
details, see "Reports" on page 229.

Service Modeling = Enables you to model the infrastructure of a business service. For details,

module see "Service Modeling" on page 253.
Notifications Enables you to see which property (Cl or attribute) has changed, been added,
module or been deleted since the last time notifications were generated. For details,

see "Notifications" on page 418.

<Username> Hovering your mouse over the <Username> allows you to access the
following:

« Server details
« Lastlogin time

« Administration Console. For details, see "Accessing the Administration
Console for the UCMDB Browser module" on the next page.

« Logout

Settings Hovering your mouse over the Settings icon allows you to access the
following:

« Manage System Categories. See "Assign Color Categories" on
page 407.

« Schedule Notifications. See "Notifications" on page 418.

« Manage Discovery Status. See "Discovery Indicators" on page 417.

HELP

Opens the UCMDB Browser Help page or a custom help page.

You can create a custom help page for the UCMDB Browser users in the
UCMDB Ul > Administration > Infrastructure Settings Manager >
UCMDB Browser Settings > Custom Help Page URL. In the value field,
add a URL, for instance http://www.microfocus.com.

When the non-administrator user accesses the Help section in the UCMDB
Browser module, the custom Help page opens.

WHAT'S NEW

Opens the What’s New page, which describes the new features and
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Ul Element Description

enhancements of the version.

Note: When you first access the UCMDB Browser module, the What's
New page is displayed, containing the new features and enhancements
of the version. This happens when you connect the first time to any
UCMDB server.

ABOUT
Displays the UCMDB Browser's version and the Copyright Information.

Return to CMS Ul | Opens the CMS Ul in a new web browser tab. For details, see the Universal
CMDB Home Help.

As an administrator, you can hide the Return to CMS Ul link for the users
without administrative privileges. To hide the link, go to the UCMDB >
Administration > Infrastructure Settings Manager > UCMDB Browser
Settings and change the value of the Show Return to CMS Ul link to
admins only setting to True. The default value is False. Also, you can use
the value of the UCMDB Browser URL setting to access CMS Ul, by
changing the value of the Override the Return to CMS Ul link setting to
True.

Accessing the Administration Console for the UCMDB

Browser module

You can access various administrative tools for the UCMDB Browser module from within the
Administration Console for UCMDB Browser.

The Administration Console for UCMDB Browser is available for users with the Administration
privileges. Bi-directional direct links are available from the UCMDB Browser module to the
Administration Console.

To
access

e Inthe UCMDB Browser module, hover your mouse over the <username> @ and then
select Administration Console from the context menu.

« Use one of the following URLSs:
o http://<browser-home>/admin, or

o http://<browser-home>/Admin.jsp

User interface elements of the Admin Console are described below:
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Ul Element (A-Z) Description

VERSION Displays the following information:

« UCMDB Browser module version
« UCMDB Server product name, version, and build

« Content Pack version and build.
HELP Opens the UCMDB Browser module online help in a separate window.
<username> @ Displays the current user that logs in to the Admin Dashboard.
Hovering your mouse over it allows to access the following options:

o Browser Ul. Returns to the CMS UlI.
« Logout. Logs out of the CMS UI.

Modules in the Administration Console for the UCMDB Browser

module

The table below describes main modules available in the Administration Console for the UCMDB
Browser module.

Module Description
CACHE Opens the Cash Operations dashboard.
OPERATIONS

You can click the button to invalidate the EhCache values

stored in the UCMDB Browser module. The data are usually cached from the

UCMDB server.
LOGS Displays a list of UCMDB Browser logs. You can perform the following actions on
alog entry: View Full, Download, and Tail.
SESSION You can view all logged in users with their active sessions for CMS UI.
MANAGER

Enable the Start Assisted Modeling link in the UCMDB

Browser module for specific users

In some cases, you may wish to grant users access to the Service Modeling module in the UCMDB
Browser module, but not to Assisted Modeling. To enable this functionality, a new
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AssistedModelingVisible infrastructure setting control is introduced. This allows you to grant or
revoke access to Assisted Modeling to different user roles, which will enable or disable the Start
Assisted Modeling link in the Service Modeling module.

If you are upgrading to this version of UCMDB, you must manually grant access to Assisted Modeling
to each userrole. To do this, follow these steps:

1. GotoUCMDB Ul > Administration > Infrastructure Settings Manager, locate the
AssistedModelingVisible setting, and set its value to true.

Loginto the UCMDB JMX console. in the Administer section of the UCMDB Help
Inthe UCMDB JMX Quick Search box, enter listResourceTypes.

Enter your Customer ID. (Default: 1)

Click Invoke to display the URM Services mbean.

Select Auth_ROLE to display the list of roles.

N o o &~ w0 N

Click the Resource ID that corresponds to the user role to which you want to grant permission to
access Assisted Modeling, and then add the following lines of code to the resource XML:

<xmlGlobalPermittedAction>ASSISTED_ MODELING</xmlGlobalPermittedAction>
<xmlGlobalPermittedAction>EXPORT_REPORT</xmlGlobalPermittedAction>

8. Click Save resource to apply your changes.
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Widgets

Learn about Widgets

Automation Widget

The Automation widget allows the user to execute Operations Orchestration (OO) flows on the selected
Cl and the Cls that are in the selected CI’'s environment. These flows are run according to the user's
permissions in OO. This widget displays all the available OO flows that can be run on the selected CI
and Cls within the CI’s environment, and displays a history of the available flows that have actually
been run on those Cls.

For the Automation Widget to appear in the UCMDB Browser module, this widget must be enabled in
UCMDB by going to Administration > Infrastructure Settings > UCMDB Browser Settings, and
setting Enable the Automation widget=True.

The UCMDB Browser module comes with an Automation Flow adapter that is deployed on the
UCMDB server when the UCMDB Browser module first loads. For this widget to work, the UCMDB
administrator must configure this adapter, as described in "Configure the Automation Flow Adapter (for
the Automation Widget)" on page 399. The UCMDB Browser module also deploys several out-of-the-
box automation flows that can be used immediately after the CMS Ul connects to the UCMDB server,
and can be used as examples for constructing other automation flows.

To select and define Automation Flows in UCMDB, see "Select and Define Automation Flows (for the
Automation Widget)" on page 400

Cl Overview Mode

This mode displays the total number of available flows that can be run on the selected Cl and Cls in its
environment (called Available Flows), and the number of times that any of the available flows have
been executed on the selected Cl or on Cls inits environment (called Execution History).
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Widget Details Mode

This mode is split into the following sections:

« Available Flows. This section displays the flows that can be run on the selected Cl and Cls in its
environment. From here you can:

o Select an Automation Flow

o Select the Cls on which to run the flow

o Configure the flow's input parameters

o See asummary of the configuration before running it

o Run the configured flow

o Seeonwhich Cls the flow was executed, and on which Cls it was not

Running the Automation Flow is possible only when all mandatory input parameters have input
values.

« Execution History. This section displays the actual flows from the Available Flows section that
have been run on the selected Cl and Cls in its environment. It displays the status of each run, the
date when the flow was run, and on which ClI it was run.

For all flows with the status Canceled, Ended, Finished, or Unknown, the user can re-run the flow
using the menu on the right side of the Automation Flow history record. Each execution has a
Response Report that opens the OO report related to the specific execution. This OO report can
also be opened from the menu on the right side of the Automation Flow history record.

Business Topology Widget

The Business widget is based on a dynamic widget and can be configured according to dynamic widget
capabilities. For more information, see "Dynamic Widgets" on page 346. The widget provides additional
modes for displaying the business topology of a Cl. It looks for containment and dependency
relationships between a business element and other Cls.

Note: You should only specify the report layout in the dynamic widget definition if the Widget Type
is set to Properties. Otherwise, your specified layout is disregarded.

Cl Overview Mode

A count of Cls contained in the current Cl's environment are displayed, divided by classification. Only
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classifications containing at least one Cl are displayed. Each classification includes the name of the
classification, its icon, and the number of Cls included in it. Clicking a particular classification displays
the widget details and filters the selected classification (in both Topology Group CIT mode and Textual

mode).

Widget Details Mode

Viewing the widget details does the following:

« Replaces the data displayed in Cl Overview mode.

« Presents the detailed environment data in Map mode, CIT Group mode, or Textual mode, whichever
was last used. The default mode is the Widget Type value that is selected during creation of the
dynamic widget in UCMDB.

Note: If graphical mode does not display, it may be due to the fact that the drive of the machine
where the UCMDB server is installed is full. Free up some space on that drive in order to view
graphical mode.

o Toolbar

The top row of the Business widget acts as a toolbar and enables you to:

« Switch between the different presentation modes

« Click abutton (in graphical mode only) that opens or closes the Cls pane. The default mode
for the Cls pane is opened.

The Cls pane details the Cls contained in the classification that is selected in the CIT Group
pane, dividing it into all relevant CI types.

o Map mode
Note: When the CMS Ul is embedded in a UCMDB server running on a Linux system,
runlevel 5 (enabled X server) is needed for the graphical mode of the Dynamic widget to

operate properly. In addition, add unset DISPLAY to the server.sh script. Restart the
UCMDB Server for the server.sh changes to take effect.

« Classification icons are displayed in layers according to relationships in the topology and not
according to the actual hierarchy.

« When you select a Cl, arefocus “ ! link appears in the corner of the selected node. Clicking

this link causes the UCMDB Browser module to refocus on that node.
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Directional lines representing links are displayed with other items in the view if the selected Cl
has a direct relationship with at least one other CI (either in the same classification orin a
different classification).

o CIT Group mode

« Foreach classification containing at least one CI, the name and number of Cls in that
classification is displayed. Clicking a classification displays all Cls contained in that
classification and matching the current filter. In addition, a thumbnail is displayed for each ClI
type that contains at least a single CI.

« Classification icons are displayed in layers according to the relative hierarchy of the Cls as
displayed in the topology map in UCMDB.

Directional lines representing links are displayed with other items in the view if the selected Cl
has a direct relationship with at least one other CI (either in the same classification orin a
different classification).

o Textual mode

«» Left pane. The left pane displays an alphabetical list of all classifications containing at least
one Cl. Each classification is broken down into a list of the Cl types in that classification that
have at least one CI. Selecting any line in this pane displays its details in the right pane.

« Right pane. The right pane displays detailed information about the item that is selected in
the left pane, divided by CI type.

Change Requests Widget

The Change Requests widget presents the Change Requests related to the selected Cl. Cl Overview
mode displays the total number of Change Requests for each Change Request state. Widget Details
mode displays a list of all the Change Requests related to the Cl and all their details. The Change
Request widget is presented only when Micro Focus Service Manager (SM) configuration element is
enabled and configured in the Infrastructure Settings in UCMDB. All data presented is taken from the
UCMDB federated RequestForChange Cl and its relationships.

Note: The Create Time for federated Cls will show the Open Time of the Change Request in SM.
Using non federated RequestforChange Cls (populated with other integrations) will cause the
Create Time to be the time when the Change Request was created in UCMDB and not the time
when the Change Request was opened in the external data source.

A Change Request is considered related to a Cl if it meets one of the following criteria:

CMS Ul (2018.08) Page 333 of 446



CMS Ul Guide

« All Change Requests linked directly to the Cl.

« Ifthe selected Cl is a Model: All Change Requests linked to all the Cls contained in that model
(meaning, any other contained model or ClI).

« Ifthe selected Cl is a Person: All Change Requests that are connected to all the Cls owned by that
person.

« Inall other cases: All Change Requests that are linked with a composition link to the selected Cl
(for example: Running Software to Windows Server).

Cl Overview Mode

In this mode, change requests related to the selected Cl that have one of the following statuses are
presented:

« Recent. All Change Requests that terminated in the recent time frame (default — 3 days, is
refreshed if the selected time frame is changed in the widget details).

« In Progress. All Change Requests that are currently in-progress. A Change Request is considered
In Progress if it is open, meaning that its planned start date has passed and its planned end date
has not yet passed. Also, its phase must qualify as In Progress, meaning that it is defined in the In
Progress list in the XML configuration file.

« Overdue. An overdue Change Request is a Change Request that was In Progress but whose
planned end-date has passed.

« Planned. All Change Requests that are planned to start in the recent time frame (default — 3 days,
is refreshed if the selected time frame is changed in the widget details.

« Delayed. A Change Request is Delayed if it was a Planned Change Request but its planned start-
date has passed.

The UCMDB administrator can define which IT SM RFC Phase is mapped to each one of the Change
Request statuses Recent, In Progress, and Planned (the Overdue and Delayed statuses are
automatically calculated by the UCMDB Browser module). The UCMDB Browser module is configured
by default in the following manner:;

UCMDB Status IT SM RFC Phase

Recent Evaluation, Closure
In Progress Implementation
Planned Approval
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If a Change Request’s phase does not exist in the configuration list it is ignored, meaning that it is not
included in the Change Request summary or detailed list.

If a Change Request’s planned start date or end date are not defined, the UCMDB Browser module
uses the current date for both planned start/end dates (in both the Cl Overview and Widget Details
modes).

Widget Details Mode

This mode adds the following to the summary displayed in the Cl overview:

« Timeline Span toggle: +/-3 days , +/-1 week, +/-1 month. Selecting a timeline span details all
Change Requests related to the selected Cl that are contained within the selected timeline (that is,
either their start date or due date are within that timeline). Note that changing the timeline should
change the summary displayed in the Cl overview.

« Show toggle: All/Late. Selecting All details all Change Requests related to the Cl in the selected
timeline, selecting Late presents only those Change Requests that are either overdue or delayed
(as explained above).

« All relevant Change Requests, sorted by their status (Recent, In Progress, Overdue, Planned,
and Delayed). The internal sort within each status group is according to Change Request phase
and then planned start date.

The following information is provided per each Change Request:

« ID. This is a clickable field that refocuses on the RequestForChange Cl when selected
o Phase

« Planned Start Date. |s emphasized if the Change Request is Delayed.

« Planned End Date. Is emphasized if the Change Request is Overdue.

« Affected Cls. Up to 10 Cls within the context of the selected Cl are presented, with a link to show
all results in the event that there are more than 10 affected Cls within the context of the selected Cl
linked to the Change Request. Affected Cls can be refocused.

» Affected Service. The first BusinessService Cl, within the context of the selected ClI, connected to
the Change Request CI through a membership link. If no such Cl exists, the Affected Service
header is not displayed. The Affected Service can be refocused.

« Severity

« Adirect link to the Service Manager system with the context of the selected change request is
presented per each change request, if this link is configured by the system administrator. For
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instructions on how to configure this direct link to Service Manager, see "Configure a Direct Link to
Service Manager for a Selected Problem, Incident, or Change Request" on page 60.

Defects Widget

The Defects widget presents the defects opened on all ALM projects that are linked (directly or
indirectly) to the selected business element CI. In Cl Overview mode, defects are displayed according
to the defect number; in Widget Details mode, defect details are displayed, as described below.

A business element Cl can be linked directly to one or more ALM project(s), using ALM filters (). A
business element Cl can also be linked indirectly to ALM projects, through its descendants (it is
connected to another business element Cl which is linked directly to one ALM project or more).

This widget is displayed only if it has been properly configured in UCMDB. For details on this
configuration, see "Integrate with ALM (for the Defects Widget)" on page 401.

This widget and the Defects adapter use the Defects Cl type (part of Universal Data Model or UDM) for
federating data from ALM and using it in the widget.

Cl Overview Mode

The total number of Open defects in all projects linked to the selected Cl are displayed, according to
severity level. The severity levels are Low, Medium, High, Very High, and Urgent.

Widget Details Mode
The following information on defects related to the selected Cl is displayed:
Left pane:

The following filters are used to filter the defects displayed in the widget's right pane:

« Refine field. Enter a value here tofilter the displayed defects to only those defects that contain this
value in one of the attributes configured for search refinement. For example, if 12 is typed, all
defects that contain “12” in at least one of the configured attributes remain visible, the others are
hidden. This is a cross filter with the other two filters (Severity and First-level, described below).

Configure attributes for the Refine search as follows:

<search_refining attribute_names>DefectReferenceNumber,DefectSummary
</search_refining_ attribute_names>

This is a comma-separated list, and the attributes listed here must belong to the Defect Cl type. An
attribute that does not belong to the Defect Cl type is ignored.
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An "X" button appears to the right of the field, which allows clearing the entered text.

« Severity. This is a toggle between available severity levels. You can filter defects according to
severity level. For example, you can choose to display only defects with Urgent severity level. The
default is All Severities, meaning that it displays defects of all severity levels. The number of
defects for each severity level is displayed.

« First level filtering. Since the resulting number of related defects can be high, it is possible to filter
them according to one of the following:

o If more than a single ALM Project is defined (either directly or indirectly), you can filter defects
according to a specific project. The number of defects per ALM project is displayed. With this
type of filtering, it is only possible to see defects of a specific ALM project. There is no option to
see all defects of all ALM projects in a single view.

o If asingle ALM project is defined, first level filtering is determined by the system administrator.

Right pane:

All relevant defects, filtered by the search string, severity level, and first-level filtering are presented.
Since all displayed defects belong to a single ALM project, the defect details presented are
configurable. Each defect can be presented in a collapsed or expanded mode; collapsed is the default.

In collapsed mode, the following information is displayed:

o DefectID
« Summary: The summary data is truncated to fit the two line column size.
« Severity (configurable, see above)

« Release: By default, sorting is done using the Severity field on a downward order. It is possible to
sort defects according to any of the above fields, either upward or downward, using the arrows that
appear on each field's label.

Sorting is done by default using the Severity field in descending order. Sorting defects by any field,
either ascending or descending, is done using the arrows displayed on each field's label.

Expanding a Defect

The following information is added to the data presented in the collapsed mode when expanding the
defect:

o Full summary information

« All defect-related properties that the UCMDB administrator configured to be displayed per ALM
project.
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All properties are textual, and are presented in two columns.
Defect Description in Widget Details Mode

The defect description setting configures which attribute of the Defect CIT is displayed in Expanded
mode. The default setting is DefectSummary, as shown below:

<description_attribute_name>DefectSummary</description_attribute_name>

The setting here must be an attribute of the Defect Cl Type. If it is not, DefectSummary is used by
default.

Severity Mapping

From the UCMDB Browser settings, it is possible to configure the list of values of the DefectSeverity
attribute that are mapped to severity levels in the UCMDB Browser module.

For each Severity, the mapping can be configured from the UCMDB Browser settings as follows:

<severity urgent_values>5:Urgent</severity urgent_values>
<severity very high values>4:Very High</severity very high_values>
<severity high values>3:High</severity high values>

<severity medium_values>2:Medium</severity medium_values>
<severity low_values>1:Low</severity low_values>

If the DefectSeverity of the Defect Cl type has the value: “2:Medium”, it is mapped as Medium in the

UCMDB Browser module. It is also possible to have a comma-separated list of values here.

Note: The severity displayed in the UCMDB Browser module can be modified through UCMDB.
Go to Administration > Infrastructure Settings Manager > UCMDB Browser Settings.

Dependent Services Widget

The Dependent Services widget presents all services (that is, all Cls that have the SERVICE_MODEL
qualifier) that will have an impact on a selected Cl if they fail, according to a specified impact severity
level.

The following table displays the severity levels used in the UCMDB Browser module and the
comparable severity levels in the UCMDB server:

UCMDB Browser module UCMDB Server
Critical Critical(9)

High Major(8)
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UCMDB Browser module UCMDB Server
Medium Minor(6)

Low Warning(2)
The severity level fora Cl is cleared (set to None) when you log in to the CMS UI.

Note: To view datain the Dependent Services widget, there must be an impact rule created in
UCMDB and you must have View permission for the Resource Groups > Impact Analysis
resource.

This widget uses out-of-the-box impact rules from UCMDB. To specify the impact rules used by this
widget, see "Specify Impact Rules" on page 394.

Cl Overview Mode

This mode summarizes the number of services that may impact the selected Cl, according to the four
severity levels: Critical, Major, Minor, and Normal.

Widget Details Mode

This mode presents detailed information on the services that may impact the selected Cl. You can
change the severity, which will rerun the analysis to show a different level of impact.

Discovery Progress Widget

The Discovery Progress widget presents the progress of running discoveries, and enables you to drill
down to discovered Cl instances. The discovery progress information displayed is the last status
known by the UCMDB server for each job Trigger Cl within the context selected for discovery.

Tip: You can also access the Discovery Progress widget simply by clicking the Cl's Discovery
Indicator in the Search and Reports modules.

Cl Overview Mode

The Triggered Cls View - Progress/Status Matrix displays a summary of the status of triggered Cls
through the progress of discovery.
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Ul Element
(A-Z)

Progress
bar

Show All

Description

Displays the percentage of new trigger Cls that have completed the discovery
process for the set of jobs contained within the focus area that you have selected for
discovery since the last time the activity was modified.

mode.

Note: When you activate discovery, the trigger Cls list is prepared. During this
time, discovery progress may not be reflected immediately.

The discovery progress is refreshed when loading the preview, opening the
Widget Details mode, or clicking Refresh Job List from the Widget Details

Clicking the Show All link or the DISCOVERY PROGRESS widget header link
opens the Widget Details Mode.

Understanding the Progress/Status Matrix and the Progress Bar

Progress
Status

Pending
Probe

Reached

Probe

Completed

Total

Total

Displays the total
number of trigger
Cls waiting for the
Probe to pick them
up for execution.

Displays the total
number of triggered
Cls that reached
the Probe, and may
have started
running.

Displays the total
number of triggered
Cls that completed
running
(successfully or
unsuccessfully).

Displays the total
number of triggered
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o

Displays the
number of
triggered Cls
successfully
waiting for the
Probe to pick them
up for execution.

Displays the
number of
triggered Cls that
successfully
reached the Probe,
and may have
started running.

Displays the
number of
triggered Cls that
successfully
completed
running.

Displays the total
number of

Displays the
number of
triggered Cls that
successfully
reached the Probe
and have started
running, but have
warnings.

Displays the
number of
triggered Cls that
successfully
completed
running, but have
warnings.

Displays the total
number of

Displays the number
of triggered Cls that
failed to complete
running, did not reach
the Probe, or were
not picked up by the
Probe for execution.

Displays the total
number of failed
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Progress
Status Total o ®
Cls. successful triggered Cls that  triggered Cls.
triggered Cls. were successful,

but had warnings

Widget Details Mode
The following information related to the triggered Cls is displayed:
Left pane:

The left pane summarizes the number of Cls that match the current filter. The left pane is divided into
two sections:

1. Summary section

o All. Shows the total number of triggered Cls. Clicking this line displays, in the right pane,
details of all triggered Cls.

o Completed. Shows the total number of triggered Cls that completed running (successfully or
unsuccessfully). Clicking this line displays, in the right pane, details of all triggered Cls that
completed running. A further breakdown summary is displayed in the Completed section
below.

o In Progress. Shows the total number of triggered Cls that are still running. Clicking this line
displays, in the right pane, details of all triggered Cls that are still running.

2. Completed section

The following filters are used to filter the triggered Cls that completed running (successfully or
unsuccessfully):

o Successfully. Displays the number of triggered Cls that successfully completed running.
Clicking this line displays, in the right pane, the triggered Cls that successfully completed
running.

o With Warnings. Displays the number of triggered Cls that successfully completed running,
but have warnings. Clicking this line displays, in the right pane, the triggered Cls that
successfully completed running, but have warnings.

o With Errors. Displays the number of triggered Cls that failed to complete running, did not
reach the Probe, or were not picked up by the Probe for execution. Clicking this line displays, in
the right pane, the triggered Cls that failed to complete running, did not reach the Probe, or were
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not picked up by the Probe for execution.

Note: When you refresh the jobs list, the selected filter does not change.

Right pane:

Displays the following:

« Check Network Availability . Allows you to check the network

availability for any of the IP addresses of a Node type Cl from the UCMDB Browser module. For
detailed instructions, see "Check Network Availability from the Discovery Progress Widget" in the

Universal CMDB Browser Online Help.

Refresh Job List
« Refresh Job List . Allows you to refresh the job list.

o Details section.

Displays the job list and the following details for all triggered Cls.

Column

Job Name

Status

CMS Ul (2018.08)

Description

Displays the list of jobs that have reached the selected stage of discovery and
with the selected status.

Displays the following status for the triggered Cl. The success data is retrieved
from the UCMDB Server side. When there is warning/error with a triggered Cl, the
data from the UCMDB Server is overwritten by the data from the probe side.

o Success. Displays the word Success in green.

The success data is retrieved from the UCMDB Server side. When there is a
warning/error with a triggered Cl, the data from the UCMDB Server is
overwritten by the data from the probe side.

o Warning. Displays the word Warning in orange.

For the triggered CI with a Warning status and a Warning message, a down
arrow is displayed at the beginning of the row. Clicking the down arrow expands
a short warning message for the triggered Cl. To collapse the warning
message, click the up arrow.

o Error. Displays the word Error in red.

For the triggered CI with an Error status and an Error message, a down arrow
is displayed at the beginning of the row. Clicking the down arrow expands a
short error/warning message for the triggered CI. To collapse the error/warning
message, click the up arrow.
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Column Description

Note: In the error/warning message list, the error messages are flagged with
@, and the warning messages are flagged with

If a triggered CI contains both error and warning messages, Error is displayed
as its status.

Probe Name of the probe.
Trigger CI | Name of the trigger Cl.

Last Displays the time that the triggered Cl was last discovered (touched) by a probe.
Discovery
Time

« Context Menu

Hovering your mouse over a record allows you to access the Context Menu displayed at the

right end of the line.

Clicking the Context Menu button allows you to access the following:

o Show Details
Displays the following details for the selected triggered Cl. This option is only available for Cls
with an Error or a Warning status.
Column Description

/ Displayed at the beginning of the row, allowing you to expand/collapse a list
of detailed error/warning messages for the triggered Cl. By default, the list
of detailed error/warning messages is expanded. To collapse the message
list, click the up - arrow. To expand the message list, click the down
arrow.

Error/Warning Displays a short error/warning message with the &) or (1) flag.

Message
Severity Displays the severity of the error/warning.
Message Displays a message code (for example, 302).
Code

Note:
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« Toview the Show details action, you must have the Run Discovery and Integration
or View Discovery Status and Error permission.

« Toview the detailed information for a triggered Cl, you can also click the triggered Cl's
status. You can view the Show Details tooltip each time you hover the mouse over an
Error or a Warning status.

« The Show details action is disabled for the triggered Cls that successfully completed

running.
To go back to the jobs list, click the button.
o Rerun

Allows you to rerun a discovery job.

Note: To use the Rerun action, you must have Run discovery and Integrations
permission.

For instructions about how to rerun a discovery job, see "Rerun a Discovery from the Discovery
Progress Widget" in the Universal CMDB Browser Online Help.

o View Discovery Log

Allows you to open the discovery log details page and view the log for the selected job.

Note:

« If the selected discovery job has no communication log, or the discovery job completed
successfully, you will see a "No data" message after clicking the View Discovery Log
action.

Communication log is available for a discovery job when the following conditions are
met:

« The Create communication log setting in the Execution Options section is set to
Always (go to UCMDB Ul > Data Flow Management > Universal Discovery >
Adapter Management > Adapter Configuration).

« Error(s) occurred during the running of the discovery job.

The RAW/WELL FORMATTED switch at the upper right side of the page allows you to toggle
between displaying raw log data or displaying formatted log data for easy troubleshooting
purpose.

Support matrix for the View Discovery Log features:

CMS Ul (2018.08) Page 344 of 446



CMS Ul Guide

Supported web browsers
Microsoft Internet Explorer 9
Microsoft Internet Explorer 10

Microsoft Internet Explorer 11 (or
later)

Google Chrome 30 (or later)
Mozilla Firefox 33 (or later)

Apple Safari 9.1 (or later)

RAW Log
Yes
Yes

Yes

Yes
Yes

Yes

Note: View raw data
only.

WELL FORMATTED
Log

No
Yes

Yes

Yes
Yes

Yes

« RAW. Displays the discovery log data dynamically in its raw form.

.
The button available at the top of the page allows you to download the

raw log data in the Log.xml file to your local drive.

Note: This button is not available if you use a web browser other than Microsoft Internet
Explorer 10 (or later), Google Chrome, or Mozilla Firefox.

« WELL FORMATTED. Retrieves and processes the raw discovery log data, and then
displays the log data in the formatted form.

This page contains two sections:

« Job summary section. Displays the discovery job related information. You can click JOB,
DESTINATION, PROTOCOL, PARAMETER, or SCANNER STATUS tab for more

details about the discovery job.

« LOG details section. Contains the following:

Ul Element Description

<Search Type a key word in the Search box to search the log entries.

box>

highlighted with yellow background.

Click to display available filters:

o Execute CMD
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When you type a key word, log entries that match the key word are
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Ul Element

Results

<Table of
log
entries>

<Log entry
data>

Description

« Connect
« Warning
« info

« debug
« error

o warn

You can select one or more filters to filter the log entries. When doing so,
only log entries that match the filter(s) are displayed, but no log entries
are highlighted.

Displays total count of log entries. When a search key word is entered or
one or more filters are selected, it displays total count of log entries that
match the key word or selected filters.

Displays log entries in a table with three columns (Time Stamp,
Severity, and Content).

Drag down the scroll bar to dynamically load and display log entries.

Log entries of different severities are displayed in different color for easy
reading:

« info. Displayedin blue.
« debug. Displayed in green.
« error. Displayed in red.

When hovering your mouse over a log entry, the log entry is displayed in
black with light gray background. If you click to select it, the selected log
entry is highlighted with light green background.

Fay
You can click the up or down arrow % next to a column header to sort the
log entries.

Displays the log data for a selected log entry.

Click the Raw tab to view the log entry data in its raw form; click the
Formatted Log tab to view the processed log message for easy reading
and troubleshooting purpose.

To go back to the jobs list, click the button.

Dynamic Widgets

Dynamic widgets are widgets that display data about a particular view. You create dynamic widgets in
the Modeling Studio in UCMDB.
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Note:

« Afteryou create a dynamic widget in UCMDB, you must log out of the CMS Ul and then log in
again to see the newly created widget.

« Only one level of grouping is supported.

« If no grouping option has been specified in the hierarchy tree, all Cl attributes appear in a single
screen.

« You must use the > Resource Creation Action > Dynamic Widget action on the Security >
Roles Manager > General Actions tab to control which users may create new dynamic
widgets in the Modeling Studio (for use in the UCMDB Browser module).

Cl Overview Mode

On the Widget tab of the dynamic widget configuration, you must set an attribute to True in the
Overview column for it to be displayed in Cl Overview mode.

The CI Overview mode displays up to six individual properties (six random properties from all nodes
specified in the dynamic widget).

Widget Details Mode

On the Widget tab of the dynamic widget configuration, you must set an attribute to True in the Details
column for it to be displayed in Widget Details mode.

Properties in Widget Details mode are displayed in different ways, depending on the dynamic widget's
configuration:

« If no grouping classifications have been specified in the hierarchy tree of the dynamic widget's
configuration, all attributes that are defined as True for being shown in Widget Details mode are
displayedin a list.

« If grouping classifications have been specified, in the first level of this mode Cls are displayed by
group (as specified in the hierarchy tree) and show a maximum of two random attributes that are
defined as True for being shown in Cl Overview mode. Selecting one of the Cls shows all of the
attributes for that Cl that are defined as True for being shown in Widget Details mode, grouped by
the group name for that attribute that was specified in the widget's configuration.

Create a dynamic widget

1. InUCMDB, go to Modeling > Modeling Studio.
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Note: To create a dynamic widget, you must have Create Dynamic Widget permission
assigned in the Roles Manager in UCMDB.

2. Click New i and from the drop-down list, select Dynamic Widget. In the New Dynamic
Widget dialog, select the base TQL query on which your new dynamic widget is based, or select
Create new query to build a new TQL query.

a. Inthe View tab, add the query nodes and relationships that define the query.

>>for version 3.1 - delete this paragraph and note, and unconditionalize the <ol>, after
confirmation with dev<<

Specify whether to use a manual (default) or rule-based hierarchy when defining the TQL

query.

Note: If you are starting with a blank widget, you must add at least one query node in
order to save your widget.

b. Inthe Report tab, select a node in the Hierarchy pane, and choose the attributes for that node
that you want to appear in the widget.

c. Inthe Widget tab, select a node and set values for that node's attributes:

Ul Element Description

Overview Boolean. Specifies whether this attribute appears in the Cl Overview mode.
Details Boolean. Specifies whether this attribute appears in the Widget Details
mode.

Refocusable = Boolean. Causes the attribute to appear as a hyperlink, which will refocus to
the Cl on which it is defined.

Group Name = String. Specifies the name of the section under which the attribute will be
grouped in the Widget Details mode.

« Select the Show path checkbox to cause the UCMDB Browser module to display the
route in the dynamic widget from a specific node in the view definition to all the node's
children.

« Select the Enforce Browser Cl access control checkbox to ensure that the dynamic
widget displays data only according to the permissions that were specified in UCMDB (on
the Browser Cl Access Control tab in the Roles manager). If the checkbox is not selected,
the dynamic widget will display all data, without permission enforcement.

« Select aninitial display mode for the dynamic widget.
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« Properties Mode. Displays individual properties for Cls.

Note: If you do not select a Widget Type value, Properties Mode is enabled by
default.

« Topology Map Mode. Displays Cls according to your current topology (folding
definitions are also reflected).

« Topology CIT Group Mode. Displays Cls grouped by ClI type according to your
current model.

« Topology Textual Mode. Displays a list of Cls broken down by ClI type.

The topology mode that you select is the initial view selection until you change to another
one in the UCMDB Browser module.

3. When you are finished, click Save il

For additional details, see "Modeling Studio" in the Modeling section of the UCMDB Help.

Environment Widget

The Environment widget presents the closest environment of the selected Cl (as defined in by the
calculated links that are specified in the Cl Type Manager in UCMDB). Details about Cls in the
environment can be displayed in either textual or graphical mode.

User preferences are saved in the UCMDB server's user preferences.

Cl Overview Mode

A count of Cls contained in the selected Cl's environment are displayed, divided by classification. Only
classifications containing more than one CI are displayed. Each classification includes the name of the
classification, its icon, and the number of Cls included in it. Clicking a particular classification displays
the widget details and filters the selected classification (in both Graphical Mode and Textual Mode).

When you click the direct link icon, another web browser window opens, displaying UCMDB's
IT Universe Manager in the Get Related Cls module.

Widget Details Mode

The widget details mode presents the detailed environment data in either textual or graphical mode,
whichever was last used. Graphical mode is the default view mode.

Note: If graphical mode does not display, it may be due to the fact that the drive of the machine
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where the UCMDB server is installed is full. Free up some space on that drive in order to view
graphical mode.

« Toolbar
The top row of the Environment widget acts as a toolbar and enables you to:

o Switch between graphical and textual modes

o Click a button (in graphical mode only) that opens or closes the Cls pane. The default mode for
the Cls pane is opened.

Note: You can also open the Cls pane by selecting a classification in the Topology map.

The Cls pane details the Cls contained in the classification that is selected in the Topology
pane, dividing it into all relevant Cl types.

o Graphical mode

Note: When the CMS Ul is embedded in an UCMDB server running on a Linux system,
runlevel 5 (enabled X server) is needed for the graphical mode of the Environment Widget to
operate properly. In addition, add unset DISPLAY to the server.sh script. Restart the UCMDB
Server for the server.sh changes to take effect.

In graphical mode, information is displayed in a topology map format, with the Cls grouped by CI
Types. In this map, the groups cannot be expanded.

You can navigate in the Environment Widget easily by turning on the quick navigation map.

In the quick navigation map, the elements from the canvas are represented. You can drag and
resize the selection in the map overview.

If the map is too large, a big overview of the map is available, which allows you to use the map
overview navigator to jump directly to a particular part of the map.

A toggle button is available in the map to allow you to turn on/off the minimap. If the map is larger
than 20 Cls, the state of the button is saved in your user preferences. For more details about the
Map Toolbar, see "Map Toolbar" on page 281.

m-E-DH--l-EIE

| Open quick navigation |

Directional lines representing links are displayed with other items in the view if the selected Cl has
a direct relationship with at least one other CI (either in the same classification or in a different
classification).
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o Textual mode

o Left pane. The left pane displays a list of all classifications containing at least one CIl. Each
classification is broken down into a list of the Cl types in that classification that have at least one
Cl. Selecting any line in this pane displays its details in the right pane.

o Right pane. The right pane displays detailed information about the item that is selected in the
left pane, divided by ClI type.

Get Related Widget

The Get Related widget presents an improved way to explore environment data. In addition to viewing
the Cls that are related to a selected Cl, you can add or remove from the map Cls that are related to a
Cl in the map. Details about related Cls can be displayed in either textual or graphical mode.

User preferences are saved in the UCMDB server's user preferences.

Cl Overview Mode

A count of Cls contained in the selected Cl's environment are displayed, divided by classification.
Each classification includes the name of the classification, its icon, and the number of Cls included in
it.

When you click the direct link icon, another web browser window opens, displaying UCMDB's

IT Universe Manager in the Get Related Cls module.

Widget Details Mode

The widget details mode presents the details about related Cls in either textual or graphical mode,
whichever was last used. Graphical mode is the default view mode.

o Toolbar

The top row of the Get Related Widget acts as a toolbar and enables you to switch between
graphical and textual modes.

o Graphical mode

Note: When the CMS Ul is embedded in an UCMDB server running on a Linux system,
runlevel 5 (enabled X server) is needed for the graphical mode of the Get Related Widget to
operate properly. In addition, add unset DISPLAY to the server.sh script. Restart the UCMDB
Server for the server.sh changes to take effect.
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In graphical mode, information is displayed in a topology map format. Using the Get Related widget
allows you to automatically bring in the map all the related Cls.

InUCMDB, Administration > Infrastructure Settings Manager > UCMDB Browser Settings >
Maximum nodes that can be explored using Get Related setting, you can specify the
maximum number of nodes to be displayed in the map. The default value is 20.

Note: If you do not want to limit the number of nodes to be displayed in the map when
accessing the Get Related widget, the value of the Maximum nodes that can be explored
using Get Related settingin UCMDB, Administration > Infrastructure Settings Manager
> UCMDB Browser Settings has to be -1.

If the number of related Cls is higher than the specified number, the following message is displayed
: "The ClI contains over "X" related Cls. Select the Cls you want to show on map".

In the Get Related Map you can explore the related Cls for all the Cls displayed in the map. You can
manually add or remove from the map Cls that are related to a selected ClI, by using the Right
panel. To go back to a previous state displayed in the get related map, select the desired Cl in the
Navigation Context menu. You can view in the Right panel the Cl Type's count information
displayed in parentheses.

Note:

o The Get Related action is not available for the federated Cls.

o Toaccess the Get Related widget, you must have the Get Related permission, and the
value of the Enable Get Related Context Menu setting in UCMDB, Administration >
Infrastructure Settings Manager > UCMDB Browser Settings has to be True (this is the
default value).

Note: To access the Get Related widget, you must have the Get Related permission, and the
value of the Enable Get Related Context Menu setting in UCMDB, Administration >
Infrastructure Settings Manager > UCMDB Browser Settings has to be True (this is the
default value).

o You can navigate in the Get Related Widget easily by turning on the quick navigation map.

In the quick navigation map, the elements from the canvas are represented. You can drag and
resize the selection in the map overview.

If the map is too large, a big overview of the map is available, which allows you to use the map
overview navigator to jump directly to a particular part of the map.
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A toggle button is available in the map to allow you to turn on/off the minimap. For more details
about the Map Toolbar, see "Map Toolbar" on page 281.

m-E-DH--l-EIE

| Open quick navigation |

Directional lines representing links are displayed with other items in the view if the selected Cl has
a direct relationship with at least one other ClI.

o Show Additional Information on the Topology Map
If desired, you can view additional information for the Cls displayed in the map. For more
information, see "Show Additional Information on a Topology Map" on page 376
« Textual mode

In Textual mode, information is presented in a list format. You can see a list of the Cls that are
displayed in the Topology Map. By default, the list of Cls is expanded.

History Widget
The History widget is used to compare details about the selected Cls between different points in time.
The comparison is based on the UCMDB History storage, and can present the following information:

« Changes in attribute values.

« Changes in connectivity between the selected Cl and related Cls (due either to addition or deletion
of links between Cls).

o Creation of the Cl in UCMDB.

The Selected tab displays historical changes for the selected Cl only. The Model tab shows Cls related
to the selected Cl that have historical changes. Clicking one of the related Cls displays historical
changes for that related CI.

Note:

« Changes are compared between two points in time. Additional or multiple changes are neither
counted nor presented. For example, the value of an attribute that changes on date X from
value A to value B, and then on date Y from value B to value A, is not displayed as changed.

« Dates presented in the History widget are displayed in the format defined in the user's default
browser. Only changes after Jan. 1, 1970 are shown. If no changes were made on the selected
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Cl between the two comparison dates, the message “No data available for History widget” is
displayed.

« Forall historical comparison purposes, the snapshot time taken into account is the time that
the Cl was changed.

User preferences are saved per user according to the last user's selection:

« The Compare mode (either Selected or Model mode, explained below)

o Thelatest From and To dates for comparison

Cl Overview Mode

This mode displays a graph summarizing the historical changes that occurred in the selected Cl (the
default display option) or its model during the previous four weeks. The X axis lists five dates, from four
weeks ago to the current date. The Y axis shows the number of changes in a single day.

Widget Details Mode

The following information is displayed in the widget details mode:

« Presents the Compare mode and the beginning and end dates used for comparison. The default end
date is the current date and time. The default beginning date is the current end date minus the
History Widget From Date setting that is setin UCMDB. The beginning date always starts from
12:00 AM. For example, if the History Widget From Date setting is 5, and the current date is Jan.
30, 2013, then the default beginning date is Jan. 25, 2013 at 12:00 AM. The default value for the
History Widget From Date setting is 7, but this value can be changed by the UCMDB
Administrator, as explained in "Change the History Widget 'From Date™ on page 383.

« If the Compare mode in the last user’s filter is Selected, the History Comparison View for the
selected Cl, according to the filter settings, is displayed.

« Ifthe Compare mode in the last user’s filter is Model, the Model view, with all classifications and ClI
types according to the filter settings (either the last user selection or default values) is displayed.

The widget details are divided into the following sections:

« Filter section

When the History widget is expanded, the Filter section is loaded with the latest user selections (as
saved in the user preferences, if any). If there is no latest user selection, the default values are:
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o Compare mode — Selected

(o]

Last history comparison dates:

« From date —this date is calculated as follows: current date minus the History Widget From
Date setting that is set in UCMDB, starting from 12:00 AM.

« To date —the current date

Each time afilter field is changed, its data is saved in the user preferences.

Use the following Ul elements to configure the information displayed by the History widget:

(o]

The Compare mode tabs toggle between displaying the history comparison only on the selected
Cl, orin the wider context of the model (explained above). When you toggle between the two

modes, the following changes occur:

« If the value changes to Selected — the History Comparison view for the selected Cl using the
current filter is displayed (regardless of the previous view).

« If the value changes to Model —the Model view, with all classifications and CITs resulting
from the current filter (regardless of the previous view) is displayed.

The date pickers allow you to select From and To dates (defining the history comparison date
boundaries). Any valid date can be selected. When you select dates, the history comparison is
recalculated according to the new dates, resulted in the displayed view being refreshed (either
history comparison or Cl selection).

Note: If the To date is earlier than the From date, an error message is displayed.

« Model View

The Model view displays all Cls contained in the selected CI's model that match the current filter
(that is, have at least one historical change during the selected time frame), divided by classification
and Cl type. This area is only visible when the Compare mode is set to Model, and it is divided into

two panes:

o Left pane

The left pane summarizes the number of Cls that match the current filter, divided into an
alphabetical list of classifications and CI types.

« Thefirst line (displaying the word All) shows the total number of Cls matching the current
filter. Clicking this line displays, in the right pane, all Cls contained in the selected CI’s model
and matching the current filter.
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« For each group with more than a single CI, the name and number of Cls in that group is
displayed. Clicking a group displays, in the right pane, all Cls contained in that group and
matching the current filter.

« Following each group's name, an alphabetical list of all Cl types in that group (with more than
asingle Cl)is displayed. Clicking a Cl type displays, in the right pane, all Cls of that CI type
and matching the current filter.

« Theicon, name, and number of Cls in that group are displayed for each Cl type.
o Right pane

The right pane displays the details of the data in left pane, divided into all relevant Cl types. For
each Cl type, the following details are displayed.

« The name of the CI type and the number of Cls contained in it.
o Thelist of Cls contained in the Cl type, including the icon, name, and type for each Cl.

In addition, hovering over a displayed Cl shows a selection button. Clicking this button opens
the History Comparison view for the selected Cl.

Ten Cls are displayed for each Cl type. If there are more than ten Cls for a Cl type, a link
appears, enabling you to view all of the Cls.

Clicking on a Cl in this pane opens the History Comparison view for that ClI.
If the number of Cls matching the current filter is O, the first line of the widget displays All 0, and
the right pane is empty.

o History Comparison View

The History Comparison view displays a list of the changes in a specific Cl between two selected
points in time. This view appears when:

o The Compare mode is set to Selected — the selected Cl is used for the historical comparison.

o The Compare mode is set to Model and a Cl is selected in the Model view —that Cl is used for
the historical comparison. In this case, a Back button also appears. Clicking the Back button
switches back to the Model view.

In the upper left corner of the History Comparison view, the following information is displayed for the
Cl used for comparison: Cl icon, name, and Cl type. Clicking on the Cl name here takes you to the
CI Overview for the Cl under comparison.

The History Comparison view has two sections: Changed Attributes and Changed Related Cls.
These sections are described in detail below.

Changed Attributes section
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The Change Attributes section displays the number of changes detected in the Cl between the
specified From and To dates, grouped by months and days.

The date appearing in the header of the From column is the closest date to the current date from
among:

o thefilter's From date
o the date that the Cl was created
o the earliest date that has history events for the selected Cl

When clicking on a month in this section, it expands and shows the number of changes made in that
month grouped by days, along with the date of the latest change made in a day and the user who
caused that change.

When clicking on a day, it expands and displays the changed attributes from that day, their old and
new values, and also the date of the latest change and the user who caused that change. If the
value of a byte type attribute does not fit entirely in the panel (it is displayed truncated), the indicator
"..." appears next to the displayed text and a Show All link appears next to it. Clicking Show All
displays the byte type attribute value entirely in a pop-up window.

If no changes are detected during the selected time period, the message "There are no items to
display" appears.

Changed Related Cls section

The Changed Related Cls section displays a list of all Cls that were either attached to (linked to) or
detached from the selected Cl between the From and To dates, grouped by months and days.

This section does not load by default. Instead, a Load Changed CIs button is

available, allowing you to load relationship changes only on demand by clicking the button.

The button is also available in the Model view. Clicking this button in Selected

view or Model view, displays the relationship changes in both Selected view and Model view.
The following information is displayed for each Cl listed in this section:

o Clicon

o name

o Cltype

o linkage state, which is either Related or Not Related
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When clicking on a month in this section, it expands and shows the number of changes made in that
month grouped by days, along with the date of the latest change made in a day and the user who
caused that change.

When clicking on a day, it expands and displays the changes from that day in the related Cls (due
either to addition or deletion of links between the selected Cl and related Cls), their old and new
states, and also the date of the latest change and the user who caused that change. When
expanded, if you click the Cl type, icon, or name, the Cl Overview for that Cl is displayed.

Impact Simulation Widget

The Impact Simulation widget presents the impact analysis of a selected Cl (that is, which Cls are
impacted by it, according to a selected impact severity level).

The following table displays the severity levels used in the UCMDB Browser module and the
comparable severity levels in the UCMDB server:

UCMDB Browser module UCMDB Server

Critical Critical(9)
High Major(8)
Medium Minor(6)
Low Warning(2)

The severity level fora Cl is cleared (set to None) when you log in to the CMS UI.

Note: Toview datain the Impact Simulation widget, there must be an impact rule created in
UCMDB and you must have View permission for the Resource Groups > Impact Analysis
resource.

This widget uses out-of-the-box impact rules from UCMDB. To configure the impact rules used by this

widget, see "Specify Impact Rules" on page 394

Cl Overview Mode

This mode summarizes the number of Cls impacted by the selected Cl by means of an Impact Bar,
according to the four severity levels: Critical, Major, Minor, and Normal.

Widget Details Mode

This mode presents detailed information on all the Cls impacted by the selected Cl. You can change
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the severity, which will rerun the analysis to show a different level of impact.

o Toolbar

The top row of the Impact Simulation Widget acts as a toolbar and enables you to switch between
graphical and textual modes.

« Graphical mode

Note: When the CMS Ul is embedded in an UCMDB server running on a Linux system,
runlevel 5 (enabled X server) is needed for the graphical mode of the Impact Simulation Widget
to operate properly. In addition, add unset DISPLAY to the server.sh script. Restart the
UCMDB Server for the server.sh changes to take effect.

In graphical mode, information is displayed in a topology map format.

Graphical mode contains the following:

Ul Element
(A-Z) Description
Additional = Allows you to view additional information for the Cls displayed in the map. For
Info more information, see "Show Additional Information on a Topology Map" on
page 376
Filter Clicking one of the following filters displays in the map all the Cls according to the

selected filter:

o By Class Qualifier
» Business Model
« Filter Analysis

o By Cl Type

Note: The filter applied in Graphical mode will also have effect in the Textual
mode.

Impact Allows you to change the severity, which will rerun the analysis to show a different
level of impact.

Note: The maximum number of Cls that can be displayed in the Topology
Map is 500. If there are more than 500 Cls, they will be listed in the Textual
mode, which is automatically displayed.

o You can navigate in the Impact Simulation Widget easily by turning on the quick navigation map.

In the quick navigation map, the elements from the canvas are represented. You can drag and
resize the selection in the map overview.
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If the map is too large, a big overview of the map is available, which allows you to use the map
overview navigator to jump directly to a particular part of the map.

A toggle button is available in the map to allow you to turn on/off the minimap. For more details
about the Map Toolbar, see "Map Toolbar" on page 281.

m-E-DH--I-EIE

| Open quick navigation |

Directional lines representing links are displayed with other items in the view if the selected Cl has
adirect relationship with at least one other Cl.

Note: The Notifications and Choose category options from a Cl's context menu ° are disabled

for the Impact Simulation widget.

o Textual mode

Textual mode contains the following:
Ul Element
(A-Z) Description
Left pane o Severity

Allows you to change the severity, which will rerun the analysis to show a
different level of impact.

o Filters

Displays allist of Cls impacted by the selected Cl, according to the four
severity levels. Selecting any line in this pane displays its details in the right
pane.

Note: When afilter is selected in Graphical mode, the Filters sectionin
Textual mode filters only the results displayed in the Topology Map.

Right pane = The right pane displays detailed information about the item that is selected in the
left pane, divided by ClI type.

Incidents Widget

The Incidents widget presents the incidents related to the selected Cl. Cl Overview mode shows the
number of incidents per priority, where the priority groups are Urgent, Major, Minor, and None. Widget
Details mode displays incident details. The Incidents Widget is presented only when the Incidents
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setting element is enabled and configured from the Infrastructure Settings Manager in UCMDB. All data
presented is taken from the UCMDB federated Incidents Cl and its relationships.

Note: The Create Time for federated Cls will show the Open Time of the Incident in SM. Using
non federated Incidents Cls (populated with other integrations) will cause the Create Time to be
the time when the Incident was created in UCMDB and not the time when the Incident was opened
in the external data source.

This widget displays incidents related to the selected Cl as follows:

« Allincidents linked directly to the CI through a Connection link.

« If the selected Cl is a Model. All incidents linked to all the Cls contained in that model (meaning,
any other contained model or Cl).

« Allincidents linked to Cls that are connected to the currently selected Cl through a composition or
membership relationship.

« For BusinessService Cls. All incidents linked directly to the Cl through an applicationLink link.

If anincident’s priority does not map to a UCMDB Browser’s Internal Priority, it should not be counted
in Cl Overview mode nor presented in Widget Details mode. For instructions on how to configure the
UCMDB Browser's Internal Priorities, see "Configure Browser Internal Priorities (for the Incidents and
Problems Widgets)" on page 107.

Cl Overview Mode

This mode presents the number of open incidents from SM that have an Open Date within the Timeline
Span selected in the Widget Details mode (see the description below). The incidents are categorized
by their Internal Priority, where:

« Open incidents are all incidents whose status (an IT SM attribute, federated to UCMDB) is within a
configured range of values defined by two configuration parameters. If an incident status does not
belong to that set of values, it is not considered open.

« Internal Priority is a UCMDB Browser set of values (1-4), where each value has a configurable label
and is mapped to a set of IT SM Priority values (an SM attribute, federated to UCMDB). For
instance, a valid configuration could be of four Internal Priorities (Urgent, Major, Minor, None),
where each is mapped to a specific unique set of IT SM Priority values.

« Both configuration parameters are defined only by the UCMDB administrator.
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Widget Details Mode

This mode adds the following information to the summary displayed in Cl overview mode:

- Timeline Span toggle. This is a 4-way toggle, with the options Less than a day, Between 1 to 3
days, More than 3 days, and Show All. Selecting a timeline span displays all open incidents

related to the selected Cl that are in the timeline span (that is, their Open Date is within that timeline

span). Changing the timeline span also changes the incident groups displayed in Cl Overview
mode. The default timeline span in Widget Details mode is Less than a day, unless there are no
incidents in that span, in which case Between 1 to 3 days is displayed. The timeline span remains
in effect for each user until it is changed.

« Allrelevant incidents, divided by their Internal Priority. The internal sort within each priority group is

according to the incident’s Open Date. The following items are provided per each incident:

o

Incident ID. This is a clickable field that refocuses on the Incident Cl when selected.
Status

Impact

Urgency

Priority

Open Date

Title

Outage Start (this is an optional SM parameter)

Affected CI. Only a single Cl is presented with a link to display all results. The Cl presented is
either the node to which the incident is linked (if it is not the current Cl) or a Business Cl affected
by the incident (if the current Cl is directly linked to the Incident Cl). If there is a Business
Service connected directly to the incident, it should be displayed as an affected Cl. Affected Cls
can be refocused.

Note: The affected Cl is displayed only if it is within the context of the selected CI.

Affected Service. The first BusinessService Cl connected to the Incident Cl through a
membership link. If no such Cl exists, the Affected Service header will not be displayed.
Affected Service can be refocused.

« Adirect link to the Service Manager system with the context of the selected incident is presented
per each incident, if this link is configured. For instructions on how to configure this direct link to
Service Manager, see "Configure a Direct Link to Service Manager for a Selected Problem,
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Incident, or Change Request" on page 60.

« Eachincident is separated from the others by empty space.

Monitoring Widget
The Monitoring widget displays the statuses of KPIs (received from the BSM) for the selected Cl. KPI
statuses can be one of the following: Ok, warning, minor, major, critical, info, no data, and downtime.

CIl Overview mode displays the worst KPI status for the selected Cl (where downtime is the worst
status, and Ok is the best status). Widget Details mode shows all the details of all KPls related to the
selected Cl.

The UCMDB Browser module comes with a BSM adapter that is deployed on the UCMDB server when
the UCMDB Browser module first loads. For this widget to work, the UCMDB administrator must
configure this adapter, as described in "Configure the BSM Health Indicator (for the Monitoring Widget)"
on page 395.

Note:

« System time on the UCMDB server and BSM server should be synchronized, otherwise
monitoring data in the UCMDB Browser module will be empty.

« The BSM does not return KPIs for Cl collections.

« Forthe Monitoring Widget to properly display KPI statuses for the selected Cl, ensure that all
Cls monitored in the BSM have the attribute Store KPI History For Over Time=true.

Adding Another Data Source for Display in the Monitoring Widget

If you want to add another data source to be displayed in the Monitoring widget, you must add an
additional integration point name to the <data_stores> tag in the ucmdb_browser_config.xml
configuration file, as shown in the following example:

<bsm_configuration>
<data_stores>
<data_store>bsm_adapter</data_store>
<data_store>second_adapter</data_store>
</data_stores>
</bsm_configuration>

Policy Widget
The Policy widget is presented only if a live Configuration Manager (CM) system is deployed in the
UCMDB environment. The terminology and icons used in both the CI Overview and Widget Details
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modes are identical to what is used in CM. All Key Performance Indicators (KPls) and related attributes
are taken from CM (that is, no calculation is performed by the CMS Ul).

Note: To use the Policy widget, you must have CM version 9.30 or later installed, and CP10 or
later installed on the UCMDB server.

Cl Overview Mode

This mode displays the selected Cl's overall policy KPI, taken from CM, as follows:

« Overall policy compliance status: whether it is satisfied or in breach
« Overall policy compliance value (in terms of percentage, graphically presented in a bar)
« KPI description, automatically generated by the CM
For business elements, the Cl overview presents the overall business policy KPI (that is, a summary of

all Cls linked to the Business Cl, as opposed to the Cl itself). A direct link to the CM system, with the
context of the selected Cl, is presented in the widget.

Notifications for changes in the Policy widget are displayed only in the Notifications tab and in the
widget's Cl Overview mode.

Widget Details Mode

This mode adds the following details, taken from CM:

« All policies linked to the selected Cl. Each policy is separated from the others by an empty space.

« Foreach linked policy, the policy name, compliance status, and a description are displayed.

Problems Widget

The Problems widget presents the problems related to the selected Cl, either according to their
numbers (in Cl Overview mode) or by their details (in Widget Details mode). A problem is considered
related to a Cl if it meets one of the following conditions:

« lItis linked directly to the ClI through a Membership link. Note that IT Service Manager connects a
Problem to its affected Business Service in the same manner (that is, a Membership link connects
the Problem Cl with the Business Service Cl).

« Ifthe selected Cl is a Model, all problems linked to all the contained Cls in that model (meaning, any
other contained model or Cl) are considered related to the selected ClI.
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« Inall other cases, all problems linked to the selected Cl's composition/membership connected Cls
(probably a Node) are considered related to the selected ClI.

Note:

« This widget appears only when it is enabled in UCMDB. For instructions on how enable this
widget, see "Enable the Problems Widget" on the next page.

« If you are connecting to a UCMDB Server that has Content Pack 10 or an older version
installed, you must perform the instructions in the section "Problems Widget" on the previous
page below so that the Problems widget functions properly.

All presented data is taken from UCMDB Federated Problems CI (and its relationships).

Note: The Create Time for federated Cls will show the Open Time of the Problem in SM. Using
non federated Problems Cls (populated with other integrations) will cause the Create Time to be
the time when the Problem was created in UCMDB and not the time when the Problem was
opened in the external data source.

Cl Overview Mode

This mode presents the total number of Open problems, categorized by their Internal Priority. Open
problems are all problems with a Status (a Service Manager attribute, federated to UCMDB) that is
within a configured set of values. If a problem’s Status does not belong to that set of values, it is not
considered open.

Internal Priorities are a set of UCMDB Browser values (1-4), where each value has a configurable label
and is mapped to a set of Service Manager Priorities (these are Service Manager attributes that are
federated to UCMDB). For instance, a valid configuration could be four Internal Priorities (Urgent,
Major, Minor, None), where each is mapped to a specific unique set of Service Manager Priority values.

Configuring the set of values to define when a Problem is open and configuring the four UCMDB
Browser Internal Priorities should be performed only by the UCMDB administrator.

The UCMDB Browser’s mapping between Internal Priorities and Service Manager priorities should be
defined once and be used by all relevant Widgets (that is, the same configuration settings are used for
both the Incidents and Problems Widgets). If a Problem’s priority does not map to a UCMDB Browser
Internal Priority, it is not counted in the Cl overview or presented in the widget details.

For instructions on how to configure the UCMDB Browser Internal Priorities, see "Configure Browser
Internal Priorities (for the Incidents and Problems Widgets)" on page 107.
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Widget Details Mode

This mode displays all relevant problems according to their Internal Priority. The internal sort within
each priority group is by alphabetic order. The following information is presented for each problem:

Problem ID: This is a clickable field that refocuses on the Problem C| when selected. The ID is
taken from the reference_number attribute.

Title: Taken from the name attribute.

Status: Taken from the problem_status attribute.
Impact: Taken from the impact_scope attribute.
Urgency: Taken from the urgency attribute.
Priority: Taken from the priority attribute.

Affected Cl: Only a single Cl is presented with a link to show all results. The Cl presented is either
the node to which the problem is linked (if it is not the current Cl) or a Business Cl affected by the
problem (if the current Cl is directly linked to the Problem Cl). If there is a Business Service
connected directly to the Problem, it should be displayed as an affected Cl. Affected Cls can be
refocused.

Affected Service: The first BusinessService Cl connected to the Problem ClI through a
membership link. If no such Cl exists, the Affected Service header is not displayed. The Affected
Service can be refocused.

A direct link to the Service Manager system with the context of the selected problem is presented
per each problem, if this link is configured. For instructions on how to configure this direct link to
Service Manager, see "Configure a Direct Link to Service Manager for a Selected Problem,
Incident, or Change Request" on page 60.

Enable the Problems Widget

To enable the Problems widget in UCMDB:

1.

In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.

In the Name column, choose Enable Problems widget.

In the Value column, choose True from the drop-down list.

Click Save|ﬂ|.

CMS Ul (2018.08) Page 366 of 446



CMS Ul Guide

Properties Widget

The Properties widget is used to present the main, general properties of the selected Cl, either by
means of a search result or by refocusing it. The properties presented are customized and differ for
each selected Cl type. Cl Overview mode presents the most important properties and Widget Details
mode displays additional properties. The information presented in this widget is logically connected to
the selected Cl and not according to the UCMDB Data Model.

To specify the properties that are displayed by this widget, see "Configure Properties to be Displayed
by the Properties Widget" on page 385.

To display attributes with empty values (by default, attributes with empty values are not displayed), see
"Configure the Properties Widget to Show/Hide Empty Attributes" on page 385.

You can prevent a Cl's location and owner from being displayed in the Properties widget by setting the
Show Location Details and Show Owner Details settings in the Infrastructure Settings Manager in
UCMDB to False. By default, these settings have the value True, and the location and owner are
displayed.

If the UCMDB administrator has configured a property as CMS Browser Editable, an Edit button is
displayed. Click this Edit button to edit the attributes of these properties. When you are finished, click
Save changes or Cancel.

Note:

« For Edit mode to work, the logged-in user must have RUN_DISCOVERY_AND _
INTEGRATIONS permission. For details, see "Roles Manager Page" in the Administer section
of the UCMDB Help.

« Toview the Tenant Owner and the Consumer Tenant attributes in the Properties widget , you
need to have the View Tenant Assignment permission, and the attributes must be defined as
CMS Browser Visible in UCMDB. To change the tenant association for a Cl, you need to
have the Change Tenant Association permission, and the Cl's attribute must be defined as
CMS Browser Editable in UCMDB.

« To edit the Tenant Owner and the Consumer Tenant attributes in the UCMDB Browser
module you need to have the Reassign Tenant and the View Tenant Assignment
permissions, and the attributes must be defined as CMS Browser Visible and CMS Browser
Editablein UCMDB.
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Cl Overview Mode

In this mode, for all Cl types, a maximum of three properties are displayed for the selected Cl. These
properties are configured by the system administrator.

If an attribute value does not fit entirely in the panel (it is displayed truncated), a Show All link appears
next to it. Clicking Show All displays the attribute value entirely in a pop-up window.

Note: For details about the priorities that are displayed, see "Configure Properties to be Displayed
by the Properties Widget" on page 385.

Widget Details Mode

In this mode, each property is presented on a separate line. The display is divided into three panels, as
follows:

« Core Properties. This panel displays the most important and valuable properties of the selected
CI. For example, for a node the displayed properties could include its OS name, serial number,
memory size, etc.

« Complementary Properties. This panel displays other important properties for the selected Cl.
These properties are usually less important than the ones presented in the Core properties panel,
but may still interest most UCMDB Browser users. All properties depicting the CI’s discovery
process are included in this panel.

« Additional Properties. This panel is configured entirely by the UCMDB administrator, and can
include all other properties the Administrator thinks may interest UCMDB Browser’s users.
Attributes that are defined as CMS Browser Visible but do not appear in one of the other two
panels are also displayed in this panel.

The panels are presented in consecutive order and labeled with the panel name. A panel with no
properties is not presented. If an attribute value does not fit entirely in the panel (it is displayed
truncated), a Show All link appears next to it. Clicking Show All displays the attribute value entirely in
a pop-up window.

Note: Forinstructions on how to assign the panel in which an attribute is displayed, see
"Configure Properties to be Displayed by the Properties Widget" on page 385.

Security Widget
The Security widget displays security-related data for the selected Cl. This widget appears only if a live
ArcSight Enterprise View (EV) system is deployed with a valid integration between it and the logged-in
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UCMDB.
Note:

« Forthis widget to work, the UCMDB administrator must configure the Enterprise View adapter,
as described in "Configure the Enterprise View Adapter" on page 399.

« Forinstructions on integrating Enterprise View with UCMDB, see "Configure Integration with
Enterprise View" on page 396.

Cl Overview Mode

In this mode, the following security-related data is presented for the selected Cl (taken directly from
ArcSight EV and not processed by the UCMDB Browser module):

o Overall security score (from 0-100, O is the best, 100 is the worst)

o Overall security status icon (uses the same icons as within ArcSight Enterprise Security Manager).
The possible icon values are:

o

High

o

Medium

Low risk

(e}

No data

(e}

« Adirect link to the ArcSight EV system asset summary

Widget Details Mode

In this mode, the following information is added to the summary displayed in Cl Overview mode (taken
from the ArcSight EV and not processed by the UCMDB Browser module):

» Risk:

o Score: from 0-100, O is the best, 100 is the worst

o lcon: Possible icon values are High, Medium, Low risk, and No data

o Compliance:
o Score: from 0-100, 0 is the best, 100 is the worst
o lcon: possible icon values are High, Medium, Low risk, and No data

o Progress: shows the percentage of overall asset compliance with a policy
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o Maturity:
o Score: from 0-5, 0 is the worst, 5 is the best
o |con: possible icon values are High, Medium, Low risk, and No data

o Progress: shows the percentage of the overall control maturity within a policy

o Vulnerability:

o Score: from 0.00-10.00, 0.00 is the best, 10.00 is the worst

o lcon: possible icon values are High, Medium, Low risk, and No data
« Enterprise Security Manager Threat:

o Score: from 0.00-10.00, 0.00 is the best, 10.00 is the worst

o |con: possible icon values are High, Medium, Low risk, and No data

Stakeholder Widget

The Stakeholder widget displays data on the owner of the selected Cl and also on owner(s) of Cls
directly related to the selected Cl. A stakeholder is defined as either the owner of the selected Cl or the
owner of a Cl directly related to the selected ClI.

Note: If the type of the selected Cl is Person, this widget is collapsed, disabled, and displays the
following message: “This widget is not relevant for selected CI”.

Cl Overview Mode

In this mode, if there is more than one owner for the selected CI this widget displays the total number of
owners (called Direct Stakeholders in the user interface). If there are one or more owners of Cls directly
related to the selected Cl, this widget displays the total number of owners of those directly related Cls
(called Other Stakeholders in the user interface). If the selected Cl has no direct owner, the message
“There is no direct stakeholder” is displayed in the center of widget.

This widget also displays the following information on the owner of the selected Cl:
« Thumbnail picture (if it exists)
« Name

« Organization or Functional Group (if defined)

« Email address (if defined)
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« Telephone number(s) (if defined). If there is more than one phone number for the owner, there is a
button that expands the list of available phone numbers and indicates the type of phone of the
owner.

Note:

« The owner can have one of the following Cl types: Organization, Functional Group, or Person.
If there are two or more direct owners of the selected Cl, this widget displays the owner in Cl
Overview mode according to the following priority levels: Organization (highest priority),
Functional Group, Person (lowest priority).

If, according to the priority levels above, there are two or more direct owners with the same
priority level to be displayed, this widget displays the owner that comes first according to
alphabetical order.

« Forthe Person CI Type, this widget displays the Person's name according to the following
priority levels: user label (highest priority), name, name of type (lowest priority).

Only if the user label does not exist, will the widget display the Person's name. And only if the
user label and name do not exist, will the widget display the name of type.

Widget Details Mode

This mode displays the same information that is listed in ClI Overview mode, but for every stakeholder
of the selected Cl, and also displays all Cls owned by the stakeholder, within the context of the
selected Cl.

Note: The default source of the thumbnail pictures is the gravatar.com website; however, this
source can be changed as described in "Change the Source of Thumbnails (for the Stakeholder
Widget)" on page 382.

Storage Data Widget

This widget shows the paths between a server and the storage arrays that support the server's file
systems. The path consists of the volumes that reside on the server and the matching volume that
resides on the storage array.

Note: In order to view the Storage widget in the UCMDB Browser module, it must be assigned to
arolein UCMDB. The widget will only be listed in the Roles Manager after the CMS Ul has been
deployed. For details, see "Roles Manager Page" in the Administer section of the UCMDB Help.
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This widget matches the data model that supports integration with Storage Essentials, but can serve

for other integrations as well.

This widget is based on a dynamic widget and can be configured according to dynamic widget
capabilities. For more information, see "Dynamic Widgets" on page 346.
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Working with Widgets

Load Embeddable Widgets

The embeddable widgets feature allows loading only a single widget instead of the entire UCMDB
Browser module. This enables other products to include widgets inside their own applications.

« The Impact Simulation Widget and Get Related Widget can be directly embedded into Service
Manager. For more details, see Service Manager documentation.

« Thereis no search Ul, only a single widget, meaning that when loading the widget, the user
must know and set the ClI ID.

If using LW-SSO, the user enters the URL of the CMS Ul and adds to that URL certain parameters that
tell the CMS Ul which widget to show, how to show it, and which CI to show for that widget. The
Embedded widget checks the LW-SSO cookie to verify that the current user is logged on. If there is no
valid session, the login page is displayed.

If not using LW-SSO, the following options are available:
1. The user enters the URL of the UCMDB Browser module and certain parameters as mentioned
above, which displays the login page.

2. The user enters the URL of the UCMDB Browser module and certain parameters as mentioned
above, and adds to that a username and encrypted password.

To generate the encrypted password:

a. GotoJMX console > UCMDB-Ul:name=UCMDB Integration >
getEncryptedPasswordForURL.

b. Inthe user name field, enter the user name.

c. Inthe password field, enter the user's password.

d. Click Invoke.
Important: Forthe embedded widgets to work when using the username and encrypted
password in the URL, you need to enable the LW-SSO framework. To do this, in the ucmdb_

browser_lwsso_config.xml file, make sure that the value for enableLWSSOFramework is
True.

Note: If the CMS Ul is configured to work with multiple UCMDB Servers, you must specify the

CMS Ul (2018.08) Page 373 of 446



CMS Ul Guide

UCMDB server's name in the URL.

To load an embeddable widget:

For LW-SSO users, you load an embeddable widget by entering the base URL and other information as
follows:

http://<CMS Ul host>:< CMS Ul port>/ucmdb-browser/ucmdb_widget. html#widget=<widget
type>~<widget state>;refocus-selection (or global-id)=<CI ID>

This URL can be divided into the following parts:

« Base URL: This is the URL of the CMS Ul. For example:
http://<CMS Ul host>:< CMS Ul port>/ucmdb-browser/

« Widget Entry Point: This is a static value, will always be:
ucmdb_widget.htmi#

« Widget type: This must be one of the possible widget types: AUTOMATION, BSM,
<DYNAMIC WIDGETS>, DEFECTS, ENVIRONMENT, GET_RELATED, HISTORY, IMPACT,
INCIDENTS, POLICY, PROBLEMS, PROPERTIES, RFC, SECURITY, or STAKEHOLDER.

Note: The dynamic widget's name must be used as widget type. For example,
BUSINESS TOPOLOGY.

o Mode: This is the visualization mode of the widget: Cl Overview mode or Widget Details mode. The
Widget Details mode is displayed by default. To change the visualization mode to Cl Overview
mode, add the following information in the URL:

mode=preview

Note: The Cl Overview mode is available only for the History widget, Impact Simulation
widget, and Get Related widget.

« Widget State: This is available only for Impact Simulation Widget and for Get Related Widget.
o Impact Simulation Widget: You can specify the severity level and the bundles. For example:
widget=IMPACT~severity=LOW&bundles=bundle1,bundie2

o Get Related Widget: You can specify a TQL previously defined in the UCMDB, and use it to
explore related Cls.

To define a TQL Query in UCMDB, see the "How to Define a TQL Query" section in the
Modeling section of the UCMDB Help.

For example:
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widget=GET_RELATED~tgl=[query_name]
« The Element Name of the first Cl Type you select must be root_node and the second
Cl Type must be related_node.

« Ifthe TQL query from URL does not exist or does not contain root_node or related_node,
the default TQL query is used.

In the CI Overview mode, the Widget State is available only for the Impact Simulation widget, and
only the severity level can be specified.

o CI1ID: The ID for the Cl whose data will be displayed by the widget. For example, 123456789.

Note: You can add multiple CI IDs for Impact Simulation Widget. You can view the CI IDs that
are not found in the UCMDB, in the left pane, under the Not Found Cls section.

Therefore, to load a widget with the examples given above, using LW-SSO, you would enter a URL of;

http://<CMS Ul host>:<CMS Ul port>/ucmdb-browser/ucmdb_
widget.html#widget=environment;refocus-selection=123456789

And if not using LW-SSO, using the above example:

http://<CMS Ul host>:<CMS Ul port>/ucmdb-browser/ucmdb_
widget.html?username=guest&password=<encrypted_
password>#widget=environment;refocus-selection=123456789

Once logged on, the user sees the Cl Overview and Widget Details modes of the widget and ClI
specified in the URL. Widget Details mode cannot be collapsed.

Important: When using the embedded CMS U, for the Impact Simulation Widget and Get
Related Widget to work, perform the following steps:

1. GotoJMX console > UCMDB:service=Settings Services > setGlobalSettingValue.
2. Inthe name field enter ui.framing.host.

3. Inthe value field enter the desired host address (the Service Manager's |P address, or the
FQDN).

4. Click Invoke.
5. Restart the UCMDB server.

When using CMS Ul standalone, for the Impact Simulation Widget and Get Related Widget to
work, perform the following:
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1. Open the %WEB_SERVER_HOME%\webapps\ucmdb-browse\WEB-INF\web.xml file.
2. Locate the following lines:

<filter>
<filter-name>ClickjackingFilterSameOrigin</filter-name>
<filter-class>com.hp.ucmdb_
browser.server.web.ClickjackingFilter</filter-class>
<init-param>
<param-name>mode</param-name>
<param-value>SAMEORIGIN</param-value>
</init-param>
</filter>
<filter-mapping>
<filter-name>ClickjackingFilterSameOrigin</filter-name>
<url-pattern>/*</url-pattern>
</filter-mapping>

3. Inthe section above, replace the following line:
<param-value>SAMEORIGIN</param-value>
with
<param-value>ALLOW_FROM <Service Manager URL></param-value>
For example,
<param-value>ALLOW_FROM https://SMservername.domain.com</param-value>

4. Restartthe CMS UlI.

Show Additional Information on a Topology Map

0 ACTIONS
1. Click and then click Additional Info.

2. Select one or more of the following checkboxes to see the specific information indicators:

History Displays changes on Cls that are in the model during the specified time period.
h
CE anges To display history changes:

a. Select History Changes. The number of history changes according to the
current settings is displayed.

b. Click Change Settings to select the beginning and ending dates for the
changes.
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Run History
c. Click to update the topology map.

Monitoring = Displays the number of KPlIs on the Cls in the model.

(|
Note: This option is displayed only when you are using the Monitoring
widget. Setup for the Monitoring widget is described in "Configure the BSM
Health Indicator (for the Monitoring Widget)" on page 395.

Policy Displays the number of policy results on Cls in the model.

Status B

Note:

o This option is displayed only when there is a live Configuration Manager
(CM) system deployed in the UCMDB environment.

o Policy indicators are counted for both the indicated Cl and the service in
which that Cl is located.

Incidents Displays incidents on Cls that are in the model during the specified time period.

® To display incidents:
a. Select Incidents. The number of incidents according to the current settings is
displayed.
b. Click Change Settings to select the beginning and ending dates for the
changes.
Update Incidents
c. Click to update the topology map.
Request Displays change requests on Cls that are in the model during the specified time
for period.
h
C‘ anges To display change requests:

a. Select Request for Changes. The current number of change requests is
displayed.

b. Click Change Settings to select the time span for change requests.

Update RFCs
c. Click to update the topology map.

Problems Displays the number of problems on Cls in the model.

Note: Your selections are saved for all the service models in your user preferences.
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Specify the Appearance and Order of Widgets

You can specify which widgets appear in the UCMDB Browser module and in what order.

In the Infrastructure Settings Manager in UCMDB, you specify the list of widgets that you do not want
to appear in the UCMDB Browser module with the List of widgets to be removed from the
application setting and the order that the widgets appear with the List of widget order in the
application setting. For details, see "Infrastructure Settings Manager" in the Administer section of the
UCMDB Help.

In addition to specifying whether widgets (including dynamic widgets) and their order are visible for all
users (as mentioned in the previous section), you can choose the widgets that you want to appear in
the UCMDB Browser module only for a particular role by selecting them on the Resources tab of the
Roles Manager in UCMDB. For details, see "Roles Manager" in the Administer section of the UCMDB
Help.

Change CI Attributes

In the Properties widget, you can change the selected Cl's attributes in the Cl details pane. A ClI
attribute can be edited if the following conditions are met:

o The attribute is marked with UCMDB_BROWSER_EDITABLE_ATTRIBUTE qualifier. Even if the
attribute does not appear in the Cl details, if it is marked with this qualifier it appears when you click
Edit. For instructions on how to mark an attribute with this qualifier, see "Mark an attribute as CMS
Browser editable" on page 381.

« The attribute is not defined as read-only. Any one of the following qualifiers defines an attribute as
read-only:

o STATIC_ATTRIBUTE
o READ_ONLY_ATTRIBUTE
o ID_ATTRIBUTE

o CALCULATED_ATTRIBUTE

Note: ClI attributes cannot be changed for federated Cls.

In addition to the standard ClI types that can be defined for a Cl in UCMDB, this widget also allows for
editing location and owner attributes of the selected ClI. The list of Cl locations that you can choose
from is derived from the list of available Locations Cls in UCMDB, and the list of owners that you can
choose from is derived from the list of available Party Cls in UCMDB. The owner attribute can have
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multiple instances. To change the location or owner, see "Change CI location and owner" on page 381.
To add an additional owner to a Cl, see "Add an additional owner" on page 381.

The following attribute types have unique editing features in the Properties widget:

« Boolean. If an attribute is defined as boolean, a drop-down box appears that allows you to choose
True or False.

« Date. If an attribute is defined as date number, a date picker appears that allows you to pick the
date according to day, month, and year.

« xml. If an attribute is defined as xml, a text editor appears that allows you to enter free text for this
attribute.

« bytes. If an attribute is defined as bytes, a text editor appears that allows you to enter free text for
this attribute. The difference between this attribute type and the xml attribute type is that the value
of this attribute type is archived before it is saved to the database.

« List of Integers. If an attribute is defined with this type, you can add a list of integers to this
attribute. For instructions on how do this, see "Add a list of Integers or Strings to an attribute" on the
next page.

« List of Strings. If an attribute is defined with this type, you can add a list of strings to this attribute.
For instructions on how do this, see "Add a list of Integers or Strings to an attribute" on the next

page.

To define an attribute in UCMDB with one of the types above, follow the instructions in "Create a Cl
attribute with a unique type" on page 382.

Caution: If you attempt to save input for string, xml, or byte attributes that is longer than the limit
defined in the UCMDB CI Type Manager, the following error message appears: "The following
error occurred: Reconciliation Dataln general error. The changes were not saved." If this happens,
re-enter the input so that it is within the defined limit.

The following changes can be made:

« "Change a Cl attribute" on the next page

« "Change a Cl attribute with Enumeration type" on the next page
o "Add alist of Integers or Strings to an attribute" on the next page
« "Change Cl location and owner" on page 381

« "Add an additional owner" on page 381

« "Mark an attribute as CMS Browser editable" on page 381

« "Create a Cl attribute with a unique type" on page 382
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Note: This feature is only accessible to users with editing permissions on the selected Cl.

Change a Cl attribute

1. Ensure that Widget Details mode is displayed for the Properties widget, and click Edit.
2. Change the value of the Cl attribute.

3. Click Save Changes.

Note: For an attribute that appears in Cl Overview mode, if you update it in Widget Details mode
the updated value will appear if you return to Cl Overview mode.

Change a Cl attribute with Enumeration type

1. Ensure that Widget Details mode is displayed for the Properties widget, and click Edit.
By the location of the enumeration attribute, click the down arrow.

From the drop-down list, select the value that you want to assign to this attribute.

> w0 D

Click Save Changes.

Add a list of Integers or Strings to an attribute
If an attribute has been defined with the type

list of integers

or

list of strings

(as described in "Create a Cl attribute with a unique type" on page 382), you can add a list of integers or
strings to the attribute as follows:

1. Ensure that Widget Details mode is displayed for the Properties widget, and click Edit.

2. Goto an attribute that is defined as list of integer or list of strings, and click the EditD button.

3. Intheinput field that appears, enter a string or integer.

4. If youwant to add an additional string or integer, click the Add button and enter the additional

string or integer in the input field that appears.
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5. Continue adding strings or integers in this manner until you have entered the data you want, and

then click Save Changes.

Change Cl location and owner

1. Ensure that Widget Details mode is displayed for the Properties widget, and click Edit..

2. By the Location or Owner field, click the Edit D button. A drop-down list appears.

3. From the drop-down list, select a Location/Owner.

Note:

o If you have along drop-down list, you can filter the list by typing the initial characters of the
Location/Owner name at the top of the drop-down list.

o When a message specifying the number of results is displayed, you have to filter the list
by typing the initial characters of the Location/Owner name at the top of the drop-down list.
For example, if you type the letters 'Per’ at the top of the Owner drop-down list, the list is
filtered to show only Owner names that start with 'Per’.

4. Click OK in the drop-down list.

Note: After selecting a Location/Owner and clicking OK, you can remove your selection by
clicking the X" button by the Location/Owner field.

5. Click Save Changes.

Add an additional owner
1. Ensure that Widget Details mode is displayed for the Properties widget, and click Edit.

2. Totheright of the owner field, click the Add button. An additional owner appears.

3. Inthe new owner field, assign a value as described above.

4. Click Save Changes.

Mark an attribute as CMS Browser editable

1. InUCMDB, go to Modeling > Cl Type Manager and select the Attributes tab.
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2. Choose the desired Cl Type.

3. Choose the attribute that you want to make "editable" from the displayed list, and click the Edit 2
button .

4. Inthe Edit Attribute dialog box that appears, click the Advanced tab, check CMS Browser
Editable, and click OK.

5. Save your changes to the Cl type.

Create a Cl attribute with a unique type

1. InUCMDB, go to Modeling > Cl Type Manager and select the Attributes tab.
2. Choose the desired Cl Type.
3. Click the Add I button. The Add Attribute dialog box opens.

4. Inthe Attribute type section, select Primitive, and from the drop-down list select one of the
following:

o list of integers
o list of strings
o boolean

o date number
o xml

o bytes

5. Save your changes to the Cl type.

Change the Source of Thumbnails (for the Stakeholder Widget)

The default source for pictures of Cl owners (both direct and indirect) presented in the Stakeholder
widget is the gravatar.com website. This source location can be changed according to the following
instructions.

1. InUCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.
2. Inthe Name column, choose Stakeholder Image URL.

3. Inthe Value column, enter the URL for the new source location. The URL should have a
parameter (or parameters) in square brackets (as shown in the examples below), which is an
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attribute name from the Party CIT, or from the Organization CIT or Person CIT which are children
of the Party CIT. At runtime, the actual value of this attribute is set in the URL in order to receive
the image.

Examples:
o Touse animage from the gravatar site, enter:
http://www.gravatar.com/avatar/[email] ?s=42&d=mm

where [email] is an attribute of the Person CIT and will be replaced by the actual email address
of the Stakeholder at runtime.

o Touse animage from Facebook image, enter:
https://graph.facebook.com/[attr_name]/picture

where [attr_name] is an any attribute that contains the Facebook User ID (this attribute should
be added to Party CIT) and will be replaced by the actual Facebook User ID of the Stakeholder
at runtime.

o To use animage from Google, enter:
https://profiles.google.com/s2/photos/profile/[attr_name]?sz=42

where [attr_name] is an any attribute that contains the Google User ID (this attribute should be
added to Party CIT) and will be replaced by the actual Google User ID of the Stakeholder at
runtime.

Change the History Widget 'From Date'

The History Widget uses a beginning date and end date to show changes in Cl data that occurred
during the period defined by those two dates. The default end date is the current date and time and the
default beginning date is the current end date minus the History Widget From Date setting that is set
in UCMDB. The default value for the History Widget From Date setting is 7, but this value can be
changed by the UCMDB Administrator as explained below.

To change the History Widget 'From Date":

1. InUCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.

2. Inthe Name column, choose History Widget From Date.

3. Inthe Value column, enter the number of days that you want for the From Date.

4. Click Save ICl.
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5. Log out from the CMS Ul, and then log in again (this loads the new setting).

Note: The change takes effect according to the time set in one of the following settings:
o Time for which information in the Browser cache is valid
o Time for which UCMDB Settings in the Browser cache is valid

For more information, see "Settings affecting overall system operation".

Check Network Availability from the Discovery Progress Widget

The new Check Network Availability button in the right pane of the

Discovery Progress widget allows you to check the network availability for any of the IP addresses of a
Node type Cl from the UCMDB Browser module.

Note: This feature is supported on UCMDB 10.22 CUP1 or later versions.

To check the network availability for any of the IP addresses of a Node Cl:

1. Inthe right pane of the Discovery Progress widget, click .

2. From the IP Address drop-down list, select the IP address of your target node.
Note:

o Thefirst IP address of the target node will be loaded by default in the IP Address field.

o Tomanually add an IP address, click and enter the IP address in the newly

appeared text box. To go back to the automatically loaded IP address, click .

3. From the Probe drop-down list, select a probe.

Note: The first probe available will be loaded by default in the Probe field.

4. Inthe Ping Times field, select or enter the number of attempts for the selected probe to perform
IP ping.

Note: The default value is 4 and it will be automatically loaded in the Ping Times field.

5. Inthe Timeout (ms) field, select or enter the frequency (in milliseconds) that the selected probe
shall try to perform IP ping.
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Note:
o The default value is 60000 (ms) and it will be automatically loaded in the Timeout field.
o The timeout increment is 5000 (ms).

o The minimum timeout required is 10000 (ms) and the maximum timeout is 300000 (ms).

6. Click “ to perform the network ping.
7. Click to go back to the jobs list.

Configure the Properties Widget to Show/Hide Empty Attributes

The Properties widget has a setting called Show attributes that have no value, which can be set to
True or False. If this setting is True, any empty attribute (that is, an attribute with no value) for the
selected Cl is displayed with the value N/A, both in the CI Overview and the Widget Details modes. If
this setting is set to False, any empty attribute for the selected Cl is not displayed. The default value of

this setting is False.

To set the Show attributes that have no value setting:
1. InUCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.

2. Set the value of Show attributes that have no value to the value that you want, either True or
False.

Configure Properties to be Displayed by the Properties Widget
You can configure attributes of Cl Types to be either displayed or not displayed by the Properties
widget, and determine whether an attribute appears in Cl Overview mode and in which properties group
it appears in Widget Details mode, as follows:

1. InUCMDB, goto Modeling > Cl Type Manager.

2. Inthelist of Cl Types on the left, choose the Cl Type with the attribute(s) that you want to
configure.

3. Select the Attributes tab in the editor on the right.

4. Inthe list of attributes, double-click on the attribute that you want to configure.

The Edit Attribute window appears.

CMS Ul (2018.08) Page 385 of 446



CMS Ul Guide

5. Inthe Edit Attribute window, click the UCMDB Browser Qualifiers tab and do one of the
following:

o To hide an attribute:

Select Hide in Properties Widget.

Note: If you select Hide in Properties Widget, make sure that CMS Browser Visible is
not also selected. Otherwise, notifications may appear for attributes that are not visible.

o Todisplay an attribute:
Select CMS Browser Visible.
6. If youchecked CMS Browser Visible in the previous step, set the following properties:

o View in preview mode: From the drop-down list, chose True if you want the attribute to
appear in the Cl overview, or False if you do not want it to appear in Cl Overview mode.

o Properties group assignment: From the drop-down list, choose the properties group (Core,

Complementary or Additional) in which you want this attribute to appear in Widget Details
mode.

7. Click OK.

Cl Overview Mode

A maximum of three properties are displayed for the selected Cl, according to the following priorities:

Note: The orderin which properties are presented is alphabetic and cannot be configured.

« For Non-Star Cls: The first three properties according to these priorities:

a. Attributes with the CMS Browser Visible qualifier on concrete attributes or attributes that are
inherited from Star Cls

b. Concrete attributes (not inherited)
« For Star Cls:

o Attributes with the CMS Browser Visible qualifier on concrete attributes or attributes that are
inherited from Star Cls.

o Special or calculated attributes
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o Concrete from the actual Cl type or inherited from the Star ClI.

For Node Star Cl type:

o Discovered Model

o Discovered OS Name

« Display Label from all connected IP Address (comma-separated)

o Memory Size

For Running Software Cl type:

o Discovered Product Name

« Display Label from connected Node

« Application Category

For Cl Collection type: the same attributes as for the Non-Star Cl

For Business Element Related Cl type:

« Business Criticality

o Last Modified Time

The order in which properties are presented in Cl Overview mode is alphabetic and cannot be

configured.

Widget Details Mode

Properties are displayed in the three panels as follows:

1. Core Properties

o StarCls

« Node

CMDB Object ID/Global ID

Discovered OS Name

Node Operating System Installation Type
Serial Number

Discovered OS Version

Discovered Vendor

Domain Name
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« Memory Size attribute from instance
« CPU Type from connected CPU, if empty — Name from connected CPU
« Calculated number of Core Number from all connected CPU Cls
« Calculated total File System Size from all connected File System Cls
« Running Software
« CMDB Object ID/Global ID
« Discovered Product Name
« Version
« Vendor
« Business Element/CI Collection
« CMDB Object ID/Global ID
« Business Criticality (for Business Element)
« Also:

« All attributes with CMS Browser Visible qualifier set to true and the Properties Group
dataitem set to Core.

o Non-StarCls
« CMDB Object ID/Global ID

« All attributes with CMS Browser Visible qualifier set to true and Properties Group data item
set to Core.

2. Complementary Properties
o StarCls
« Node
« Last Modified Time
« Updated By
« Node Boot Time
« Node Is Virtual
« Running Software
« Application Category
« Application Installed Path
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« Application Version Description
« Last Modified Time
« Updated By
« Business Element/CI Collection
« Create Time
o Created By
« Last Modified Time
« Updated By
« Also:

« Concatenation of Display Name (comma-separated) of all directly connected Party Cls.
For example," John Doe, UCMDB Ul, CMS” (divided into two labels, Owners for Person
Cls and Organizations for Organization Cls).

« Concatenation of Display Name (comma-separated) of all directly connected Location
Cls. For example, “Room 301, 3rd floor, M1, Cupertino, California, World, Milky Way,
Universe”.

« All attributes with the CMS Browser Visible qualifier set to true and Properties Group
data item set to Complementary.

o Non-Star Cls

o Last Modified Time
« Updated By

« Concatenation of Display Name (comma-separated) of all directly connected Party Cls. For
example," John Doe, UCMDB UIl, CMS” (divided into two labels, Owners for Person Cls
and Organizations for Organization Cls).

« Concatenation of Display Name (comma-separated) of all directly connected Location Cls.
For example, “Room 301, 3rd floor, M1, Cupertino, California, World, Milky Way, Universe”.

« All attributes with the CMS Browser Visible qualifier set to true and Properties Group data
item set to Complementary.

3. Additional Properties
o All attributes complying with the following rule and that were not displayed in any other panel:

IStatic && Have value && Visible && !Deprecated (excluding all attributes derived from
Managed Object)
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o All attributes with CMS Browser Visible qualifier set to true and Properties Group data item set
to Additional.

Direct Links

A direct link provides the URL to addition information, or to the browser-generated content (for example,
the content of a report or the result of a search).

The direct link icon E31 is available in reports and some widgets.

Tip: If you want to share what is currently displayed with others, you can always copy the URL
from the address bar of the browser and then share the URL with others.

You can access adirect link with predefined username and encrypted password, by adding
&username=<username>&password=<passEncrypt>&isEncoded=true to the URL, after the
UCMDB server's name.

To generate the encrypted password:

1. GotoJMX console > UCMDB-Ul:name=UCMDB Integration >
getEncryptedPasswordForURL.
2. Inthe user name field, enter the user name.

3. Inthe password field, enter the user's password.

4. Click Invoke.

Direct Links in Reports

In a generated report, when you click the direct link icon  , the following two options are available:

=]

Copy URL: Copy the URL of the current generated report to the clipboard.
Email URL: Send the URL of the current generated report by using the default email application.

When you select a report or browse through the Reports module, a link is generated in the address bar
of the browser. You can always copy the URL generated and then share it with others.

Other users can open the same report by using the URL, as long as they have View Permissions for
that particular report.
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Direct Links in Widgets

For some of the widgets displayed in the UCMDB Browser module, once you select a Cl and its data is
displayed in the UCMDB Browser module, it is possible to view additional data in the context of the
selected Cl and the displayed widget. A link icon (=3 ) appears on the far right side of the widgets that

provides, among other things, a direct link to an external application. When you click this icon and

select Open Link, you can launch an external application in the context of the selected Cl, as follows:

Link

Properties Widget

Environment Widget

Impact Simulation

Widget

Policy Widget

Change Request
Widget

Incidents Widget

CMS Ul (2018.08)

Description

When you click the link icon in the Properties widget and select Open
Link, the UCMDB server for the machine you selected in your initial
search opens (you must log in first), and displays all the CI properties for
the Cl you selected in the UCMDB Browser module.

When you click the link icon in the Environment widget and select Open
Link, the UCMDB server for the machine you selected in your initial
search opens (you must log in first), and displays a diagram of all Cls
related to the Cl you selected in the UCMDB Browser module.

When you click the link icon in the Impact Simulation widget and select
Open Link, the UCMDB server for the machine you selected in your initial
search opens (you must log in first), and displays the impact analysis for
the Cl you selected in the UCMDB Browser module.

When you click the link icon in the Policy widget and select Open Link,
the Configuration Manager installation for the machine you selected in
your initial search opens (you must log in first), and displays a view
containing the defined policies for the Cl you selected in the

UCMDB Browser module(if a view that is managed by Configuration
Manager exists that contains that Cl). If the selected Cl is present in more
than one view, Configuration Manager displays a dialog box where the
user can select which view to open.

In the Change Request widget, the link icon appears only in the widget
details, and each Change Request listed has its own link icon. When you
click the link icon for a Change Request and select Open Link, Service
Manager opens (you must log in first), and displays a form containing more
details on that Change Request.

In the Incidents widget, the link icon appears only in the widget details,
and each Incident listed has its own link icon. When you click the link icon
for an Incident and selecting Open Link, Service Manager opens (you
must log in first), and displays the incident details.

I Note: The link icon appears only if the Incidents Widget is configured
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Link Description

for a direct link that contains the tag: {SINCIDENT_ID} in the direct
link URL.

Problems Widget In the Problems widget, the link icon appears only in the widget details,
and each Problem listed has its own link icon. When you click the link icon
for a Problem and selecting Open Link, Service Manager opens (you must
log in first), and displays the problems details.

Get Related Widget When you click the link icon in the Get Related widget and select Open
Link, the UCMDB server for the machine you selected in your initial
search opens (you must log in first), and displays a diagram of all Cls
related to the Cl you selected in the UCMDB Browser module.

When you click £3, there is also an option to send a link to the Cl in an email.

When entering a URL for a direct link from the UCMDB Browser module, you can also use a global ID.
The highlighted section in the example below shows the syntax:

http://<browser-home>/ucmdb-browser?server=Default%20Client#global-
id=ca733b86bd6dc30ecd6e8a4467788cb7; widget=properties

Export Widget Details

You have the ability to export the details for a selected Cl in any of the supported widgets (Properties,
Environment, Impact Simulation, History, and Stakeholder widgets).

To enable this functionality, in UCMDB, go to Administration > Infrastructure Settings Manager >
UCMDB Browser Settings and set Enable reports to True. If this feature has not been enabled in
UCMDB, the export icons do not appear in the UCMDB Browser module.

Note: Generated reports that are older than one week are automatically deleted.

Export details for a specific widget

In Cl Overview mode, click the [* iconona supported widget and select one of the following options:

o Export to PDF
« Export to XLS
o Exportto CSV

The details that are displayed in the selected widget are generated in a file which you can view
immediately or save.
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In the exported file, the ' character is added in front of any CI attribute name that begins with one of the
following characters: @ + - =.

Note: The report generated from the History widget contains the history (changed attributes and
related Cls) of the selected Cl, and of the Cls contained in the selected CI’'s model, based on the
specified time range. The same data will be exported from both Selected view and Model view.

Export details for all supported widgets

In Cl Overview mode, click the E icon at the top of the screen and select one of the following options:

« Export to PDF
o Exportto XLS

The details that are displayed for all supported widgets are generated in a file which you can view
immediately or save.

In the exported file, the ' character is added in front of any CI attribute name that begins with one of the
following characters: @ + - =.

Refocus Links

Certain CI properties displayed by widgets have refocus links, meaning that you can select the
property and all the widgets reload, displaying information about the Cl property that was selected.

For the Environment and Impact Simulation widgets, all displayed Cls have refocus links.

For the Properties widget, the following Cl properties have refocus links:

« In Cl Overview mode

o For Nodes: connected IP addresses

o For Running software: connected nodes
« In Widget Details mode

o Connected Party (Owner) properties

o Connected Person properties

o Connected Locations
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Rerun a Discovery from the Discovery Progress Widget

As a discovery administrator, you can rerun a particular discovery job from the Discovery Progress
widget to reproduce the issue for troubleshooting purpose.

To rerun a discovery from the Discovery Progress widget:

1. Inthe right pane of the Discovery Progress widget, hover the mouse over a job, click the Context

Menu — andselect Rerun.
Note: The Rerun option is available only for the job with Success, Warning, or Error status.

Once you click Rerun, the selected job is dispatched, and as a result the job status changes.

If you rerun the job from the completed job table, the job instance will be removed from the table

immediately.

Refresh Job List
2. Click to check the new status and wait for the job to complete running.

Note:
o It may take a while before the status is updated.

o If the job cannot be rerun for some reason (for example, the server is down, the session
has expired, the job's status has changed), the following message appears: "Discovery

job can't rerun".

3. Hoverthe mouse over the job that just completed running, click the Context Menu ~— and

select Show details to view detailed messages.

4. Click to go back to the jobs list.

Specify Impact Rules

The Impact Simulation and Dependent Services widgets run impact analysis that uses impact rules, in
the same manner as UCMDB. These impact rules can be grouped into bundles. The default setting is
to run the analysis using all available bundles, however you can choose to run the analysis using only

certain bundles and not others.
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To select bundles for impact analysis:

1. InUCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.

2. Inthe Name column, choose List of impact rules bundles to be used.
3. Inthe Value column, enter a comma-separated list of bundle names.
Note:
o Incorrect bundle names are ignored.
o A bundle name that contains a comma cannot be used.
4. Click Save [Ell.
5. Log out from the CMS Ul, and then log in again (this loads the new bundle settings).
Note: The change takes effect according to the time set in one of the following settings:
o Time for which information in the Browser cache is valid

o Time for which UCMDB Settings in the Browser cache is valid

For more information, see "Settings affecting overall system operation".

Configure the BSM Health Indicator (for the Monitoring Widget)
To use the Monitoring widget, you perform the following configurations:
1. Synchronize the CMS and BSM:
a. InUCMDB, goto Data Flow Management > Integration Studio.
b. Create a new integration point with the following settings:

« Integration name. BSM synchronization
o Adapter. BSM
« Hostname. BSM hostname
« Port. BSM host port
« Credentials. Choose ‘generic protocol’
» Push Back IDs. Choose ‘enabled’
c. Save the integration point and invoke synchronization.

2. Create the BSM KPI Adapter Integration Point:
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a. InUCMDB, goto Data Flow Management > Integration Studio.
b. Create a new integration point with the following settings
« Integration name. BSM Kpi Adapter
« Adapter. BSMKpiAdapter
« Hostname. BSM hostname (use only FQDN)
o Port. BSM host port
« Credentials. Choose ‘generic protocol’
o Customer ID. Enter the Customer ID
c. Select the Kpi and KpiObjective checkboxes and save the integration point.

Note: The BSM KPI Adapter is deployed on the UCMDB server upon initial login to the CMS

Ul. This triggers deployment of content and makes it available for configuration on the
UCMDB server.

3. Specify Data Over Time settings:
a. InBSM, goto Admin > Service Health.
b. Onthe Cl Indicators tab, select a view that contains one or more Cls with KPIs.

c. Select one or more Cls in the upper pane (that have the KPIs you want to view in the
Monitoring widget).

d. Inthe Cl Data pane at the bottom of the screen, select the Save KPI data over time for the
selected Cls checkbox.

Configure Integration with Enterprise View

To enable the Enterprise View/UCMDB Integration, you must first install Enterprise View (EV) and
BusinessObjects. Once these are installed, you must perform the following procedures:

« "Deploy a Universe for Integrating the UCMDB Browser module into BusinessObjects" on the next
page

« "Deploy a Report Designed for UCMDB Browser module Integration into BusinessObjects" on
page 399
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Deploy a Universe for Integrating the UCMDB Browser module into

BusinessObjects

1. Verify that an EnterpriseView Universe exists with the correct description.

a.

Open the Central Management Console (go to Programs > Business Objects Xl 3.1 >
Business Objects Enterprise > BusinessObjects Enterprise Central Management
Console, orin aweb browser, go to the URL: http://<CMS host>:<CMS HTTP port>/
CmcApp).

Log in with the user name and password that you defined in BusinessObjects installation.
Go to Universes.

Open the folder EnterpriseView Universe, and check that EnterpriseView Universe is there
and that version 0.52 appears in the Description field.

2. Back up Existing Universe

Right-click on the universe EnterpriseView Universe and go to Organize > Move To.

Choose the root folder Universes and click the right arrow to move the folder to the
Destinations column.

Click Move.
Exit the Central Management Console and create a new file system folder.

Copy the files export.properties and export.bat from the folder ImportExportEVUniverse
located in the CMS Ul content folder into the folder you created in the previous step.

In the file export.properties in the folder you just created, change the following parameters to
the correct username, password, host name, and port of the host where the BusinessObjects
application is installed:

« userName=<BO user name>
o password=<BO_password>

« CMS=<host_name>:<port>

g. Run export.bat from the newly created folder where you copied export.properties.

Note: If you export from the original ImportExportEVUniverse, the universe you export
overwrites the original file that contains the EV Universe for the UCMDB Browser module
integration.

3. Import the Universe for Integration with the UCMDB Browser module
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a. Open the folder ImportExportEVUniverse and in the file import.properties, change the
following parameters to the correct username, password, host name, and port of the host
where the BusinessObjects application is installed:

o userName=<BO_user_name>
« password=<BO_password>
o CMS=<host_name>:<port>
b. From the same folder (ImportExportEVUniverse), run import.bat.

c. Inthe CMS console, ensure that EnterpriseView Universe is still situated under the root
folder Universes, and that the description field has changed to version 0.52 a.

d. Move the universe back to the folder EnterpriseView Universe (right-click the imported
universe, select Organize > Move To and select the EnterpriseView Universe folder).

4. Change the Database Connection for the Newly Imported Universe

a. Onthe machine where the BusinessObjects application is installed, go to Programs >
Business Objects Xl 3.1 > Business Objects Enterprise > Designer.

b. Skip the Quick Design window.
c. GotoFile > Import.

d. Select the folder EnterpriseView Universe and choose the universe EnterpriseView_
Universe.

e. GotoTools > Connections.
f. Select EnterpriseView Connection and click Edit.
g. Inthe Edit dialog box, enter the details of the Oracle EnterpriseView user.
h. Click Next and enter the following for the Configuration Parameters:
« Pool timeout = 10 minutes
« Array fetch size = 1
o Array Bind size =5
« Login timeout = 600 minutes
i. Click Save.

j- GotoFile > Export, select the EnterpriseView Universe folder, and click OK.
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Deploy a Report Designed for UCMDB Browser module Integration into

BusinessObjects

1.  Onthe machine where the BusinessObjects application is installed, go to Programs > Business
Objects Xl 3.1 > Business Objects Enterprise > Web Intelligence Rich Client.

2. Select File > Open, and open the file UCMDB_Browser_Integration.wid, located in the CMS Ul
content folder.

3. Select File > Export to CMS, and in the folders list, select EnterpriseView Reports.
4. Click OK.

Configure the Enterprise View Adapter
1. InUCMDB, go to Data Flow Management > Integration Studio.
2. Create a new integration point with the following settings:

o Integration name: EnterpriseViewDataSource (required)

e}

Adapter: EnterpriseViewAdapter (required)

o

Hostname: enter the Business Object’s server hostname (required)

(e}

Port: enter the Business Object’s host port (required). The default port is 6400.

o

Credentials ID: Choose Generic Protocol with your credentials

3. Inthe Data Flow Probe drop-down list, select a probe.

4. Save the integration point.

Note: The EnterpriseViewAdapter adapter is deployed on the UCMDB server upon initial login to
the CMS UlI. This triggers deployment of content and makes it available for configuration on the
UCMDB server.

For instructions on integrating Enterprise View with UCMDB, see "Configure Integration with

Enterprise View" on page 396

Configure the Automation Flow Adapter (for the Automation Widget)

To use the Automation widget, you must create an Integration Point for the Automation Flow Adapter
as follows:
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1. InUCMDB, go to Data Flow Management > Integration Studio.
2. Create a new integration point with the following settings:
o Integration name. Automation Flow Adapter (required)
o Adapter. AutomationFlowAdapter (required)
o Protocol. Https (required)
o Hostname. Enter the OO server's hostname (required)
o Port. Enter the OO host's port (required)
o Application Context. /PAS/services/WWSCentralService (optional)
o Use LW-SSO. True or False (required)
o Credentials ID. Choose Generic Protocol with your credentials (required if Use LW-

SSO=False)

Note: If Use LW-SSO=True, the OO server and UCMDB server must both enable LW-
SSO. LW-SSO configuration on the UCMDB server is described in the section "LW-SSO
Authentication Overview" in the Hardening section of the UCMDB Help. LW-SSO
configuration on OO is described in the Micro Focus Operations Orchestration
Administrator Guide. A user who performs actions (run/view automation flows) on OO
must exist as an external user on the OO server with the same user name that he has on
the CMS Ul and with the correct permissions.

If Use LW-SSO=False, all users who performs actions on OO get the permissions of the
integration user, which is defined in the Credentials ID field.

3. Save the integration point.

4. Logout and log into UCMDB Server again for the change to take effect.

Note: The Automation Flow Adapter is deployed on the UCMDB server upon initial CMS Ul start
up. This triggers deployment of content and makes it available for configuration on the UCMDB
server.

Select and Define Automation Flows (for the Automation Widget)

1. InUCMDB, go to Modeling > Modeling Studio.
2. Select New, and from the drop-down list, select Automation Flow Mapping.

The New Automation Flow Mapping dialog opens.

CMS Ul (2018.08) Page 400 of 446



CMS Ul Guide

3. Inthe New Automation Flow Mapping dialog, choose Create new query or Choose base
query.

The Automation Flow Mapping Editor opens, with two tabs: Query Definition and
Automation Flows.

4. Inthe Query Definition tab, define the Automation Flow mapping by defining a query with one
node as the contact node.

5. Inthe Automation Flows tab, add flows by clicking the Add Automation Flow link.
The Select Automation Flow window opens.

6. Entertext for a search in this window (the search is performed by name, domain, or category) and
click the Search button.

The search results appear.
7. Choose a flow from the list of search results.

The flow name now appears in the Automation Flows tab window with its input fields. If the input
field has a default value, it is set in the field.

8. Enterinputs in each field. Inputs can be added by typing free text in the field, by selecting an
attribute from a TQL node, or by entering a complex expression containing both free text and an
attribute from a TQL node. If default values exist, you can change them.

9. You can add more flows by repeating steps 5-8.

Note: Automation Flow Mapping supports one contact node only.

Integrate with ALM (for the Defects Widget)

The following configuration procedures need to be performed to use the Defects widget in the UCMDB
Browser module:

« "Set Up the Defects Adapter" on the next page

« "Create New Attribute and Severity Mapping Properties Files (optional)" on the next page

« "Create the DefectsFilter Cl and Relate it to the Business Element" on page 404

« "Enable the Defects Widget in UCMDB" on page 404
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Set Up the Defects Adapter

1. InUCMDB, go to Data Flow Management > Integration Studio.
2. Create a new integration point with the following settings:
o Integration Name. Defects Adapter
o Adapter. ALMAdapter
o Protocol. must be http or https
o HostnamelP. the name or IP address of the machine where ALM is installed
o Port. the port number of the ALM server
o Domain. the domain that is defined in ALM

o Credentials ID. click the browse button and from the list that appears choose credentials for
connecting to ALM, or create new credentials

3. Optional: Click Test Connection to ensure that a connection can be established with the ALM
server.

4. Click OK.
5. Under the Supported and Selected Cl Types panel, check the Defect Cl type.

6. Click the Save Integration Point button.

Create New Attribute and Severity Mapping Properties Files (optional)

There are two out-of-the-box mapping properties files, one for attributes and one for severities. The
attributes mapping properties files map between names of defect fields in ALM to names of attributes of
the class type Defectin UCMDB. The severities mapping properties file maps between severity levels
in ALM to the five severity levels in UCMDB, as defined in the DefectSeverity typedef in UCMDB.
These files can be accessed by means of the Defects Adapter, by going to Data Flow Management >
Adapter Management > ALMAdapter > Configuration Files. The files are called
sample.attribute.mappings.properties and sample.severity.mappings.properties.

You may want to create your own customized attributes or severity mapping properties files. This could
be necessary if the names of the fields in the out-of-the-box mapping properties files do not match the
names in your ALM system, or could be useful if you want to add additional fields that do not exist in the
out-of-the-box mapping properties files.

To create a new attribute or severity mapping properties file:
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1. If you are creating an attribute mapping properties file:

a. Toretrieve the ALM defect attribute field names that you need to create the mapping, go to the
following URL:

http://<ALM server>:8080/qcbin/rest/domains/<domain>
/projects/<project>/customization/entities/defect/fields ?login-form-required=y

b. Inthe ALM login page, enter your user credentials.

c. Inthe XML file that appears there is alist of the defect’s fields. Note the Name element in
each field, you are going to map the value that appears for the Name element here to the
names of attributes of the class type Defectin UCMDB.

2. InUCMDB, go to Data Flow Management > Adapter Management.
3. Click the New button and from the pop-up menu select New Configuration File.

4. Enter a name that starts with ALMAdapter/..., for example:
ALMAdapter/attribute.mappings.properties.

Note: The custom attribute mappings file should be named attribute.mappings.properties,
and the custom severity mappings file should be named severity.mappings.properties. If
project-specific mappings files are required, they should be named <project-
name>.attribute.mappings.properties and <project-
name>.severity.mappings.properties for attributes or severities, accordingly.

5. Click the Browse button by the Package field, choose ALMAdapter from the list that appears, and
click OK.

6. Inthe text editor, for attributes mapping each row should contain the name of the ALM field
(attribute) on the left side and name of the equivalent Cl attribute on the right side in the following
manner:

<ALM field name>=<C] attribute>

For severities mapping, each row should contain the ALM severity on the left side and the
equivalent UCMDB severity (as defined in the DefectSeverity typedef in UCMDB) on the right
side, in the following manner:

<ALM severity>=<UCMDB severity>

7. Click OK when you are finished editing the new mapping properties file.

Note:
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« The name of the CI attribute must exist in the class type Defect.

« Forthe severities file, if a severity in ALM has a space, a back slash must precede the space
as follows: Very\ High.

« Inthe UCMDB Browser module, there are only 5 severity levels (Low, Medium, High, Very
High, and Urgent), so all ALM severities must map to one of these 5 levels.

« Thetype of all custom UCMDB attributes must be String.

Create the DefectsFilter Cl and Relate it to the Business Element

The Defects Filter Cl that is related to a specific business element represents the ALM filter that is
used to retrieve the relevant defects for that business element.

Note: You can relate more than one DefectsFilter Cl to a business element.
To create the DefectsFilter Cl and relate it to the business element:

1. Create afilterin ALM (if one has not already been created).
Copy the filter's text.

In UCMDB, go to Modeling > IT Universe Manager.

In the Browse Views tab, click the New CI button.

From the ClI type tree, select the DefectsFilter Cl type.

o o &~ w BN

Paste the filter text from the ALM filter into the FilterText attribute value.

Note: Currently there is a limitation of maximum 885 characters in the FilterText attribute
value.

7. InProjectGroup attribute, enter the ALM project name.
8. Optional: Give the filter a custom name by setting the Name attribute value.
9. Click Save.

10. Relate the DefectsFilter Cl to the business element using a containment relationship from the
Defects filter to the business element.

Enable the Defects Widget in UCMDB

Before connecting to the CMS Ul, enable the Defects widget as follows:
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1. Goto Administration > Infrastructure Settings Manager > UCMDB Browser settings.

2. Set the value of Enable the Defects Widget to True.

How to View Discovery Status and Errors for a Selected Cl from the
Discovery Progress Widget

Discovery administrators and data consumers can view warning or error indicators for discovery issues
with discovery jobs in the Discovery Progress widget, they can also view summary and detailed
discovery status, errors, and warnings for a selected Cl in the Discovery Progress widget.

Note: To use this feature, you need to have the Run Discovery and Integration or the View
Discovery Status and Error permissions. The out-of-the-box Discovery and Integrations
Admin role has all these permissions by default.

You also need the View permission to the Discovery Progress widget.

This task includes the following steps:

« Prerequisites: Grant the Required Permissions

« View the Discovery Progress widget in the UCMDB Browser module

Prerequisites: Grant the Required Permissions
Note: This step is performed by the system administrator.

To view the Discovery Progress widget from the UCMDB Browser module, your
administrator needs to grant the following permissions to you:

o Run Discovery and Integrations (for discovery administrators) or View Discovery Status
and Error (for data consumers)

o Access to UCMDB Browser
a. Loginto UCMDB and go to Security > Roles Manager > Roles.
b. Select the role to which you want to add the permission.

Create a new role if you do not have such a role.

Note: The View Discovery Status and Error permission is not available for all out-of-
the-box roles.

c. Click the General Actions tab.
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d. Inthe Data Flow Management Actions section, select the Run Discovery and Integrations
or View Discovery Status and Error action in the Available Actions pane and move it to the

Selected Actions pane.

e. Inthe System Access Actions section, select Access to UCMDB Browser in the Available
Actions list and add it to the Selected Actions list.

2.
View discovery status, errors, and warnings for a selected Cl in the Discovery
Progress widget

a. Launchthe UCMDB Browser and access the Discovery Progress widget.

« For discovery administrators, launch the Discovery Progress widget from the
Discovered Cls dialog in UCMDB UI.

When performing job-based discovery troubleshooting in the Universal Discovery module,
after drilling down to the Discovered Cls dialog (for example, by following the Triggered
Cls > Completed with Errors > <Double-click an error message, and then right-click a
detailed message> > Show Results for Triggered Cl > <Select a CIT and click Show

Additional Data s > Discovered Cls), you may want to find out more details about an
affected ClI.

Todo so,

A. Inthe Discovered Cls dialog, right-click a discovered Cl and select Open UCMDB
Browser from the context menu.

The UCMDB Browser launches, with the CI Details pane opening in the right side of
the UCMDB Browser search page.

B. Inthe Cl details pane, click DISCOVERY PROGRESS or Show All in the
Discovery Progress widget in Cl Overview mode.

The Discovery Progress widget opens to its widget details mode.

« For data consumers, launch UCMDB Browser and open the Discovery Progress
widget for a selected CI

A. logintothe UCMDB Browser, enter either of the following in a web browser:
http://<server_name>:<8088>/ucmdb-browser
https://<server_name>:<8443>/ucmdb-browser

where <server_name> represents the fully qualified domain name (FQDN) of the
UCMDB server.

B. Search for the CI of your interest.

CMS Ul (2018.08) Page 406 of 446



CMS Ul Guide

The returned search results page displays allist of all Cls. The discovery indicator (Q
, o, or ®) next to each returned CI gives you a straightforward discovery status of
the CI.

C. Onthe returned search results page, click the ClI of your interest.
The CI Details pane opens in the right side of the page.

D. Click DISCOVERY PROGRESS or Show All in the Discovery Progress widget in
Cl Overview mode.

The Discovery Progress widget opens to its widget details mode.

b. View discovery indicators, discovery status, errors, and warnings for a selected Cl in the
Discovery Progress widget.

For details about the Discovery Progress widget, see the Discovery Progress Widget section
in the Use section of the Universal CMDB Browser Online Help.

Assign Color Categories

Color categories in the UCMDB Browser module help you with the navigation and searching of Cls.
You may assign any of the available colors to any ClI:

Gray (if no category is specified)

Dark Steel .
Green .

Orange
Purple
Red

Slate

Turquoise
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Yellow

You can view and change the color categories by:

« Clicking the colored icon in the upper right corner of each Cl on the search results page (both in grid
view and thumbnails view) and on the Most Visited page.

« Selecting Choose Category from the context menu o for a selected CI.
To assign a color category, click the color icon in any of these locations, and select the color category
that you want to apply to the CIl. Changes are reflected in all places where categories are indicated.

After assigning colors, you can use the color categories to refine your search (for example, "all red
Windows servers" or "all blue business applications located in Seattle".

Note: When upgrading from UCMDB Browser to CMS Ul 2018.08 or later versions, the colors
assigned in the previous version will be updated to the new colors and names available in the CMS
Ul 2018.08 or later versions. If the default names for the colors have been changed in the previous
version, only the colors will be updated, and the names will remain as they were defined before.

Enable color categories

1. InUCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.

2. Set the value of Enable categories to True.
3. Click Save IE.

4. Log out from the CMS Ul, and then log in again (this loads the new setting).

Note: The change takes effect according to the time set in one of the following settings:
o Time for which information in the Browser cache is valid
o Time for which UCMDB Settings in the Browser cache is valid

For more information, see "Settings affecting overall system operation".
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Manage color categories

1. Click the Settings button and select Manage System Categories.

2. Change the label for one or more of the available colors.

3. Click OK.

Assisted Modeling

Note: Assisted Modeling is supported only with the Enhanced Search Engine enabled (the value
of the cmdb.search.enabled JMX setting is true).

If the Enhanced Search Engine is disabled (the value of the cmdb.search.enabled JMX setting is
false), the value of the ucmdb_browser.modeling_configuration.enable_validation JMX
setting must be true.

Assisted modeling in the UCMDB Browser module provides a more accessible interface for Cl
modeling than is available in UCMDB. Assisted modeling is designed for end-users who do not need
the full modeling capabilities that the UCMDB provides for administrators. The UCMDB Browser
module provides a very intuitive and straightforward user interface for creating Cls and relationships
between Cls.

Assisted modeling is performed according to modeling templates. Best practice modeling templates
are provided out-of-the-box. The best practices templates can be used out-of-the-box ‘as is’, or the
UCMDB administrator can edit them according to your organization's needs. New modeling templates
can also be created by the UCMDB administrator. For instructions on creating templates, see "Create
Modeling Templates" on page 415.

To change the order in which modeling layers are displayed, see "Change the Modeling Layering Order"
on page 416.

Note: To use assisted modeling, users must have data-update permissions assigned in the Roles
Manager in UCMDB, and View access to at least one of the modeling templates.

Get Started with Assisted Modeling

You can access Assisted Modeling in two ways, through the Service Modeling module:
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o Click Start Assisted Modeling.
or

« Hoveryour mouse over a Cl in a service model map and select Assisted Modeling from the

context menu #‘

When the modeling is completed, click .

The modeling topology map is displayed with the selected Cl automatically loaded in the model. To see
the related Cls, see "View a List of All Cls that are Related to the Selected CI" on page 412.

Note:

« Thetemplates displayed in the drop-down list are according to the user’s permissions on the
query resource and also according to the selected Cl type. To quickly locate a template, you
can filter the list of templates by entering a text string in the drop-down list.

« The selected template can be changed after you have started to make modeling changes.
However, if you change the template all modeling changes made with the previous template
are not saved.

Modeling Actions
You can perform the following modeling actions:
« "Group the Cls in the Model by Cl Type" on the next page

« "Edit the Properties for the Selected CI" on the next page

« "Remove the Selected Cl from the Model" on page 412

« "View aList of All Cls that are Related to the Selected CI" on page 412

« "View only the Cls that are Directly Related to the Selected CI" on page 412
« "Add an Existing Cl to the Model" on page 412

« "Create aNew Cl and Add It to the Model" on page 413

« "Create and Remove Relationships between the Selected Cl and Other Cls in the Model" on
page 414

« "Save Changes to the Model" on page 415

« "Create Modeling Templates" on page 415
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« "Change the Modeling Layering Order" on page 416

« Navigate the Modeling Topology Map Using a Quick Navigation Map

Group the Cls in the Model by CI Type

P
I+]
'

To group the Cls in the model by CI Type, click the "*= button in the model. The Cls are now grouped,

and a number of grouped Cls is displayed.
" O

To expand the grouped Cls, click the

P
&)
L

button.

Edit the Properties for the Selected Cl

1. Ensure that a Cl is selected in the map.

2. Inthe right pane, click Edit CI.

Note:

o Similar to the Properties widget in the UCMDB Browser module, the Cl properties are
displayed in the right pane. In the Assisted Modeling window, mandatory properties are
marked with an . All of the mandatory fields must have a value to save changes you
make to any of the CI properties.

o For a property to be edited, it must be defined as CMS Browser Editable in UCMDB, in
the same manner as the Properties widget.

o If an attribute of a Cl type has the Hide in Modeling qualifier selected, it is not displayed
when editing the CI.

Note: Similarto the Properties widget in the UCMDB Browser module, the CI properties are
displayed in the right pane. In the Assisted Modeling window, mandatory properties are
marked with an . All of the mandatory fields must have a value in order to save changes you
make to any of the CI properties.

3. Edit the property values.
4. Click Apply at the bottom of the pane.
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Remove the Selected Cl from the Model

1. Ensure that the Cl you want to remove is selected in the map.

2. Intheright pane, click Remove from Model.

The Cl is removed from the model.

Note:

« If you create a model based on a particular Cl, you cannot remove that Cl from the model.

« If you create a model based on an empty template, you can remove all Cls from the model.

View a List of All Cls that are Related to the Selected Cl

You can view in the model all Cls related to the selected Cl (as defined by the selected template) as
follows:

In the right pane, click Show All Connected Cls. This loads, from UCMDB, all Cls related to the
selected Cl, as defined by the modeling template. The related Cls are displayed in the model.

View only the Cls that are Directly Related to the Selected CI

You can view in the model only the Cls directly related to the selected Cl (as defined by the selected
template) as follows:

In the right pane, click Show One Level Connected Cls. This loads, from UCMDB, only the Cls
directly related to the selected Cl, as defined by the modeling template. In the new panel that opens
you can select the Cls that you want to be displayed in the model, and then click Show on Map. The
selected Cls are displayed in the model.

Note: Once the Cls that you have selected using the Show One Level Connected Cls option
are displayed in the map, you can remove them from the model only by using the Remove from
Model option. You cannot remove them by deselecting the checkboxes from the Show One Level
Connected Cls option.

Add an Existing Cl to the Model

You can add an existing Cl to the model. When you do this, it is automatically connected to the
selected Cl in the model. This may not be the CI that started the model.
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1. Do one of the following:

o Inthe right pane, go to the section called Add Cls and click Existing under the CI type that
you want.

o Click Plus @ in one of the Cl type sections in the model. Then, in the right pane, click Add
Existing <Cl type>.

The search screen appears. By default, a list of all Cls with the CI type you selected in the
previous step is displayed.

You can view in the search screen only the results that respect the attribute condition and the
cardinality condition defined for the TQLs in UCMDB, by changing the value of the Force
Assisted Modeling validation through TQL conditions setting to True in the UCMDB >
Administration > Infrastructure Settings Manager > UCMDB Browser Settings.

2. Locate the Cl you want to add either by finding it in the displayed list or by searching for it in the
search box and click Add, which appears when you hover over the CI.

The Cl is now added to the model, directly linked to the selected ClI.

3. You can continue to add more Cls in this manner. When finished, click Done at the bottom of the
right pane.

Create a New Cl and Add It to the Model

You can create a new Cl and add it to the model. When you do this, it is automatically connected to the
selected Cl in the model. This may not be the CI that started the model.

Note:

« Only Cls with a Cl type that has been assigned the MODELING_ENABLED qualifierin
UCMDB (by the system administrator) can be created in the Assisted Modeling module.

« Toedit the Tenant Owner and the Consumer Tenant attributes in the Assisted Modeling
module you need to have the Reassign Tenant and the View Tenant Assignment
permissions, and the attributes must be defined as CMS Browser Visible and CMS Browser
Editable in UCMDB.

1. Do one of the following:

o Inthe right pane, go to the section called Add Cls and click New under the Cl type that you
want.
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o Click Plus @ in one of the CI type sections in the model. Then in the right pane, click
Create New <ClI type>.

Note:

« Similar to the Properties widget in the UCMDB Browser module, the CI properties are
displayed in the right pane. In the Assisted Modeling window, mandatory properties are
marked with an . All of the mandatory fields must have a value to save changes you
make to any of the CI properties.

« Fora property to be edited, it must be defined as CMS Browser Editable in UCMDB,
in the same manner as the Properties widget.

« Ifan attribute of a Cl type has the Hide in Modeling qualifier selected, it is not
displayed when editing the CI.

Note: Similarto the Properties widget in the UCMDB Browser module, the Cl properties
are displayed in the right pane. In the Assisted Modeling window, mandatory properties are
marked with an . All of the mandatory fields must have a value to save changes you
make to any of the CI properties.

2. Edit the property values.
3. Click Apply on the bottom of the pane.

The Cl is now added to the model, linked to the Cl that was selected.

Create and Remove Relationships between the Selected Cl and Other Cls in the
Model

You can create relationships between Cls in the model and the selected ClI, or remove existing
relationships between Cls in the model and the selected CI.

1. Inthe right pane, go to the Edit Connections section and hover over the Cl that you want to
create a relationship with or remove the relationship from the selected CI.

Note: You can create relationships only with those Cls that are allowed by the template to
have a relationship with the selected Cl and only with those Cls that are displayed.

2. Click Connect or Disconnect.

CMS Ul (2018.08) Page 414 of 446



CMS Ul Guide

Save Changes to the Model

Click Save at the top right of the Assisted Modeling window. When you click Save, all the changes you
have made in the Assisted Modeling window are saved to UCMDB. Until you click Save, none of the
changes you have made are saved.

It is possible that when you click Save, you will receive an error message(s) indicating what needs to
be fixed. Also, if there are errors the invalid Cl is marked with a red triangle on the upper left corner.

Create Modeling Templates

1. InUCMDB, go to Modeling Studio and click New L
2. From the drop-down list, select Query. The Query Definition editor opens.

3. Click Query Definition Properties 4|, The Query Definition Properties dialog box opens.

Note: By default, the Type field in the Query Definition Properties dialog box is Integration.
This value should not be changed.

4. Ensure that Integration is selected in the Type field (it should be selected by default).

L]

5. Inthe Bundles field, click Select Bundles | *** .. The Select Bundles dialog box opens.

6. From the Bundles list, select modeling and click OK. If modeling does not appear in the list,
enter modeling in the text field and click Add New Bundle.

7. Inthe Query Definition Properties dialog box, click OK.

8. Build the TQL query and save it to any location.

Note:

« A user must have permissions on the query resource in order to view the template in the
UCMDB Browser module.

« The following limitations exist on modeling templates:
o Virtual links and compound links are not allowed.

o The TQL query must not have circular dependency.
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Change the Modeling Layering Order

If you are viewing the model in Layers mode, you can change the order in which the modeling layers are
displayed

(N
1. Click at the bottom of the Assisted Modeling window.

2. Under Change Layout, select Layers.

3. InUCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.

4. Inthe Name column, select Layer ordering.

5. Inthe Value field, change the layering order to the order that you want. Ensure that all layering
names are separated by commas.

6. Click Save.

7. If the CMS Ul is currently open, log off and then log on again to see the changes in the layering
order. If the CMS Ul is not open, you will see the changes in the layering order the next time you
log on.

Note: The change takes effect according to the time set in one of the following settings:
o Time for which information in the Browser cache is valid

o Time for which UCMDB Settings in the Browser cache is valid

For more information, see "Settings affecting overall system operation".

Navigate the Modeling Topology Map Using a Quick Navigation Map
You can navigate the modeling topology map easily by turning on the quick navigation map.

In the quick navigation map, the elements from the canvas are represented. You can drag and resize
the selection in the map overview.

If the map is too large, a big overview of the map is available, which allows you to use the map
overview navigator to jump directly to a particular part of the map.

A toggle button is available in the map to allow you to turn on/off the minimap. If the map is larger than
20 Cls, the state of the button is saved in your user preferences.
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BR o -+ o0

| Open quick navigation |

For more details about the Map Toolbar, see "Map Toolbar" on page 281.

Discovery Indicators

Note: This feature is supported on UCMDB 10.21 CUP1 and later versions.

You can see different types of discovery indicators in the Search, Advanced Search and Reports
modules in the UCMDB Browser module.

These indicators allow you to see a warning or an error flag on a discovered Cl, if any of the discovery
jobs have completed with warnings or errors.

To use this feature, you need to have the Run Discovery and Integration or View Discovery Status
and Error permission.

By default, the Discovery indicators are disabled. To enable the Discovery indicators, goto UCMDB
Browser module > Settings > Manage Discovery Status > select the Display Discovered Cls
Status checkbox, and then click OK.

There are three types of discovery indicators:

1. A warning indicator '’ shows on the Cl in the UCMDB Browser module when there is at least

one discovery job completed with warnings and there is no discovery job completed with errors.

2. An error indicator ® shows on the Cl in the UCMDB Browser module when there is at least one

discovery job completed with errors.
3. A success indicator @ shows on the Cl in the UCMDB Browser module when all the discovery
jobs completed successfully.

If a Cl is not discovered (updated) by any of the discovery jobs, then no indicator will show on that CI.

Note: Inthe UCMDB Browser module, discovery indicators:

« Apply to discovery jobs only, including regular discovery jobs, management zone jobs, and
Automated Service Modeling (ASM) jobs. Integration jobs are not supported in this release.

« Do not show on a discovered Cl when there is no relation between the Cl and the job.
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Notifications

Note: If youlogintothe CMS Ul with the customer state of Authorized, the Notifications
functionality is disabled automatically, even if it is enabled via settings.

Notifications in the UCMDB Browser module enable you to see which property (CI or attribute) has
changed, been added, or been deleted since the last time notifications were generated. Notifications
are sent according to values specified in the UCMDB settings.

After enabling notifications in UCMDB (as described in "Configure notifications" on the next page),
select Select Notifications from the context menu 'a' for a selected ClI to specify the widgets for

which you want to see notifications. This icon appears on the search results page and on the Most
Visited page.

A list of notifications appears in the Notifications tab in the UCMDB Browser module, marked with a &=
(unread) or £ (read) indicator, as well as in the locations mentioned above. In the Notifications tab, you

can choose to display all notifications or only unread notifications.

Clicking a notification opens the Cl in Cl Overview mode. Here, the widgets to which you have
subscribed that contain changes are marked with a 218 indicator (the changes themselves are visible

only in Widget Details mode). After entering Widget Details mode for any of the marked widgets, the
icon in Cl Overview mode changes to IEI. For widgets that contain changes, in Widget Details mode,
notifications that are marked with an IEEB indicator display their values inline. |f EEZE is displayed,

click the indicator to see the older values in a pop-up window.

Indicators for changed values appear in the following widgets:

Properties widget = Anindicator is displayed next to each changed attribute (simple or logical, such
as owner, CPU, memory, and so on). For details, see "Properties Widget" on

page 367.
Environment Anindicator is displayed for each newly added Cl in the Cl list. For details, see
widget "Environment Widget" on page 349.
History widget An indicator is displayed for the current Cl and for Cls related to the current CI

(up tofive levels). For details, see "History Widget" on page 353.

Policy widget An indicator is displayed on each new policy or on a change in the policy status.
For details, see "Policy Widget" on page 363.

Stakeholder Anindicator is displayed for each Cl in the list, as well as on the stakeholder's
widget personal information (email address and phone numbers). For details, see
"Stakeholder Widget" on page 370.
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Widgets related to = An indicator is displayed for each ticket, summarizing the changes in the ticket.
Service Manager: = Indicators appear for new and updated items (what changed in the affected Cls,
Change Request, phase, severity value, dates, and so on).

Incidents, and
Problems widgets Note: You may receive notifications for these widgets but not be able to

view the corresponding widget details if:

« The particular request from Service Manager is in a state that currently
is not configured as being displayed in the UCMDB Browser module. To
specify Service Manager request states to be displayed, in UCMDB, go
to Administration > Infrastructure Settings Manager > UCMDB
Browser Settings and specify the statuses that you want to be
displayed.

« The particular Cl that was subscribed to notifications for these widgets
from Service Manager is no longer affected by a request.

Dynamic widgets = Anindicator is displayed next to each changed attribute (for attributes that are
selected in the widget definition).

Note: To receive notifications about changed attributes in dynamic
widgets, you must configure the attributes in the dynamic widget
configuration. For details, see "Create a dynamic widget" on page 347.

Note: In all widgets, for data that has been removed or deleted, a F=m==-== E= indicator appears
next to the widget's title. Click the indicator to view a pop-up window containing all deleted Cls and
attributes.

Configure notifications

« To enable notifications:

a. InUCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.

b. Inthe Name column, choose Enable notifications.

c. Inthe Value column, set the value to True.
d. Click Save [E1.

e. Log out from the CMS Ul, and then log in again to load the new setting.

Note: The change takes effect according to the time set in one of the following settings:
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« Time for which information in the Browser cache is valid
« Time for which UCMDB Settings in the Browser cache is valid

For more information, see "Settings affecting overall system operation".

f. Inthe UCMDB Browser module, click ¢ and specify the widgets for which you want to see

notifications.
« To specify persistency values for notifications:

The length of time that notifications are retained and how often they are generated are defined in the
JMX console:

a. GotoJMX Console > UCMDB:service=Settings Services > setSettingValue.
b. Tochange each setting, follow these steps:
i. Inthe name field, enter one of the strings listed below:

« tql.tracker.queue.evaluation.initial.delay.in.min - the initial delay (in minutes) after
startup, before a TQL query is calculated.

« tgl.tracker.queue.evaluation.period.in.min - the interval (in minutes) of how often a TQL
query is scheduled to run.

« tgl.tracker.queue.max.single.run.time.in.min - the maximum length of time (in minutes)
for the system to work on calculating changes on Cls or TQL queries during a single
execution.

« tql.tracker.min.time.between.tracker.runs.in.min - the minimum length of time
between two runs of a TQL query.

Note: To find the default value for each setting, enter the required string in the name
field of getSettingDefaultValue and click Invoke.

ii. Inthe value field, enter the value you want to set.
ii. Click Invoke.

c. Restart the UCMDB server.

Schedule Notifications

You can configure the UCMDB Browser module to receive notifications by email.
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You can schedule how often to receive notifications by email by clicking on the Settings button

and selecting Schedule Notificationsfrom the drop-down list.

The emails include the following for each Cl with notifications:

« the name, type, and icon
« the widgets that contain the changes from the notifications

« alink back to the UCMDB Browser module in the context of the ClI

You can choose to receive emails on an ad-hoc basis, or daily at a time that you specify. You must
specify the email address to which the notifications will be sent.

o Ad-hoc emails

Click the Schedule ad-hoc email checkbox to receive notification emails at the interval that has
been specified by your system administrator.

To specify this interval, set the tql.tracker.queue.evaluation.period.in.min setting as described in
"Configure notifications" on page 419.

The same natification will not be sent more than one time.
« Daily emails

Click the Schedule daily email checkbox and select the time of day that you want to receive the
emails.

All unread notifications will be sent, whether or not they were sent previously.

Note: After you change this setting, you must restart the CMS Ul to apply the new value.

Export notifications

You can choose to export results for all notifications or only for unread notifications. On the
Notifications tab, click View: Unread or View: All as required.

In addition to the attributes that you specify in the Infrastructure Settings Manager in UCMDB, the
name of the widget in which the changed CI appears is also included in the results.

« To specify the attributes to be exported:

a. InUCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.
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b. Do the following:

« Inthe Name column, choose Minimal export of search results and choose True if you
want to export only the display label, class name, Cl ID, and Global ID attributes for each
Cl. Choose False if you want to export all attributes that are displayed in the Properties
Widget.

Additional attributes can be excluded if they are marked in the CI Type Manager in UCMDB.
For details, see the description of the Hide in Export Search Results qualifier in the
Modeling section of the UCMDB Help.

« Inthe Name column, choose Remove logical attributes (owner, location) from export
of search results and choose True to remove the owner and location attributes from the
exported search results.

If you set Minimal export of search results to False, the attributes displayed in the expanded
mode of the Properties widget are exported.

« To export notification results:
a. Click Export results [ in the search results toolbar. The following options are available:

« Current page > XLS, XLSX, or CSV
« Allpages > XLS, XLSX, or CSV
b. Click Open, Save, or Cancel.
The created file is named with the date and time that the export was performed.

Note: Inthe exported file, the ' character is added in front of any CI attribute name that begins
with one of the following characters: @ + - =.

Universal Discovery Licensing Overview

Tofit the changing IT world and to meet the increasing need for a more flexible and comprehensive
licensing system, the Universal Discovery Licensing is improved and adjusted to follow the unit-based
licensing model. Benefits of the new licensing system include the following:

« Increased licensing flexibility. The new unit-based model covers both UD Full and UD Inventory.
There is no longer the need to worry that Universal Discovery will consume a more expensive UDF
license when you run out of UDI licenses.
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« Extended license coverage to cover servers, workstations, containers, network devices, and
storage devices. No need to wait for the product team to build new and updated discovery of
network and storage devices.

« Alignment with ITOM licensing practices. UD Full and UD Inventory are no longer licensed as
separate products.

Note: The unit-based licensing model requires UCMDB version 2018.08 and Content Pack
version 26.00 or later.

What's Changed Compared to the UDI/UD Full

Licensing Modeling

The new licensing model introduced since version 11.0 changes how some jobs charge for your
discovery in 2018.08. Here is the list of changes:

« VMware virtualization will now consume an Advanced unit for each node (same with Hyper-V and
Solaris Zones)

« If you discover running software on a server, it consumes an advanced unit for that server

« Workstations will never consume an Advanced license. UCMDB determines whether a compute
device is a workstation or not by the operating system installed on it (for example, including but not
limited to, Windows 7, Windows 10 or macOS)

« Thetwo discovery jobs related to Netflow will now only consume a Basic unit

« Itis now possible to capture Oracle LMS on servers without an additional license beyond the
Advanced unit

Units Model of the Universal Discovery Licensing

In the new units model:

e« 1Unit=1UD Full license

« Everything else is aratio of the UD Full License

The table below describes the conversion rates between UD Full, UD Basic, and Units:
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Server Workstation Network Storage Docker
Type (Unit) (Unit) (Unit) (Unit) (Unit)
UD Full (Advanced 1 0.1 0.1 0.1 0.1
Discovery)
UD Basic (Basic 0.2 0.1 0.1 0.1 0.1
Discovery)

| Note: The highlighted cells indicate adjustments.

In brief, a 10 units license pack of Universal Discovery 2018.08 Licensing contains the following:

10 10 Servers - 50 Servers - 100 100
Units - gf:lvanced or . Basic 18 Worktations 1o 100 Containers  Fg¥d Network{ Storage
iscovery Discovery Devices

Key Capabilities and Differentiation Between Basic

Discovery and Advanced Discovery

The table below describes the capabilities available with Universal Discovery Basic Discovery and
Advanced Discovery license types.

License 10 Units License Packs

Type provide Key Capabilities
Basic 50 Servers OSI « Discover basic network, servers and their OSs
Discovery

« Capture software utilization and inventory, including
network and storage devices, workstations, and
containers

« Utilize Smart Software Analytics (SSA) to customize

100 network / storage software teaching

devices, containers,
workstations, printers or « Understand which hardware and installed software

mobile devices. you have.

« Utilize zone-based and discovery job section to
perform discovery

« Credential Less Discovery (netflow)

Advanced 10 Servers OSI « Everything from Basic Discovery
Discovery . . .
« Discovery of software dependencies and topologies

« In-depth application discovery

CMS Ul (2018.08) Page 424 of 446



CMS Ul Guide

License 10 Units License Packs

Type provide Key Capabilities

« Includes (but not limited to): Cloud and Virtualization,
Clustering and Load Balancers, Detailed DB /
Middleware / Enterprise Applications / multi-tier

interdependencies discovery.

o L2discovery

« Automated Service Modeling and Discovery to build

service maps automatically

o Customized discovery

o Oracle LMS (free of charge) to capture audit details

The table below illustrates differentiation between UD Basic Discovery and UD Advanced Discovery.

License
Type Definition
Basic A node will consume a Basic Discovery unit when information is

Discovery collected that is within the context of the node being discovered:

« Physical inventory

« Installed software inventory
o Users

» Ports/LUNs

Advanced A node will consume an Advanced Discovery unit when
Discovery information is collected about it running software, or how the node
interact with other nodes or running software:

« Running Software inventory (and its processes)
» Serverto Serverlinks

« Serverto Running Software links

« Running Software to Running Software links

« Serverto Storage links

« Serverto Network links

« Virtual to Physical links

CMS Ul (2018.08)

Use Cases

Physical
Asset
Management

Software
Asset
Management*

Security
Policy

Management
Configuration
Policy

Management

Incident
Management

Service
Management

Change
Management

Impact
Analysis

Event
Management

Event
Correlation
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License
Type Definition Use Cases

o Oracle Audit
Preparations

« Security
Policy
Management

« Dependency
Policy
Management

Note: * Universal Discovery can collect software inventory to be used for the SAM use case by
Asset Manager.

Access the new License Summary Report
1. Launch CMS Ul as Admin user.

2. Click the Help button in the top right corner of the window, and then select About.
The About window opens.

3. Gotothe LICENSE tab.
Check the license summary:

o License Status - Is license status compliant, noncompliant, or expiring in a number of days.

o Total Units - Provides data about units of licenses consumed and units available, as well as
the units consumption rate.

o Is UCMDB Foundation — Indicates whether you have Foundation license or not.

o The Managed Data Repository (MDR) usage is displayed according to the Available 3rd
Party Integrations you have in UCMDB.

o OSs managed by CM usage displays the number of OSls belonging to the results of the
managed in CM views.
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ABOUT LICENSE

License Information:

License Status: expiring in 15 days

Teotal Units: 18.3/20000-Usage: 0.1%

Is UCMDB Foundation: No

Available 3rd Party Integrations: 1/200-Usage: 0.5%

0Ss managed by CM: 0/0-Usage: 0%

oK

4. Click the link after License Status.
The License Summary Report page opens.
5. Check the license summary report.

o Only Instant-On license is listed even though you have had some licenses installed when you
worked with the previous version. The license issued for previous versions are not compatible
with UCMDB 2018.08 and they are not visible.

o The Advanced UD license usage is not yet displayed even if there are discovered OSls in your
UCMDB.

o OSs managed by CM usage displays the number of OSIs belonging to the results of the
managed in CM views.

o The Managed Data Repository (MDR) usage is displayed according to the Available 3rd
Party Integrations you have in UCMDB.

o Total Units usage provides data about units consumed and units available, as well as the units
consumption rate.
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LICENSE SUMMARY REPORT
LICENSE CONSUMPTION SUMMARY
License Servers
Advanced UD o
Basic UD 24

Total Units

6.2/20000 - Usage : 0.0%

AVAILABLE LICENSES

# Status License Description

1 Active

UCMDBUD-InstantOn license

Workstations Network Devices

14 0

Available 3rd Party Integrations

0/200 - Usage : 0.0%

Type Expiring Date

INSTANT_ON 7/9/18 11:59 PM

Export License Consumption Details Report o,

Storage Devices Containers

0Ss managed by CM

0/0 - Usage : 0%

v [

Starting Date Remaining Days License Capacity

N/A 90 1

In the Available Licenses section, you can click " to select whether you want to display All
licenses or licenses of Active or Expired status. You can also click [ to select columns you

want to display. By default all columns are displayed.

6. Click Export License Consumption Details Report -+ in the upper right corner of the page,

then select one of the following options to export the detailed report in Excel format:

o Unit Consumption Details

o MDR Consumption Details

Open the exported Excel report and review the details, for example, the device name that is

identified.

The table below describes each column in the exported Unit Consumption Details report:

Column

instance_type

Units
Cl_type
global_id
name

node_role

CMS Ul (2018.08)

Description

Instance type of the resource. Valid values include server, workstation,

network, docker, and so on.

Units consumed.

Cl type attribute value of the resource.

Global ID attribute value of the resource.

Name attribute value of the resource

Whether the resource is of node type, but not of network or storage
device, and what node type the resource is: server or workstation.
Value example: [server, virtualized_system] or [virtualized_system]
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Column

os_family

discovered os_
version

create_time

created by

last_modified time

data_updated_by

root_
iscandidatefordeletion

Description

for a server resource; [desktop, virtualized_system] fora
workstation resource.

OS family of the resource: Windows, Linux, MacOS, or others.

The discovered OS version of the resource (if applicable).

Time the record for the resource is created.

Indcates who created the record of the resource.

Value example: UCMDBDiscovery: Host Connection by Shell
indicates that the record is created by the Universal Discovery Host
Connection by Shell job.

Time the record of the resource was last updated.

Indicates the discovery job that last updated the record of the resource.

Value example: UCMDBDiscovery: Host Connection by Shell

Is the C| candidate for deletion or not. Default: FALSE

The table below describes each column in the exported MDR Consumption Details report:

Column
Integration name
Adapter name

Is Free

Used MDR license:

Description

Name of the integration point.

Name of the adapter used in the integration point.
Is the integration available free of charge or not.

Number of MDR licenses used.

Frequently Asked Questions

« Q: What must be prepared to upgrade the Universal Discovery Licensing to 2018.08?

A: You must do all of the following:

o Access the Support Entitlement Portal to convert any MDR and ACM licenses you own to the
format required by 2018.08 or later. This can be done by you and does not require any help from

Micro Focus teams.

CMS Ul (2018.08)

Page 429 of 446



CMS Ul Guide

o Contact the Software Sales Assist team (sw_ssa@microfocus.com) before upgrading UCMDB
to migrate your UD Full and UD Inventory licenses to units.

o Install the converted MDR and ACM licenses into UCMDB, and also install the migrated Units
into UCMDB.

o Q: Will | be able to use UCMDB 2018.08 without updated licenses?

A: If 2018.08 license is not applied, you will be provided a limited time trial license. Production
usage of UCMDB with this trial license is not allowed.

The UCMDB splash screen contains a link to the JMX method that allows you to add the new
license.

o Q: Will | be able to use the existing MDR licenses in UCMDB 2018.08?

A: Yes. Your existing licenses will work fine in UCMDB 2018.08. You just need to “convert” them
via the Support Entitlement portal so that they are compatible with UCMDB 2018.08.

« Q: How should | deal with the license upgrade from a previous version to UCMDB 2018.087?

A: For detailed instructions, see "How to Deal with License Upgrade from a Previous Version to
UCMDB 2018.087" on page 1.

For more details about 2018.08 licensing, go to the CMS page on the Software Sales Portal and check
the Licensing section on the Resources tab. Or, contact the Software Sales Assist team (sw_
ssa@microfocus.com) directly.
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Troubleshooting CMS Ul - Known Issues

Problem: "There is no data available for this report" message is displayed for individual default report
widgets (such as Installed Software) on the Home module

« Cause: It could be one of the following:

o ltis true that there is no data available for the reports. Or,

o The reports are querying over a large amount of data from the UCMDB server which exceeds the
maximum number of elements allowed in view, and you may find "server view query over limit"
errorin log.

« Solution: In case of the second scenario, to resolve the display issue, goto UCMDB Ul >
Administration > Infrastructure Settings Manager, locate the Maximum number of elements
(nodes) in TQL result for view setting (default value: 30000) and increase its value to meet your
need.

Problem: Performance for the CMS Ul is slow.

« Possible Solution: Add the variable CATALINA_OPTS to the Operating Systems environment
variables with values:

-Xms512M -Xmx4096M

Problem: The Tomcat log that contains requests to the CMS Ul and their HTTPS codes becomes too
large and is unreadable.

« Solution: Comment out the following lines in the server.xml file, located in <CMS_UI_
installation_directory>\webapps\release\conf:
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<Valve className="org.apache.catalina.valves.AccessLogValve" directory="logs"
prefix="localhost_access_log." suffix=".txt"
pattern="%h %1 %u %t &quot;%r&quot; %s %b" />

Problem: Icons are not displayed when the Turn Off Data URI support setting is not disabled.

« Solution: Disable the Turn Off Data URI support setting on Windows as follows:

a. Click Start, type gpedit.msc in the Start Search box, and then press ENTER.

b. Inthe navigation pane of the Local Group Policy Editor window, expand Computer
Configuration > Administrative Templates > Windows Components > Internet Explorer
> Security Features.

c. Intheright pane, double-click Turn Off Data URI support.
d. Select Enabled, click Apply, and then click OK.

e. Go back to the navigation pane of the Local Group Policy Editor window, expand User
Configuration > Administrative Templates > Windows Components > Internet Explorer
> Security Features.

f. Repeat step 3 and step 4.

Troubleshooting Service Modeling

Troubleshooting Automated Service Modeling
(ASM) - General Guideline

This chapter introduces the general troubleshooting guidelines for problems that may occur during the
Service Modeling process.

When an error occurs with a particular Cl in the topology map, an error icon appears on the Cl.

b

2

The following steps demonstrate the basic troubleshooting procedure for such an error:
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1. View the error message in the UCMDB Browser module.
a. Click the erroricon onthe ClI.

The Discovery Issues pane appears and lists all the related discovery issues.

Discovery Issues X
All Discovery Issues 1
Credential-Related Errors 1

b. Click one of the categories.
A list of errors of the category appears.
c. Click an error to view the detailed error message.
Software Related Errors
The following outgoing ports are filtered because they are not in portMumber ToPortName.xml: 13080, 61447, 61448,
61449, 61450, 61451, 61452, 51453, 61454, 61455, 61456, 61457, 61458, 65121, 65305, 65306
&, Download Discovery Log B Email Administrator 4 Troubleshooting Guide

2. Perform one of the following actions when appropriate.

o Forsome errors under Software Related Errors, you can directly provide some missing
information in the UCMDB Browser module. As in the above example, if you click the Add
Port Number button, you will be able to add the missing port numbers.

CMS Ul (2018.08) Page 433 of 446



CMS Ul Guide
Troubleshooting

[h11p]16.155.155.45:8080 /webtier-9.51/index.do P
Problem Source: Some outgoing ports are filtered Back to List

Add Port Number

PORT UPDATE
We have discovered new port numbers

Application Name

Port Number Select All  Deselect All
O 13080 2
61447 E
61448
61449
61450

61451

Jooooad

&1457 -

Save Mapping

o Search the error message in this chapter, and try the suggested solutions.

3. Rerun the Service Modeling task.

Troubleshooting ASM - Host Discovery by Shell job

This chapter describes the error messages you may receive from the Host Discovery by Shell job and
provides suggested solutions.

Error Message: The IP address is not in the discovery IP Range
Error Category: Probe Errors

Probe Errors
16BN is not in the discovery IP Range. You need fo create a new IP range.

The following jobs are impacted:
1.5D_3_Host Discovery by Shell Add IP Range

o4 Download Discovery Log B Email Administrator ¥4 Troubleshooting Guide

Solution: Add the IP address or range to the Ranges setting of the probe. For more details, see "Add
an IP Range Manually" on page 264.

Error Message: Inaccessible network path to target server. Perhaps it is a virtual IP address.

Error Category: Connection Errors
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Others
Inaccessible network path 1636 to target server. Perhaps it is a virtual IP address.

Add Physical IPs
ok Download Discovery Log B Email Administrator 4 Troubleshooting Guide

Solution: Add physical IPs as entry points of next hop

(https]16. I 36:8443 /
Probiem Source: Inaccessible network path to farget server Backto L
Add Physical IPs

1p* Port* Context

Add Physical IP

OK Cancel

Error Message: Need credential to the host

Error Category: Credential-related Errors

Credential-Related Errors
Mo valid credentials to the host 16.155.155.155 are found. You need to create valid credentials.

ok, Download Discovery Log B Email Administrator {4 Troubleshooting Guide

Solution: Add the valid credentials. For more information about how to do this, see "Add or Edit
Credentials" on page 440.
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[https]16.155.155.155:8743 fwebtier-9.51/index.do
Problem Source: No valid credentials found

ENTER CREDENTIALS

Possible Applicable Protocols

NTCMD

Network Scope

9) Al Discovery Issues

username

Confirm password

windows_domain

local_share_path

Selected Range

User Label

password

connection_timeout

20000

run_windows_commands_impersonated
true @ false

remote_share_path

Back to List

Error Message: Connection timeout

Error Category: Timeout Errors

Timeout Errors

SSH: Timeout trying to connect to the remote agent. Try increasing the timeout value.

o, Download Discovery Log B2 Email Administrator

Solution:

« Increase the timeout value in protocol settings.

o For Windows machines, wait for a few minutes and then try again.

¥4 Troubleshooting Guide

Error Message: The discovery job did not find any process listening on port: <port_number>

Error Category: Software Related Errors

Solution:

« Check if the configured account has sufficient privileges to run relevant commands. Specifically,

o ps -e

o netstat -nap

CMS Ul (2018.08)
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o lsof
Elevate privilege for UNIX credentials.
« Verify if the service is still accessible.

o Check if Isof is installed on the target machine if it runs UNIX.

Error Message: No application signature matches the process <process_info> listening on port <port_
number>

Error Category: Software Related Errors

Solution: Add the signature for the application. For more information about how to do this, see "Add or
Edit Application Signatures" on page 441.

Error Message: The following outgoing ports are filtered because they are not in
portNumberToPortName.xml

Error Category: Software Related Errors

Software Related Errors
No application signature matches the process [Process('ucmdb_server.exe', 2632, "jre\bin\ucmdb_server" -

-server -XX:+PrintCommandLineFlags -XX:+UseG1GC -XX:+UnlockExperimentalVMOptions =
SK:MaxGCPauseMillis=2000 -Dsun.rmidoc.clientgcinterval=0x7fffffffiffffffe

-Dsun.rmi.dge.server.gcinterval=0x7ffffffffffffffe -verbose:gc -XX:+PrintGCDetails -Ducmdb.home=.. . )

- PR . L Add Application Signature
-Dcom.sun.management,jmxremote -Djava.io.tmpdir=./runtime/jetty-cache
-Djava.naming.factory.url.pkgs=org.mortbay.naming

Piaien manains famtbam e lnibialonem cmamthas namins lnitalmantatlamtams Pusmmdb heamas hana—

& Download Discovery Log B Email Administrator {14 Troubleshooting Guide

Solution: Add the port number to portNumberToPortName.xml.

To do this, click the Application Signature button in the error message and then follow the
instructions. Alternatively, you can directly modify the portNumberToPortName.xml file to add the
port number.
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[https]16.187.187.87:8443 fucmdb-uiflogin_page.jsp
Problem Source: No application signature matches the process

Add Application Signature
Software Library Software Signature
Add Delete Refresh Expand ID
(! Software Element Categories Category

Supported Version

Created Cl Properties

€l Type RunningSoftware

Discovered Product
MName

Vendor

Processes
Add Edit |

Key Main Name Port Command Line

Save Cancel

Error Message: The following outgoing ports are filtered because they are not in
portNumberToPortName.xml.

Error Category: Software Related Errors
Software Related Errors
The following outgoing ports are filtered because they are not in portNumberToPortNamexml: 13080, 61447, 61448,
61449, 61450, 61451, 61452, 61453, 61454, 61455, 61456, 61457, 61458, 65121, 65305, 65306 Add Port Number
&, Download Discovery Log B Email Administrator ¥4 Troubleshooting Guide

Solution: Add the port number to portNumberToPortName.xml.

To do this, click the Add Port Number button in the error message and then follow the instructions.
Alternatively, you can directly modify the portNumberToPortName.xml file to add the port number.
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[http]16.155.155.16:8080 /webtier-9.51findex.do
Problem Source: Some outgoing ports are filtered

Add Port Number

PORT UPDATE
We have discovered new port numbers

Application Name

Port Number Select Al Deselect All

13080

61447 =

61449
61450

61451

O
H
[0 s148
O
O
O
rm

AI1L5Y

Save Mapping

Back to List

Error Message: Failed to resolve host name to IP
Error Category: |P-related Errors

Solution: Check DNS server configuration.

Error Message: Need sudo permission
Error Category: Software Related Errors

Solution: Elevate privilege for UNIX credentials to run the relevant command.

Error Message: No Isof installed on the host
Error Category: Software Related Errors

Solution: Install Isof on the target machine.

Error Message: The host is a Solaris local zone

Error Category: Software Related Errors

Solution: None for this release. Currently Solaris local zone is not supported by ASM.

Error Message: No SCP reported from configuration signature.

Error Category: Others

CMS Ul (2018.08)
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Solution: No SCP reported from configuration signature for application <Application Name>. Check
the ConfigurationFileSignature.xml file to make sure all parameter values for your application are
correct.

Troubleshooting ASM - References

This chapter provides instructions for some of the solutions mentioned earlier.

Add an IP Range to the Ranges Setting

1. GotoData Flow Probe Setup > Domains and Probes pane > Domains and Probes root node
> adomain > Data Flow Probes > a Data Flow Probe.

2. Inthe Ranges pane, click New Range |

3. Provide the necessary information on the New Ranges dialog box, and then click OK.

Discover Load Balancers

1. Run the Host Connection by SNMP job.

2. Run one of the following jobs depending on the type of the load balancer:
o F5BIG-IP LTM by SNMP
o Alteon application switch by SNMP
o Cisco CSS by SNMP

Add or Edit Credentials

1. Goto Data Flow Probe Setup > Domains and Probes pane > Domains and Probes root node
> adomain > Credentials > a protocol.

2. Inthe right pane, perform one of the following actions to add or edit an entry:
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o Toadd a new connection detail, click Create new connection details for selected protocol
type =

o To edit an existing credential, select the entry and then click Edit connection details for

selected protocol type <.

3. Provide the information on the dialog box that pops up, and then click OK.

Edit the portNumberToPortName.xml File

1. Goto Data Flow Management > Adapter Management.
2. Click the Search button </, and then search for portNumberToPortName.xml.

3. Edit the portNumberToPortName.xml file, and then click Save.

Add or Edit Application Signatures

1. GotoData Flow Management > Adapter Management.
2. Inthe Resources pane, select Host_Resources_By TTY > Adapters > TTY_HR_AII.

3. Inthe Adapter Definition tab > Global Configuration Files section, select

applicationsSignature.xml and then click Edit i .

Troubleshoot SAML Authentication

Errors in the CMS Ul error log

[https-jsse-nio-8449-exec-1] SamlLoginUtils - Failed to get SAML configuration

If you are running CMS Ul in standalone mode, check that the saml_configuration.properties file (in the
<CMS Ul home>/conf directory) is configured correctly.

If you are running CMS Ul in embedded mode, check that the UCMDB server started successfully.
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IDP Endpoint could not be null

If you are running CMS Ul in standalone mode, check that the mam.server.sso.saml.auth.idp
property in the saml_configuration.properties file (in the <CMS Ul home>/conf directory) is configured
correctly.

If you are running CMS Ul in embedded mode, check that the
setIDPEndpointForSAMLAuthentication method in JMX console is configured correctly.

Username claim type could not be null

If you are running CMS Ul in standalone mode, check that the
mam.server.sso.saml.auth.username.claimtype property in the saml_configuration.properties file
(in the <CMS Ul home>/conf directory) is configured correctly.

If you are running CMS Ul in embedded mode, check that the
setSAMLCIlaimTypeContainingUserName method in JMX console is configured correctly.
Request issuer could not be null

If you are running CMS Ul in standalone mode, check that the
mam.server.sso.saml.auth.request.issuer property in the saml_configuration.properties file (in the
<CMS Ul home>/conf directory) is configured correctly.

If you are running CMS Ul in embedded mode, check that the setAuthRequestlssuer method in JMX
console is configured correctly.
Response issuer could not be null

If you are running CMS Ul in standalone mode, check that the
mam.server.sso.saml.response.issuer property in the saml_configuration.properties file (in the
<CMS Ul home>/conf directory) is configured correctly.

If you are running CMS Ul in embedded mode, check that the setSamIResponselssuer method in
JMX console is configured correctly.
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Ul Error Messages

"Could not extract IdP authenticated user from SAML Response. The assertion
cannot be used before ..." or "Could not extract IdP authenticated user from SAML
Response. The assertion cannot be used after..."

This issue occurs when the system time on the AD FS server and on the UCMDB Server or CMS Ul
server is incorrectly skewed. The AD FS server system clock must be set to a time later than that of
the UCMDB Server or CMS Ul server. If this is not the case, you must set a time skew to offset the
time difference. The time skew is measured in seconds.

You can set the time skew by using the setSamITimeSkew method in JMX console and the
mam.server.sso.saml.time.skew property in the saml_configuration.properties file (in the <CMS U/
home>/conf directory).

By default, the time skew is 0.

For example, if the value of the setSamITimeSkew method is 60, the AD FS server system clock can
be up to 60 seconds earlier than the system clock on the UCMDB Server or CMD Ul server.

Login Issues

| configured AD FS but the browser is redirected back to the AD FS login page when
I try to log in

This issue occurs when you fail to log in to AD FS.

To resolve this issue, follow these steps:

1. Check whether the AD FS public key was imported to the <CMS U/l>/conf/server.truststore file.
The alias of this public key must be the same as that in the setldpCertificateAlias method in JMX
console and in the mam.server.sso.saml.auth.certificate.alias property in the saml_
configuration.properties file (in the <CMS Ul home>/conf directory).

2. Check the value in the Relying party identifiers field under the Identifiers tab of the Relying
Trust Party in AD FS. This value must be the same as that in the setAuthRequestlssuer method
in JMX console and in the mam.server.sso.saml.auth.request.issuer property in the saml_
configuration.properties file (in the <CMS Ul home>/conf directory).
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Tip: The values may not match due to an additional slash ("/") at the end of the identifier.

| configured AD FS but | receive a "no permission™ error when | try to log in
This issue occurs when you do not have permission to log in to the UCMDB Server.

To resolve this issue, go to UCMDB Server and create a group for your user profile. The group ID
should be set in the setSamlUserDefaultGroup method in JMX console and in the
mam.server.sso.saml.auth.default.group property in the saml_configuration.properties file (in the
<CMS Ul home>/conf directory). The two value must be same.

You can also create a group with the same name as the group in AD FS. For example, you belongto a
group named "Domain users" in ADFS, and the domain name is "samltest.com". In this situation, you
would create a group named "samltest\Domain users". When you next log in, you will be added to the

group.

Tip: Do not forget to set a profile for the group.

| have logged in using the AD FS login page, but a blank page is displayed in
UCMDB Server or CMS Ul, and an external user named "NULL" is created in
UCMDB Server

First, check the server.truststore file (in the <CMS Ul home>/conf directory) to make sure that the IDP
token_signing certificate was successfully imported.

Then, check the Claim Issuance Rules to make sure that all three rules (CommonName, Group,
NamelD) are configured correctly.

Logout Issues

| can log in with SAML authentication, but when | click the Logout button | am
logged in again

This issue occurs when you fail to log out from AD FS.

To resolve this issue, follow these steps:

1. Check your UCMDB private key in the server.keystore file (in the <CMS U/I>/conf/ directory). The
private key alias must be the same as that in the setSamlLogoutCertAlias method in JMX
console and in the mam.server.sso.saml.logout.certificate.alias property in the saml_
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configuration.properties file (in the <CMS Ul home>/conf directory).

2. Open the Signature tab of the Relying Trust Party in AD FS to check whether your UCMDB
public key was imported.

3. Open the Edit Claim Issuance Policy window of the Relying Trust Party in AD FS to check that
three rules are added.
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Send documentation feedback

If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on CMS Ul Guide (CMS Ul 2018.08)
Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a web mail client, and
send your feedback to cms-doc@microfocus.com.

We appreciate your feedback!
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